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What is New - Knowledge Base Updates for IGEL OS 12.8.0
Release notes for IGEL OS Base System and all apps can be found in the IGEL App Portal1.

Start Menu with Grid Layout
The start menu can now be displayed in a grid layout, as an alternative to the list layout. For details, see Start Menu 
in IGEL OS 122.

igelrmserver Configuration Change
Starting from IGEL OS 12.8.0, the DNS entry igelrmserver  is only used during the device registration process 
by default. It can be configured as a fallback if no other UMS addresses are available. For details, see Options of 
Remote Management in IGEL OS 12 (see page 284).

Language & Keyboard Layout Tray App
New tray application added to manage system language and keyboard language settings. For details, see Tray 
Applications in IGEL OS 12 (see page 367).

TPM PCR Support For New HP Devices
Trusted Platform Module (TPM) Platform Configuration Register (PCR) support added for HP t740 and t755. For 
details, see Device Encryption in IGEL OS 12 (see page 237).

Further Accessibility Configurations and Tray App
Added further accessibility configurations in IGEL Setup > User Interface. For details, see Accessibility 
Configuration in IGEL OS 123. Also, a tray app to individually configure accessibility settings was added. For details, 
see Accessibility Tray Apps in IGEL OS 124.

1. https://app.igel.com/
2. https://kb.igel.com/en/igel-os-base-system/current/start-menu-in-igel-os-12
3. https://kb.igel.com/en/igel-os-base-system/current/accessibility
4. https://kb.igel.com/en/igel-os-base-system/current/accessibility-tray-apps-in-igel-os-12

https://app.igel.com/
https://kb.igel.com/en/igel-os-base-system/current/start-menu-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/accessibility
https://kb.igel.com/en/igel-os-base-system/current/accessibility-tray-apps-in-igel-os-12
https://app.igel.com/
https://kb.igel.com/en/igel-os-base-system/current/start-menu-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/accessibility
https://kb.igel.com/en/igel-os-base-system/current/accessibility-tray-apps-in-igel-os-12
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Introduction to IGEL OS 12
IGEL OS 12 is installed in the form of the IGEL OS Base System app.

Installation and Update
The Base System app can be installed on the devices through explicit app assignment in the IGEL Universal 
Management Suite (UMS) Web App. For more information on explicit app assignment, see IGEL UMS 12: Basic 
Configuration5 and How to Assign Apps to IGEL OS Devices via the UMS Web App6.

You can find information on how to update the Base System app in IGEL UMS 12: App Update7.

IGEL OS 12 Release Notes
You can find information about the apps and app versions in the IGEL App Portal8 in the Description and History
tabs of the apps.

The component list of the IGEL OS Base System app can be found in the Description tab under Read More.

5. https://kb.igel.com/en/universal-management-suite/current/migrate-a-ums-server-with-the-same-embedded-databa
6. https://kb.igel.com/en/universal-management-suite/current/how-to-assign-apps-to-igel-os-devices-via-the-ums-
7. https://kb.igel.com/en/how-to-start-with-igel/current/igel-ums-12-app-update
8. https://app.igel.com/#/

https://kb.igel.com/en/universal-management-suite/current/migrate-a-ums-server-with-the-same-embedded-databa
https://kb.igel.com/en/universal-management-suite/current/how-to-assign-apps-to-igel-os-devices-via-the-ums-
https://kb.igel.com/en/how-to-start-with-igel/current/igel-ums-12-app-update
https://app.igel.com/#/
https://kb.igel.com/en/universal-management-suite/current/migrate-a-ums-server-with-the-same-embedded-databa
https://kb.igel.com/en/universal-management-suite/current/how-to-assign-apps-to-igel-os-devices-via-the-ums-
https://kb.igel.com/en/how-to-start-with-igel/current/igel-ums-12-app-update
https://app.igel.com/#/
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The changelog of the IGEL OS Base System app can be found in the History tab.
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Configuration of IGEL OS 12 Device Settings
This article explains how you can edit the system and session settings of IGEL OS 12 devices. Generally, you can 
change IGEL OS 12 device settings:

 via the UMS Web App using either profiles or the Device Configurator or, for some cases, Corporate 
Identity Customization (CIC) Configurator

 locally on the device via IGEL Setup

Configuration Options
You can use the following configuration methods:

Configura
tion 
Method

Description Opening Options

Profile 
Configurat
or

Configurations are made through 
activating parameters to be 
defined by the profile and then 
applying the profile to the device.

Note: When creating profiles, a 
Quick Setup mode is available for 
specific apps. It offers not all 
parameters for configuration, but 
only the most important ones that 
are necessary for starting to 
quickly use the app.

The Profile Configurator can be 
opened from the UMS Web App > 
Configuration9 > Profiles.

 Creating and assigning profiles to devices: see 
https://kb.igel.com/en/universal-management-
suite/current/how-to-create-and-assign-
profiles-in-the-igel-ums-

 Opening existing profiles:
 Double clicking on the profile name
 Clicking the Edit Configuration button
 Selecting the Edit 

Configuration command in the context 
menu of the profile

The best practice is to configure your devices via profiles in the UMS Web App. For customizing user 
interface settings in accordance with your company’s corporate design standards, the use of CICs is 
recommended.

9. https://kb.igel.com/en/universal-management-suite/current/configuration-centralized-management-of-device-set

https://kb.igel.com/en/universal-management-suite/current/configuration-centralized-management-of-device-set
https://kb.igel.com/en/universal-management-suite/current/how-to-create-and-assign-profiles-in-the-igel-ums-
https://kb.igel.com/en/universal-management-suite/current/configuration-centralized-management-of-device-set
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Configura
tion 
Method

Description Opening Options

Corporate 
Identity 
Customiza
tion (CIC) 
Configurat
or

The CIC Configurator provides the 
opportunity to cutomize the user 
interface of your devices in a more 
easier way than the other 
configuration methods.

The CIC Configurator can be 
opened from the UMS Web App > Configuration 
> Corporate Identity Customizations.

 Creating and assigning CICs: see https://
kb.igel.com/en/universal-management-suite/
current/how-to-use-corporate-identity-
customizations-in-ig

 Opening existing CICs:
 Double clicking on the CIC name
 Clicking the Edit Configuration button
 Selecting the Edit 

Configuration command in the context 
menu of the CIC

Device 
Configurat
or

Configurations made here have the 
same effect as local configurations 
via IGEL Setup.

The Device Configurator can be opened from the 
UMS Web App > Devices10.

 Double clicking on the device name
 Clicking the Edit Configuration button
 Selecting the Edit Configuration command in 

the context menu of the device

IGEL 
Setup

Configurations are made locally on 
the device.

For more information, see IGEL 
Setup (see page 32).

 Starting methods defined under Accessories > 
Setup

 Keyboard command [Ctrl]  +  [Alt]  +  [s]
 Keyboard command [Ctrl]  +  [Alt]  +  [F2] in the 

appliance mode

Configurations applied through profiles take precedence and cannot be changed through other 
configuration methods. In other configuration methods, the parameter is grayed out and a lock symbol 
indicates that the setting is configured through a profile: 

In the Device Configurator or IGEL Setup, hovering over the lock will display the name of the profile that 
defines the parameter.
For more information, see https://kb.igel.com/en/universal-management-suite/current/how-to-check-
which-profiles-define-parameters-in-t.

10. https://kb.igel.com/en/universal-management-suite/current/devices-view-and-manage-your-endpoint-devices-in-t

https://kb.igel.com/en/universal-management-suite/current/how-to-use-corporate-identity-customizations-in-ig
https://kb.igel.com/en/universal-management-suite/current/devices-view-and-manage-your-endpoint-devices-in-t
https://kb.igel.com/en/universal-management-suite/current/how-to-check-which-profiles-define-parameters-in-t
https://kb.igel.com/en/universal-management-suite/current/devices-view-and-manage-your-endpoint-devices-in-t
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General GUI Elements of the Configurator Dialog

GUI Element Description

1 Search for Settings Clicking the icon opens the  Search for Settings  tab. You can use 
free text to search for configuration pages and parameter fields. You 
can also search for registry keys by activating the toggle button for 
advanced search, and enabling the Include Registry option.

Clicking on a search result displays the configuration page 
containing the result. The result is highlighted on the page.

When a search result is clicked, the search menu remains displayed 
in the top right corner with the following navigation options:

 arrows to go to the next or the previous search result
 search icon to expand the search tab
 X to close the search

2 Related Pages Clicking the icon displays the  Related Pages  tab. The tab displays 
a list of pages that contain settings related to the settings on the 
current page.

3 Tooltip Hovering over the icon displays information about the parameter.

4 Reset to default Clicking the icon resets the parameter to the default value.

In the Profile Configurator this icon is replaced by the parameter 

activator:  .  When you deactivate the parameter, the value will 
be automatically set back to the default value. 
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Adjustment Tracking in the Configurator Dialog

The adjustment tracker icon in the top right corner tracks the number of unsaved changes. Clicking the icon opens 
the  Unsaved adjustments and the All adjustments  tabs. The Unsaved adjustments tab displays a list of pages 
that contain unsaved changes. Clicking a page in the list opens the page. The unsaved changes are marked with an 
orange dot on the right side of the parameter. In the All adjustments tab, you find a list of pages that contain saved 
changes, grouped by tabs.

Navigation Tree Highlights
When using the configurator in the IGEL UMS Web App, your changes are marked with the following colored icons in 
the navigation tree for easier tracking. 

There is an unsaved change in one of the child pages.

There is an unsaved change in the page.
There is an unsaved change in the tab.

There is a saved template key change in one of the child pages.

There is a saved template key change in the page.
There is a saved template key change in the tab.

There is a saved change in one of the child pages.
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There is a saved change in the page.
There is a saved change in the tab.

The icons marking the type and status of the change have a display priority, with unsaved changes having the 
highest priority and saved changes having the lowest.
For example, if there is a saved change on one child page and a unsaved change on another child page, the parent 
page and the tab will be marked for the unsaved change.

Saving Changes and Exiting the Configurator Dialog
You have the following options to save changes and close the configurator:

→ Click Save and Close  to save your changes and close the configurator.

→ Click  Close  if you have not made any changes and would like to abort the configurator. If you have made 
changes, a confirmation dialog is displayed. In the dialog, you have the following options:

 Click  Discard  to close without saving the changes.
 Click  Save and Close to save the changes before closing.
 Click Cancel to go back and see the list of unsaved changes.

→ Click Save if you have finished configuring a setup area and would like to save your settings without closing the 
configurator.

Configurator Tabs
Settings for all apps except IGEL OS Base System app are displayed under the tab Apps.

IGEL OS Base System settings are grouped by function under the following tabs:
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 Accessories in IGEL OS 12 (see page 12)
 User Interface (see page 41)
 Network (see page 140)
 Devices in IGEL OS12 (see page 215)
 Security Configuration in IGEL OS 12 (see page 236)
 System Configuration in IGEL OS 12 (see page 276)
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Accessories in IGEL OS 12
In this chapter, you find information on the configuration of accessories in IGEL OS.

 Terminals in IGEL OS (see page 13)
 SSH Client (see page 15)
 VNC Viewer in IGEL OS 12 (see page 17)
 Network Tools (see page 18)
 Application Launcher (see page 22)
 App Portal (see page 25)
 System Information (see page 26)
 Screenshot Tool (see page 29)
 Setup (see page 32)
 System Log Viewer in IGEL OS 12 (see page 34)
 Task Manager (see page 37)
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Terminals in IGEL OS
With a local terminal, you can execute local commands on your device. This article shows how to configure the 
starting methods for terminals, and how to use local terminals in IGEL OS. 

Menu path: Accessories > Terminals 

Terminal Sessions

List of configured local terminal sessions

To manage the list of sessions, proceed as follows:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

It is also possible to access a local shell without a terminal session: Alternatively, you can switch to the 
virtual terminals  tty11  and  tty12  by pressing [Ctrl]+[Alt]+[F11 ]or [Ctrl]+[Alt]+[F12]. Pressing [Ctrl]+
[Alt]+[F1] takes you back to the user interface.
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→  Click   to define the starting methods for the session.

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

Using Local Terminal
To use the local terminal, proceed as follows:

1. Start the local terminal.
2. Log in as  user  or  root .

3. Enter the shell commands supported by IGEL OS.

If Use password is enabled in the Administrator area under Security > Password, you need to enter the 
administrator password to access a local terminal as  root .

If an administrator password is set, accessing a local terminal as  user  is only possible if the following 
two conditions are met:

 Access to local terminals has been activated for  user . This is possible with the registry 

key  system.security.usershell  under System > Registry. The default setting of 

the registry key forbids terminal access for  user .
 Use password is enabled in the User area under Security > Password.

For accessing a local terminal as  user , the user password has to be entered.
For more on password configuration, see Password and User Types in IGEL OS 1211.

For a collection of commands supported by IGEL OS, see the IGEL Community cheatsheet12.

11. https://kb.igel.com/en/igel-os-base-system/12.6.1/password-and-user-types-in-igel-os-12
12. https://www.igelcommunity.com/post/igel-os-linux-commands-cheatsheet

https://kb.igel.com/en/igel-os-base-system/12.6.1/password-and-user-types-in-igel-os-12
https://www.igelcommunity.com/post/igel-os-linux-commands-cheatsheet
https://kb.igel.com/en/igel-os-base-system/12.6.1/password-and-user-types-in-igel-os-12
https://www.igelcommunity.com/post/igel-os-linux-commands-cheatsheet
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SSH Client
You can launch applications on a remote computer via SSH (Secure Shell). The display is usually on the terminal; 
X11 connections can also be routed via SSH. This article shows how to configure SSH sessions in IGEL OS.

Menu path: Accessories > SSH Client

Application via SSH

To manage the list of SSH sessions, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

→ Click  to define the starting methods for the session.

The starting methods parameters are described under Starting Methods for Apps (see page 421). 
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Command
Menu path: SSH Client > [Session Name] > Command

Here, you can change the following settings:

Remote user name

User name under which the application runs on the remote computer. If left blank, user will be asked for it at 
session startup.

Remote Host

Host name or IP address of the remote computer.

Command Line

Command which is to be executed on the remote computer immediately after logging in.

Options
Menu path: SSH Client > [Session Name] > Options

Here, you can change the following settings:

Enable X11 connection forwarding

 X11 applications on the remote computer that are launched via the SSH session will be shown on your device. 
(Default)

☐ No X11 programs can be launched on the remote computer via the SSH session.

Enable compression

 The data will be compressed for transmission.

☐ The data will not be compressed for transmission. (Default)

Port

SSH port. (Default: 22)
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VNC Viewer in IGEL OS 12

Starting from IGEL OS Base System 12.6.0, the VNC Viewer accessory was removed from the base system. 
The TigerVNC VNC Viewer app is offered as a replacement and a more flexible solution for VNC session 
types, see TigerVNC VNC Viewer13.

13. https://kb.igel.com/en/igel-apps/current/tigervnc-vnc-viewer

https://kb.igel.com/en/igel-apps/current/tigervnc-vnc-viewer
https://kb.igel.com/en/igel-apps/current/tigervnc-vnc-viewer
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Network Tools
This article shows the starting methods configuration and the use of Network Tools in IGEL OS. The tool provides 
network analysis, for example, Ping, Netstat, Traceroute.

Menu path: Accessories > Network Tools

You can configure the starting methods for an easy access of the Network Tool. 

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

Using Network Tools
->Start Network Tools.

Starting from OS version 12.3.1, Password protection is not configurable and administrator credentials 
are required to start Network Tools.
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To obtain information regarding a network device available on your device, proceed as follows:

1. Switch to the Devices tab.
2. Under Network device, select the network device for which you would like to obtain information.

The information regarding the selected network device will be shown.

To send a ping query to a device in your network, proceed as follows:

1. Switch to the Ping tab.
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2. Under Network address, enter the IP address or the host name of the device to which you would 
like to send a ping query.

3. If necessary, add the number of ping queries under Send.
4. Click Ping.

The set number of ping queries will be sent. The results will then be shown.

To obtain information regarding the network status of your device, proceed as follows:

1. Switch to the Netstat tab.
2. Select the desired information under Display:

 Routing Table Information
 Active Network Services
 Multicast Information

3. Click Netstat.
The desired information will be shown.

To identify the router via which an IP data packet from your device reaches a specific target computer, proceed as 
follows:

1. Switch to the Traceroute tab.
2. Under Network address, give the IP address of the target computer.
3. Click Trace.

The device will send IP packets to the target computer at short intervals, each with a TTL (Time To 
Live, i.e. maximum number of hops) increased by 1.
When the packet reaches the target computer, "reached” will be shown in the last line and no 
further packet will be sent.
If no computer replies, "no reply" will be shown.

To obtain DNS information regarding an address on the Internet from your device, proceed as follows:

1. Switch to the Lookup tab.
2. Under Network address, give the IP address or the host name.
3. Under Information type, select which information is to be shown.

The following information types are available:
 Default Information
 Internet Address
 Canonical Name
 CPU / OS Type
 Mailbox Exchange
 Mailbox Information
 Name Server
 Host name for Address
 Text Information
 Well Known Services
 Any / All information

4. Click Lookup.
The desired information will be shown.
Further information regarding the DNS (Domain Name System) can be found on Wikipedia 
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under Domain Name System14.
Detailed descriptions of the Domain Name concept can be found in RFC 103415 and in related RFCs.

14. https://en.wikipedia.org/wiki/Domain_Name_System
15. https://tools.ietf.org/html/rfc1034

https://en.wikipedia.org/wiki/Domain_Name_System
https://tools.ietf.org/html/rfc1034
https://en.wikipedia.org/wiki/Domain_Name_System
https://tools.ietf.org/html/rfc1034
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Application Launcher
With the Application Launcher, you can launch predefined sessions, and device functions and tools. You are also 
given information regarding the device and the licenses used. This article shows how to configure the Application 
Launcher in IGEL OS.

Menu path: Accessories > Application Launcher

You can configure the starting methods for an easy access of the Application Launcher.

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

Application Launcher Configuration
Menu path: Application Launcher > Application Launcher Configuration
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Hide system page

 The  button for displaying the system tools (accessories) will not be shown.

☐ The  button for displaying the system tools (accessories) will be shown. (Default)

Show current user name in About, Application Launcher and start menu

 The current user will be shown at the top edge of the relevant window. (Default)

☐ The current user will not be shown.

Single click mode

 Sessions are started with a single-click. Recommended for users of touchscreen monitors.

☐ Sessions are started with a double-click. (Default)

In order for user names to be recognized and passed on, you must configure two settings beforehand:
 Enable using Active Directory/Kerberos under Security > Active Directory/Kerberos. For 

details, see Active Directory/Kerberos Configuration in IGEL OS 12 (see page 262)
 Enable local logon under Security > Logon > Active Directory/Kerberos. For details, 

see Active Directory/Kerberos - Enable Login in IGEL OS 12 (see page 250)
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You can hide the shutdown menu from the Application Launcher using the Hide Shutdown menu 
button option under User Interface > Commands > Shutdown Menu > Quick Access. For more 
information, see Commands Session in IGEL OS 12 (see page 125) .
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App Portal
This article shows how to configure the starting methods for the App Portal in IGEL OS.

Menu path: Accessories > App Portal

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

 To use the IGEL App Portal locally on the device, verify first that Permit local app installation is enabled 
under Security > Update. (Default)
For detailed information on how to use the App Portal, see How to Start with IGEL > Installing IGEL OS Apps 
Locally on the Device.
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System Information
This article shows the starting methods configuration and the use of System Information in IGEL OS. Through 
System Information, you can obtain information regarding the operating system of your device, the installed 
system components, internal and connected hardware, and the network. You can also measure the performance of 
your device using various benchmarks.

Menu path: Accessories > System Information

You can configure the starting methods for an easy access of the System Information.

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

An administrator password is required by default to start System Information if Use Password is enabled 
under Security > Password. For details, see Password and User Types in IGEL OS 1216.
The password requirement can be changed through the Password protection option in the starting 
methods configuration. 

16. https://kb.igel.com/en/igel-os-base-system/12.6.1/password-and-user-types-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/12.6.1/password-and-user-types-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/12.6.1/password-and-user-types-in-igel-os-12
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Using System Information
->Start System Information.

To obtain system information regarding a specific component of your IGEL OS device, proceed as follows:

1. Navigate to the desired area, e.g. Computer > Operating System.
The information regarding the desired area will be shown.

2. To send the information shown, e.g. to the IGEL Support, click Copy to Clipboard.
The information is on your clipboard. With Paste or [Ctrl] + [V], you can paste the information into 
an e-mail or a web form.

You can use the System Information function to find out the Vendor ID and Product ID of your connected 
hardware. They are required, for example, if you want to configure Device Rules under Setup > Devices > 
USB Access Control. For more information, see USB Access Control in IGEL OS 1217.

17. https://kb.igel.com/en/igel-os-base-system/12.6.1/usb-access-control-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/12.6.1/usb-access-control-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/12.6.1/usb-access-control-in-igel-os-12
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Screenshot Tool
This article shows the starting methods configuration and the use of the Screenshot Tool in IGEL OS.

Menu path: Accessories > Screenshot Tool

You can configure the starting methods for an easy access of the System Information.

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

Using Screenshot Tool

1. Start the Screenshot Tool.

2. Select a Region to capture option. You have the following options:

Hotkeys can be configured for using the Screenshot Tool under User Interface > Hotkeys. 
Hotkeys can be configured to take Screenshot of active window or Screenshot of entire 
screen. When using the hotkeys, the screenshot is taken without delay, and the mouse 
pointer is not captured. For more information on hotkey configuration, see Hotkeys (see 
page 66).
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 Entire screen
The entire screen content will be photographed.

 Active window
The window that is currently active will be photographed.

 Select a region
You can select a section of the screen using the mouse.

3. Set the Capture the mouse pointer option.
 The mouse pointer is visible on the screenshot.

4. Specify the Delay before capturing in seconds. The minimum value is 0.
5. Click OK.

If you have enabled Entire screen or Active window, the screenshot will be taken after the Delay 
before capturing has elapsed.
If you have enabled Select a region, you can select the desired part of the screen using the mouse. 
To do this, press and hold the left mouse button while dragging the mouse across the screen.
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6. Specify how the screenshot is to be used.
You have the following options:

 Save
If this option is enabled, the screenshot will be saved in PNG format via your device. You can 
save the screenshot locally, on a network drive or on a USB mass storage device.

 Copy to the clipboard
If this option is enabled, the screenshot will be available in the device's local cache.

 Open with
If this option is enabled, the screenshot will be opened in your device's image viewer.
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Setup
With the IGEL Setup, you can configure your endpoint device. This article shows how to configure the starting 
methods for the IGEL Setup in IGEL OS. 

Menu path: Accessories > Setup

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

If you configure user types and passwords under Security > Password, a login window appears at the start of the 
IGEL Setup. For more information, see Password and User Types in IGEL OS 12 (see page 241) .

If you do not configure the user types and passwords, the IGEL Setup can be opened without password 
protection.
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->Select from the configured user types and provide the corresponding password. 

The following user types can be configured to access the IGEL Setup:

 Administrator
 Setup administrator
 Setup user
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System Log Viewer in IGEL OS 12
This article shows how to configure the System Log Viewer in IGEL OS. With this function, you can view your device’s 
system logs.

Menu path: Accessories > System Log Viewer

You can configure the starting methods for an easy access of the System Log Viewer.

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

Options
Menu path: Accessories > System Log Viewer > Options

Here, you can add additional files to the files shown by default. The System Log Viewer shows the following files by 
default:

 /config/Xserver/card0

 /config/Xserver/monitor-info
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 /config/Xserver/xorg.conf-0

 /var/log/Xorg.0.log

 /var/log/auth.log

 /var/log/daemon.log

 /var/log/igfmount.log

 /var/log/kern.log

 /var/log/syslog

 /var/log/tcsetup.log

 /wfs/user/setup-assistant.log

To add a further file to the display, proceed as follows:

1. Click  .
2. In the Add dialog, enter the path and the file name of the desired file. Example:  /var/log/

splash.debug

3. Click OK.
When the System Log Viewer is started, the file that you have added will be shown.

Using System Log Viewer
→ Start the System Log Viewer.

If you want to add several files, you can also use the asterisk *. Example:  /var/log/

*.log  or   /var/log/ *.txt

Known Issue

The added file is only shown after the restart of the device. The configuration will be reworked in a 
future release.
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→ In the left-hand column, select the file that you want to view.

The selected file will be shown in the right-hand column.
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Task Manager
The Task Manager provides an overview of the applications and other processes running on the device. It can be 
used to pause, end, or change the priority of processes. This article shows the starting methods configuration and 
the use of the Task Manager in IGEL OS. 

Menu path: Accessories > Task Manager

You can configure the starting methods for an easy access of the Task Manager.

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

Using Task Manager
With the Task Manager, you can observe and influence applications and processes in the following ways:

 Determining device processor usage
 Determining device memory usage
 Determining processor usage by a specific application
 Determining memory usage by a specific application
 Pausing and continuing an application
 Closing an application
 Force closing an application
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 Changing the priority of an application

->Start the Task Manager.

To determine the device's total processor usage:

->Read the percentage value under CPU.

To determine the devices's total memory usage:

->Read the percentage value under Memory.

To calculate the value in bytes, click   and enable Show memory usage in bytes.

To determine the extent to which a specific application contributes to processor usage, proceed as follows:

1. In the search window, enter the name of the application or part of the name.
The Task Manager will now show only the relevant applications and processes.

2. Read the percentage value for the relevant application in the CPU column.

To determine the extent to which a specific application contributes to memory usage, proceed as follows:
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1. Click   next to  and ensure that Virtual Bytes and Private Bytes are enabled.
2. In the search window, enter the name of the application or part of the name.

The Task Manager will now show only the relevant applications and processes.
3. Read the values in the VSZ and RSS columns.

The VSZ column shows how much memory is available for the application. The RSS column shows 
how much memory the application is currently using.

To pause an application, proceed as follows:

1. Highlight the application.
2. Open the application’s context menu by right-clicking on it and select Stop.

The application will be paused (Signal SIGSTOP). You can then continue the application.

To continue an application, proceed as follows:

1. Highlight the application.
2. Open the application’s context menu by right-clicking on it and select Continue.

The application will continue (Signal SIGCONT).

To close an application, proceed as follows:

1. Highlight the application.
2. Open the application’s context menu by right-clicking on it and select Terminate.

The application will close (Signal SIGTERM).
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To force an application to close, proceed as follows:

1. Highlight the application.
2. Open the application’s context menu by right-clicking on it and select Kill.

The application will be forced to close (Signal SIGKILL).

To change the priority of an application, proceed as follows:

1. Highlight the application.
2. Open the application’s context menu by right-clicking on it and select Priority.
3. Select one of the following values for the priority:

 Very low (nice value: 15)
 Low (nice value: 5)
 Normal (nice value: 0)
 High (nice value: -5). This value can only be set by the administrator.
 Very high (nice value: -15) This value can only be set by the administrator.

In this case, the application is instructed to close by the operating system. If the 
application does not react to this instruction, you can force it to close with 
the Kill command.

As a normal user, you can only change the priority from a higher value to a lower value. 
Example: If you have changed the priority from Normal to Low, you can only then change 
it to Very low – you can no longer change it back to Normal. The administrator can 
increase the priority.

The priority corresponds to the nice value. High values result in a low priority, while low 
values result in a high priority.
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User Interface
In this chapter, you find information on the configuration of the user interface in IGEL OS.

 Language Settings in IGEL OS 12 (see page 42)
 Display Settings in IGEL OS 12 (see page 44)
 Screenlock / Screensaver in IGEL OS 12 (see page 55)
 Hotkeys (see page 66)
 Input (see page 67)
 Desktop Settings in IGEL OS 12 (see page 100)
 Commands Session in IGEL OS 12 (see page 125)
 Accessibility Configuration in IGEL OS 12 (see page 128)
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Language Settings in IGEL OS 12
This article shows how to configure the country-specific language settings in IGEL OS 12.

Menu path: User Interface > Language

Language

Sets the language of the user interface.

Keyboard layout

When the language is changed for the first time, the keyboard layout is automatically set to the same language.

Show keyboard layout switcher in taskbar

 Shows an icon with the active keyboard layout in the taskbar. The user can access the Language & Keyboard 
Layout Tray App19 by clicking the icon.

If configured, the language cannot be changed through the Language & Keyboard Layout Tray App18. If you 
want to enable the user to change the language through the tray app, set the parameter to default.

18. https://kb.igel.com/en/igel-os-base-system/current/tray-applications-in-igel-os-12
19. https://kb.igel.com/en/igel-os-base-system/current/tray-applications-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/tray-applications-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/tray-applications-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/tray-applications-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/tray-applications-in-igel-os-12
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☐ No keyboard layout switcher is shown. (Default)

The taskbar indicator displays the active keyboard layout using the language and country code.

For example, FR CH if French (Switzerland) was selected,

and DE CH if German (Switzerland) was selected.

Show language setting together with keyboard layout in tray-app

This parameter is only available together with Show keyboard layout switcher in taskbar.

 The user can change the display language of the session in the Language & Keyboard Layout Tray App21. The 
display language reverts back to the default setting after reboot. The default setting is defined by the option 
Language under User Interface > Language.

☐ No keyboard layout switcher is shown. (Default)

Input language

The default setting is geared to the selected keyboard layout.

Standards and formats

Sets the country-specific standards and formats, e.g. time and currency. The default setting is geared to the 
selected input language.

You can enable or disable the keyboard layout switcher in the taskbar of the login screen or locked screen 
separately. The behaviour is independent from the logged-in taskbar icon. You can find the login screen 
and locked screen configurations under User Interface > Desktop > Screenlock / Screensaver > 
Taskbar20.

20. https://kb.igel.com/en/igel-os-base-system/current/taskbar-1
21. https://kb.igel.com/en/igel-os-base-system/current/tray-applications-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/tray-applications-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/taskbar-1
https://kb.igel.com/en/igel-os-base-system/current/taskbar-1
https://kb.igel.com/en/igel-os-base-system/current/tray-applications-in-igel-os-12
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Display Settings in IGEL OS 12
This article shows how to configure the display settings for the monitors in IGEL OS.

Take notice that a successful and correct display configuration depends, however, on many factors. For example, 
cables, current driver, BIOS settings, etc. can influence your screen configuration and, thus, have to be considered 
when setting up the monitor environment.

Menu path: User Interface > Display Settings

You can also use the display tray app for display configurations. For more information, see Tray 
Applications in IGEL OS 12 (see page 367).
Also note the following: When the endpoint device is connected to different environments, such as when 
the user switches between different workplaces, it will attempt to store each monitor setup.

Always try the configuration locally before applying it to multiple devices via a profile: A faulty display 
configuration can cause your GUI to become unstable and lead to a black screen.
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General Settings
Number of screens

The number of monitors used can be selected by clicking the numbered buttons.

In a multimonitor configuration, every screen connected to the endpoint device can be configured independently 
after selecting the screen. The selected screen is highlighted with a yellow frame. The white bar at the bottom edge 
of the screen represents the physical orientation of the monitor. The position of the screens can be configured by 
drag&drop.

Screen resolution

The resolution can be selected from a drop-down menu. (Default: Autodetect)

If you face a black screen problem because of the wrong display configuration, try one of the following 
recovery options:

 In the UMS: Edit the display configuration via Devices > [device name] > [device's 
context menu] > Edit Configuration or via a new profile.

 In Web UMS: Edit the settings by clicking Edit Configuration in the Device Information of 
the device under Devices > [device name].

 On the endpoint device: Restart the device and select Emergency boot (setup only)
during the boot procedure. In the Setup, you can then change the display configuration.
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Screen rotation

The rotation can be selected from a drop-down menu. (Default: None)

Advanced Settings for the Screen
Detect refresh rate automatically

 A refresh rate for the monitor is identified automatically. (Default)

☐ A refresh rate for the monitor is to be set manually.

Refresh rate

Number of individual images per second
Possible values:

 30 ... 100 (Default: 60)

Graphic card

Graphic card assigned to the selected screen. A graphic card can have more outputs than are actually used. In order 
to ensure transparency, you may need to assign the graphic cards manually.

You have the option of defining your own resolutions via the registry 
key  x.xserver0.custom_resolution . In order for the values set there to take effect, the 
resolution must be set to Autodetect. The following parameters apply to the entry in the registry:

 WxH  : W = width, H = height (example: 1920x1080)

 WxH@R  : W = width, H = height, R = refresh rate (example: 1920x1080@60 or 
1920x1200@59.8)

Be careful when changing resolutions manually. Excessively high resolutions can cause a black screen.

For details of the display resolution supported by your IGEL device, please see the datasheet archive for 
legacy IGEL devices22.
For detailed instructions on MST configuration for UD3 and UD7, see:

 UD3 Model M350C: Multistream Transport
 UD7 Model H860C: Multistream Transport Monitor Daisy Chaining

Be careful when changing the refresh rate manually since a faulty configuration can cause a black screen.

22. https://kb.igel.com/knowledge-base-archive/current/datasheet-archive

https://kb.igel.com/knowledge-base-archive/current/datasheet-archive
https://kb.igel.com/knowledge-base-archive/current/datasheet-archive
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Monitor

Connection type. (Default: Automatic)

 Power Options of the Display in IGEL OS 12 (see page 48)
 Access Control to the Display in IGEL OS 12 (see page 50)
 Gamma Correction (see page 52)
 DPI Options (see page 53)

If Automatic is set for the Monitor and no configurable monitor is found for the selected graphic card, the 
next available monitor will be used by another graphic card.
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Power Options of the Display in IGEL OS 12
This article shows how to configure energy-saving stages in IGEL OS.

Menu path: User Interface > Display Settings > Power Options > Power Management / Brightness Reduction

Power Management

Handle display power management

 The DPMS energy saving functions are enabled. (Default)

On Battery / Plugged In

You can select time frames after which energy-saving modes get activated. The time frames are configured 
separately for On Battery and Plugged In use of the device. When Never is selected, the energy-saving mode is 
disabled.
The following energy-saving modes can be configured:

Changing the default settings may result in higher power consumption and shorter battery runtime.

The display must support Display Power Management Signaling (DPMS).
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 Standby Time
After this time frame, the device goes to standby mode.

 Suspend Time
After this time frame, the device goes to sleep mode.

 Off Time
After this time frame, the device turns off.

Brightness Reduction

These settings are relevant for mobile devices resp. for devices with integrated display.

If a device is switched on but not used for some time, energy can be saved by brightness reduction. The values of 
the reduction are configured separately for On Battery and Plugged In use of the device.

On Battery / Plugged In

On inactivity reduce to

The percent value to which the brightness is reduced after a period of inactivity.

Reduce after

The period of inactivity after which brightness is reduced. You can set the period between 10-120 seconds. Setting 
the value to 9 deactivates the reduction.

Chronologically, Standby mode must occur before or simultaneously with Suspend mode, and Suspend
mode must occur before or simultaneously with Off mode. Therefore, verify that the customized timeout 
values are greater than or equal to the timeout values of earlier modes: Standby Time ≤ Suspend Time ≤ 
Off Time.
Inconsistent values will result in BadValue error.
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Access Control to the Display in IGEL OS 12
This article shows how to control access to the display in IGEL OS. Device access control is enabled by default.

Menu path: User Interface > Display Settings > Access Control

Disable console switching

 You can NOT switch to the console using [Ctrl] + [Alt] + [F11] or [Ctrl] + [Alt] + [F12].

☐ You can access the console using [Ctrl] + [Alt] + [F11] or [Ctrl] + [Alt] + [F12]. (Default)

Access control

 Access to this display from other computers will be controlled. (Default)

Disable TCP connections

 All TCP connections to the display are disabled. Only local applications are displayed. The xhost mechanism 
does not function. (Default)

This parameter is ignored if XDMCP is configured.
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List of Trusted X Hosts

List of approved computers for console access

To manage the list:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

When adding the Trusted host, give the name of the remote host (not the IP address) you would like to add.
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Gamma Correction
This article shows how to increase or decrease the various brightness ranges in order to adjust the display on your 
screen in IGEL OS.

Menu path: User Interface > Display Settings > Gamma Correction

You can change the gamma values for red, green and blue on each screen separately. The scale ranges from 0.10 
(dark) to 10 (light) and is set to 1.00 by default.

Gamma Value Red

Changes the brightness curve for the red color portion.

Gamma Value Green

Changes the brightness curve for the green color portion.

Gamma Value Blue

Changes the brightness curve for the blue color portion.
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DPI Options
This article shows how to configure DPI values for the display in IGEL OS.

Menu path: User Interface > Display Settings > DPI Options

Monitor DPI detection

Defines how the DPI value should be determined.
Possible options:

 Off: The DPI value is defined by Monitor DPI. There is no automatic detection.
 Smart (Default):

The DPI value is defined automatically. With this setting, the user interface is readable also on 
monitors with very high resolutions, e.g. 4k monitors. The DPI value is set to either 96, 125, 150, 
175, 200, 225, 250, 275 or 300, depending on which value is closest to the value calculated based 
on the monitor resolution. 

 Pixel-Precise: 
The DPI value is defined automatically. With this setting, the user interface is readable also on 
monitors with very high resolutions, e.g. 4k monitors. The value calculated based on the monitor 
resolution is used directly.

Monitor DPI
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The DPI resolution (dots per inch) for your monitor. (Default: 96)
This parameter is only available if Monitor DPI detection is set to Off.
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Screenlock / Screensaver in IGEL OS 12
This article shows how to configure the starting methods for the screenlock and screensaver in IGEL OS. 

Menu path: User Interface > Desktop > Screenlock / Screensaver

You can configure the screenlock and screensaver to be activated via icons in the Quick Start Panel and on the 
desktop or via hotkey.

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

 Options (see page 56)
 Taskbar (see page 59)
 Screensaver in IGEL OS 12 (see page 63)

The automatic activation of the screensaver separate from the screenlock can be configured under 
Screenlock / Screensaver > Options. For details, see Screenloock/Screensaver Options in IGEL OS 12.
The look of the taskbar on the locked screen can be configured under Screenlock / Screensaver > 
Taskbar. For details, see Taskbar in Locked Screen in IGEL OS 12 (see page 59).
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Options
This article shows how to configure the setting options for the screenlock and the screensaver in IGEL OS.

Menu path: User Interface > Screenlock / Screensaver > Options

Start automatically

The screenlock and screensaver starts automatically if there is no activity on the device within the 
Timeout period. Depending on the configurations under Require password to unlock 
(screenlock) and Allow administrator password, the screen can be unlocked with the local user/
administrator password. (Default)

Timeout

Period of time in minutes before the screenlock and the screensaver starts. (Default: 5)

Require password to unlock (screenlock)

If a user is logged in, the same authentication is required to unlock the screen. For example, if the 
user is logged in via Active Directory (AD), the AD credentials are used to unlock the screen. For 
more information, see Active Directory/Kerberos - Enable Login in IGEL OS 12 (see page 250) . The 
authentication methods can be configured under Security > Logon. For more information, see 
Logon Settings in IGEL OS 12 (see page 246) . (Default)
The screen can be unlocked without authentication.
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Different screenlock timeout

You can specify a time limit for the screenlock to activate separately from the screensaver. 
The same time limit will be used for the screenlock and the screensaver. This means that after the 
set time the screen will be locked and then the screensaver will appear. (Default)

Screenlock timeout

Period of time in minutes before the screenlock starts. (Default: 5)

Hide username

The username is not displayed on the locked screen. This applies to the user logged in via 
Kerberos / Active Directory23 or as a local user24.
The username is shown on the locked screen. (Default)

Allow administrator password

Access is allowed for the user and the administrator. The screen can also be unlocked by the 
administrator password, if the administrator password is configured. For more information, see 
Password and User Types in IGEL OS 12 (see page 241) .
Access is allowed for the user only. (Default)

Countdown duration in seconds

Countdown time after which the screenlock is initiated. If the value is 0, the screen is locked without a countdown. 
(Default: 0)

Countdown visual effect

The appearance of the digits for the countdown is specified together with the settings for the clock display 
under Screenlock / Screensaver > Screensaver. The following parameters are relevant for the 
countdown:

 Clock display monitor
 Show seconds
 Horizontal clock position
 Vertical clock position
 Clock background color
 Clock foreground color

For detailed information, see Screensaver in IGEL OS 12 (see page 63) .

23. https://kb.igel.com/en/igel-os-base-system/current/active-directory-kerberos-enable-login-in-igel-os-
24. https://kb.igel.com/en/igel-os-base-system/current/local-user-login-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/active-directory-kerberos-enable-login-in-igel-os-
https://kb.igel.com/en/igel-os-base-system/current/local-user-login-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/active-directory-kerberos-enable-login-in-igel-os-
https://kb.igel.com/en/igel-os-base-system/current/local-user-login-in-igel-os-12
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While the countdown is running, a current screenshot is displayed in the background. This parameter determines 
the visual effect that the screenshot will be displayed with.
Possible options:

 Dark screenshot
 Gray screenshot

Countdown background image

Path and file name of an image file, which is displayed in the background while the countdown is running. This 
background image is displayed instead of the screenshot, if the path and file name are valid; if the field is empty, 
the screenshot is displayed. Supported file formats: JPEG, PNG, GIF. Example:  /images/image.jpg
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Taskbar
This article shows how to configure the taskbar for the login dialog and for when the screen is locked in IGEL OS.

Menu path: User Interface > Desktop > Screenlock / Screensaver > Taskbar

Show UMS connection status tray icon on lockscreen

 When the screen is locked, the current status of the Universal management Suite (UMS) connection is shown in 

the system tray. For example, with the icon   for connected. Clicking the icon displays information about the 
connected UMS server. (Default)

Show battery tray icon on lockscreen

 When the screen is locked, the current status of the battery is shown in the system tray. For example, with the 

icon   . Hover over the icon to see information on the charge. Clicking the icon displays the battery tray app. 
(Default)

Show ethernet connection status tray icon on lockscreen

You can use the following parameters to enable / disable access to tray apps when the screen is locked. 
The parameters for the desktop (that can be found under User Interface > Desktop > Taskbar Items) and 
the parameters for the lockscreen are independent from each other. You need to enable / disable the icons 
for both use cases separately. For more information, see Tray Applications in IGEL OS 12 (see page 367) and 
Taskbar Items in IGEL OS 12 (see page 112).



Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   60 / 691

 The current status of the LAN network connection is shown in the system tray. For example, with the icon   for 
connected. Clicking the icon displays the LAN tray app. (Default)

Show wifi connection status tray icon on lockscreen

 The current status of the Wi-Fi network connection is shown in the system tray. For example, with the icon   . 
Clicking the icon displays the Wi-Fi tray app. (Default)

Show mobile-broadband connection status tray icon on lockscreen

 The current status of the network connection is shown in the system tray. For example, with the icon   or   . 
Clicking the icon displays the mobile broadband tray app. (Default)

Show input settings tray icon on lockscreen

 If a mouse is detected, the   icon is shown in the system tray. If a touchpad is detected, or both a mouse and a 

touchpad are detected, the   icon is shown. Clicking the icon displays the mouse & touchpad tray app. 

☐ The icon is not shown when the screen is locked. (Default)

Show audio tray icon on lockscreen

 The   and   icons are shown in the system tray. Clicking the icon displays the sound tray app.  

☐ The icon is not shown when the screen is locked. (Default)

Taskbar Settings for the Login Dialog

Show taskbar in login screen

 A taskbar is shown in the login screen. (Default)

Show clock

 A clock is shown in the taskbar in the login screen. (Default)

Show keyboard layout switcher

 A keyboard layout switcher is shown in the taskbar in the login screen. (Default)

Show on-screen keyboard button

 A button to start an on-screen keyboard is shown in the taskbar in the login screen.

☐ The button is not shown. (Default)
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Start on-screen keyboard automatically

 The on-screen keyboard is started automatically with the login screen.

☐ The on-screen keyboard is not started automatically. (Default)

Show reboot button

 The reboot button is shown in the taskbar in the login screen.

☐ The button is not shown. (Default)

Show shutdown button

 The shutdown button is shown in the taskbar in the login screen. (Default)

Taskbar Settings When the Screenlock Is Active

Show taskbar in screenlock

 A taskbar is shown when the screen is locked. (Default)

Show clock

 A clock is shown in the taskbar when the screen is locked. (Default)

Show keyboard layout switcher

 A keyboard layout switcher is shown in the taskbar when the screen is locked. (Default)

Show on-screen keyboard button

 A button to start an on-screen keyboard is shown in the taskbar when the screen is locked.

☐ The button is not shown. (Default)

Start on-screen keyboard automatically

 The on-screen keyboard is started automatically when the screen is locked.

☐ The on-screen keyboard is not started automatically. (Default)

Show reboot button

 The reboot button is shown in the taskbar when the screen is locked.

☐ The button is not shown. (Default)

Show shutdown button
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 The shutdown button is shown in the taskbar when the screen is locked.

☐ The button is not shown. (Default)

Show logoff button

 The logoff button is shown in the taskbar when the screen is locked.

☐ The button is not shown. (Default)



Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   63 / 691

Screensaver in IGEL OS 12
This article shows how to configure the screensaver in IGEL OS.

You can configure the activation of the screensaver under Screenlock / Screensaver > Options. For details, see 
Screenloock/Screensaver Options in IGEL OS12.

Menu path: User Interface > Desktop > Screenlock / Screensaver > Screensaver

Screen background color

Color palette for determining the background color of the screen in screensaver mode. Click the color preview 
square to open the color selector.

Enable image display

 An image will be shown as the screensaver. (Default)

File for screensaver logo
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Complete path for an individual image file or directory that contains an unlimited number of images. If no path is 
given, the IGEL logo will be used.

One image per monitor

 If a number of monitors are used, a different image will be shown on each one. (Default)

☐ Images will be distributed over the monitors.

Image duration

Time in seconds until the image is changed. (Default: 10)

Image display mode

Type of display. The following are available to choose from:

 Small-sized hopping: Small images are shown in changing positions. (Default)
 Medium-sized hopping: Larger images are shown in changing positions.
 Full-screen center cut-out: The images are shown in full-screen size. However, they may be 

clipped.
 Full-screen letterbox: The images are shown as large as possible in relation to the screen size.

Clock display monitor

Selects the monitor on which the clock is to be shown. The following are available to choose from:

 None (Default)
 All
 Display [1-8]

Show seconds

 Time is shown with seconds in digital format.

☐ Time is shown without seconds in digital format. (Default)

Clock display size

The following sizes are available to choose from:

 Tiny
 Small
 Medium
 Large

If you enter a folder instead of a single image file as the source, all images in the folder will be displayed as 
a slide show. The display time for the images can be configured under Image duration.
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 Huge

Horizontal clock position

The following screen positions are available to choose from:

 Left
 Center
 Right

Vertical clock position

The following screen positions are available to choose from:

 Top
 Center
 Bottom

Clock background color

Color palette for determining the background color of the clock. Click the color preview square to open the color 
selector.

Clock background opacity percentage

The opacity of the clock background. (Default: 75)

Clock foreground color

Color palette for determining the color of the numbers displayed. Click the color preview square to open the color 
selector.
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Hotkeys
Hotkeys configured for frequently used operations make it easier to use the device. A hotkey is a combination of 
one or more modifiers and an alphanumeric key. This article shows how to configure hotkeys in IGEL OS. 

Menu path: User Interface > Hotkeys

Editing Hotkeys
You can enable or disable hotkeys and change the keys used:

1. Click   to edit the hotkey of the selected operation.
2. Use the Hotkey option to enable the hotkey.
3. Select a predefined Modifier.

A modifier is a key symbol or key combination. These are the pre-defined modifiers and the 
associated key symbols:

 None: No modifier is used

 Shift: 
 Ctrl: [Ctrl] 

 Win: 

 Alt: [Alt] 
Key combinations are formed as follows with  | :

 Ctrl|Alt:  [Ctrl] + [Alt]
4. Enter a Key that is to be used as the hotkey to start the operation.

5. Click Confirm.

When this keyboard key is used as a modifier, it is represented as Win; when it is used as a 
key, it is represented as  Super_L .

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as  user  and enter  xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with  keysym  contains the key symbol for 

the Key field. Example:  Tab  in  (keysym 0xff09, Tab)
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Input
The following input devices can be configured in IGEL OS.

 Keyboard Settings in IGEL OS 12 (see page 68)
 Additional Keyboard Layouts in IGEL OS 12 (see page 75)
 Mouse Settings in IGEL OS 12 (see page 77)
 Touchpad Settings in IGEL OS 12 (see page 81)
 Touchscreen Configuration in IGEL OS 12 (see page 89)
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Keyboard Settings in IGEL OS 12
This article shows how to configure the keyboard settings in IGEL OS.

Menu path: User Interface > Input > Keyboard

Keyboard layout

Specify the keyboard layout. The selected layout applies to all parts of the system including emulations, window 
sessions and X applications.

Enable dead keys

 Dead keys can be used to enter special characters.

☐ Dead keys cannot be used to enter special characters. (Default)

Keyboard type

Specifies the keyboard type.
Possible values:
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 Default: Automatically selects the keyboard type according to the computer type (Macbook, 
Chromebook or PC105 for all others).

 Standard PC keyboard (105 keys)
 IBM keyboard (122 keys)
 Trimodal keyboard
 Sun Type 6 keyboard
 Chromebook
 Macbook
 Macbook international
 Thinkpad

Show indicator in taskbar

 Shows the language code for the keyboard in the taskbar.

☐ Hides the language code for the keyboard in the taskbar. (Default)

Repeat delay

Determines the delay (in milliseconds) before automatic repetition begins. (Default: 660)

Repeat rate

Determines the number of times a character repeats per second. (Default: 40)

Test

Free-text area to test the repeat settings.

Start with NumLock on

 NumLock will be enabled automatically during the boot process. (Default)

Secure keyboard input with Cherry SECURE BOARD

 A secure keyboard input mode will be enabled for the connected Cherry SECURE BOARD. In this mode, keyboard 
traffic between the keyboard and the endpoint is transmitted over a TLS 1.3 encrypted connection. The standard 
keyboard channel will be locked, which means that keyboard input devices without the secure mode will be 
blocked; see https://www.cherry-world.com/cherry-secure-board-1-0.html.

☐ The secure keyboard input mode is disabled. (Default)

https://www.cherry-world.com/cherry-secure-board-1-0.html
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Input Methods for Keyboard in IGEL OS 12

This article shows how to configure keyboard input methods in IGEL OS. This is necessary if the settings under User 
Interface > Language (see page 42) do not suit your needs and you require, for example, input support for the Chinese 
or Japanese languages. The feature is currently experimental.

Input Methods

Menu path: User Interface > Input > Keyboard > Input Methods

Keyboard input methods (experimental)

 Input Method Editor (IME) support is activated. You can select the required input method under Methods (see 
page 71) and initial states under Intelligent Pinyin (see page 73).

☐ Input Method Editor (IME) support is disabled. (Default)

Next input method

Defines keyboard shortcuts to toggle between input methods defined under Methods (see page 71) and keyboard 
layout defined under User Interface > Input > Keyboard. (Default: <Super>space )

Rules for the hotkeys:

 Use angle brackets <>  for a modifier.
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 Type the name of the key right after a modifier, without blanks.

 Use a blank to separate several hotkeys.
Example: <Super>space <Shift><Alt>m

Candidates orientation

Specifies how all the possible characters for an input code will be shown.

Possible values:

 vertical (Default)
 horizontal

Show property panel

Specifies if the property panel should be displayed. Properties in the panel change depending on the selected input 
method.

Possible values:

 do not show (Default)
 hide automatically
 always

Auto hide timeout

A period of time in milliseconds during which the property panel will be displayed after focus-in or property change. 
This setting is relevant if Show property panel is set to “hide automatically”.

Methods

Menu path: User Interface > Input > Keyboard > Input Methods > Methods
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After activating User Interface > Input > Keyboard > Input Methods > Keyboard input methods, you can select 
the following input methods:

Chinese Intelligent Pinyin

 Intelligent Pinyin can be used as an input method for Chinese.

☐ Intelligent Pinyin cannot be used. (Default)

Chinese Bopomofoto

 Bopomofoto can be used as an input method for Chinese.

☐ Bopomofoto cannot be used. (Default)

Japanese - Mozc

 Mozc can be used as an input method for Japanese.

☐ Mozc cannot be used. (Default)

Enabled input methods as well as available IME functions can be selected via the corresponding icon in the system 
tray.

Examples:
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Intelligent Pinyin

Menu path: User Interface > Input > Keyboard > Input Methods > Intelligent Pinyin

The following settings are relevant if Chinese Intelligent Pinyin is activated as an input method under User 
Interface > Input > Keyboard > Input Methods > Methods.

Initial state Chinese
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 The keyboard input is initially set to Chinese. (Default)

☐ The keyboard input is initially set to English.

Initial state full width

 Initially, full-width characters are used.

☐ Initially, half-width characters are used. (Default)

Initial state full punctuations

 Initially, full-width punctuation is used. (Default)

☐ Initially, half-width punctuation is used.

Initial state Simplified Chinese

 The keyboard input is initially set to Simplified Chinese. (Default)

☐ The keyboard input is initially set to Traditional Chinese.
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Additional Keyboard Layouts in IGEL OS 12
This article shows how to configure additional keyboard layouts in IGEL OS. The configured additional keyboard 
layouts can be selected in the Language & Keyboard Layout Tray App25.

For information on how to configure an on-screen keyboard, see On-screen Keyboard (see page 93) .

Menu path: User Interface > Input > Additional Keyboard Layouts

Layout [1-3]

Enable this layout

 Keyboard layout is enabled and can be defined.

☐ Keyboard layout is disabled. (Default)

Keyboard layout

Selects the language for the keyboard layout.

Enable dead keys

Enable this function if the keyboard used supports dead keys for special characters.

Hotkey

25. https://kb.igel.com/en/igel-os-base-system/current/tray-applications-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/tray-applications-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/tray-applications-in-igel-os-12


Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   76 / 691

 A hotkey can be used to switch to this keyboard.

☐ The hotkey is disabled. (Default)

Key

Key for the hotkey

Modifiers

Additional modifier for the hotkey

Hotkey for Default Keyboard Layout

Activate hotkey to switch to the default keyboard layout

 A hotkey can be used to take you back to the default keyboard layout. This is useful when a number of keyboard 
layouts are configured.

☐ The hotkey is disabled. (Default)

Hotkey

Key for the hotkey

Modifiers

Additional modifier for the hotkey

Hotkey for Next Keyboard Layout

Activate hotkey to switch between a number of keyboard layouts

 A hotkey which switches to the next keyboard layout can be used. This is useful when a number of keyboard 
layouts are configured.

☐ The hotkey is disabled. (Default)

Hotkey

Key for the hotkey

Modifiers

Additional modifier for the hotkey
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Mouse Settings in IGEL OS 12
This article shows the mouse settings that you can configure in IGEL OS 12.

Menu path: User Interface > Input > Mouse

Left-handed mode

 The mouse is in left-handed mode.

☐ The mouse is in right-handed mode. (Default)

Natural scroll

 When scrolling with the mouse wheel, the screen content moves in reverse to the wheel movement. If you scroll 
the wheel down, the screen moves upwards and vice-versa.

☐ When scrolling with the mouse wheel, the screen content moves synchronously to the wheel movement. If you 
scroll the wheel down, the screen moves downwards and vice-versa.  (Default)
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Emulate 3 button mouse

 Enables emulation of the third (middle) mouse button for mice with only two physical buttons. This third button 
is emulated by pressing both buttons at the same time. The Emulate timeout determines how long (in 
milliseconds) the driver waits before deciding whether two buttons were pressed at the same time.

☐ Disables emulation of the third (middle) mouse button for mice with only two physical buttons. (Default)

Emulate timeout

Determines how long (in milliseconds) the driver waits before deciding whether two buttons were pressed at the 
same time.

Hide cursor

 The mouse pointer will be hidden after the defined time limit.

☐ The mouse pointer is never hidden. (Default)

Idle time for visible cursor

The period after which the pointer is hidden.

Pointer speed

Determines the mouse resolution in counts per inch.

Double click interval

Changes the maximum interval in milliseconds between two consecutive mouse clicks which are to be recognized 
as a double-click. The smaller the interval, the faster the consecutive clicks need to happen, to be recognized as a 
double click.

Double click distance

Changes the maximum distance in pixels between two clicks which are to be recognized as a double-click. The 
object under the second click is double-clicked.

If the Show input settings tray icon on desktop option is enabled under User Interface > Desktop > 
Taskbar Items, and a mouse is detected, you can use the Mouse & Touchpad tray app to quickly configure 
the following mouse settings:

 Primary Button
Sets the primary button both for mouse and touchpad. In IGEL Setup, you can configure 
this through Left-handed mode.

 Pointer Speed
Sets the speed of the pointer both for mouse and touchpad. In IGEL Setup, you can 
configure this through Pointer speed.
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 Double-click Speed 
Sets how fast two consecutive mouse clicks need to happen to be recognized as a double-
click. You can test this with the click to test area. In IGEL Setup, you can configure this 
through Double click interval. The smaller the interval, the faster the consecutive clicks 
need to happen, to be recognized as a double click.

 Scrolling Direction
Sets the direction of the screen movement when scrolling with the mouse. In IGEL Setup, 
you can configure this through Natural scroll.
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Touchpad Settings in IGEL OS 12
This article shows the touchpad settings that you can configure in IGEL OS 12.

Menu path: User Interface > Input > Touchpad

Enable touchpad on boot

 The touchpad is enabled on boot. This can be overridden by the hotkey configured below. (Default)

Hotkey

 Each time you press the hotkey, you activate or deactivate the touchpad.

☐ No hotkey can be used to activate or deactivate the touchpad. (Default)

The actual settings depend on the hardware supported by the particular touchpad.
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Modifiers

Modifiers for the hotkey

Key

Key for the hotkey

Natural Scroll

 When scrolling through the touchpad, the screen content moves synchronously to the fingers' movement. If you 
move your fingers down, the screen moves downwards and vice-versa.

☐ When scrolling through the touchpad, the screen content moves in reverse to the fingers' movement. If you 
move your fingers down, the screen moves upwards and vice-versa. (Default)

Custom configuration

 Further touchpad settings can be configured according to your needs.

☐ No custom configuration can be made. (Default)

Tapping mode

Switches the tapping mode on or off.
Possible values:

 With tapping (Default)
 Without tapping

Min speed

Minimum speed of the pointer in seconds. (Default: 1.00)

Max speed

Maximum speed of the pointer in seconds. (Default: 1.75)

Acceleration

Acceleration from the minimum to the maximum speed in seconds. (Default: 0.01)

With some touchpads, you can assign mouse actions to tapping the corners of the touchpad. The action can be 
configured for each corner to trigger a right, left, or middle mouse click.

 Top left action (Default: No action)
 Top right action (Default: Middle mouse button)
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 Bottom left action (Default: No action)
 Bottom right action (Default: Right mouse button

If the Show input settings tray icon on desktop option is enabled under User Interface > Desktop > 
Taskbar Items, and a touchpad is detected, you can use the Mouse & Touchpad tray app to quickly 
configure the following touchpad settings:

 Primary Button
Sets the primary button both for mouse and touchpad. In IGEL Setup, you can configure 
this through Left-handed mode under User Interface > Input > Mouse.

 Pointer Speed
Sets the speed of the pointer both for mouse and touchpad. In IGEL Setup, you can 
configure this through Pointer speed under User Interface > Input > Mouse.

 Enabled
The toggle buttons enables/disables the touchpad.

 Touchpad Sensitivity
Sets how sensitive the touchpad is to the touch. In IGEL Setup, you can configure this 
through Min speed, Max speed, and Acceleration. If you have those values custom 
configured, it is advised not to change the slider in the tray app, as it will reset the levels in 
the IGEL Setup.

 Scrolling Direction 
Sets the direction of the screen movement when scrolling with the touchpad. In IGEL 
Setup, you can configure this through Natural scroll.

 Scrolling Method
Sets the type of finer movement to be detected as scrolling. In IGEL Setup, you can 
configure this through Two finger vertical scroll and Two finger horizontal scroll under 
User Interface > Input > Touchpad > Scrolling.

 Tap to Click
The toggle switch enables/disables clicking with a tap on the touchpad. In IGEL Setup, you 
can configure this through Tapping mode.

 Palm Detection
The toggle switch enables/disables palm detection. When enabled, it avoids triggering a 
function accidentally with the palm of your hand. The function must be supported by the 
device. In IGEL Setup, you can configure this through Palm detect under User Interface > 
Input > Touchpad > Advanced.
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 Scrolling with Touchpad in IGEL OS 12 (see page 85)
 Advanced Touchpad Settings in IGEL IOS 12 (see page 87)
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Scrolling with Touchpad in IGEL OS 12

This article shows how to configure the scrolling with the touchpad in IGEL OS.

Menu path: User Interface > Input > Touchpad > Scrolling

Vertical scroll

 The right edge of the touchpad will be used as a vertical scrollbar. The vertical scroll speed can be set. (Default)

☐ The right edge is not enabled as a scrollbar.

Vertical scroll speed

The distance from which scrolling is recognized when moving the finger in a vertical direction. (Default: 25)

Two finger vertical scroll

In order to configure scrolling, Custom configuration needs to be enabled under User Interface > Input > 
Touchpad.
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 Two-finger scrolling is enabled for vertical scrolling.

☐ Two-finger scrolling is disabled. (Default)

Horizontal scroll

 The bottom edge of the touchpad will be used as a horizontal scrollbar. The horizontal scroll speed can be set.

☐ The bottom edge is not enabled as a scrollbar. (Default)

Horizontal scroll speed

The distance from which scrolling is recognized when moving the finger in a horizontal direction. (Default: 25)

Two finger horizontal scroll

 Two-finger scrolling is enabled for horizontal scrolling.

☐ Two-finger scrolling is disabled. (Default)
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Advanced Touchpad Settings in IGEL IOS 12

This article shows how to configure advanced settings of the touchpad in IGEL OS.

Menu path: User Interface > Input > Touchpad > Advanced

Corner coasting

 You can continue scrolling if your finger reaches the corner when scrolling vertically or horizontally along the 
touchpad edges. The scrolling continues while the finger stays in the corner.

☐ The scrolling stops as soon as the reaches the corner. (Default)

Circular scrolling

 You can scroll in a circle. In the selection menu, you can specify where to begint the circular scrolling.

☐ Circular scrolling is disabled. (Default)

Circular scroll trigger

In order to configure advanced settings, Custom configuration needs to be enabled under User Interface 
> Input > Touchpad.
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Trigger region of the touchpad to start circular scrolling.
Possible values:

 All edges (Default)
 Top edge
 Top right corner
 Right edge
 Bottom right corner
 Bottom edge
 Bottom left corner
 Left edge
 Top left corner

Tap and drag gesture

 You can move items by tapping them and then touching again and dragging them by moving the finger on the 
touchpad. (Default)

Locked drags

 The tap and drag gesture ends only after an additional tap.

☐  The tap and drag gesture ends when you release the finger. (Default)

Palm detect

 Avoids triggering a function accidentally with the palm of your hand. The function must be supported by the 
device.

☐ Palm detection is disabled. (Default)

ClickPad

 ClickPads are permitted. These are touchpads with so-called integrated soft buttons on which physical clicks 
are possible.
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Touchscreen Configuration in IGEL OS 12
This article shows how to configure the touchscreen connected to your endpoint device in IGEL OS. To ensure that 
you can open the setup and navigate within it, the initial configuration should take place with a mouse and 
keyboard connected.

For information on how to calibrate the touchscreen, see Touchscreen Calibration (see page 92) .

For information on how to configure an on-screen keyboard, see On-screen Keyboard (see page 93) .

Menu path: User Interface > Input > Touchscreen

Enable touchscreen

 The touchscreen is enabled.

☐ The touchscreen is disabled. (Default)

Touchscreen type

Selects the touchscreen driver which is to be used.
Possible options:
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 EvTouch (USB) (Default)
 eGalax
 Elo Multitouch (USB)
 Elo Singletouch (USB)

Touchscreen already calibrated

If you enable the touchscreen function, the touchscreen must be calibrated before use.

 Calibration starts automatically after each system boot. (Default)

☐ Calibration does not start automatically after each system boot.

Swap X and Y values

 X values are interpreted as Y values and Y values as X values. Enable this option if the mouse pointer moves 
vertically when you move your finger in a horizontal direction. Enable if the touchscreen is used rotated by 90°.

☐ X and Y values are not swapped. (Default)

Minimal X value / Minimal Y value

These values are determined by the calibration tool. However, you can also change them manually. (Default: 0)

Maximal X value / Maximal Y value

These values are determined by the calibration tool. However, you can also change them manually. (Default: 4000)

Emulate right button

 A right-click is generated by touching the screen for the period of time defined under Right button timeout.

☐ Touching the screen for a long time does not generate a right-click. (Default)

Right button timeout

Time (in milliseconds) after which a right-click is generated. (Default: 1000)

Multimonitor

Graphic card

Graphics card assigned to the selected touchscreen. A graphics card can have more outputs than are actually used. 
In order to ensure transparency, you may need to assign the graphics cards manually.

Touchscreen monitor

If Automatic is set for the Touchscreen monitor and no configurable monitor is found for the selected 
graphics card, the next available monitor will be used by another graphics card.
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Assigns a monitor connection to the touchscreen. Example: DisplayPort. (Default: Automatic)

 Touchscreen Calibration (see page 92)
 On-screen Keyboard (see page 93)
 Multitouch Gestures for a Touchscreen in IGEL OS 12 (see page 98)
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Touchscreen Calibration

This article shows the starting options for the touchscreen calibration tool in IGEL OS.

Menu path: User Interface > Input > Touchscreen > Touchscreen Calibration

The starting methods parameters are described under Starting Methods for Apps (see page 421). 
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On-screen Keyboard

This article shows how to configure the starting methods for an on-screen keyboard in IGEL OS.

Menu path: User Interface > Input > Touchscreen > On-screen keyboard

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

 Appearance Configuration in IGEL OS 12 (see page 94)
 Application Integration in IGEL OS 12 (see page 96)
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Appearance Configuration in IGEL OS 12

This article shows how to configure the appearance of the on-screen keyboard in IGEL OS.

Menu path: User Interface > Input > Touchscreen > On-screen keyboard > Appearance

Show function keys

 The on-screen keyboard features the function keys [F1] ... [F12]. (Default)

Show navigation keys

 The on-screen keyboard features the arrow keys for navigating on the screen. (Default)

Show Numpad

 The on-screen keyboard features the number block.

☐ The on-screen keyboard does not feature the number block. (Default)

The layout for the normal keyboard is used for the on-screen keyboard.
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Enable switching to alternative layout

 The on-screen keyboard has an additional key by which the user can toggle between the normal layout and a 
reduced layout. The reduced layout resembles the numpad, with the following differences:

 Additional backspace key [←]
 Additional tab key [↹]
 Additional space key [ ]
 Additional escape key [Esc]
 Return key [⏎] instead of [Enter] key

☐ Switching to the reduced layout is not possible. (Default)
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Application Integration in IGEL OS 12

This article shows how to configure the integration of the on-screen keyboard in IGEL OS.

Menu path: User Interface > Input > Touchscreen > On-screen keyboard > Application Integration

Taskbar Settings for the Login Dialog

These settings are relevant if a login is necessary in order to use the device. This applies to all logon methods that 
are possible with the device.

Show on-screen keyboard button

   A button for launching the on-screen keyboard is shown during the login dialog.

☐ The on-screen keyboard cannot be launched during the login dialog. (Default)

Start on-screen keyboard automatically

 The on-screen keyboard is shown during the login dialog and can be used for input.
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☐ The on-screen keyboard is not shown during the login dialog. However, it can be launched via a button if Show 
on-screen keyboard button is enabled. (Default)

Taskbar Settings When the Screenlock Is Active

Show on-screen keyboard button

 A button for launching the on-screen keyboard is shown when the screen is locked.

☐ The on-screen keyboard cannot be launched when the screen is locked. (Default)

Start on-screen keyboard automatically

 The on-screen keyboard is shown when the screen is locked.

☐ The on-screen keyboard is not shown when the screen is locked. However, it can be launched via a button 
if Show on-screen keyboard button is enabled. (Default)

On-Screen Keyboard Toggle Button

Show button

 A button for switching the on-screen keyboard on and off is shown on the desktop.

☐ The toggle button is not shown. (Default)

Button size

The size of the toggle button. A size between 40 and 80 pixels can be chosen. (Default: 60px)

Automatically show on-screen keyboard when text field is selected

 The on-screen keyboard is shown automatically when an input field is selected.

☐ The on-screen keyboard is not shown automatically. (Default)
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Multitouch Gestures for a Touchscreen in IGEL OS 12

To configure multitouch gestures for a touchscreen in IGEL OS, it is first necessary to enable touchscreen function 
under User Interface > Input > Touchscreen > Enable touchscreen, see Touchscreen Configuration in IGEL OS 
1226.

Menu path: User Interface > Input > Touchscreen > Multitouch Gestures

Enable multitouch gestures

Multitouch gesture support is activated. You can configure the settings described below.

Multitouch gestures cannot be used for the touchscreen devices. (Default)

2 fingers right click

You can tap the touchscreen with two fingers simultaneously to perform a right-click.
A right-click with two fingers is not possible. Instead, a long click is used if Emulate right button is 
enabled under User Interface > Input > Touchscreen. (Default)

2 fingers scroll

Note that this activates local multitouch gestures on IGEL OS. For VDI applications, use the vendor’s 
touchscreen functionality, if available.

26. https://kb.igel.com/en/igel-os-base-system/current/touchscreen-configuration-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/touchscreen-configuration-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/touchscreen-configuration-in-igel-os-12
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You can scroll in all directions - up, down, left, and right - using two fingers.
Scrolling with two fingers is disabled. (Default)

3 fingers swipe down to show desktop

You can swipe with three fingers down on the touchscreen to quickly minimize all open windows 
and display the desktop. If the desktop is already shown, performing the gesture restores all open 
windows.
The desktop will not be displayed when using three fingers for swiping down on the touchscreen. 
(Default)
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Desktop Settings in IGEL OS 12
This article shows how to configure general settings for the appearance of the desktop in IGEL OS.

Menu path: User Interface > Desktop

Local window manager for this display

 Enables local window management for the display. (Default)

User interface theme

You can either select one of our predefined color schemes or define a color scheme of your own.

 IGEL color: The color of dialog frames and the taskbar is blue, headings and icons are white, 
highlights are light blue.

 IGEL dark: The color of dialog frames and the taskbar is black, headings and icons are white, 
highlights are dark gray.

 IGEL light: The color of dialog frames and the taskbar is light gray, headings and icons are black, 
highlights are dark grey.

 Custom colors: Define your own color combinations below.
 Base color of the UI theme: The color of dialog frames and the taskbar. Click the color 

preview square to open the color selector.
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 Highlight color of the UI theme: The color of highlights. Click the color preview square to 
open the color selector.

 Icon and font color: The optimization can be selected based on custom colors.

Desktop icon size

The size of icons displayed on the desktop

Desktop icon font color

The font color for the labels associated with the desktop icons. Click the color preview square to open the color 
selector.

Monitor for desktop icons

If you use several monitors, select the one that is to display desktop icons.

 All monitors
 Same as taskbar
 1st monitor
 2nd monitor
 (other monitors if connected)

Single click mode

 Programs are opened with a single click. (Default)

Desktop Fonts
Default font

The font type of texts appearing on the taskbar and in the start menu. The following fonts are available to choose 
from:

 RobotoRegular (Default)
 Sans
 Sans Bold
 Serif
 Serif Bold

Default font size

The font size of texts appearing on the taskbar and in the start menu in pt (points).

Desktop icon font size

The font size of texts for desktop icons in pt (points).
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Titlebar font

The font type of texts appering in titlebars. The following fonts are available to choose from:

 RobotoBold (Default)
 Sans
 Sans bold
 Serif
 Serif Bold

Titlebar font size

The font size of texts appearing in titlebars in pt (points).

 Background (1st Monitor) (see page 103)
 Taskbar Configuration in IGEL OS 12 (see page 107)
 Taskbar Background in IGEL OS 12 (see page 110)
 Taskbar Items in IGEL OS 12 (see page 112)
 Pager in IGEL OS 12 (see page 116)
 Start Menu in IGEL OS 12 (see page 121)
 In-Session Control Bar in IGEL OS 12 (see page 123)



Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   103 / 691

Background (1st Monitor)
This article shows how to configure the desktop background in IGEL OS.

Menu path: User Interface > Desktop > Background (1st Monitor)

You can use predefined IGEL backgrounds, a fill color or a color gradient. You can also use a background image of 
your own.

Wallpaper

Provides a selection of predefined IGEL backgrounds:

 Neutral
 Off
 IGEL (Default)

Wallpaper style

You can set up a separate background image for each monitor that is connected to the device.
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Provides various design versions:

 Auto
 Centered
 Tiled
 Stretched (Default)
 Scaled
 Zoomed

Color style

Sets a fill color or a color gradient.

 Solid color
 Horizontal gradient (Default)
 Vertical gradient

Desktop color

The desktop color if Wallpaper is set to Off. Click the color preview square to open the color selector.

2nd desktop color

The second desktop color if Wallpaper is set to Off and a gradient Color style is selected. Click the color preview 
square to open the color selector.

Custom wallpaper download

 You can provide a user-specific background image on a download server. Specify the download server 
under Desktop > Background > Custom Wallpaper Server.

☐ Custom wallpaper is not used. (Default)

Custom wallpaper file

The name of the background image file

The user-specific background image will be downloaded from the specified server if the function was enabled and if 
requested manually through Wallpaper update under Desktop > Background > Custom Wallpaper Server. The 
download can also be launched from the IGEL Universal Management Suite (UMS) via the Update desktop 
customization command.

A user-specific boot image can be provided on a download server. The file types BMP, JPG, GIF, TIF, PNG 
and SVG are supported for an own background image and bootsplash. A total storage area of 25 MB is 
available for all user-specific images. For more information, see Universal Management Suite > UMS 
Reference Manual > Firmware Customizations in the IGEL UMS.
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Custom Wallpaper Server

This article shows how to configure the download server for your own background images in IGEL OS.

Menu path: User Interface > Desktop > Background > Custom Wallpaper Server

Protocol

Determines the protocol that is to be used. The following are available to choose from:

 HTTP: Download from a web server. (Default)
 HTTPS: Download from a TLS/SSL-secured web server
 FTP: Download from an FTP server
 SecureFTP: Download via SSH-secured FTP
 FTPS: Download from a TLS/SSL-secured FTP server
 File: The image file lies in the file system of the device, possibly as a shared NFS or Windows 

update. You can enter the location under Local path.

Local path

The path to the background image. The parameter is shown when File is selected as protocol.

Server name
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Name or IP address of the server used

Server path

Directory in which you saved the background image

Port

Port used (Default: 80)

User name

Name of the user account on the server

Password

Password for this account

Wallpaper update

The button refreshes the background image when clicked.
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Taskbar Configuration in IGEL OS 12
This article shows how to enable and configure the taskbar in IGEL OS. 

Menu path: User Interface > Desktop > Taskbar

Use taskbar

 The taskbar is displayed and the setting options are available. (Default)

Taskbar position

Specifies the display position of the taskbar.
Possible values:

 Bottom (Default)
 Top

Further settings can be found under User Interface > Screenlock / Screensaver > Taskbar. For detailed 
information on those settings, see Taskbar (see page 59).
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 Left
 Right

Vertical taskbar mode

Specifies how items are shown in the taskbar. This parameter is available if Taskbar position is set to Left or Right.
Possible values:

 Vertical: The session texts are rotated by 90°.
 Deskbar: The session texts are not shown. (Default)

Taskbar height/width

Specifies the size of the taskbar in pixels. This is the height of the taskbar if the position is top or bottom, and the 
width of the taskbar if the position is left or right. (Default: 48)

Number of rows/columns in taskbar

Specifies the number of rows for the Quick Start Panel. The following taskbar items can be broken down into a 
number of rows and columns: Icons in the Quick Start Panel, window buttons.
Possible values:

 Automatic: The number of rows for the Quick Start Panel depends on the height and width of the 
taskbar.

 Numeric value: The chosen value specifies the number of rows for the Quick Start Panel.

Multimonitor taskbar size

Specifies whether the taskbar is expanded onto several monitors or restricted to one monitor.
Possible values:

 Restrict taskbar to one monitor
 Extend taskbar to all monitors

If Maximum number of rows/columns in window button list is set to Automatic, the window buttons as 
well as the icons in the Quick Start Panel will be shown in a number of rows depending on the height of the 
taskbar. The number of rows increases in increments of 55 pixels:

 1 - 55 pixels: One row
 56 - 110 pixels: Two rows
 111 - 165 pixels: Three rows
 166 - 220 pixels: Four rows
 221 - 275 pixels: Five rows
 276 or more pixels: Six rows

The Maximum number of rows/columns in window button list parameter is described 
under Taskbar Items in IGEL OS 12 (see page 112) .
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Monitor

Specifies the screen on which the taskbar is shown. This parameter is available if Multimonitor taskbar size is set 
to Restrict taskbar to one monitor. (Default: 1st monitor)

Taskbar on top of all windows

 The taskbar is displayed on all screens, even in sessions with a full-screen window.

☐ The taskbar is not displayed in sessions with a full-screen window. (Default)

Taskbar auto hide

 The taskbar is hidden automatically and will only be shown if the mouse pointer is moved to the position of the 
taskbar at the edge of the screen.

☐ The taskbar is always displayed. (Default)

Auto hide behavior

Specifies when the taskbar is automatically hidden.
Possible values:

 Intelligently: The taskbar is shown as standard. The taskbar will be hidden if the space is needed 
by a window, e. g. a window in full-screen mode.

 Always: The taskbar is hidden as standard. The taskbar will be shown if the mouse pointer is 
moved to the edge of the screen.

Taskbar show delay

Time interval in milliseconds before the taskbar is shown. The mouse pointer must be at the edge of the screen 
constantly during this time interval. This setting is only effective if Taskbar auto hide is enabled. (Default: 600)

Taskbar hide delay

Time interval in milliseconds before the taskbar is hidden. This setting is only effective if Taskbar auto hide is 
enabled. (Default: 400)

With the show delay, you can prevent the taskbar for a full-screen session being covered by the device's 
taskbar. A show delay is necessary if the taskbar for the full-screen session is set to be shown 
automatically and both taskbars are positioned at the same screen edge. If no show delay is set and the 
user brings up the taskbar for the full-screen session, this will immediately be covered by the device's 
taskbar. During the show delay time interval, the user has time to move the mouse pointer away from the 
edge of the screen.
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Taskbar Background in IGEL OS 12
This article shows how to configure the background style of the taskbar in IGEL OS.

Menu path: User Interface > Desktop > Taskbar Background

Background style
Possible values:

 System preset (Default)
 Solid color
 Color gradient
 Background image

Further settings depending on the style selection:

Taskbar color

The color for the taskbar. Click the color preview square to open the color selector.
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2nd taskbar color

The 2nd color for the taskbar if you want to create gradient colors. Click the color preview square to open the color 
selector.

Reverse gradient

 The color gradient is reverse.

☐ The color gradient is normal. (Default)

Background image path

Path to the background image
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Taskbar Items in IGEL OS 12
This article shows how to configure taskbar items in IGEL OS.  

Menu path:  User Interface > Desktop > Taskbar Items

Taskbar clock

 A clock is shown in the taskbar.

Clicking the taskbar clock displays the calendar and the Timezone dropdown menu. You can use the dropdown to 
set the timezone the device is located in. The dropdown menu is only accessible if the System > Time and Date > 
Timezone systray settings parameter is enabled. For details, see Time and Date in IGEL OS 12 (see page 277) .
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Sorting order in window button bar

Specifies the criteria according to which the window buttons are sorted.
Possible values:

 Timestamp: The window buttons are sorted in the chronological order in which the windows were 
opened.

 Group and timestamp: The window buttons are grouped according to the type of application. If, 
for example, a number of setup applications are open, all associated window buttons will be 
arranged next to each other. Within the group, the window buttons are sorted chronologically.  
(Default)

 Window title: The window buttons are sorted alphabetically.
 Group and window title: The window buttons are grouped according to type. If for example a 

number of setup applications are open, all associated window buttons will be arranged next to 
each other. Within the group, the window buttons are sorted alphabetically.

 Drag'n'Drop: You can order the buttons as you wish using drag and drop.

Maximum number of rows/columns in window button bar

Specifies the maximum number of rows available for window buttons.
Possible values:

 Automatic: The number of rows depends on the settings of the Taskbar height/width and 
Number of rows/columns in taskbar parameters under User Interface > Desktop > Taskbar. For 
details on the parameters, see Taskbar Configuration in IGEL OS 12 (see page 107).

 Numeric values: This value specifies the maximum number of rows. (Default: 1)

Show labels in window button bar

 The names of the ongoing sessions are displayed in the associated window buttons. (Default)
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☐ Only the icons are displayed.

Taskbar system tray

 The system tray is shown in the taskbar. (Default)

Show UMS connection status tray icon on desktop

 The current status of the Universal management Suite (UMS) connection is shown in the system tray. For 

example, with the icon   for connected. Clicking the icon displays information about the connected UMS server. 
(Default)

Show battery tray icon on desktop

 The current status of the battery is shown in the system tray. For example, with the icon  . Hover over the icon 
to see information on the charge. Clicking the icon displays the battery tray app. (Default)

Show ethernet connection status tray icon on desktop

 The current status of the LAN network connection is shown in the system tray. For example, with the icon   for 
connected. Clicking the icon displays the LAN tray app. (Default)

Show wifi connection status tray icon on desktop

 The current status of the Wi-Fi network connection is shown in the system tray. For example, with the icon  . 
Clicking the icon displays the Wi-Fi tray app. (Default)

Show mobile-broadband connection status tray icon on desktop

 The current status of the mobile network connection is shown in the system tray. For example, with the icon 

or  . Clicking the icon displays the mobile broadband tray app. (Default)

Show input settings tray icon on desktop

 If a mouse is detected, the  icon is shown in the system tray. If a touchpad is detected, or both a mouse and a 

touchpad are detected, the   icon is shown. Clicking the icon displays the mouse & touchpad tray app. (Default)

The following parameters enable icons to access the system tray applications. For details on system tray 
apps, see Tray Applications in IGEL OS 12 (see page 367) .
The parameters for the desktop and the parameters for the locksreen are independent from each other. 
You need to enable / disable the icons for both use cases separately. You can enable taskbar items for the 
lockscreen under User Interface > Desktop > Screenlock / Screensaver > Taskbar. For more 
information, see Taskbar (see page 59) .
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Show display tray icon on desktop

 The current display configuration icon is shown in the system tray. For example, with the  icon. Clicking the 
icon displays the display tray app. (Default)

Show audio tray icon on desktop

 The   and  icons are shown in the system tray. Clicking the icon displays the sound tray app.  (Default)

Size of icons in system tray

Specifies the size of system tray icons (volume, network connection etc.). You can select a pre-defined value or 
enter a numeric value.
Predefined values:

 Automatic: The size is adjusted to the height and width of the taskbar.
 Small: 20 pixels (Default)
 Medium: 40 pixels
 Large: 60 pixels
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Pager in IGEL OS 12
You can use the Pager tool to enable the use of multiple virtual desktops and organize your IGEL OS desktop. The 
Pager allows you to divide one desktop into several virtual workspaces. This article shows how to configure and use 
the Pager tool in IGEL OS. For details on how to use the pager, see the below section Using Pager (see page 117) .

Menu path: User Interface > Desktop > Pager

Use pager

 The Pager is enabled. You can configure up to 25 virtual desktops. The Pager will be displayed on the right of the 
taskbar:

Make sure you have enabled User Interface > Desktop > Taskbar > Taskbar on top of all windows before 
using the Pager. For more information on the setting, see Taskbar Configuration in IGEL OS 12 (see page 107).
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☐ The Pager is disabled. (Default)

Number of screens - Horizontal

Specifies how many workspaces will be shown next to each other. (Default: 2)

Number of screens - Vertical

Specifies how many workspaces will be shown above each other. (Default: 1)

Paging resistance

Specifies how many pixels the cursor needs to be moved over the edge of the screen before it triggers a switch of 
the desktop. (Default: 10)

You only need to use this setting if you enable at least one of the following options – Wrap workspaces while 
dragging a window or Wrap workspaces with pointer.

Wrap workspaces while dragging a window

 The desktop is switched as soon as a window is dragged out of view.

☐ The desktop is not switched when a window is dragged out of view. (Default)

Wrap workspaces with pointer

 The desktop is switched as soon as the mouse reaches the edge of the screen.

☐ The desktop is not switched when the mouse reaches the edge of the screen. (Default)

Using Pager

The Pager makes switching between multiple full-screen applications easier. Instead of minimizing/maximizing 
sessions or switching between them using key combinations, you simply click on the desired workspace using the 
mouse. When you switch back, the virtual desktop is displayed exactly as before (unless you restarted the system or 
changed the language in the IGEL Setup). 

Known Issue

The vertical value is implemented as horizontal and all the screens are shown next to each other. The 
configuration will be reworked in a future release.
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To use multiple workspaces:

1. Launch the desired sessions/applications on your device, e.g. Chromium browser and System 
Information. 

2. In the Pager panel in the taskbar, navigate to another workspace, e.g. Workspace 2, and click it.

The Pager can only be used in non-appliance mode.
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In Workspace 2, you will see the empty desktop, without opened sessions/applications.
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3. Start the required sessions/applications in Workspace 2, e.g. the Task Manager. 

4. When you need to switch back to the Chromium browser and System Information, simply select 
the corresponding workspace (in this example, Workspace 1) in the Pager panel in the taskbar.
Your desktop will be displayed exactly as before switching to Workspace 2.

Tip
You can use drag & drop to rearrange the sessions/applications between the workspaces. Click and hold 
the application/session symbol in the taskbar and drag it to the desired workspace in the Pager panel.
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Start Menu in IGEL OS 12
This article shows how to configure the desktop start menu in IGEL OS.

Menu path: User Interface > Desktop > Start Menu

The following options, which are all enabled by default, can be configured to be shown in the start menu.

Screenlock

 The  icon is shown. (Default)

Show Shutdown menu button

 The  icon is shown. (Default)

System tab

For the icon to be displayed, the following parameters need to be enabled:
 at least one login method under Security > Logon. For more information, see Logon 

Settings in IGEL OS 12 (see page 246).
 the Require password to unlock (screenlock) option under User Interface > 

Screenlock / Screensaver > Options. For more information, see Options (see page 56).
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 The  icon is shown. (Default)

About

 The  icon is shown. (Default)

Show current user name in About, Application Launcher and start menu.

Layout

Defines the initial layout of the start menu. The layout can be changed by the user.

Possible Options:

 Grid View: The start menu items are displayed in a grid layout. (Default)
 List View: The start menu items are displayed as a list.

In order for user names to be recognized and passed on, you must configure two settings beforehand:
 Enable using Active Directory/Kerberos under Security > Active Directory/Kerberos. For 

details, see Active Directory/Kerberos Configuration in IGEL OS 12 (see page 262)
 Enable local logon under Security > Logon > Active Directory/Kerberos. For details, 

see Active Directory/Kerberos - Enable Login in IGEL OS 12 (see page 250)
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In-Session Control Bar in IGEL OS 12
This article shows how to configure the control bar for full-screen sessions in IGEL OS.

Menu path: User Interface > Desktop > In-Session Control Bar

In a full-screen session, the in-session control bar allows you

 to eject a USB drive.
 to start the wireless manager (only available in Appliance Mode).
 to minimize the session view (not available in Appliance Mode).
 to end the session.

Use in-session control bar in all supported sessions

 The in-session control bar is shown. Depending on the configuration, the in-session control bar will be 
permanently visible or will be shown as soon as you move the cursor to the top edge of the screen.

☐ In-session control bar is not used. (Default)

The in-session control bar is available for the following session types:
 Citrix - see Citrix Workspace App



Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   124 / 691

Start Monitor

The monitor on which to start the session window.

Using In-Session Control Bar

→ To eject a USB device, click  .

→ To start the wireless manager in Appliance Mode, click  .

→ To minimize the session view, click  . (Not available in Appliance Mode.)

→ To end the session, click  .

→ To make the in-session control bar permanently visible, click  .

 ThinLinc 
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Commands Session in IGEL OS 12
This article shows how to set up system command sessions in IGEL OS.

Menu path: User Interface > Commands > Shutdown menu / Sort icons / Restart windowmanager

System commands can be made accessible to the user through configuring them as sessions:

 Shutdown menu: Opens the shutdown menu. You can configure the shutdown menu under 
System > Power Options > Shutdown. For more information, see Shutdown Settings in IGEL OS 
1227.

 Sort icons: Arranges the icons into a structured grid layout. Icons are automatically aligned in 
vertical columns and grouped together to form a clean, compact block instead of being freely 
positioned on the screen.

27. https://kb.igel.com/en/igel-os-base-system/current/shutdown-settings-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/shutdown-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/shutdown-settings-in-igel-os-12


Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   126 / 691

 Restart windowmanager: Restarts the device's user interface.

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

Quick Access
Menu path: User Interface > Commands > Shutdown Menu > Quick Access

The sorting behavior of desktop icons can also be configured in IGEL Setup under System > Registry > 
windowsmanager > defaulttheme > icon_sort.
Two sorting options are available:

 Default: Uses the original sorting behavior. Icons are arranged according to the internal 
filename and follow the standard system sorting logic. This preserves the existing 
behavior and layout.

 Alphanumeric: Automatically sorts icons in order from 0–9 and A–Z. Numbers are sorted 
numerically, followed by letters in alphabetical order.
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Here, you can configure the quick access to the shutdown menu from the start menu and the Application Launcher.

Show Shutdown menu button

 The  icon is shown in the start menu. (Default)

Hide Shutdown menu button

 The  icon is shown in the Application Launcher.

☐ The  icon is not shown in the Application Launcher. (Default)
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Accessibility Configuration in IGEL OS 12
The following accessibility settings can be configured in IGEL OS 12.

 Themes (see page 129)
 Color Filter (see page 131)
 Screen Magnifier (see page 132)
 Screen Reader (see page 135)
 Mouse (see page 136)
 Keyboard Mouse (see page 137)
 Keyboard Sensitivity (see page 138)
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Themes
This article describes how you can configure themes in IGEL OS.

Menu path: User Interface > Accessibility > Themes

User Interface Theme

You can change the User Interface Theme to one of the following options:

 IGEL Dark
 IGEL Light
 IGEL Color
 IGEL High Contrast
 IGEL High Contrast Inverted
 Custom Colors

Base color of the UI Theme

The settings in this section are only related to accessibility. By clicking on Related pages in the top right 
corner, you will be redirected to the regular desktop settings as described in Desktop Settings in IGEL OS 
1228.

28. https://kb.igel.com/en/igel-os-base-system/current/desktop-settings-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/desktop-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/desktop-settings-in-igel-os-12
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When you change the User Interface Theme, the base color changes as well. You can also manually set the base 
color of the UI Theme either by manually entering the color code.

You can also click on the color icon to the right to open the Select Color window. Choose your desired color or 

create a custom color by clicking on . Confirm your choice by clicking Select.
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Color Filter
This article describes how to set color filters.

Menu path: User Interface > Accessibility > Color Filter

 Select a color filter mode from the dropdown menu and set the color filter strength.

Available color filter modes:

 Protanopia
 Protanopia High Contrast
 Deuteranopia
 Deuteranopia High Contrast
 Tritanopia
 Monochrome
 Monochrome inverted
 Invert Colors

☐ No color filter is enabled. (Default)
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Screen Magnifier
This article describes how to use and modify the screen magnifier.

Menu path: User Interface > Accessibility > Screen Magnifier

Use screen magnifier

 A window opens and shows an enlarged part of the screen depending on the mouse position. By default, the 

magnifier follows the mouse. A system tray app  appears after enabling the screen magnifier. Clicking on it will 
close and open the screen magnifier.

Configuration options within the screen magnifier window:
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Follow Mouse (M)

This option is enabled by default. The magnified area follows the mouse.

Fixed Center (F)

The magnified area stays at a fixed position on the screen. Dragging the window to a different spot changes the 
magnified area to be displayed.

Zoom (+/-)

Set the zoom level from 1x to 16x. By default, this value is set to 2x.

Minimap

 Enables a minimap at the bottom of the window. It shows the magnified area on the screen.

☐ Minimap is disabled. (Default)

Stay on top

 The magnifier window always stays on top of other screens. (Default)

☐ The magnifier window behaves like a normal window. It can be covered by other applications.

Smoothing

 Reduces pixelation and jagged edges in the magnified area.

☐ Smoothing is disabled. (Default)
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☐ Screen magnifier is disabled. (Default)

You can configure the screen magnifier to be activated via icons in the Quick Start Panel and on the desktop or via 
hotkey.

The starting methods parameters are described under Starting Methods for Apps29.

29. https://kb.igel.com/en/igel-os-base-system/current/starting-methods-for-apps

https://kb.igel.com/en/igel-os-base-system/current/starting-methods-for-apps
https://kb.igel.com/en/igel-os-base-system/current/starting-methods-for-apps
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Screen Reader
This article describes how to use and modify the screen reader.

 Enable screen reader.

☐ Screen reader is disabled. (Default)

You can configure the screen reader to be activated via icons in the Quick Start Panel and on the desktop or via 
hotkey.

The starting methods parameters are described under Starting Methods for Apps30.

30. https://kb.igel.com/en/igel-os-base-system/current/starting-methods-for-apps

https://kb.igel.com/en/igel-os-base-system/current/starting-methods-for-apps
https://kb.igel.com/en/igel-os-base-system/current/starting-methods-for-apps
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Mouse
This article describes how you can adjust mouse settings.

Menu path: User Interface > Accessibility > Mouse

Mouse pointer size

Modify the mouse pointer from the bar by dragging or by clicking in the bar. The available mouse pointer sizes 
range from 16 to 94 (Default size: 24).

The setting in this section is only related to accessibility. By clicking on Related pages in the top right 
corner, you will be redirected to the regular mouse settings as described in Mouse Settings in IGEL OS 1231.

31. https://kb.igel.com/en/igel-os-base-system/current/mouse-settings-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/mouse-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/mouse-settings-in-igel-os-12
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Keyboard Mouse
This article explains how to use the keyboard mouse.

Use numpad to move mouse

 Use the keypad number keys to move the mouse.

Click here to see how to navigate the mouse when the keyboard mouse is enabled:

 Use NumPad 5 for left-clicks.
 Use Shift + NumPad 5 for right-clicks
 Use NumPad 4 and 6 for horizontal movement.
 Use NumPad 2 and 8 for vertical movement.
 Use NumPad 1, 3, 7 and 9 for diagonal movement.

☐ Use your mouse or touchpad for moving the mouse and clicking. (Default)
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Keyboard Sensitivity
This article describes how to configure the keyboard sensitivity.

Menu path: User Interface > Accessibility > Keyboard Sensitivity

Test

Free-text area to test the repeat settings.

Repeat keys

 Pressing and holding down a key will register repeated events. (Default)

☐ Pressing and holding down a key will register only one event.

Repeat delay

Determines the delay (in milliseconds) before automatic repetition begins. (Default: 660)

Repeat rate

The settings in this section are only related to accessibility. By clicking on Related pages in the top right 
corner, you will be redirected to the regular keyboard settings as described in Keyboard Settings in IGEL 
OS 1232.

32. https://kb.igel.com/en/igel-os-base-system/current/keyboard-settings-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/keyboard-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/keyboard-settings-in-igel-os-12
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Determines the number of times a character repeats per second. (Default: 40)

Sticky keys

 Allows modifier keys and regular keys to be pressed one after another and still be recognized as a combined 
input.

☐ Modifier keys and regular keys need to be pressed at the same time in order to trigger the event. (Default)

Slow keys

 Adds a delay before a keypress is registered. The key must be held down for a set duration to be recognized.

☐ A keypress is registered immediately. (Default)

Slow keys input delay

You can set the delay in milliseconds before the key input is accepted.

Bounce keys

 Helps ignore unintentional repeated keypresses by filtering out rapid duplicates.

☐ Rapid, repeated keypresses are interpreted as separate inputs. (Default)

This option can only be used when Slow keys is enabled.
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Network
In this chapter, you find information on network configuration in IGEL OS.

 DHCP Options in IGEL OS 12 (see page 141)
 DNS Settings in IGEL OS 12 (see page 145)
 Mobile Broadband in IGEL OS 12 (see page 147)
 Wireless Connections in IGEL OS 12 (see page 150)
 LAN Interfaces in IGEL OS 12 (see page 161)
 Default Gateway Configuration in IGEL OS 12 (see page 169)
 Network Drives (see page 173)
 Common Settings of the Network in IGEL OS 12 (see page 180)
 SCEP Client (NDES) in IGEL OS 12 (see page 182)
 VPN Settings in IGEL OS 12 (see page 189)
 Proxy Configuration in IGEL OS 12 (see page 211)
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DHCP Options in IGEL OS 12
This article shows how to configure standard and custom DHCP options with which the client can request 
information from the DHCP server in IGEL OS.

Standard Options
Menu path: Network > DHCP Options > Standard Options

User class

A freely definable character string which can serve as a criterion for allocating specific settings for the DHCP server.

List of standard options

Options with which the client can request information from the DHCP server.



Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   142 / 691

You will find information regarding the various DHCP options in RFC 2132 DHCP Options and BOOTP Vendor 
Extensions33.

To manage the list of options, proceed as follows:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   brings up the Add dialogue, where you can define the following settings:

Activated

 The option is enabled. (Default)

Option name

The name of the option. Select from the list of predefined names.

Custom Options
Menu path: Network > DHCP Options > Custom Options

33. https://tools.ietf.org/html/rfc2132

https://tools.ietf.org/html/rfc2132
https://tools.ietf.org/html/rfc2132
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To manage the list of options, proceed as follows:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   brings up the Add dialogue, where you can define the following settings:

Activated

 The option is enabled. (Default)

For more information regarding these options, see the manual for your DHCP server or your network 
components.
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Option name

The name of the option. Add a prefix of your own in order to prevent a conflict with the default DHCP options. 
Example of the syntax: [ YourPrefix]-[OptionName] . English letters, numbers and the special character “-” 
are allowed.

Code

A number that is used by the DHCP server and DHCP client to reference an option. A number between 80 and 254 
can be chosen. (Default: 80)

Data type

Type of option.
Possible values:

 Boolean
 Integer 8
 Integer 16
 Integer 32
 Signed integer 8
 Signed integer 16
 Signed integer 32
 Unsigned integer 8
 Unsigned integer 16
 Unsigned integer 32
 IP address
 Text (Default)
 String
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DNS Settings in IGEL OS 12
This article shows how to configure DNS settings in IGEL OS.

Menu path: Network > DNS

Enable DNS

 The manual DNS configuration will be used.

☐ The DNS configuration will be carried out by DHCP or BOOTP. (Default)

Default domain

Usually the name of the local network.

Nameserver
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IP address of the nameserver to be used.

Nameserver

IP address of an alternative nameserver.

Manually overwrite DHCP settings

 The default route, the domain name, and the DNS server will be overwritten by manual entries.

☐ Manual entries will not overwrite DHCP settings. (Default)

Dynamic DNS registration

 The terminal name will be registered dynamically via the DNS or DHCP server.

☐ The terminal name will not be registered dynamically. (Default)

Dynamic DNS registration method

 DHCP: Updates the terminal name through DHCP option 81. (Default)
 DNS: Sends updates to the DNS server in accordance with RFC 2136.

TSIG key file for additional DNS authentication

Path to the private key if TSIG-based DDNS registration is used.

You can add more nameservers through the registry:
1. Search for nameserver with the Include Registry enabled or navigate to System > 

Registry > network.dns.nameserver%
2. Click Add Instance to create further server entries.
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Mobile Broadband in IGEL OS 12
This article shows how to configure a modem or a surf stick in IGEL OS 12.

Menu path: Network > Mobile Broadband

If the surf stick is inserted and has been configured, the network connection will be established after the endpoint 
device boots. It can take between a few seconds and around 1 minute to establish a connection. The network 
connection will remain in place until the surf stick is removed or the endpoint device is put on standby or shut 
down.

The status of the network connection is shown in the system tray:

 The network connection is established; the endpoint device is online. This symbol is shown if 

Modem is selected as the device type:
If Router is selected as the device type, the corresponding symbol for a LAN connection is shown: 

.
 The network connection was interrupted; the endpoint device is offline. This symbol is shown if 

Modem is selected as the device type:

You can also use the Mobile Broadband Tray App for quick configurations. For details, see Tray 
Applications in IGEL OS 12 (see page 367).

Ensure that data traffic is adequately secured. You can do this in the following ways:
 Use a private APN.
 Use OpenVPN and block traffic that would circumvent VPN with firewall rules.
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If Router is selected as the device type, the corresponding symbol for a LAN connection is shown: 

.

You can change the following settings:

Enable Mobile Broadband

 The mobile broadband network can be used if a supported modem is connected. (Default)

☐ The mobile broadband network cannot be used. 

Device type

The type of the connected device.
Possible options:

 Modem: The device will be operated as a modem. The access data can be changed with the 
parameters number, user name, password, APN, network ID and PIN. (Default)

 Router: The device will be operated as a router. The device must be configured in advance in such 
a way that it is ready for use when it is inserted.

When Modem is Selected as Device Type
Custom APN (Access Point Name)

APN (Access Point Name) for your network connection. If you do not know the APN, ask your mobile 
communications operator for it.

Provider username

User name for your network connection. If you do not know the user name, ask your mobile communications 
operator for it.

Provider password

Password for your network connection. If you do not know the password, ask your mobile communications 
operator for it.

Enable automatically connect

 The mobile internet connection is established automatically. (Default)

Allow changing the SIM-PIN in the tray application

 The PIN of the SIM-card can be changed in the tray application. (Default)

Select the Router device type if you use a device from Huawei in the HiLink mode; example: Huawei E3372.
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Allow changing the request for the SIM-PIN after boot inside the tray application

 The request for the PIN after booting can be enabled/disabled in the tray application. (Default)

Roaming

 The WWAN modem is allowed to connect to roaming networks. (Default)

☐ The WWAN modem can only connect to home networks.
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Wireless Connections in IGEL OS 12
This article shows how to configure wireless connections in IGEL OS.

Menu path: Network > Wireless

You can find details of compatible wireless hardware in the IGEL Linux 3rd Party Hardware Database34.

You can use the Automatic switch of network connection parameter under Network > Common 
Settings to set the behaviour of switching between LAN, Wi-Fi, and WWAN networks. For details, see 
Common Settings of the Network in IGEL OS 12 (see page 180) .

Predictable Network Interface Names (PNINs)
The names of Ethernet and WLAN interfaces are predictable network interface names (PNINs), see 
Predictable Network Interface Names35. This ensures the stability of interface names on reboot and 
generally improves the reliability of associating configurations with interfaces.

34. https://www.igel.com/linux-3rd-party-hardware-database/
35. https://www.freedesktop.org/wiki/Software/systemd/PredictableNetworkInterfaceNames/

https://www.igel.com/linux-3rd-party-hardware-database/
https://www.freedesktop.org/wiki/Software/systemd/PredictableNetworkInterfaceNames/
https://www.igel.com/linux-3rd-party-hardware-database/
https://www.freedesktop.org/wiki/Software/systemd/PredictableNetworkInterfaceNames/
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Activate wireless interface

 The wireless interface is enabled. (Default)

☐ The wireless interface is disabled. 

Get IP from DHCP server

The IP address of the endpoint device will be obtained automatically using DHCP. (Default)

DHCP options can be specified under Network > DHCP Options. For details on the configuration, see DHCP Options 
in IGEL OS 12 (see page 141) .

Specify IP address

The IP address and the network mask are entered manually.

IP address

IP address of the endpoint device

Network mask

Network mask of the endpoint device

 As " eth0 ", " eth1 ", and " wlan0 " have been replaced by PNINs, configurations or 
custom scripts that include the old names of Ethernet and WLAN interfaces, 
e.g.  eth0 ,  eth2 ,  wlan0 , have to be adjusted. 
The following already existing configurations do NOT require manual adjustment since old 
names  eth0 ,  eth1 , etc. will internally be replaced by the correct PNINs automatically: 

 (11.10-en) Tcpdump

 To view the PNINs and the order of the configured interfaces, you can use the following 
commands. The default interface is always listed first, the second interface is listed 
second, etc.
Ethernet (LAN):  cat /config/net/en-interfaces

WLAN:  cat /config/net/wl-interfaces

(Note: Only the first wireless interface (former  wlan0 ) is supported. All other wireless 
interfaces will be ignored.)

 If you need to configure more than two Ethernet interfaces, go to System > Registry 
> network.interfaces.ethernet.device% and add an instance by clicking Add Instance.
To explicitly assign a configuration instance to a certain interface, enter the corresponding 
PNIN for the registry key network.interfaces.ethernet.device%.ifname.
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IPv6 configuration:

 Compatibility mode: Behavior of earlier firmware versions. (Default)
 Disabled: IPv6 is completely disabled.
 Automatic: IPv6 auto-configuration is based on router advertisements (can include DHCPv6).

You will find further information in RFC 486136.
 DHCPv6: IPv6 configuration using DHCPv6 if router advertisements are not available.

You will find further information in RFC 4862 Section 5.5.237.

Enable Wi-Fi automatic switch

 Wi-Fi is turned on automatically when a wired LAN connection is disconnected and Wi-Fi is turned off 
automatically when a wired LAN connection is established.

☐ Wi-Fi is not turned on automatically when a wired LAN connection is disconnected and Wi-Fi is not turned off 
automatically when a wired LAN connection is established. (Default) 

 Wi-Fi Networks Configuration in IGEL OS 12 (see page 153)
 Wireless Regulatory Domain (see page 159)

If the toggle button in the Wi-Fi tray app is used for turning the Wi-Fi on or off, the Wi-Fi automatic switch 
gets disabled until the reboot of the device. On reboot, the previously configured setting will be restored.
For details, see Tray Applications in IGEL OS 12 (see page 367) .

36. https://tools.ietf.org/html/rfc4861
37. https://tools.ietf.org/html/rfc4862#section-5.5.2

https://tools.ietf.org/html/rfc4861
https://tools.ietf.org/html/rfc4862#section-5.5.2
https://tools.ietf.org/html/rfc4861
https://tools.ietf.org/html/rfc4862#section-5.5.2
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Wi-Fi Networks Configuration in IGEL OS 12
This article shows how to configure wireless network connections in IGEL OS. All the wireless network connections 
configured for the device are shown in the list, including connections configured through the UMS or the Wi-Fi tray 
app. For more information on the tray app, see Tray Applications in IGEL OS 12 (see page 367) .

Menu path: Network > Wireless > Wi-Fi Network

To edit the Wi-Fi networks list, proceed as follows:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   brings up the Add dialogue, where you can define the settings of the wireless network.

For further configuration see How to Configure Server Certificate Verification during 802.1x Authentication 
in IGEL OS 12 (see page 576) .
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Wi-Fi Networks Settings

Wireless network name (SSID)

Name of the wireless network (SSID)
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Enable encryption

Encrypted connection is used. (Default)

Network authentication

You can configure the following network authentication methods. 

 WPA Personal: Wi-Fi Protected Access Pre-Shared Key (WPA / IEEE 802.11i/D3.0) 
 WPA Enterprise: Wi-Fi Protected Access with 802.1X authentication (WPA / IEEE 802.11i/D3.0)
 WPA2 Personal (Default): Wi-Fi Protected Access Pre-Shared Key (WPA2 / IEEE 802.11i/RSN)
 WPA2/WPA3 Enterprise: Wi-Fi Protected Access with 802.1X authentication (WPA2 / WPA3 / IEEE 

802.11i/RSN)
 WPA3 Personal: Wi-Fi Protected Access SAE (Simultaneous Authentication of Equals) 
 WPA3 Enterprise B192: allow connections to WPA3 Enterprise with 192-bit mode (00-0F-AC:12 

cipher suite, GCMP-256 pairwise cipher and required PMF)

Depending on the selection, you can configure the corresponding parameters below.

 For WPA/WPA2/WPA3 Personal encryption, see WPA/WPA2/WPA3 Personal (see page 155).
 For WPA/WPA2/WPA3 Enterprise encryption, see WPA Enterprise or WPA2/WPA3 Enterprise or 

WPA3 Enterprise B192 Enterprise Encryption (see page 156).

WPA/WPA2/WPA3 Personal Encryption

Network key

WPA network key/passphrase as set at the access point. This is either an ASCII character string with a length of 8...63 
or exactly 64 hexadecimal digits.

Data encryption

 Default: The default value depends on which network authentication method is selected. For 
WPA, TKIP is the default. For WPA2, AES (CCMP) is the default. (Default)

 TKIP: Temporal Key Integrity Protocol (IEEE 802.11i/D7.0)
 AES (CCMP): AES in Counter mode with CBC-MAC (RFC 3610, IEEE 802.11i/D7.0)
 AES (CCMP) + TKIP: One of two encryption methods is selected by the access point.
 Automatic: The access point can choose the encryption method freely – nothing is stipulated.

AP shows SSID (scan mode)

Scan mode for access points.

 Default (visible SSID) (Default)
 Broadcast (visible SSID): Alternative for access points which allow the SSID broadcast
 No broadcast (hidden SSID): Alternative for access points which refuse the SSID broadcast 

(hidden access points)



Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   156 / 691

Enable automatically connect

Automatic connection to the access point is enabled. (Default)

WPA Enterprise or WPA2/WPA3 Enterprise or WPA3 Enterprise B192 Encryption

Data encryption

 Default: The default value depends on which network authentication method is selected - TKIP for 
WPA, AES (CCMP) for WPA2.

 TKIP: Temporal Key Integrity Protocol (IEEE 802.11i/D7.0)
 AES (CCMP): AES in Counter mode with CBC-MAC (RFC 3610, IEEE 802.11i/D7.0)
 AES (CCMP) + TKIP: One of two encryption methods is selected by the access point.
 Automatic (Default): The access point can choose the encryption method freely – nothing is 

stipulated.

EAP type

 PEAP: Protected Extensible Authentication Protocol
 TLS: Transport Layer Security with client certificate
 TTLS: Tunneled Transport Layer Security
 FAST: Flexible Authentication via Secure Tunneling

Anonymous identity

This identity is sent by authentication instead of the actual Identity. This prevents the disclosure of the actual 
identity of the user. The anonymous identity is relevant for any of the above-mentioned EAP Types, except for TLS.

Auth method

Method for authentication that is available for the selected EAP type.
Possible options:

 MSCHAPv2: Microsoft Challenge Handshake Authentication Protocol (Default)
 TLS: Transport Layer Security with client certificate
 GTC: Generic Token Card
 MD5: MD5-Challenge
 PAP: Password Authentication Protocol

Validate server certificate

In case of WPA3 Enterprise B192 Encryption, GCMP-256 encryption is silently enforced regardless of the 
Data encryption setting.
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 The endpoint device validates the authenticity of the authentication server against the certificate file. This 
certificate file is stored under the path defined by CA root certificate. (Default)

☐ The authenticity of the authentication server is not validated.

CA Root Certificate

Path and file name of the file that contains the certificates with which the authentication server authenticates itself.

Identity

Username that is stored at the authentication server

Password

Password relevant to the user name

Enable automatically connect

Automatic connection to the access point is enabled. (Default)

AP shows SSID (scan mode)

Scan mode for access points.

 Default (visible SSID) (Default)
 Broadcast (visible SSID): Alternative for access points that allow the SSID broadcast
 No broadcast (hidden SSID): Alternative for access points that refuse the SSID broadcast (hidden 

access points)

TLS as EAP Type

The following settings are relevant if you have selected TLS as EAP type:

Manage certificates with SCEP (NDES)

 Client certificates will automatically be managed with SCEP. For more information on SCEP configuration, 
see SCEP Client (NDES) in IGEL OS 12 (see page 182) .

☐ Client certificates will not be managed with SCEP. (Default)

Client Certificate

Path to the file with the certificate for client authentication in the PEM (base64) or DER format.

Private key

If a private key in the PKCS#12 (PFX) format is used, leave this field empty.
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Path to the file with the private key for the client certificate. The file can be in the PEM (base64), DER, or PKCS#12 
(PFX) format. The Private key password may be required for access.

Identity

User name for network access

Private key password

Password for the Private key for the client certificate

FAST as EAP Type

The following setting is relevant if you have selected FAST as EAP type:

Automatic PAC provisioning

Specifies how the PAC (Protected Access Credential) is delivered to the client. 

Possible options:

 Disabled: PAC files have to be transferred to the device manually, e.g. via UMS file transfer.
 Unauthenticated:  An anonymous tunnel will be used for PAC provisioning. 
 Authenticated: An authenticated tunnel will be used for PAC provisioning.
 Unrestricted: Both authenticated and unauthenticated PAC provisioning is allowed. PAC files are 

automatically created after the first successful authentication. (Default)

PAC files are stored in  /wfs/eap_fast_pacs/ .
PAC file names are automatically derived from the Identity, but are coded. In the case of the manual PAC 
provisioning, you can determine the PAC file names with the following script:  /bin/

gen_pac_filename.sh
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Wireless Regulatory Domain
This article shows how to set the location of the device in IGEL OS.

Menu path: Network > Wireless > Wireless Regulatory Domain

Wireless regulatory domain

Select the area in which the device is located.

 Not configured (Default)
 Africa
 Arctic
 Asia
 Australia
 Europe
 North America
 South America
 World

Location

Select the country in which the device is located. The available options are based on the selected area.

 Not configured (Default)
 World
 Albania
 Armenia

[...]
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 Cyprus
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LAN Interfaces in IGEL OS 12
This article shows how to configure LAN interfaces in IGEL OS. 

Menu path: Network > LAN Interfaces > [Interface]

You can use the LAN tray app for quick ethernet network configurations. For details, see Tray Applications 
in IGEL OS 12 (see page 367).

Predictable Network Interface Names (PNINs)
The names of Ethernet and WLAN interfaces are predictable network interface names (PNINs), see 
Predictable Network Interface Names38. This ensures the stability of interface names on reboot and 
generally improves the reliability of associating configurations with interfaces.

 As " eth0 ", " eth1 ", and " wlan0 " have been replaced by PNINs, configurations or 
custom scripts that include the old names of Ethernet and WLAN interfaces, 
e.g.  eth0 ,  eth2 ,  wlan0 , have to be adjusted. 
The following already existing configurations do NOT require manual adjustment since old 
names  eth0 ,  eth1 , etc. will internally be replaced by the correct PNINs automatically: 

 (11.10-en) Tcpdump

 To view the PNINs and the order of the configured interfaces, you can use the following 
commands. The default interface is always listed first, the second interface is listed 
second, etc.

38. https://www.freedesktop.org/wiki/Software/systemd/PredictableNetworkInterfaceNames/

https://www.freedesktop.org/wiki/Software/systemd/PredictableNetworkInterfaceNames/
https://www.freedesktop.org/wiki/Software/systemd/PredictableNetworkInterfaceNames/
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Activate default interface (Ethernet)

 The interface is enabled. (Default)

☐ The interface is disabled.

Get IP from DHCP server

 The IP address of the client will be obtained automatically using DHCP. (Default)

DHCP options can be specified under Network > DHCP Options > Standard Options. For more information, 
see DHCP Options in IGEL OS 12 (see page 141) .

Specify an IP address

The IP address and the network mask are entered manually.

IP address

IP address of the device

Network mask

Network mask of the device

IPv6 configuration

 Compatibility mode: Behavior of earlier firmware versions. (Default)

 Disabled: IPv6 completely disabled

 Automatic: IPv6 auto configuration based on router advertisements (can include DHCPv6).
For further information, see RFC 4861.39

Ethernet (LAN):  cat /config/net/en-interfaces

WLAN:  cat /config/net/wl-interfaces

(Note: Only the first wireless interface (former  wlan0 ) is supported. All other wireless 
interfaces will be ignored.)

 If you need to configure more than two Ethernet interfaces, go to System > Registry 
> network.interfaces.ethernet.device% and add an instance by clicking Add Instance.
To explicitly assign a configuration instance to a certain interface, enter the corresponding 
PNIN for the registry key network.interfaces.ethernet.device%.ifname.

39. https://tools.ietf.org/html/rfc4861

https://tools.ietf.org/html/rfc4861
https://tools.ietf.org/html/rfc4861
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 DHCPv6: IPv6 configuration using DHCPv6 if router advertisements are not available.
This is mentioned in RFC 4862 Section 5.5.2.40

Network link type

 Auto sense (Default)
 1000 Mbps Full Duplex
 100 Mbps Full Duplex
 100 Mbps Half Duplex
 10 Mbps Full Duplex
 10 Mbps Half Duplex

Force auto-negotiation

 The half-/full-duplex problems can be avoided for switches that expect the auto-negotiation flag for fixed 
bandwidths.

☐ Auto-negotiation is not forced. (Default)

 Network Port Authentication in IGEL OS 12 (see page 164)
 Wake On LAN Settings in IGEL OS 12 (see page 167)

40. https://tools.ietf.org/html/rfc4862#section-5.5.2

https://tools.ietf.org/html/rfc4862#section-5.5.2
https://tools.ietf.org/html/rfc4862#section-5.5.2
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Network Port Authentication in IGEL OS 12
This article shows how to enable and configure network port authentication in IGEL OS.

Menu path: Network > LAN Interfaces > [Interface] > Authentication

Enable IEEE 802.1x authentication

 Network port authentication is enabled.

☐ Network port authentication is disabled. (Default)

If you enable authentication, further options become available:

EAP type

The type of the authentication procedure:

 PEAP: Protected Extensible Authentication Protocol (Default)
 TLS: Transport Layer Security with client certificate
 TTLS: Tunneled Transport Layer Security
 FAST: Flexible Authentication via Secure Tunneling

Anonymous identity

For further configuration see How to Configure Server Certificate Verification during 802.1x Authentication 
in IGEL OS 12 (see page 576) .
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This identity is sent by authentication instead of the actual Identity. This prevents the disclosure of the actual 
identity of the user. The anonymous identity is relevant for any of the above-mentioned EAP Types, except for TLS.

Auth method

The following authentication methods are available:

 MSCHAPV2: Microsoft Challenge Handshake Authentication Protocol (Default)
 TLS: Transport Layer Security with client certificate
 GTC: Generic Token Card
 MD5: MD5-Challenge
 PAP: Password Authentication Protocol

Validate server certificate

 The server’s certificate is checked cryptographically. (Default)

CA root certificate

The path to the CA root certificate file. This can be in PEM or DER format.

Identity

User name for RADIUS

Password

Password for network access

The following settings are relevant if you have selected TLS as EAP Type:

Manage certificates with SCEP (NDES)

 Client certificates will automatically be managed with SCEP. For more information, see SCEP Client (NDES) in 
IGEL OS 12 (see page 182).

☐ Client certificates will not be managed with SCEP. (Default)

Client certificate

If you leave the Identity and Password fields empty, an entry mask for authentication purposes will be 
shown. However, this does not apply to the methods with a client certificate (TLS and PEAP-TLS) where 
these details are mandatory.
If Identity and Password entered via the entry mask should be saved, see How to Configure the 
Permanent Storage of User-Provided Network Credentials (Wi-Fi and Ethernet) (see page 580).
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Path to the file with the certificate for client authentication in the PEM (base64) or DER format.

Private key

Path to the file with the private key for the client certificate. The file can be in the PEM (base64), DER, or PKCS#12 
(PFX) format. The Private key password may be required for access.

Identity

User name for network access

Private key password

Password for the Private key for the client certificate

The following setting is relevant if you have selected FAST as EAP Type:

Automatic PAC provisioning

Specifies how the PAC (Protected Access Credential) is delivered to the client. 
Possible options:

 Disabled: PAC files have to be transferred to the device manually, e.g. via UMS file transfer.
 Unauthenticated:  An anonymous tunnel will be used for PAC provisioning. 
 Authenticated: An authenticated tunnel will be used for PAC provisioning.
 Unrestricted: Both authenticated and unauthenticated PAC provisioning is allowed. PAC files are 

automatically created after the first successful authentication. (Default)

If a private key in the PKCS#12 (PFX) format is used, leave this field empty.

PAC files are stored in  /wfs/eap_fast_pacs/ .
PAC file names are automatically derived from the Identity, but are coded. In the case of the manual PAC 
provisioning, you can determine the PAC file names with the following script:  /bin/

gen_pac_filename.sh

In tests with  hostapd , it has been necessary to disable TLS 1.2. To do that, enter the following 
command for System > Registry 
> network.interfaces.ethernet.device0.ieee8021x.phase1_direct:  tls_disable_tlsv1_2=1
To add further device registry keys, go to System > Registry > network.interfaces.ethernet.device%
and click Add Instance.
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Wake On LAN Settings in IGEL OS 12
With Wake-on-Lan (WoL), you can switch on devices over the network.

For further information on the WoL functionality of the Universal Management Suite (UMS), see Wake on LAN 
Configuration in the IGEL UMS41.

Menu path: Network > LAN Interfaces > [Interface] > Wake On LAN

Alternative Wake-on-Lan Options
On this Setup page, you can enable or disable Wake-on-Lan via a magic packet. Alternatively, you can set 
your IGEL OS device to use other options for Wake-on-Lan, but this should be tested thoroughly to avoid 
issues. The following options can be configured via the Registry (System > Registry):

 Wake on ARP packet: 
network.interfaces.ethernet.device%.wol.wake_arp

 Wake on broadcast message: 
network.interfaces.ethernet.device%.wol.wake_bcast

 Wake on multicast message: 
network.interfaces.ethernet.device%.wol.wake_mcast

 Wake on physical activity: 
network.interfaces.ethernet.device%.wol.wake_phy

 Wake on unicast message: 
network.interfaces.ethernet.device%.wol.wake_ucast

WoL via Docking Stations and USB-C-to-LAN adapters
When using the supported devices with USB-C docking, or USB-C-to-LAN adapters, WoL is only supported 
from suspend mode and not power off mode. For more details, see Devices Supported by IGEL OS 1242 .

IGEL OS 12.3.2 or higher: WoL Setting in BIOS is Detected on Supported Lenovo Devices
On Lenovo devices that are supported by IGEL OS 12, the system can detect whether WoL is enabled in the 
BIOS or not. If the system detects that WoL is disabled in the BIOS, all WoL described on this configuration 
page is disabled.
You can enable or disable the WoL detection with System > Registry > network > interfaces > 
respect_bios_wol_setting (registry key  network.interfaces.respect_bios_wol_setting ).

41. https://kb.igel.com/en/universal-management-suite/current/wake-on-lan-configuration-in-the-igel-ums
42. https://kb.igel.com/en/hardware/current/devices-supported-by-igel-os-12-1

https://kb.igel.com/en/universal-management-suite/current/wake-on-lan-configuration-in-the-igel-ums
https://kb.igel.com/en/hardware/current/devices-supported-by-igel-os-12-1
https://kb.igel.com/en/universal-management-suite/current/wake-on-lan-configuration-in-the-igel-ums
https://kb.igel.com/en/hardware/current/devices-supported-by-igel-os-12-1
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Wake on magic packet

 The device can be started with a Wake-on-LAN magic packet. (Default)
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Default Gateway Configuration in IGEL OS 12
This article shows how to configure the default gateway in IGEL OS.

Menu path: Network > Default Gateway

Default gateway

 Routing is enabled.

☐ Routing is disabled. (Default)

Default gateway

Gateway that routes the packets to the target network

Interface

The network interface via which the route is to run

Predictable Network Interface Names (PNINs)
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The names of Ethernet and WLAN interfaces are predictable network interface names (PNINs), see 
Predictable Network Interface Names43. This ensures the stability of interface names on reboot and 
generally improves the reliability of associating configurations with interfaces.

 As " eth0 ", " eth1 ", and " wlan0 " have been replaced by PNINs, configurations or 
custom scripts that include the old names of Ethernet and WLAN interfaces, 
e.g.  eth0 ,  eth2 ,  wlan0 , have to be adjusted. 
The following already existing configurations do NOT require manual adjustment since old 
names  eth0 ,  eth1 , etc. will internally be replaced by the correct PNINs automatically: 

 (11.10-en) Tcpdump

 To view the PNINs and the order of the configured interfaces, you can use the following 
commands. The default interface is always listed first, the second interface is listed 
second, etc.
Ethernet (LAN):  cat /config/net/en-interfaces

WLAN:  cat /config/net/wl-interfaces

(Note: Only the first wireless interface (former  wlan0 ) is supported. All other wireless 
interfaces will be ignored.)

 If you need to configure more than two Ethernet interfaces, go to System > Registry 
> network.interfaces.ethernet.device% and add an instance by clicking Add Instance.
To explicitly assign a configuration instance to a certain interface, enter the corresponding 
PNIN for the registry key network.interfaces.ethernet.device%.ifname.

43. https://www.freedesktop.org/wiki/Software/systemd/PredictableNetworkInterfaceNames/

https://www.freedesktop.org/wiki/Software/systemd/PredictableNetworkInterfaceNames/
https://www.freedesktop.org/wiki/Software/systemd/PredictableNetworkInterfaceNames/
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Routing in IGEL OS 12
This article shows how to configure routing in IGEL OS.

Menu path: Network > Default gateway > Routing [1-5]

Routing

 This route is enabled.

☐ This route is disabled. (Default)

Network route / Host route

Type of route.

 Network route: The routing relates to a (sub) network. (Default)
 Host route: The routing relates to the address of a computer.
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Network/Host IP or Name

The address of the network (for a network route) or the IP address or the name of the host (for a host route).

Network mask

Mask for the desired IP range, e.g. 255.255.255.0

Gateway

Gateway that routes the packets to the target network

Interface

The network interface via which the route is to run
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Network Drives
The following network drives can be configured in IGEL OS.

 NFS in IGEL OS 12 (see page 174)
 Windows Drive Configuration in IGEL OS 12 (see page 177)
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NFS in IGEL OS 12
This article shows how to integrate network drives using the Network File System (NFS) in IGEL OS.

Menu path: Network > Network Drives > NFS

NFS Mount List

List of integrated network drives

To manage the network drives, proceed as follows:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   brings up the Add dialogue, where you can define the following settings:
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Enabled

 The network drive will be integrated. (Default)

Local mount point

The local directory under which the server directory is to be visible. (Default:  /nfsmount )

Server

NFS server that exports the directory.

In both the Local mount point and Directory name only  /  (Linux/Unix-style forward slash) is permitted 
as a path separator.
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Directory name

Path under which the NFS server exports the directory.

For Server, you can provide an IP address, a hostname or a Fully-Qualified Domain Name (FQDN).
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Windows Drive Configuration in IGEL OS 12
This article shows how to integrate network drives shared by Windows as well as those from Linux/Unix servers via 
the SMB protocol (Samba) in IGEL OS.

Menu path: Network > Network Drives > Windows Drive

SMB Mount List

List of integrated network drives shared through SMB

To manage the list of drives, proceed as follows:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.
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Clicking   brings up the Add dialogue, where you can define the following settings:

Enabled

 The network drive will be integrated. (Default)

Local mount point

The local directory under which the server directory is to be visible. (Default:  /smbmount )
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Server

The IP address, Fully-Qualified Domain Name (FQDN) or NetBIOS name of the server

Share name

Path name as exported by the Windows or Unix Samba host

User name

User name for your user account on the Windows or Unix Samba host

Password

Password for your user account on the Windows or Unix Samba host

User writable

 The user can not only read but also write directory contents. Otherwise, only the local root user is able to do 
this.

☐ The user can only read directory contents. (Default)

For Local mount point, only  /  (Linux/Unix-style forward slash) can be used as a path separator. Note 

that if you enter, for example,  \smbmount  as a moint point, a directory called  \smbmount  will be 

created, because  \  is a legal character in Linux directory names. For Share name, however,  /  (Linux/

Unix-style forward slash) or  \  (Windows-style backward slash) can be used as a path separator.

If a NetBios name is provided for Server, make sure it is not preceded by slashes, e.g.  \

\myComputer  (wrong) vs.  myComputer  (correct).
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Common Settings of the Network in IGEL OS 12
This article shows how to configure common network settings in IGEL OS 12.

Menu path: Network > Common Settings

Computer name

Local name of the device. If the field is empty, the default name is used. The default name is combined of ' ITC ' 
and the MAC address of the device.

For more information on naming configurations, see (12.05.100-en) How to Rename IGEL OS Devices .

Host List

List of configured hosts. If no Domain Name Service (DNS) is used, you can specify a list with computers in order to 
allow translation between the fully qualified host name, the short host name and the IP address.

To manage the list of computers, proceed as follows:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   brings up the Add dialogue, where you can define the following settings:

 IP address
IP address of the host you would like to add.
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 Fully qualified host name
Host name along with the domain, e.g.  mail.example.com

 Short host name
E.g.  mail

Automatic switch of network connection

 The network connections (LAN, Wi-Fi, WWAN) are turned on and off automatically based on availability. (Default)

☐ The network connections are not turned on and off automatically. The toggles can be used in the mobile 
broadband tray app and Wi-Fi tray app to manage connections.

The automation is based on the following order of priorities:
1. LAN
2. Wi-Fi
3. Mobile broadband

Actions of the automation:
1. When a LAN connection is available, Wi-Fi and mobile broadband connections get 

disabled. The toggles in the the mobile broadband tray App and Wi-Fi tray app get 
disabled, so you cannot overwrite the setting there.

2. When a LAN connection is not available, the Wi-Fi connection is enabled automatically, 
and mobile broadband remains disabled. You can use the toggle in the Wi-Fi tray app to 
enable/disable Wi-Fi. When the network type is disabled through the toggle, the setting is 
saved persistently over boot.

3. When there are no available LAN and Wi-Fi connections, mobile broadband gets enabled. 
You can use the toggle in the mobile broadband tray app to enable/disable Wi-Fi. When 
the network type is disabled through the toggle, the setting is saved persistently over 
boot.

For more on network tray apps, see Tray Applications in IGEL OS 12 (see page 367) .
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SCEP Client (NDES) in IGEL OS 12
SCEP allows the automatic provision of client certificates via an SCEP server and a certification authority. This type 
of certificate is automatically renewed before it expires and can be used for purposes such as network 
authentication (e.g. IEEE 802.1x). This article shows how to configure SCEP certificate management in IGEL OS.

Menu path: Network > SCEP Client (NDES)

Manage certificates with SCEP

 Certificate management via SCEP Client (NDES) is enabled. 

☐ Certificate management via SCEP Client (NDES) is not enabled. (Default)

A Microsoft Windows Server (MSCEP, NDES) for example can serve as a queried counterpart (SCEP server and 
certification body). More information can be found at Microsoft, e.g. in the following Technet article: Network 
Device Enrollment Service (NDES) in Active Directory Certificate Services (AD CS)45.

 SCEP Server in IGEL OS 12 (see page 183)
 Certificate (see page 185)
 Certification Authority Configuration in IGEL OS12 (see page 188)

The SCEP configuration process is quite complex, for example, you need to enter the CA certificate 
fingerprint (under Certification Authority) and the Challenge password (under SCEP server). To save time 
and effort, we recommend you to set up SCEP in the IGEL Universal Management Suite (UMS) as a profile 
and distribute it to the devices. For more information, see How to Create and Assign Profiles in the IGEL 
UMS Web App44.

44. https://kb.igel.com/en/universal-management-suite/current/how-to-create-and-assign-profiles-in-the-igel-ums-
45. https://learn.microsoft.com/en-us/archive/technet-wiki/9063.active-directory-certificate-services-ad-cs-network-device-

enrollment-service-ndes

https://learn.microsoft.com/en-us/archive/technet-wiki/9063.active-directory-certificate-services-ad-cs-network-device-enrollment-service-ndes
https://kb.igel.com/en/universal-management-suite/current/how-to-create-and-assign-profiles-in-the-igel-ums-
https://kb.igel.com/en/universal-management-suite/current/how-to-create-and-assign-profiles-in-the-igel-ums-
https://learn.microsoft.com/en-us/archive/technet-wiki/9063.active-directory-certificate-services-ad-cs-network-device-enrollment-service-ndes
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SCEP Server in IGEL OS 12
This article describes the settings required for connecting the IGEL OS device to an SCEP server. For more details, 
see How to Enroll and Renew Certificates with SCEP (NDES) on IGEL OS 12 Devices .

Menu path: Network > SCEP Client (NDES) > SCEP Server

SCEP server URL

Address by which the SCEP client communicates with the SCEP server.
Examples:

 http://myserver.mydomain.com/certsrv/mscep/mscep.dll  (Windows Server 
2019)

 http://myserver.mydomain.com/certsrv/mscep  (before Windows Server 2019)

Proxy server for SCEP requests

If a proxy must be used, provide its address in the format host:port ; otherwise, leave the field blank.

Challenge password

The password that the SCEP client must present to the SCEP server in its requests (CSR).

HTTPS is not supported; however, all security-critical data that are transferred between the SCEP client 
and other components are encrypted.

Microsoft NDES Server Settings
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Certificate renewal period (days)

Time interval before certificate expiry during which renewal attempts are performed. (Default: 30)

Certificate expiry check interval (days)

Specifies how often the certificate is checked against its expiry date. (Default: 1)

By default, the password on a Microsoft NDES server is valid for 1 hour and can be used only once. In order 
to use the password on numerous devices, additional settings must be made on the NDES server. For 
information, see the section "Password and Password Cache" on https://social.technet.microsoft.com46.
On a Microsoft NDES server, you can retrieve the password under https://<HOSTNAME>/certsrv/

mscep_admin

As an example, a certificate is valid until 31.12. of a year. If the period for renewal is set to 10 days, a new 
certificate will be requested for the first time on 21.12. of the same year.

46. https://social.technet.microsoft.com/wiki/contents/articles/9063.active-directory-certificate-services-ad-cs-network-device-
enrollment-service-ndes.aspx

https://social.technet.microsoft.com/wiki/contents/articles/9063.active-directory-certificate-services-ad-cs-network-device-enrollment-service-ndes.aspx
https://social.technet.microsoft.com/wiki/contents/articles/9063.active-directory-certificate-services-ad-cs-network-device-enrollment-service-ndes.aspx
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Certificate
This article shows how to specify the basic data for the certificate to be issued by the certification body for SCEP in 
IGEL OS. Here you can set the data for the Certificate Signing Request (CSR).

Menu path: Network > SCEP Client (NDES) > Certificate

Type of CommonName/SubjectAltName

The characteristic for linking the certificate to the device.

 IP address: The IP address of the device.
 DNS name: The DNS name of the device. (Default)

 IP address (auto): The IP address of the device (inserted automatically).
 DNS name (auto): The DNS name of the device (inserted automatically).

 Email address: An email address.
 DNS name as UPN (auto)

If the client automatically obtains its network name, DNS name (auto) is a good type for the client 
certificate. 

If you use DNS name (auto) and the hostname gets changed, the network authentication will usually 
continue to function using the certificate with the old hostname. This can later lead to client certificate 
renewal failure, with the notification: " Renewal of client certificate failed - subject 

has changed OLDNAME > NEWNAME ". You can change the behavior through 
the network.scepclient.cert%.hostname_change_handling registry key. For details and 
troubleshooting, see Troubleshooting: SCEP Certificate Renewal Failure due to Hostname Change (see page 
563).
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 UPN (Microsoft User Principal Name)
 

CommonName/SubjectAltName

The parameter is available if Type of CommonName/SubjectAltName  is set to  IP address,  DNS name, UPN, or  
Email address. Give a designation that matches the  Type of CommonName/SubjectAltName. For certain types, 
this occurs automatically. No entry is then required.

 

CommonName/SubjectAltName Suffix

The parameter is available if  Type of CommonName/SubjectAltName  is set to  IP address (auto),  DNS name 
(auto), or  DNS name as UPN (auto). Specifies a suffix that will be added to CommonName/SubjectAltName.
Possible values:

 None: No suffix will be added.
 Dot + DNS domain (auto): The system's current DNS domain name, separated with a dot, will be 

added. Example:  .igel.local
 Free text entry: The manually entered suffix will be added. Take notice that the percent symbol 

"%"  is used for introducing the escape sequence, and thus the following replacements take place 
automatically:

 % D   is replaced by the system's DNS domain name at the time the  certificate signing 

request  (CSR) is created. Example:  @% D   will be changed into  @ igel.de if the 

system's current DNS domain name is  igel.de .

 %%  will be replaced by  %. Example:  A  %% B  will be changed into  A  % B .

 Other combinations with  %  are currently discarded. Example:  A  % BC  will be changed 

into  A  C .

Organizational unit

If you have to specify the suffix manually, make sure you enter the separator.

You can configure 4 additional Subject Alternative Names (SANs) in the Certificate Signing Request (CSR) 
using the following registry keys:
CommonName/SubjectAltName (+N)
| Registry | network.scepclient.cert%.subjectaltname_otherN  |
Type of CommonName/SubjectAltName (+N)
| Registry | network.scepclient.cert%.subjectaltname_otherN_type  |
CommonName/SubjectAltName Suffix (+N)
| Registry | network.scepclient.cert%.subjectaltname_otherN_suffix  |
N refers to a slot number in the range {1, 2, 3 ,4}. The slot is ignored if 
network.scepclient.cert%.subjectaltname_otherN_type is set to none.
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Stipulated by the certification authority

 

Organization

A freely definable designation for the organization to which the client belongs

 

Locality

Details regarding the device’s locality. Example: "Augsburg".

 

State

Details regarding the device’s locality. Example: "Bayern".

 

Country

Two-digit ISO 3166-1 country code. Example: "DE".

 

RSA key length (bits)

Defines the key length (one suited to the certification authority) for the certificate that is to be issued.
Possible values:

 1024
 2048
 4096

The RSA key length specified here must not be lower than the minimum key length configured on the 
server.
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Certification Authority Configuration in IGEL OS12
This article shows how to configure the details of the certification authority in IGEL OS. If the CA certificate 
fingerprint is specified, the client will use it to check the integrity of the CA certificate it receives from the SCEP 
server.

Menu path: Network > SCEP Client (NDES) > Certification Authority

The details for the following fields can be obtained from the certification authority:

CA identifier

FQDN (Fully Qualified Domain Name) of the CA

CA certificate fingerprint (MD5)

MD5 fingerprint of the root certificate in the form 
01:02:03:04:05:06:07:08:09:0A:0B:0C:0D:0E:0F:10

You can get the fingerprint from your NDES server: https://<NDES Servername>/certsrv/

mscep_admin
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VPN Settings in IGEL OS 12
Remote users securely access company networks via virtual private network (VPN) protocols. This article shows 
how to configure the tray icon, the context menu, and the dialog window for VPN in IGEL OS.

Menu path: Network > VPN

Enable tray icon

 A tray icon for the network interface will be shown. (Default)

Enable context menu

 A context menu will be shown when you click on the tray icon. (Default)

Enable network info dialog

 A dialog window with information regarding the network connection will be shown when you click on the 
context menu. (Default)
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 OpenVPN in IGEL OS 12 (see page 191)
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OpenVPN in IGEL OS 12
The OpenVPN client puts in place a virtual private network using TLS encryption and requires OpenVPN 2.x as a VPN 
server. This article shows how to configure OpenVPN connection in IGEL OS. 

Menu path: Network > VPN > OpenVPN

Enable autostart during boot

 Autostart will be enabled for the session selected under Autostart session ID.

☐ Autostart is disabled. (Default)

Restart connection when disconnected

 The connection is restarted automatically when a disconnect occurs.

If problems occur with OpenVPN, read the  /var/log/syslog  file with the System Log Viewer. For 
more information, see System Log Viewer in IGEL OS 1247.

47. https://kb.igel.com/en/igel-os-base-system/12.6.1/system-log-viewer-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/12.6.1/system-log-viewer-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/12.6.1/system-log-viewer-in-igel-os-12
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☐ The connection is not restarted automatically when a disconnect occurs. (Default)

Autostart session ID

Select the desired session from the list of OpenVPN sessions to enable this connection to be established during the 
boot procedure.

To manage the list of OpenVPN sessions, proceed as follows:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   opens the configuration pages for the OpenVPN session.

OpenVPN Session Configuration

Menu path: Network > VPN > OpenVPN > [OpenVPN Session Name]
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Session name: Name for the session.

Starting Methods for Session

Start menu

 The session can be launched from the start menu.

Menu folder

If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be 
created for the session. The menu path will be used in the start menu and in the desktop context menu.

Start menu's system tab

 The session can be launched with the start menu's system tab.

Application Launcher

 The session can be launched with the Application Launcher.

Application Launcher folder

If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be 
created for the session. The menu path will be used in the Application Launcher.

Desktop

 The session can be launched with a program launcher on the desktop.

Desktop folder

If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be 
created for the session. The menu path will be used for the program launcher on the desktop.

Desktop context menu

 The session can be launched with the desktop context menu.

Quick start panel

 The session can be launched with the quick start panel.

The session name must not contain any of these characters:  \ / : * ? “ < > | [ ] { } ( )
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Password protection

Specifies which password will be requested when launching the session.

Possible values:

 None: No password is requested when launching the session.
 Administrator: The administrator password is requested when launching the session.
 User: The user password is requested when launching the session.
 Setup user: The setup user password is requested when launching the session.

Hotkey Configuration

Hotkey

 The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers

A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/combination or 
your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

 (No modifier) =  None

   =  Shift
 [Ctrl] =  Ctrl

   =  Mod4

 [Alt] =  Alt

Key combinations are formed as follows with  | :

Password protection only works if the selected password is configured under Security > Password. 
Without the password configuration, the session will launch without requesting a password. For more 
information, see Password and User Types in IGEL OS 12 (see page 241) .

Do not use [AltGr] as a modifier (represented as  Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".

When this keyboard key is used as a modifier, it is represented as  Mod4 ; when it is used as a key, it 

is represented as  Super_L .
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 Ctrl +    =  Ctrl|Super_L

Key

Key for the hotkey

 IPv4 Settings for OpenVPN in IGEL OS 12 (see page 196)
 Options for OpenVPN in IGEL OS12 (see page 198)
 Proxy (see page 201)
 Network Route in IGEL OS 12 (see page 203)
 OpenVPN Session in IGEL OS12 (see page 205)
 TLS-Options (see page 209)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on 
as  user  and enter  xev -event keyboard . Press the key to be used for the hotkey. The text in 

brackets that begins with  keysym  contains the key symbol for the Key field. 

Example:  Tab  in  (keysym 0xff09, Tab)
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IPv4 Settings for OpenVPN in IGEL OS 12

This article shows how to configure DNS and routing settings for OpenVPN connections in IGEL OS. By default, 
OpenVPN uses the server’s DNS and routing settings. 

Menu path: Network > VPN > OpenVPN > [OpenVPN Connection] > IPv4

Automatic DNS

 The nameserver(s) will be carried over by the OpenVPN server. (Default)

☐ The nameserver(s) specified under Extra nameserver(s) will be used.

Extra nameserver(s)

One or more nameservers, IP addresses separated by commas.

Extra search domains

One or more search domains, separated by commas.
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Automatic routes

 The routing table will be carried over by the OpenVPN server. (Default)

☐ Extra routes will be configured.

VPN is the default route

 All the traffic is routed through the VPN by default. (Default)

☐ Extra routes will be configured.

For details on extra route configuration, see Network Route in IGEL OS 12 (see page 203) .
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Options for OpenVPN in IGEL OS12

This article shows how to configure the options for the OpenVPN client in IGEL OS in order to ensure interaction 
with the server.

Menu path: Network > VPN > OpenVPN > [OpenVPN Connection] > Options

Gateway port

Local gateway port. (Default: 1194)

Further information regarding the options can be found in the OpenVPN documentation48 which is 
maintained by the OpenVPN project.

48. https://openvpn.net/index.php/open-source/documentation.html

https://openvpn.net/index.php/open-source/documentation.html
https://openvpn.net/index.php/open-source/documentation.html
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Custom renegotiation interval

Renegotiate data channel key after given number of seconds. (Default: 0)

Use LZO data compression

 The client will use LZO compression. Necessary if the server uses compression.

☐ The client will not use LZO compression. (Default)

Protocol used for communication to the host

 UDP: UDP will be used. (Default)
 TCP-client: TCP will be used.

Virtual network type

 TUN: Routing will be used. (Default)
 TAP: Bridging will be used.

Use custom tunnel Maximum Transmission Unit (MTU)

The MTU of the TUN device will be used as a given value. The MTU of the interface will be derived from it.

UDP fragment size

Allow internal data fragmenting up to this size in bytes. Leave this field empty to keep the default value.

Restrict tunnel TCP Maximum Segment Size (MSS)

 The TCP segment size (MSS) of the tunnel will be restricted.

☐ The TCP segment size (MSS) will not be restricted. (Default)

Randomize remote hosts

 The remote gateways will be ordered randomly as a simple type of load balancing.

If establishing a tunnel fails, try again with Use LZO data compression enabled.

The --comp-lzo option is considered deprecated from OpenVPN v2.4 and should not be used any more.
For more information, see https://community.openvpn.net/openvpn/wiki/DeprecatedOptions#Option:--
comp-lzoStatus:Pendingremoval.

If you use a proxy, select TCP-client.

https://community.openvpn.net/openvpn/wiki/DeprecatedOptions#Option:--comp-lzoStatus:Pendingremoval
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☐ The remote computers will not be ordered randomly. (Default)

Cipher

Encryption algorithm for data packets. (Default: BF-CBC - Blowfish in the Cipher Block Chaining Mode)

HMAC authentication

Hashing algorithm for packet authentication (Default: SHA1)
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Proxy

This article shows how to set up an optional proxy server for the VPN connection in IGEL OS.

Menu path: Network > VPN > OpenVPN > [OpenVPN Connection] > Proxy

Proxy type

 None: Direct connection to the Internet. (Default)
 HTTP: HTTP proxy will be used.
 SOCKS: SOCKS proxy will be used.

If you use a proxy, set the Communication protocol to the host as tcp-client under OpenVPN > 
[OpenVPN Connection] > Options. For detailed information on options settings, see Options for OpenVPN 
in IGEL OS12 (see page 198).



Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   202 / 691

Proxy address

Name or IP address of the proxy server

Proxy port

Port on which the proxy service is available

Retry indefinitely when errors occur

 In the event of errors, repeated attempts to establish a connection via proxy will be made.

☐ No further attempts to establish a connection will be made. (Default)

The following credentials are for the HTTP proxy type:

Proxy user name

User name for the proxy server

Proxy password

Password for the proxy server
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Network Route in IGEL OS 12

This article shows how to configure extra routes for the network in IGEL OS.

Menu path: Network > VPN > OpenVPN > [OpenVPN Connection] > Route [0,1,2]

Enable

 This route is enabled.

☐ This route is not enabled. (Default)

Network route / Host route

 Network route: The routing relates to a (sub) network. (Default)
 Host route: The routing relates to the address of a computer.

Network/Host IP

The address of the network (for a network route) or the IP address or the name of the host (for a host route).
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Network mask

Mask for the desired IP range, e.g. 255.255.255.0

Gateway

Gateway that routes the packets to the target network.

Metric

The numerical quality assessment for routing decisions, 0 is the best value.



Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   205 / 691

OpenVPN Session in IGEL OS12

This article shows how to configure the authentication of the OpenVPN session in IGEL OS.

Menu path: Network > VPN > OpenVPN > [OpenVPN Connection] > Session

OpenVPN server(s)

Name or public IP address of the OpenVPN server. You can enter multiple values separated by commas.

Authentication type

 TLS-Certificates: Authentication with user certificate and private key.
 Name/Password: Authentication with user name and password.
 Name/Password with TLS-Certificates: Combines name/password with user certificate.
 Static Key: Authentication with a private key. No PKI infrastructure is needed for this.
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TLS Certificates Authentication Type

Client certificate file

File with the client certificate. Enter a path relative to  /wfs/OpenVPN .

CA certificate file

File with the CA certificate. Enter a path relative to  /wfs/OpenVPN .

Private key file

File with the private key. Enter a path relative to  /wfs/OpenVPN .

Private key password

Password in case one is set for the private key.

Name/Password Authentication Type

User name

User name - if you leave this field empty, the user will be asked for it when establishing a connection.

Password required

 The user must enter a password. (Default)

Password

Password - if you leave this field empty, the user will be asked for it when establishing a connection.

Persistent storage of files is possible in the folder  /wfs  resp. subfolders of  /wfs  only.
Files stored under other paths will be lost when the device is rebooted.

If you have a PKCS#12 file which contains the client certificate, CA certificate and private key, always enter 
its name in the three file fields. The advantage lies in the fact that only a single file needs to be distributed.

When you leave the Private key password option empty, a password dialog pops up when you start your 
openvpn session to enter the password. On versions below OS 12.4.0, the password dialog only works for 
keys based on RSA. Starting from OS version 12.4.0, EC keys are also supported.
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CA certificate file

File with the CA certificate. Enter a path relative to  /wfs/OpenVPN .

Name/Password with TLS-Certificates Authentication Type

User name

User name - if you leave this field empty, the user will be asked for it when establishing a connection.

Password required

 The user must enter a password. (Default)

Password

Password - if you leave this field empty, the user will be asked for it when establishing a connection.

Client certificate file

File with the user certificate. Enter a path relative to  /wfs/OpenVPN .

CA certificate file

File with the CA certificate. Enter a path relative to  /wfs/OpenVPN .

Private key file

File with the private key. Enter a path relative to  /wfs/OpenVPN .

Private key password

Password in case one is set for the private key.

Static Key Authentication Type

Private key file

File with the static key. Enter a path relative to  /wfs/OpenVPN .

Key Direction

 None: No key direction. (Default)

If you have a PKCS#12 file which contains the user certificate, CA certificate and private key, always enter 
its name in the three file fields. The advantage lies in the fact that only a single file needs to be distributed.
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 0: If the default option is not used, one side of the connection should use Direction 0 and the other 
Direction 1.

 1: If the default option is not used, one side of the connection should use Direction 0 and the other 
Direction 1.

Remote IP address

The VPN IP address of the server

Local IP address

The VPN IP address of the client
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TLS-Options

Transport Layer Security (TLS) is the successor to Secure Sockets Layer (SSL). It is a standard consisting of several 
protocols that can transmit encrypted data between authenticated communication partners over potentially 
insecure IP networks such as the Internet. This article shows how to configure TLS options for the OpenVPN 
protocol in IGEL OS.

Menu path: Network > VPN > OpenVPN > [OpenVPN Connection] > TLS-Options

Subject match

The Subject Match accept/reject the server connection based on a custom test of the server certificate's embedded 
X509 subject details. The formatting of these fields changed into a more standardized format: C= US , 

L= Somewhere , CN= JohnDoe , emailAddress= john@example.com .

For more information, see the Reference manual for OpenVPN 2.649.

Remote peer certificate TLS type

Require that peer certificate was signed with an explicit key usage and extended key usage based on RFC3280 TLS 
rules.

49. https://openvpn.net/community-resources/reference-manual-for-openvpn-2-6//

https://openvpn.net/community-resources/reference-manual-for-openvpn-2-6//
https://openvpn.net/community-resources/reference-manual-for-openvpn-2-6//
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This is a useful security option for clients, to ensure that the host they connect to is a designated server. Or the 
other way around; for a server to verify that only hosts with a client certificate can connect.

 Do not verify: No remote certificate check. (Default)
 Check for server certificate: The --remote-cert-tls server option is equivalent to --remote-cert-

ku --remote-cert-eku "TLS Web Server Authentication".
 Check for client certificate: The --remote-cert-tls client option is equivalent to --remote-cert-

ku --remote-cert-eku "TLS Web Client Authentication".

Key file for additional TLS authentication

As the path enter relative to  /wfs/OpenVPN  or select using the file selection. This adds an additional HMAC 
legitimization level above the TLS control channel in order to prevent DDOS attacks.

tls-auth (Key Direction) / tls-crypt

 None: No key direction. (Default)
 tls-auth 0: If the default option is not used, one side of the connection should use Direction 0 and 

the other Direction 1.
 tls-auth 1: If the default option is not used, one side of the connection should use Direction 0 and 

the other Direction 1.
 tls-crypt: In contrast to tls-auth, setting a key direction is not required. Use this option if the 

version of the OpenVPN server is 2.4 or higher. For more information on tls-crypt, see Reference 
manual for OpenVPN 2.650.

This is an important security precaution to protect against a man-in-the-middle attack, where an 
authorized client attempts to connect to another client by impersonating the server. The attack is easily 
prevented by having clients verify the server certificate using any one of --remote-cert-tls, --verify-x509-
name, or --tls-verify.

50. https://openvpn.net/community-resources/reference-manual-for-openvpn-2-6//

https://openvpn.net/community-resources/reference-manual-for-openvpn-2-6//
https://openvpn.net/community-resources/reference-manual-for-openvpn-2-6//
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Proxy Configuration in IGEL OS 12
This article shows how to select the communication protocols for which a system-wide proxy server is to be used in 
IGEL OS.

Menu path: Network > Proxy

System-wide proxy configuration

Possible options:

 Direct connection to the Internet (Default)

The endpoint device is directly connected to the Internet. No proxy is used.

 Manual proxy configuration

You can configure one or more proxies in the fields from FTP proxy up to SOCKS protocol version, see 
Manual Proxy (see page 211).

 Automatic proxy configuration

The proxy settings are dynamically retrieved via a PAC file (Proxy Auto Config) that you specify under URL, see 
Automatic Proxy (see page 213). For more information on PAC, see e.g. https://en.wikipedia.org/wiki/Proxy_auto-
config. If no PAC file can be obtained or no proxy is reachable, a direct connection to the internet is attempted.

Manual Proxy Configuration
FTP proxy / Port

FTP proxy server and port

HTTP proxy / Port

https://en.wikipedia.org/wiki/Proxy_auto-config


Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   212 / 691

HTTP proxy server and port

SSL proxy / Port

SSL proxy server and port

SOCKS host / Port

Socks proxy server and port

SOCKS protocol version

Selects the SOCKS protocol version. (Default: SOCKS v5)

No proxy for

List of computers to which the endpoint device is to connect directly, separated by commas. 
(Default: localhost,127.0.0.1)

Proxy realm for browser

Area in which the browser authenticates itself for the proxy. Together with the user name and password, this 
information is necessary for authentication.

Authentication at proxy (NTLM/HTTP Basic)

IGEL OS supports NTLM and HTTP Basic authentication at the proxy using the below parameters.

Use passthrough authentication

 The logon information saved temporarily when logging on to the OS 12 device will be carried over when logging 
on to the proxy.

☐ The login information entered under User name and Password will be used to log in to the proxy server. 
(Default)

User name

User name with which the system authenticates itself for the proxy.

Password

Password with which the system authenticates itself for the proxy.

Allow HTTP Basic authentication

Please note that the password is sent to the proxy unencrypted if HTTP Basic encryption is used.
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 Authentication via HTTP Basic is allowed.

☐ Authentication via HTTP Basic is disallowed. (Default)

Automatic Proxy Configuration
URL

URL of the PAC file for automatic proxy configuration

No Proxy for

List of computers to which the endpoint device is to connect directly, separated by commas. 
(Default: localhost,127.0.0.1)

Proxy realm for browser

Area in which the browser authenticates itself for the proxy. Together with the user name and password, this 
information is necessary for authentication.

Authentication at proxy (NTLM/HTTP Basic)

IGEL OS supports NTLM and HTTP Basic authentication at the proxy using the below parameters.

Use passthrough authentication

 The logon information saved temporarily when logging on to the OS 12 device will be carried over when logging 
on to the proxy.

☐ The login information entered under User name and Password will be used to log in to the proxy server. 
(Default)

User name

User name with which the system authenticates itself for the proxy.

Password

Password with which the system authenticates itself for the proxy.

Allow HTTP Basic authentication

This field can be left blank for Web Proxy Auto-Discovery (WPAD) via DHCP and well known URLs.

Please note that the password is sent to the proxy unencrypted if HTTP Basic encryption is used.
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 Authentication via HTTP Basic is allowed.

☐ Authentication via HTTP Basic is disallowed. (Default)
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Devices in IGEL OS12
In this chapter, you find information on the configuration of devices in IGEL OS.

 Hardware Info (see page 216)
 Storage Devices (see page 217)
 Bluetooth in IGEL OS 12 (see page 226)
 USB Access Control in IGEL OS 12 (see page 227)
 Audio in IGEL OS 12 (see page 231)
 Webcam Information in IGEL OS 12 (see page 233)
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Hardware Info
The Hardware info button provides quick access to information about the endpoint device and the connected 
devices.

Menu path: Devices > Hardware Info

->Click Hardware info to view information on the used hardware in the System Information dialog.
For more information on the dialog, see System Information (see page 26).

The page is only available locally on the device in the IGEL Setup. In order to access the page from the 
UMS, you need to shadow the device. For detailed information on shadowing, see Shadow Settings in IGEL 
OS 12 (see page 291) and Universal Management Suite > UMS Reference Manual > Devices - Managing Devices in 
the IGEL UMS > Shadowing - Observe IGEL OS Desktop via VNC.
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Storage Devices
The Show attached storage devices button provides quick access to information about registered storage devices.

Menu path: Devices > Storage Devices

->Click Show attached storage devices to view a list of registered storage devices in the Disk Utility dialog.
For more information on the dialog, see Disk Utility (see page 223).

 Storage Hotplug in IGEL OS 12 (see page 218)
 Options (see page 221)
 Disk Utility (see page 223)
 Safely Remove Hardware in IGEL OS 12 (see page 225)

The page is only available locally on the device in the IGEL Setup. In order to access the page from the 
UMS, you need to shadow the device. For detailed information on shadowing, see Shadow Settings in IGEL 
OS 12 (see page 291) and Universal Management Suite > UMS Reference Manual > Devices - Managing Devices in 
the IGEL UMS > Shadowing - Observe IGEL OS Desktop via VNC.
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Storage Hotplug in IGEL OS 12
This article shows how to set up the connection of hotplug storage devices to the device in IGEL OS. These can be, 
for example, USB mass storage devices or MMC card readers.

Menu path: Devices > Storage Devices > Storage Hotplug

The following file systems are officially supported: 

For related settings options of the Citrix Workspace App, see Configuration of the Citrix Workspace App on 
IGEL OS .
For related settings in the Devices area, see USB Access Control in IGEL OS 12 (see page 227) and Safely 
Remove Hardware in IGEL OS 12 (see page 225) .
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ext2, ext3, ext4 Standard Linux file systems

squashfs a packed read-only file system

vfat supports all FAT variants 

exFAT supports exFAT (found on SDXC SD-cards)

ISO 9660 CDROM/DVD file systems

udf CDROM/DVD file systems

ntfs supported with ntfs-3g (Fuse)

Enable dynamic client drive mapping

Defines the creation of drives in ICA sessions, RDP sessions or Horizon sessions. The mounting of hotplug storage 
devices to the local file system is not influenced by this parameter.

 Drives are created automatically in a session when a hotplug storage device is connected to the device. When 
the device is removed, the corresponding drive is removed automatically.

☐ Drives are not created automatically in a session when a hotplug storage device is connected to the device.

Default permission

Default access rights for hotplug storage devices.
Possible values:

 Read only
 Read/Write (Default)

Before you unplug a hotplug storage device from the endpoint device, you must safely remove it. 
Otherwise, data on the hotplug storage device can be damaged. Depending on the configuration, there are 
several ways to safely remove a hotplug storage device:

 Click   in the task bar. The taskbar can be made available in a full-screen session by 
enabling Taskbar on top of all windows under User Interface > Desktop > Taskbar. For 
more information, see Taskbar Configuration in IGEL OS 12 (see page 107) .  

 Click   in the in-session control bar. Depending on the configuration, the in-session 
control bar may be available in a full-screen session. For further information, see In-
Session Control Bar in IGEL OS 12 (see page 123) .

 Use the Safely Remove Hardware function. The function can be configured 
under Devices > Storage Devices > Safely Remove Hardware. For more information, see 
Safely Remove Hardware in IGEL OS 12 (see page 225) .

If the following warning is displayed: Volume(s) still in use. Don't remove the device., then the hotplug 
storage device must not be removed. First, exit the program concerned or close all files or directories that 
reside on the hotplug storage device.
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Notification

Hotplug beep

 A signal tone will be heard when connecting and disconnecting hotplug storage devices. (Default)

Hotplug message

 Hotplug messages will be shown when connecting and disconnecting hotplug storage devices. (Default)

Timeout

Period of time in seconds after which the window with the hotplug messages is hidden. If the parameter is set to No 
timeout, the window will be shown until it is closed manually. (Default: 15)
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Options
This article shows how to specify a directory in which external storage devices are accessible to the user in IGEL OS. 
The devices are always mounted in the  /media  directory.

Menu path: Devices > Storage Devices > Options

User browse directory

 The directory defined under Browse directory: / is linked to the  /media  directory. (Default)

Browse directory: /
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Local directory in which the devices can be found. (Default:  userhome/media )

Support for built-in floppy drives

 Built-in disk drives are active.

 Built-in disk drives are disabled. (Default)

This option is only valid for drives which are not connected via USB.
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Disk Utility
With the Disk Utility function, you can obtain information regarding the hotplug storage devices connected to your 
endpoint device in IGEL OS. You can also use the function to safely remove hotplug storage devices.

Menu path: Devices > Storage Devices > Disk Utility

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

The Disk Utility function can only be started if the automatic mounting of hotplug storage devices is 
enabled through the Enable dynamic client drive mapping option under Devices > Storage Devices > 
Storage Hotplug.

If the Disk utility in eject menu option is enabled under Devices > Storage Devices > Safely Remove 
Hardware, the Disk Utility can also be started from the context menu of the eject icon in the taskbar.
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Using Disk Utility

→ Start Disk Utility.

To obtain information regarding a hotplug storage device connected to your endpoint device:

→ Select the hotplug storage device in the left-hand column.
The information regarding the hotplug storage device is shown in the right-hand column.

To remove a hotplug storage device safely:

→ Click Safely Remove Hardware in the right-hand column.
The hotplug storage device is disconnected from the endpoint device. Once it has been disconnected, the storage 
device can be removed from the device.

If the Hotplug beep option is enabled under Devices > Storage Devices > Storage Hotplug, a signal tone 
will signal that the device has been disconnected successfully.
If the Hotplug message option is enabled under Devices > Storage Devices > Storage Hotplug, a 
message window will signal that the device has been disconnected successfully.
For more information, see Storage Hotplug in IGEL OS 12 (see page 218).
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Safely Remove Hardware in IGEL OS 12
With the Safely Remove Hardware function, you can remove a hotplug storage device connected to your endpoint 
device safely, without the risk of losing data. This article shows how to configure the starting methods for the 
function in IGEL OS.

Menu path: Devices > Storage Devices > Safely Remove Hardware

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

Disk utility in eject menu

 The Disk Utility can be started from the context menu of the eject icon in the taskbar. (Default)

To start the function, click on  and select Disk Utility. For more information on using the function, see Disk 
Utility (see page 223) .
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Bluetooth in IGEL OS 12
This article shows how to set up a Bluetooth service in IGEL OS. For details on the settings options for Bluetooth 
devices, see Tray Applications in IGEL OS 12 (see page 367) .

Menu path: Devices > Bluetooth

Bluetooth

 The Bluetooth service is active. (Default)

Autopair input devices if no input devices are connected

 If neither a mouse nor a keyboard is connected to the device, autopairing with Bluetooth input devices will be 
attempted. (Default)
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USB Access Control in IGEL OS 12
This article shows how to control USB access to the endpoint device in IGEL OS. You can allow or prohibit the use of 
USB devices on your endpoint. Specific rules for individual devices or device classes are possible.

Menu path: Devices > USB Access Control

Enable

 USB access control is enabled and the following settings can be configured.

☐ USB access control is inactive. (Default)

Default rule

Specifies whether the use of USB devices is allowed or prohibited.

 Allow (Default)
 Deny

Default permission

Default access rights for USB devices.

 Read Only
 Read/Write (Default)

Class Rules
Class rules apply to USB device classes. To manage the list of class rules:

The activation of USB Access Control and setting the Default rule to Deny will block the use of USB 
devices locally and in the session and, thus, might disable devices needed for the users. Therefore, activate 
the USB access control only if your security policy requires that. In this case, set Default rule to Deny and 
configure Allow rules for the required USB devices and USB device classes. 
It is recommended to make settings for USB Access Control as the last step in the device configuration. 
Before activating the USB access control, check that all your other settings for printers, Unified 
Communication, USB redirections, mapping settings for USB devices are working as expected.
Note that the USB access control is completely separate than USB redirection for remote sessions.
Take also notice that the feature does not disable a USB port physically, i.e. power delivery will still work.
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 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   brings up the Add dialogue, where you can define the following settings:

 Rule

Specifies whether the use of the device class defined here is allowed or prohibited.

- Allow 

-Deny (Default)

 Class ID

Device class for which the rule should apply. (Examples: Audio, Printers, Mass Storage).

 Name

Name of the rule

Device Rules
Device rules apply to specific USB devices. To manage the list of device rules:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   brings up the Add dialogue, where you can define the following settings:

 Rule

Specifies whether the use of the device defined here is allowed or prohibited.
-Allow 
-Deny (Default)

 Vendor ID

Hexadecimal ID of the device manufacturer

 Product ID

Hexadecimal ID of the device
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Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see System Information (see page 26).
System Information example:

Alternatively, you can use the command  lsusb  (or  lsusb | grep -i [search term] ) in the 
terminal.
Example for  lsusb :
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 Device UUID

Universal Unique Identifier (UUID) of the device

 Permission

Authorizations for access to the device
Possible values: 

-Global setting: The default setting for hotplug storage devices is used; see the Default 
permission parameter under Devices > Storage Devices > Storage Hotplug. For more information, 
see Storage Hotplug in IGEL OS 12 (see page 218) .

-Read only

-Read/Write

 Name

Name of the rule
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Audio in IGEL OS 12
This article shows how to configure presets for the audio system in IGEL OS. The settings can also be changed using 
the Sound Tray App. For details, see Tray Applications in IGEL OS 12 (see page 367) .

Menu path: Devices > Audio > Options

Use volume setting supplied by UMS

 The settings for the below parameters Mute, PCM volume, Input mute, and Input volume are restored after 
each system restart. The settings set in Sound Preferences or in the taskbar will only remain until system restart. 

☐ The settings set in Sound Preferences or in the taskbar will be restored after system restart. (Default)

Mute

 Audio playback is muted.

☐ Audio playback is on. (Default)

PCM volume

Preset volume in percent. (Default: 50)

Input mute

 The audio input is muted. Sounds from a microphone that are recorded are not transferred to the endpoint 
device.
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☐ The audio input is switched on. Sounds from a microphone that are recorded can be transferred to the endpoint 
device. (Default)

Input volume

Volume of recorded sounds at the audio input device in percent. (Default: 100)

Overamplification
Enable volume overamplification

 Allows to set the volume up to 150%.

☐ The volume cannot be overamplified. (Default)

Enable input volume overamplification

 Allows to set the input volume up to 150%.

☐ The input volume cannot be overamplified. (Default)

Default Sound Output
Default audio output

Name of the output port
Possible options:

 Automatic: The audio output is automatically assigned to a device. Not connected ports will be 
ignored.

 HDMI / DisplayPort
 Speakers
 Headphones

Default Sound Input
Default audio input

Name of the input port
Possible options:

 Automatic: The audio input is automatically assigned to a device. Not connected ports will be 
ignored. The following order applies here:
1. USB devices
2. PCI devices

 Microphone
 Headset microphone
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Webcam Information in IGEL OS 12
With the Webcam Information function, you can select and test a webcam in IGEL OS 12. If required, you can adjust 
the width and height via the command line.

Menu path: Devices > Webcam Information

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

Using Webcam Information

Selecting the Camera

1. Start the Webcam Information tool.
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2. Select the camera you want to use and click OK.

The live image of the selected camera is shown on your device.

You can switch between cameras anytime by clicking on the camera selector.
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Changing the Width and Height

By default, the Webcam Information tool uses the camera’s default width and height.

→ To change the width and height of the camera image, start the program from the command line like this:

qcam -s width=<WIDTH IN PIXELS>,height=<HEIGHT IN PIXELS>

Example:

qcam -s width=800,height=600

You can determine the values supported by the webcam in the local terminal with the 
command  webcam-info -l .

In order to check whether the webcam is functioning in a session (e.g. redirected via Citrix HDX Webcam 
Redirection), open https://www.onlinemictest.com/webcam-test/ in your browser within the session.

https://www.onlinemictest.com/webcam-test/
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Security Configuration in IGEL OS 12
In this chapter, you find information on security configuration in IGEL OS.

 Device Encryption in IGEL OS 12 (see page 237)
 Password and User Types in IGEL OS 12 (see page 241)
 Logon Settings in IGEL OS 12 (see page 246)
 Active Directory/Kerberos (see page 262)
 Smartcard Services in IGEL OS 12 (see page 268)
 Change Password in IGEL OS 12 (see page 270)
 Update (see page 274)
 Certificates Enrolled via the UMS as CA Proxy (see page 275)
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Device Encryption in IGEL OS 12
If you want to strengthen the security of your endpoint device, you can deploy strong device encryption that is 
derived from a user password. The encryption is applied to all partitions that can contain user data, e.g. browser 
history or Custom Partitions.

Menu path: Security > Device Encryption

Device encryption mode

Possible options:

 Keep: The default encryption scheme is maintained. If a password has been set, it will remain 
unchanged. (Default)
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 Activate: The device will be re-encrypted using strong encryption methods when the user enters 
the password for the first time. It is strongly recommended to enforce the use of a strong 
password; see Minimum password length (see page 239) and the subsequent password settings. The 
re-encryption may take about 10 to 60 seconds; the duration depends on the hardware 
performance and the size of the Custom Partition.

 Deactivate: The device will be re-encrypted back to the default device encryption scheme on the 
next boot. The re-encryption may take about 10 to 60 seconds.

Change password

Only applicable if device encryption is activated. Click the button to change the password for device encryption.

Authentication type

Possible options:

 PW: Password only authentication. 
 TPM+PIN: TPM is a physical chip in the device, specifically designed to securely store 

cryptographic keys (and other data). IGEL supports the TPM 2.0 implementation, so the used 
hardware device is also required to support TPM 2.0. If TPM is used then you will need a further 
authentication method in order to finish booting and unencrypting the device. In order to access 
the key in the TPM, the user needs to insert a PIN first.

 TPM PCR: The TPM chip automatically validates the integrity of the hardware. Only supported by a 
few devices.

 TPM PCR+PIN: The above mentioned methods combined.

If you want to switch back to the default device encryption, you must have the password. If the password 
gets lost, you must reinstall IGEL OS on the device, for example, using the OS Creator. For detailed 
instruction, see Installing the Base System via IGEL OS Creator (OSC)51.

Devices That Support TPM PCR
Trusted Platform Module (TPM) Platform Configuration Register (PCR) is only supported by the following 
devices:

 HP t640
 HP t740 (Supported with IGEL OS version 12.7.6 or higher. Downgrades below 12.7.6 are 

not supported.)
 HP t755 (Supported with IGEL OS version 12.7.6 or higher. Downgrades below 12.7.6 are 

not supported.)
 IGEL UD 3 (M350C with Bios version V:3.D.13A-05232022 or higher)
 IGEL UD 7 (H860C with Bios version 3.6.13A-05202022 or higher)

If TPM PCR is selected on a device that does not support it, the authentication type falls back to PW
(password authentication).
If TPM PCR+PIN is selected on a device that does not support it, the authentication type falls back to 
TPM+PIN.

51. https://kb.igel.com/en/how-to-start-with-igel/current/installing-the-base-system-via-igel-os-creator-osc

https://kb.igel.com/en/how-to-start-with-igel/current/installing-the-base-system-via-igel-os-creator-osc
https://kb.igel.com/en/how-to-start-with-igel/current/installing-the-base-system-via-igel-os-creator-osc
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Security level

Possible options:

 Auto, constant-time: The password aggregation function that fits best with the defined Target 
time delay (ms) is selected and the manual selection under Password aggregation function is 
ignored. (Default)

 Auto, at least level: The security level will be at least as high as the value selected by Password 
aggregation function; if the Target time delay (ms) allows for a higher security level, the higher 
security level will be used.

 Manual: The Password aggregation function can be set manually, irrespective of the delay time 
specified by Target time delay (ms).

Target time delay (ms)

Maximum time that should be consumed by the password aggregation function. This delay is effective when the 
user enters the device encryption password on boot or changes the device encryption password. (Default: 700)

Password aggregation function

Security level of the encryption. 
Possible options:

 I: Argon2id, 8M/7 ops
 II: Argon2id, 128M/3 ops (Default)
 III: Argon2id, 256M/3 ops
 IV: Argon2id, 512M/3 ops
 V: Argon2id, 1024M/4 ops
 VI: Argon2id, 128M/4 ops

Minimum password length

Minimum number of characters the password must be composed of. (Default: 8)

Unwanted strings in password (comma separated)

Comma-separated list of strings that must not be in the password

The password must contain

Defines how many of the subsequent minimum requirements (minimum amount of lower case letters, etc.) must be 
fulfilled.
Possible options:

 All (Default)
 2 of
 3 of
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Minimum amount of lower case letters

Defines at least how many lower case letters must be in the password.

Minimum amount of upper case letters

Defines at least how many upper case letters must be in the password.

Minimum amount of numbers

Defines at least how many numbers must be in the password.

Minimum amount of special characters

Defines at least how many special characters must be in the password.

Special characters allowed

Lists all the non-alphanumerical characters without separators that are allowed in the password.
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Password and User Types in IGEL OS 12
The following article provides details on the user types and their roles in IGEL OS. You can configure passwords for 
the user types to protect your endpoint devices against unwanted changes. 

Menu path:  Security > Password

IGEL Setup Password Protection
Configure the administrator password to create the password protection for the IGEL Setup. You can also configure 
the setup administrator and the setup user to allow additional access to the IGEL Setup. For more information, see 
Setup (see page 32) .
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User Rights
The user types have the following access rights:

 Administrator: If configured, the administrator password protects the following critical actions/
areas from unauthorized access:

 IGEL Setup
 Reset to factory defaults boot mode. (For more information, see Boot Menu in IGEL OS 

12 (see page 417) .)
 Accessing the local terminal as root . (For more information, see Terminals in IGEL OS (see 

page 13) .)
 Virtual console access. (For more information, see Access Control to the Display in IGEL OS 

12 (see page 50) .)
 sessions, for which Administrator is set under Password protection. (For more 

information, see Starting Methods for Apps (see page 421) .)

If configured, the administrator can access the following with a password:
 Unlocking the screenlock. (For more information, see Screenloock/Screensaver Options in 

IGEL OS 12 .)
 Secure Shell  (SSH). (For more information, see SSH Access in IGEL OS 12 (see page 288) .)

 Setup administrator : If configured, the setup administrator can access the following with a 
password:

 IGEL Setup

 Setup user : If configured, the setup user can access the following with a password:
 IGEL Setup. (Unlike in OS 11, in OS 12 the Setup User can access all parts of Setup.)
 sessions, for which Setup user is set under Password protection. (For more information, 

see Starting Methods for Apps (see page 421) .)

 User : If configured, the user can access the following with a password:
 the terminal session as user . (For more information, see Terminals in IGEL OS (see page 

13) .)

The assignment of the administrator password is a prerequisite for all other rights assignments. Even if the 
administrator wants to leave the administration of the IGEL Setup to the setup administrator, the 
administrator password must be set.

If you do not configure any password, the IGEL Setup can be opened without password protection.

If you configure a Setup user in OS 12, they have effectively the same Setup permissions as 
the Administrator. This includes running Custom Commands (command execution with 
privilege escalation).
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 sessions, for which User is set under Password protection. (For more information, see 
Starting Methods for Apps (see page 421) .)

 User account for remote access: If configured, the ruser  can access the device via Secure Shell 
 (SSH). (For more information, see SSH Access in IGEL OS 12 (see page 288) .)

Administrator
Use password

 Administrator password protection is enabled and further user types can be configured. The password is set by 
clicking  Set password.

☐  Administrator access is granted without password protection. No password can be configured for the user 
( user ), the setup user, and the setup administrator. (Default)

Change password

Click the button to set a new password.

You can also use the  User password for starting the screenlock:  User Interface > Screenlock / 
Screensaver >   Starting Methods for Session > Password protection. For details, see Screenlock / 
Screensaver in IGEL OS 12 (see page 55) .
However, note the following:  
The  User  is not the same as the local user configured under Security > Logon > Local User. For unlocking 
the screenlock, the local user password (not the user password) is used. For details, see Local User Login in 
IGEL OS 12 (see page 256) and Screenloock/Screensaver Options in IGEL OS 12 .

Effects on local terminal access

Setting an administrator password has the following effects on the access to local terminals:

 For logging in as  root , the administrator password must be entered.

 Logging in as  user   is no longer possible by default. However, you can allow access for  

user    by making the following settings:
 

 Enable the registry key  system.security.usershell   (Default: Disabled).
 Set a user password.

For logging in as  user , the user password will have to be entered.
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Setup Administrator
Setup administrator access

This option is only available if an administrator password is set.

 The setup administrator can access the IGEL Setup with a password. The password is set by clicking  Set 
password.

☐ The setup administrator cannot access the IGEL Setup. (Default)

Change password

Click the button to set a new password.

Setup User
Setup user access

This option is only available if an administrator password is set.

 Setup user password protection is enabled. The password is set by clicking  Set password.

☐ The setup user cannot access the IGEL Setup. Sessions, for which Setup user is set under Password protection
will not have password protection. (Default)

Change password

Click the button to set a new password.

User
Use password

This option is only available if an administrator password is set.

 User password protection is enabled. The password is set by clicking  Set password.

☐ If an administrator password is set, the user ( user ) cannot log in to the device via the local terminal. Sessions, 
for which User is set under Password protection will not have password protection. (Default)

Change password

Click the button to set a new password.

User Account for Remote Access
Enable login

 The remote user ( ruser ) can log in to the device via SSH. (Default)
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☐ Logging in via SSH is not possible.

For further SSH access settings, see SSH Access in IGEL OS 12 (see page 288) .

Use password

 A password is needed to log in via SSH. The password is set by clicking  Set password.

☐ No password is needed to log in via SSH. (Default)

 

Change password

Click the button to set a new password.
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Logon Settings in IGEL OS 12
The following logon settings are available in IGEL OS.

 Taskbar (see page 247)
 Active Directory/Kerberos - Enable Login in IGEL OS 12 (see page 250)
 Single Sign-On in IGEL OS 12 (see page 252)
 Local User Login in IGEL OS 12 (see page 256)
 Guest - Passwordless Access to IGEL OS 12 (see page 258)
 UMS as Identity Broker with IGEL OS 12 (see page 260)
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Taskbar
This article shows how to configure the taskbar for the login dialog and for when the screen is locked in IGEL OS.

Menu path: Security > Logon > Taskbar

Taskbar Settings for the Login Dialog

Show taskbar in login screen

 A taskbar is shown in the login screen. (Default)

Show clock
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 A clock is shown in the taskbar in the login screen. (Default)

Show keyboard layout switcher

 A keyboard layout switcher is shown in the taskbar in the login screen. (Default)

Show on-screen keyboard button

 A button to start an on-screen keyboard is shown in the taskbar in the login screen.

☐ The button is not shown. (Default)

Start on-screen keyboard automatically

 The on-screen keyboard is started automatically with the login screen.

☐ The on-screen keyboard is not started automatically. (Default)

Show reboot button

 Reboot button is shown in the taskbar in the login screen.

☐ The button is not shown. (Default)

Show shutdown button

 Shutdown button is shown in the taskbar in the login screen. (Default)

Taskbar Settings When the Screenlock Is Active

Show taskbar in screenlock

 A taskbar is shown when the screen is locked. (Default)

Show clock

 A clock is shown in the taskbar when the screen is locked. (Default)

Show keyboard layout switcher

 A keyboard layout switcher is shown in the taskbar when the screen is locked. (Default)

Show on-screen keyboard button

 A button to start an on-screen keyboard is shown in the taskbar when the screen is locked.

☐ The button is not shown. (Default)
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Start on-screen keyboard automatically

 The on-screen keyboard is started automatically when the screen is locked.

☐ The on-screen keyboard is not started automatically. (Default)

Show reboot button

 Reboot button is shown in the taskbar when the screen is locked.

☐ The button is not shown. (Default)

Show shutdown button

 Shutdown button is shown in the taskbar when the screen is locked.

☐ The button is not shown. (Default)

Show logoff button

 Logoff button is shown in the taskbar when the screen is locked.

☐ The button is not shown. (Default)
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Active Directory/Kerberos - Enable Login in IGEL OS 12
This article shows how to enable local login to the device via the Kerberos protocol in IGEL OS.

Menu path: Security > Logon > Active Directory/Kerberos

Login to Active Directory domain

 You can log in to the device via Active Directory.

☐ You cannot log in to the device via Active Directory. (Default)

Login Methods

Explicit

 You can log in with a user name and password. (Default)

☐ You cannot log in with a user name and password. If logging in with a smartcard is set up, you can log in with a 
smartcard.

Remember last user name

 The login dialog will be pre-populated with the last user name that logged on. Explicit must be enabled for this.

☐ The login dialog will not be pre-populated. (Default)

Smartcard

 You can log in using a smartcard.

Active Directory/Kerberos must be configured as a prerequisite, see Active Directory/Kerberos (see page 262) .

The login can be used for single sign-on in a number of session types (ICA, RDP).
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☐ You cannot log in using a smartcard. (Default)

Smartcard removal action 

Specifies what action is performed when the smartcard via which the user is logged in is removed.
Possible actions:

 Log out: The user is logged out from the device. (Default)
 Lock device: The screen is locked.

Automatically perform login

 The device performs the login automatically on startup. The credentials provided in Username for autologin
and Password for autologin are used for Microsoft Active Directory (AD).

☐ The login is not performed automatically; a login dialog is displayed.

Username for autologin

The username that is used for automatic login.

Password for autologin

The password that is used for automatic login.

If the login method is configured and the Allow system logoff option is enabled under System > Power 
Options > Shutdown, the user can log off the device through the shutdown menu. For information on how 
to access the shutdown menu, see Commands Session in IGEL OS 12 (see page 125) . For information on how 
to configure the shutdown menu, see Shutdown Settings in IGEL OS 12 (see page 308) .
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Single Sign-On in IGEL OS 12
Single Sign-On (SSO) is an authentication method that can be used via a cloud-based identity provider (IdP) to 
access the local device and apps. This article describes the options used for configuring SSO in IGEL OS.

Menu path: Security > Logon > Single Sign-On

Single Sign-On with identity provider

 SSO is used as the authentication method. 

☐ SSO is not used. (Default)

Identity provider

The identity provider used for the SSO configuration.

Possible options:

 Microsoft Entra ID
 Okta
 OpenID Connect
 Ping Identity | PingOne

See How to Configure Single Sign-On (SSO) on IGEL OS 12 (see page 588) for a detailed description of the 
entire SSO configuration process.

To have a fallback option if something goes wrong with SSO, e.g. a network failure, it is recommended to 
configure local login in addition under Security > Logon > Local User. For more information, see Local 
User Login in IGEL OS 12 (see page 256) .
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 Omnissa Workspace ONE Access

Identity Provider Is Set to "Microsoft Entra ID"

Microsoft Entra ID

The value you have obtained as Directory (tenant) ID in the Microsoft Entra ID Portal.

Application (client) ID

The value you have obtained as Application (client) ID in the Microsoft Entra ID Portal.

Client secret

The client secret that was created in the Microsoft Entra ID Portal. 

Identity Provider Is Set to "Okta"

Okta URL

The URL of the Okta identity provider.

Client ID

The client ID that was created in Okta.

Client secret

This is a value created by the identity provider. The value can be copied from the Identity Provider Admin Console.

Identity Provider Is Set to "OpenID Connect"

This option can be used for various identity providers that support OpenID Connect.

Issuer URL

The URL at the identity provider's site where the OpenID configuration document for your application can be found. 
This is the part of the path that precedes /.well-known/openid-configuration

Client ID

The client ID that is registered in your identity provider.

Client secret

The client secret that has been created by your identity provider.
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Identity Provider Is Set to "Ping Identity | PingOne"

PingOne issuer URL

The URL at the Ping Identity / PingOne site where the OpenID configuration document for your application can be 
found. This is the part of the path that precedes /.well-known/openid-configuration

Client ID 

The client ID that is registered in Ping Identity / PingOne for your application.

Client secret

The client secret that has been created in Ping Identity / PingOne for your application.

Identity Provider Is Set to "Omnissa Workspace ONE Access"

Workspace ONE Access issuer URL

The URL at the Workspace ONE Access site where the OpenID configuration document for your client can be found. 
This is the part of the path that precedes /.well-known/openid-configuration

Client ID

The client ID that is registered in Workspace ONE Access for your client.

Client secret

The client secret that has been created in Workspace ONE Access for your client.

Federated Identity Across IdPs

A federation can be set up between IdPs. For example, if Okta and Microsoft Entra ID are federated, Okta offers 
access/authentication against Microsoft Entra ID and vice versa. In the case of federated IdPs, the login screen 
contains a host that differs from the primary IdP. As IGEL OS only allows the primary IdP by default (e.g. 
“login.microsoftonline.com“), you must explicitly allow any further hosts.

List of allowed hosts for redirection

Hostnames that will be allowed by IGEL OS

Format:

 Only the hostnames (no protocol specification, like “https://”)
 Several entries are separated by semicolons “;”

Example: “login.microsoftonline.com”
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Scopes for OpenID Connect

You can define a list of scopes to which the client will request access. In addition to the standard scopes of OpenID 
Connect, custom scopes can be defined.

OpenID Connect scope

List of OpenID Connect scopes to which the client will request access

Format:

 Space separated list
 US ASCII only, no special characters or spaces within one scope

Example: “openid profile email custom_scope“

Automatic Desktop Login

As an alternative to the interactive desktop login, predefined user credentials can automatically be provided to the 
IdP on startup. The credentials are stored securely on the endpoint device.

Automatic login is available for the following IdPs:

 Okta
 Microsoft Entra ID (formerly known as Microsoft Azure AD)
 Ping Identity | PingOne
 Omnissa Workspace ONE Access

Automatically perform login

 After startup, the endpoint device performs the login automatically using the Username for autologin and the 
Password for autologin.

Username for autologin

The name of a user known to the IdP used.

Password for autologin

The password of the user provided in Username for autologin.

Please be aware that after the automatic desktop login, a fully unlocked desktop session will run on your 
endpoint device. This feature should only be used for use cases where no interactive login is possible. It is 
good practice to restrict this user's access to only the relevant components and data that are necessary for 
the specific use case.
Please also note that Multi-Factor Authentication (MFA) is not possible when automatic login is enabled.
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Local User Login in IGEL OS 12
This article shows how to configure the local login authentication in IGEL OS.

Menu path: Security > Logon > Local User

Login with local user password

 Upon the start of the device, a login screen is shown and authentication with a local user password is required. 
The password specified under Password is deployed to log in.

☐ No authentication is required upon device startup. (Default)

Password

The password deployed to log in. This password is also required for unlocking the screen if the Require password 
to unlock (screenlock) option is enabled under User Interface > Screenlock / Screensaver > Options. For more 
information, see Screenloock/Screensaver Options in IGEL OS 12 .

If several login methods are enabled, the login method can be selected on the login screen.
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If the login method is configured and the Allow system logoff option is enabled under System > Power 
Options > Shutdown, the user can log off the device through the shutdown menu. For information on how 
to access the shutdown menu, see Commands Session in IGEL OS 12 (see page 125) . For information on how 
to configure the shutdown menu, see Shutdown Settings in IGEL OS 12 (see page 308).
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Guest - Passwordless Access to IGEL OS 12
This article shows how to configure a passwordless guest user with limited access to applications in IGEL OS.

Menu path: Security > Logon > Guest

Login as guest

If several login methods are enabled, the login method can be selected on the login screen:
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 Pre-configured sessions can be accessed without a password through the guest user.

☐ The guest user is disabled. (Default)

Configuring Access for the Guest User

Each session can be made available for the normal user, the guest user, or both through the Registry parameters:

 sessions.<instance>.login_method
 app.<app-name>.sessions.<instance>.login_method

By default, all the sessions are available for the normal user only.

→ To configure access for passwordless guest login, choose applications which should be available in a guest 
session by setting the above parameters to Guest or All.

On command-line use nodelist sessions  to get a currently defined list of sessions.
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UMS as Identity Broker with IGEL OS 12
You can use the IGEL Universal Management Suite (UMS) as identity broker for IGEL OS 12 devices. With this 
configuration, the user can log in to the IGEL OS device using the company Active Directory (AD) credentials even if 
they are outside of the company network. The device then reaches out to the UMS and authenticates through the 
UMS itself.

For details on how to configure the UMS as Identity Broker, see How to Configure IGEL UMS As Identity Broker52 .

Menu path: Security > Logon > UMS as Identity Browser

Login with UMS as Identity Broker

Users can authenticate through AD credentials on the IGEL OS device.
Users cannot authenticate. (Default)

The user can change the AD password from the IGEL OS 12 device, as described in Change Password in 
IGEL OS 12 (see page 270) .

This authentication method can also be used for SSO, for example, in an IGEL Remote Desktop session. For 
details, see Configuration of IGEL Remote Desktop on IGEL OS53 .

Once the UMS is configured as identity broker, the user of the OS device can change the AD password as 
described in Change Password in IGEL OS 12 (see page 270) .

52. https://kb.igel.com/en/universal-management-suite/12.07.100/how-to-configure-igel-ums-as-identity-broker
53. https://kb.igel.com/en/igel-apps/current/configuration-of-igel-remote-desktop-on-igel-os

https://kb.igel.com/en/universal-management-suite/12.07.100/how-to-configure-igel-ums-as-identity-broker
https://kb.igel.com/en/igel-apps/current/configuration-of-igel-remote-desktop-on-igel-os
https://kb.igel.com/en/universal-management-suite/12.07.100/how-to-configure-igel-ums-as-identity-broker
https://kb.igel.com/en/igel-apps/current/configuration-of-igel-remote-desktop-on-igel-os
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Skip UMS as Identity Broker if UMS server is unavailable

When the UMS server is not available, the user can log in via Active Directory/Kerberos. In order to 
do this, logging in via Active Directory/Kerberos must be configured; further information can be 
found under Active Directory/Kerberos - Enable Login in IGEL OS 12 (see page 250) .
The authentication is not skipped. (Default)

Remember last user name

The login dialog will be pre-populated with the last user name that logged in. The user only needs 
to provide the password to log in.
No pre-populated user name is offered in the login dialog. (Default)

Automatically perform login

After boot, the device automatically logs in with the credentials defined under Username for 
autologin and Password for autologin.
The login is not performed automatically; a login dialog is displayed. (Default)

Username for autologin

The username that is used for automatic login.

Password for autologin

The password that is used for automatic login.
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Active Directory/Kerberos
This article shows how to configure the options for Active Directory with Kerberos in IGEL OS.

Menu path: Security > Active Directory/Kerberos

Enable

 The Kerberos basic configuration will be carried out.

☐ The Kerberos basic configuration will not be carried out. (Default)

Default domain (fully qualified domain name)
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This value must match the Windows domain on which the logon is to take place. The value must be entered in 
upper case letters. e.g.  EXAMPLE.COM .

DNS lookup for domain controller

 In order to find the Key Distribution Centers (KDCs, domain controllers) and other servers for a realm, if they are 
not explicitly indicated, DNS SRV records are used. (Default)

☐ The KDCs entered under Security > Active Directory/Kerberos > Domain 1 ... Domain 4 will be used.

DNS lookup for domain

 In order to determine the Kerberos realm of a host, DNS TXT records are used. (Default)

☐ The details under Setup > Security > Active Directory/Kerberos > Domain Realm Mapping are used.

Obtain Addressless Tickets

 The first Kerberos ticket is addressless. This may be necessary if the client is located behind an Network Address 
Translation (NAT) device. (Default)

 Domain Configuration for Active Directory/Kerberos in IGEL OS 12 (see page 264)
 Domain Realm Mapping in IGEL OS 12 (see page 266)
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Domain Configuration for Active Directory/Kerberos in IGEL OS 12
This article shows how to configure domains for the Active Directory/Kerberos configuration in IGEL OS. Up to four 
domains can be configured.

Menu path: Security > Active Directory/Kerberos > Domain [1-4]

Fully qualified domain name

Name of the domain

Domain Controller List
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To manage the list of domain controllers:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

To configure a domain, proceed as follows:

1. Under Fully qualified domain name, give the name of the domain (Kerberos realm).

2. Click   to create a new entry.
3. Under Domain Controller, give the name or IP address of the domain controller (Kerberos Key 

Distribution Center). A port number can be added to the host name; the port name must be 
preceded by a colon.

4. Click Confirm.
The domain controller will be added to the Domain Controller List.
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Domain Realm Mapping in IGEL OS 12
With domain realm assignment, a host name is translated into the corresponding Kerberos realm name. This article 
shows how to configure domain realm mapping in IGEL OS.

Menu path: Security > Active Directory/Kerberos > Domain Realm Mapping

Use default DNS domain - Active Directory domain mapping

 The DNS name and Active Directory domain name match. (Default)

☐ DNS name and Active Directory domain name assignments must be set up.
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Domain Realm Mapping

To manage the list of realm mappings:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

To set up a DNS name to Active Directory domain name assignment proceed as follows:

1. Click    to create a new entry.
The Add dialog is displayed.

2. Under DNS host or domain name, enter the lower case FQDN name of a host or a domain that is 
to be assigned to an Active Directory domain name. Example: .example.com

3. Under Active Directory domain name, enter the Active Directory domain name that is to be 
assigned to the host name.

4. Click Confirm.
The data entered will be added to the Domain Realm Mapping list.
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Smartcard Services in IGEL OS 12
Smartcard services need to be configured in order to use smartcard readers. This article shows the settings options 
of smartcard services in IGEL OS.

Menu path: Security > Smartcard > Services

Activate PC/SC daemon

You will find a list of supported smartcard readers in the https://www.igel.com/ready/showcase-
categories/security/.

https://www.igel.com/ready/showcase-categories/security/
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The PC/SC daemon enables the smartcard reader to connect to the device, so that the smartcard is available to an 
application. This can be a server-side application where data is forwarded via an RDP or ICA connection or a local 
application, e.g. the browser.

 The PC/SC service is enabled. The card reader is available for applications. (Default)

☐ The PC/SC service is disabled. The card reader is not available.

PC/SC devices

List of smartcard readers currently connected to the device. Internal smartcard readers and a variety of USB 
smartcard readers are supported.

Refresh device list

Click the button to refresh the list of available PS/SC devices.
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Change Password in IGEL OS 12
This article shows how to set up and use the Change Password function in IGEL OS.

Menu path: Security > Change Password

With this function, the user can change the password or PIN for the login method he used for the last login, provided 
one of the following login methods was used:

 Active Directory with username and password
 Active Directory with third-party smartcard
 Local user password
 Active Directory with UMS as identity broker

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

If autostart is enabled in the starting methods, the Change Password function is presented after login.

When the AD/Kerberos password is about to expire, a dialog is presented after login to inform the user 
about the required password change. When the user clicks the password change button in this dialog, the 
Change Password function starts automatically.
If the password is already expired when the user tries to log in, the user is required to change the password 
in the login dialog. After entering the new password, the password gets changed and the user is logged in.
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Using Change Password
To change your password for your current login method, proceed as follows:

1. Start the Change Password function in one of the configured ways, for example, through a 
desktop icon, or through the start menu.
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2. Enter the old and new password or PIN in the dialog. The dialog differs according to the login 
method that is currently used.
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3. Click OK.
If the password change is successful, a confirmation dialog is shown.
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Update
This article shows how to enable local app installation in IGEL OS. For more information on local app installation, 
see Installing IGEL OS Apps Locally on the Device54. For more information on app updates, see Update - App Update 
Settings in IGEL OS 1255.

Menu path: Security > Update

Permit local app installation

 Enables the local app portal and the installation of apps by the user. (Default)

54. https://kb.igel.com/en/how-to-start-with-igel/current/installing-igel-os-apps-locally-on-the-device
55. https://kb.igel.com/en/igel-os-base-system/current/update-app-update-settings-in-igel-os-12

https://kb.igel.com/en/how-to-start-with-igel/current/installing-igel-os-apps-locally-on-the-device
https://kb.igel.com/en/igel-os-base-system/current/update-app-update-settings-in-igel-os-12
https://kb.igel.com/en/how-to-start-with-igel/current/installing-igel-os-apps-locally-on-the-device
https://kb.igel.com/en/igel-os-base-system/current/update-app-update-settings-in-igel-os-12
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Certificates Enrolled via the UMS as CA Proxy
With the CA Proxy feature, you can use the IGEL Universal Management Suite (UMS) to enroll endpoint device 
certificates from an external PKI via the EST protocol.

When your UMS is configured as a CA proxy, you can provide the data for the desired certificate here. For details, see 
UMS as a Certificate Authority (CA) Proxy56.

Menu path: Security > Certificates

56. https://kb.igel.com/en/universal-management-suite/current/ums-as-a-certificate-authority-ca-proxy

https://kb.igel.com/en/universal-management-suite/current/ums-as-a-certificate-authority-ca-proxy
https://kb.igel.com/en/universal-management-suite/current/ums-as-a-certificate-authority-ca-proxy
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System Configuration in IGEL OS 12
In this chapter, you find information on system configuration in IGEL OS.

 Time and Date in IGEL OS 12 (see page 277)
 Remote Management in IGEL OS 12 (see page 280)
 Remote Access in IGEL OS 12 (see page 287)
 Logging in IGEL OS 12 (see page 296)
 Power Options in IGEL OS 12 (see page 300)
 System Customization in IGEL OS 12 (see page 311)
 Registry in IGEL OS 12 (see page 356)
 Notification - User Notifications in IGEL OS 12 (see page 359)
 Update - App Update Settings in IGEL OS 12 (see page 361)
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Time and Date in IGEL OS 12
This article shows the time and date settings options in IGEL OS.

Menu path: System > Time and Date

Timezone

Sets the timezone the device is located in.

Timezone systray settings

 You can set the timezone by clicking on the taskbar clock and selecting from the Timezone dropdown menu. 
The taskbar clock can be activated under User Interface > Desktop > Taskbar Items. (Default)
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☐ The Timezone dropdown menu is not available through the taskbar clock. 

Use NTP time server

 The system clock is set via Network Time Protocol (NTP) during boot.

☐ The system clock is not set via NTP. (Default)

NTP time server

IP address or name of the NTP time server. If you would like to enter a list of NTP time servers for redundancy 
purposes, separate the names / IP addresses by spaces.

Manual Date and Time Configuration

Carries over the time and date and sets the hardware clock. Once the date and time is set, click Change date and 
time to save the change.

HW clock timezone

Sets the hardware clock.
Possible options:

 Auto (default)

You can set the date by selecting from the calendar, or using the arrow keys to adjust the date.
You can set the time by typing it in, or using the arrow keys to adjust the time.
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 UTC
 Localtime

IGEL OS and Windows have different default time settings, IGEL OS using UTC and Windows using local 
time. When using IGEL UD Pocket with Windows, this would lead to Windows interpreting the real time 
clock as set to local time and show the wrong time. To avoid this, the Auto setting looks for Windows 
partitions and, if present, assume that Windows is installed and the real time clock is automatically set to 
local time.
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Remote Management in IGEL OS 12
In IGEL OS, endpoint devices are managed using the Universal Management Suite (UMS). This article shows the 
settings related to the remote management, for example, the configuration of UMS servers and user information 
dialogs on UMS updates.

Menu path: System > Remote Management

Universal Management Suite

If the device is registered on a UMS Server, its IP address / hostname and Port number will be shown in the list.

To manage the list of servers:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

The list can contain more than one UMS instance. The device will go through the entries in the list until it 
can contact a UMS Server successfully.
Starting with IGEL OS 12.8.0, the device will only use the DNS entry igelrmserver  during registration 

or as a fallback if no UMS addresses are configured or if contact to igelrmserver  is explicitly enabled 
using the option System > Remote Management > Options > Use "igelrmserver" as fallback.
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Clicking   brings up the Add dialogue, where you can define the following settings:

 UMS server
Name or IP of the UMS Server

 Port number
Port number of the UMS Server (Default: 8443)

 Connector type
The value is automatically defined by the UMS. You can use the Ranking of connectors option 
under System > Remote Management > Options to define which connection the device should 
try to establish first based on the connector types.
Possible values:

 undefined (default)
 ums

Direct connection to the Universal Management Suite.
 icg

Connection to the IGEL Cloud Gateway (ICG).

Display “Apply changes” dialog on boot

If new settings were made in the UMS, the device may receive them during the boot procedure. 

 During the boot procedure, the Apply changes dialog is displayed and the user can decide whether the 
reconfiguration process runs immediately. (Default)

☐ The Apply changes dialog will not be shown. The new settings will be applied or ignored depending on the 
setting under Default action on boot.

Timeout

Number of seconds for which the Apply changes dialog is shown. If the timeout is exceeded, the received settings 
will automatically be applied. (Default: 20)
Setting the value to 0 disables the timeout, and the dialog is shown until the user clicks a button.

Default action on boot

Configure the action that is to be performed if the dialog exceeds the timeout or if the timeout is disabled.
Possible values:

 Apply changed configuration immediately: New settings will take effect immediately, and 
programs that are running may be restarted. (Default)

With the Apply changes dialog the user can only control when the reconfiguration process runs. If the user 
refuses the reconfiguration process, it is delayed till the next system restart. Even if the user refuses the 
reconfiguration, parameter values are always applied.
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 Ignore changed configuration: New settings will not be applied. The new configuration will be 
saved on the device, and applied the next time a new configuration is applied.

Prompt user on UMS actions

 The user is informed through a message window when UMS actions are performed on the device. (Default)

☐ The user is not informed when UMS actions are performed on the device.

Timeout

Number of seconds for which the UMS actions information dialog is shown. If the timeout is exceeded, the received 
settings will automatically be applied. (Default: 20)
Setting the value to 0 disables the timeout, and the dialog is shown until the user clicks on a button.

Structure tag

The structure tag is used to sort the device into a directory in accordance with the UMS directory rules. For details 
see (12.06.100-en) Using Structure Tags with IGEL OS Devices.

Log message severity

Instead of setting the structure tag using this option, the preferable way to manually set the structure tag 
in the OS12 is using the command tool: /sbin/rmagent-set-structure-tag -t <TAG>

Instead of checking the structure tag here, use the command tool /sbin/rmagent-get-

structure-tag  for retrieving of the current value of the structure tag in the OS12. Because if the 
structure tag is set via Setup Assistant or via DHCP tag, the value in the Setup will be empty, but the 
command will always retrieve the value.

The command line tool /sbin/rmagent-register  provides the possibility to set the structure tag 

using the option -u <TAG> . This tool is used for some scenarios of automatic register with custom 
scripts.
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Select the severity level above which device errors are to be transferred to the UMS. Messages with a lower severity 
are suppressed.
Possible options:

 off (Default)
 error
 warn
 info
 debug

Show UMS connection status tray icon on desktop

 The  icon is displayed in the taskbar, showing the status of the UMS connection. Clicking the icon displays 
information about the connected UMS server.



Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   284 / 691

Options of Remote Management in IGEL OS 12
This article shows the configuration of remote management options in IGEL OS 12. 

Menu path: System > Remote Management > Options

Log login and logoff events

Details of logon and logoff events of the following logon types are sent to the UMS:

 Active Directory/Kerberos
 Single Sign-On
 Local User
 Guest User
 UMS Identity Broker

Login and logoff events are not sent to the UMS. (Default)

Delay session start at boot time in order to apply new UMS settings

Events are only logged if the Enable user logon history parameter is enabled in the UMS Console, under 
UMS Administration > Global Configuration > Misc Settings. For more information, see (12.05.100-en) 
Misc Settings in IGEL UMS.

The logged events can be found both in the UMS Console and the UMS Web App. For more information, see 
(12.05.100-en) View Device Information in the IGEL UMS.
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If new settings were made in the UMS, the device may receive them during the boot procedure. After the device 
connects to the UMS at boot time, new settings might be transferred to the device.

The start of the sessions will be delayed until the settings have been transferred or the time limit 
defined under Timeout has been exceeded.
The start of the sessions is not delayed. (Default)

Timeout

Delay in seconds after which the sessions get started during the boot procedure. (Default: 10)

Ranking of connectors

Defines the order in which the device connects to the configured device connectors based on their connector types. 
Connector types are listed in System > Remote Management > Universal Management Suite.
Possible options:

 no preference (default)
The device connects randomly to any configured device connector, regardless of the connector 
type.

 prefer UMS
The device will try to connect to the UMS Servers first (that is, the connections listed with the ums
connector type are contacted first).
The device will only try to connect to an ICG if UMS Servers are not reachable or configured.

 prefer ICG
The device will try to connect to an ICG (that is, the connections listed with the icg connector type 
are contacted first).
The device will only try to connect to a UMS server if no ICG is reachable or configured.

Use "igelrmserver" as fallback

To connect to the UMS, the device will first try to connect through all configured UMS and ICG 
addresses. If those connection do not work and the FQDN of the igelrmserver  can be 
resolved to an IP address, the device will use that as a fallback.
To connect to the UMS, the device will try to connect through all configured UMS and ICG 
addresses. The device will not use the igelrmserver  address as a fallback option. (Default)

Enable IGEL Asset Inventory Tracking (AIT)

Starting from IGEL OS 12.8.0, the DNS entry igelrmserver  is only used during the device registration 
process by default. It can be configured as a fallback if no other UMS addresses are available.

IGEL Asset Inventory Tracking (AIT) has the following requirements:
 Universal Management Suite (UMS) 12.08.100 or later
 Valid Enterprise license
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The endpoint device sends data about all connected USB and Bluetooth devices to the UMS. The 
data is sent if one of the following applies:
- The device boots
- A periphery device is plugged in/off
- The UMS triggers a refresh of the asset information
No data is sent to the UMS.

AIT events delay (secs)

The time delay in seconds after which an event, such as connecting a headset, is communicated to the UMS. This 
can be used to accumulate several events in one message to the UMS, which saves resources: All events that occur 
after an event has started the delay timer and before the delay timer has expired are sent as one message together 
with the first event. If the delay is set to 0, each event is sent immediately in a single message to the UMS:

Possible values: 0 … 180
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Remote Access in IGEL OS 12
To support remote management, the following remote access options can be configured for the device.

 SSH Access in IGEL OS 12 (see page 288)
 Shadow Settings in IGEL OS 12 (see page 291)
 Secure Terminal in IGEL OS 12 (see page 294)
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SSH Access in IGEL OS 12
This article shows how to configure Secure Shell (SSH) access to the device in IGEL OS.

Menu path: System > Remote Access > SSH Access

Enable

 The SSH service is enabled.

☐ The SSH service is disabled. (Default)

If SSH access is enabled, you can configure the following:

Permit empty passwords

 Logging on without a password is allowed.

☐ Logging on without a password is not allowed. (Default)

Permit administrator logon

 Logging on as an administrator is allowed.

☐ Logging on as an administrator is not allowed. (Default)

Port number

Port number for SSH. (Default: 22)

User Access
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List of configured users.

To manage the list:

 User name

Permitted user

 Hostname

Name of the host from which SSH access takes place (example:  xterm.igel.de )

 Deny

 Access is denied.

☐ Access is allowed. (Default)

Permit X11 forwarding

  X11 forwarding is enabled.

☐  X11 forwarding is disabled. (Default)

Applications Access for Remote User “ruser”

The ruser  is not intended for real SSH sessions, but only for starting X applications configured below. By default 

these are  localshell  and  /config/sessions/setup0 .

To manage the list:

 Click   to create a new entry.

 Click   to remove the selected entry.

Unlike root and user, the ruser is not intended for real SSH sessions, but only for starting X applications 
that are listed below under Applications Access for Remote User “ruser”.

For ruser  a password has to be assigned under Security > Password. The names root  and user
work also without passwords. For more information, see Password and User Types in IGEL OS 12 (see page 
241) .

If you try to log on to the device as ruser via SSH, then you will never be able to connect. The connection 
will be closed immediately without anything happening. In this case you must add the parameter "-X" and 
the program to be started in the session call, like in this example: 

ssh -X ruser@192.168.10.203 localshell
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 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   brings up the Add dialogue, where you can define the following settings:

 Command line

Command that is allowed or prohibited for the remote user

 Enable application

 The application given under Command line may be executed by the remote user. (Default)

☐ The application given under Command line may not be executed by the remote user.
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Shadow Settings in IGEL OS 12
IGEL OS offers the ability to observe the endpoint device via shadowing through the IGEL Virtual Network 
Computing (VNC) Viewer in the Universal Management Suite (UMS) or another VNC client (e.g. TightVNC), see 
Universal Management Suite > UMS Reference Manual > Devices - Managing Devices in the IGEL UMS > Shadowing - 
Observe IGEL OS Desktop via VNC. The shadowing of IGEL OS 12 devices through the UMS is always via Unified 
Protocol, i.e. communication is always encrypted. This article shows the settings for configuring the VNC access to 
your devices.

Menu path: System > Remote Access > Shadow

Allow remote shadowing

 Desktop content can be accessed by remote computers with VNC software.

☐ VNC shadowing is not allowed. (Default)

If Allow remote shadowing is activated, you can change the following settings:

Deny shadowing via external VNC tool
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 The device can only be shadowed via the UMS. Shadowing of the device by an external VNC viewer is not 
possible. For details, see Universal Management Suite > UMS Reference Manual > Devices - Managing Devices in the 
IGEL UMS > Shadowing - Observe IGEL OS Desktop via VNC > External VNC Viewer. (Default)

☐ The device can be shadowed by an external VNC viewer, not only the UMS.

Use password

 The remote user is authenticated with a password before shadowing.

☐ The remote user is not authenticated for shadowing. (Default)

Password

Password for the VNC connection

Prompt user to allow remote session

 The local user will be asked for permission before shadowing. (Default)

Allow user to disconnect remote shadowing

 A Disconnect button with which the user can terminate the VNC connection is shown. (Default)

Allow input from remote

 The remote user can make entries using the keyboard and mouse as if they were the local user. (Default)

Scale frame buffer

 The screen content of the shadowed device is reduced or enlarged by the Scale factor before being transferred.

☐ The screen content is transferred in the original size. (Default)

Scale factor

In a number of countries, for example, Germany, unannounced shadowing is prohibited by law. Do not 
disable this option if you are in one of these countries!
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Factor by which the screen content of the shadowed device is enlarged or reduced. Values under 1 reduce the 
content. (Default: 1.0)

Position of the indicator

Defines the position of the popup notification about being shadowed.
Possible options:

 Top right
 Top left
 Bottom left
 Bottom right (Default)

Further parameters for the VNC server on the device are accessible under System > Registry 
> network.vncserver.
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Secure Terminal in IGEL OS 12
This article shows how to enable or disable the secure terminal connection on the endpoint device in IGEL OS.

Menu path: System > Remote Access > Secure Terminal

Secure Terminal

 Secure terminal connection is enabled between the device and the Universal Management Suite (UMS).

☐ Secure terminal connection is disabled between the device and the UMS. (Default)

For information on how to use the secure terminal from the UMS, see Universal Management Suite > UMS Reference 
Manual > Devices - Managing Devices in the IGEL UMS > Accessing Devices via Secure Terminal (Secure Shell) in the IGEL 
UMS.
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You can enable secure terminal connection for all registered devices by activating the Enable secure 
terminal globally option under UMS Console > UMS Administration > Global Configuration > Remote 
Access.

For a list of IGEL specific commands collected by the IGEL Community, see Cheatsheet-IGELCommunity57.

57. https://igel-community.github.io/IGEL-Docs-v02/Docs/Cheatsheet-IGELCommunity/

https://igel-community.github.io/IGEL-Docs-v02/Docs/Cheatsheet-IGELCommunity/
https://igel-community.github.io/IGEL-Docs-v02/Docs/Cheatsheet-IGELCommunity/
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Logging in IGEL OS 12
This article shows the options to configure local and remote logging for the device in IGEL OS. 

Menu path: System > Logging

Local logging

 The log messages are stored locally in  /var/log . The format is human-readable. Log rotation is applied.

☐ The log messages are not stored locally.

You can use the System Log Viewer to access system logs. For more information, see System Log Viewer in 
IGEL OS 12 (see page 34) .
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Persistent log partition

This parameter is effective if Local logging is activated.

 The log messages are stored in a persistent partition on the device. This partition is encrypted.

☐ The log messages are stored in temporary files that are deleted on reboot.

Partition size in MB

Size of the persistent log partition

Remote mode

Possible options:

 Server: The device receives log messages from a remote client.
 Client: The device sends its log messages to a remote server.
 Off: The device does not send or receive any log messages. (Default)

Remote Mode Switched to Server
You can configure the device to act as a syslog server. Other clients can send log files to this server; you can create a 
separate server configuration for each client.

Template for log file storage

Pattern from which the file path for storing the received log messages is created. For example, in  /var/log/

%HOSTNAME%/messages . %HOSTNAME%  is the name of the sender which is configured under Name. 

To manage the Server list:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   brings up the Add dialogue, where you can define the following settings:

 Local port
Port on which the local server listens for log messages

 Transport protocol
Protocol to be used for the transmission of log messages
Possible options:

 TCP (Default)
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 UDP
 Name

Hostname of the sender (optional). This is useful for filtering the log messages based on the clients 
that have sent them.

 Local address

Optional parameter; on multihomed machines (i. e. machines with multiple addresses), this specifies to which 
local address rsyslog is bound. If no address is specified it defaults to  0.0.0.0 , so that rsyslog listens on 
every network interface. For more information, see the official documentation at https://www.rsyslog.com/
doc/v8-stable/configuration/modules/imtcp.html.

Remote Mode Switched to Client
You can configure one or more clients, e.g. one server for kernel messages and another server for authentication 
messages.

To manage the Clients list:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   brings up the Add dialogue, where you can define the following settings:

 Remote address

IP address or hostname of the remote server

 Remote port

Port on which the server listens for log messages

 Transport protocol
Protocol to be used for the transmission of log messages
Possible options:

 TCP (Default)
 UDP

 Syslog facility

Type of program for which log messages are created. (Default: Any)

 Syslog level

Severity level of the event. (Default: Any)

 Syslog style template
Format in which the messages are sent
Possible options:

 RSYSLOG_TraditionalForwardFormat (Default)

https://www.rsyslog.com/doc/v8-stable/configuration/modules/imtcp.html
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 RSYSLOG_ForwardFormat
 RSYSLOG_SyslogProtocol23Format
 RSYSLOG_StdJSONFmt

 TLS enabled

 TLS encryption for the transmission of log messages is enabled.

☐ Transmitted log messages are not encrypted. (Default)

 CA certificate

Path to the local CA root certificate file in PEM format which is used to verify the authenticity of the X.509 
certificate of your log collector and analyzer. If the UMS is used to transfer the certificate file to devices, the 
same path and file name as in the UMS must be entered. Example:  /wfs/ca-certs/ca.pem
For more information, see Logging and Log Evaluation58.

58. https://kb.igel.com/en/security-safety/current/logging-and-log-evaluation

https://kb.igel.com/en/security-safety/current/logging-and-log-evaluation
https://kb.igel.com/en/security-safety/current/logging-and-log-evaluation
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Power Options in IGEL OS 12
The following power option configurations are available in IGEL OS.

 System Power Options in IGEL OS 12 (see page 301)
 Battery Settings in IGEL OS 12 (see page 304)
 Display Power Management in IGEL OS 12 (see page 306)
 Shutdown Settings in IGEL OS 12 (see page 308)
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System Power Options in IGEL OS 12
This article shows how to configure settings for energy saving on your IGEL OS device. You can configure the 
behavior after a time of inactivity and the CPU power plan.

Menu path:  System > Power Options > System

System suspend/shutdown on inactivity

Specify how long the user can be inactive before the system switches to standby mode or shuts down, depending 
on the System action on inactivity setting.
Possible values:

 Default: The same as Never except for factory preloads, where Default is "After 20 mins". 
(Default)

 Never: The system does not switch to standby mode or shut down on inactivity.
 After 1 minute
 ...
 After 24 hours

Display of Energy Star Logo on Selected HP Endpoint Devices

With selected Hewlett-Packard (HP) endpoint devices, the Energy Star certification mark is displayed on 
this Setup page.

A setting of 20 minutes or less is recommended. Otherwise, this may result in increased power 
consumption and shorter battery runtime. A corresponding message is then displayed.
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System action on inactivity

Possible options:

 Suspend: The system is set to standby mode after the timeout defined under System suspend/
shutdown on inactivity. (Default)

 Shutdown: The system is shut down after the timeout defined under System suspend/shutdown 
on inactivity. 

Without dialog

 The user is not asked if the system is to be set to standby mode.

☐ The dialog asking for user confirmation is shown. (Default)

Dialog timeout

Time in seconds, for which the dialog is to be displayed. (Default: 10 seconds)

Plugged In

CPU power plan for AC mode

The CPU power plan (CPU Governor) used in AC mode
Possible options:

 High performance: Full performance with maximum processor speed. (Default)
 Balanced: Slower regulation of performance in a balanced manner according to the demands of 

programs.
 Power saver: Lowest processor speed

Lid close action while plugged in

The action that is performed when the lid of the device gets closed. 

Possible options:

 Suspend: When the lid gets closed, the device goes into suspend mode and applications are 
closed. When the lid is opened again, the device starts, connections are restarted, and re-login is 
required. Applications have to be started manually. (Default)

Changing the default values for the settings described below may result in higher power consumption and 
shorter battery runtime.

You can also use the battery tray app to set the CPU power plan for the current mode in use (AC or battery). 
For details, see Battery Settings in IGEL OS 12 (see page 304) .
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 Turn off display: When the lid gets closed, the internal display is turned off.

On Battery

CPU power plan for battery mode

The CPU power plan (CPU Governor) used in battery mode
Possible options:

 High performance: Full performance with maximum processor speed
 Balanced: Regulation of performance in a balanced manner according to the demands of 

programs. (Default)
 Power saver: Lowest processor speed

Lid close action while not plugged in

The action that is performed when the lid of the device gets closed. 

Possible options:

 Suspend: When the lid gets closed, the device goes into suspend mode and applications are 
closed. When the lid is opened again, the device starts, connections are restarted, and re-login is 
required. Applications have to be started manually. (Default)

 Turn off display: When the lid gets closed, the internal display is turned off.

The suspend action is only performed if there are no external displays connected and 
activated. When an external display is connected and activated, the internal display is turned off, 
and if the internal display was the primary display, a new primary display is assigned.

You can also use the battery tray app to set the CPU power plan for the current mode in use (AC or battery). 
For details, see Battery Settings in IGEL OS 12 (see page 304) .

The suspend action is only performed if there are no external displays connected and enabled. 
When an external display is connected and activated, the internal display is turned off, and if the 
internal display was the primary display, a new primary display is assigned.
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Battery Settings in IGEL OS 12
This article shows battery settings options in IGEL OS.

Menu path: System > Power Options > Battery

Battery Notification

Critical battery level (percentage)

Percentage of remaining battery charge deemed critical. (Default: 5)

Critical battery action

Action to be taken in the event of a critical charge level
Possible options:

 Do nothing
 Show warning (Default)
 Run command
 Run command in terminal
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Critical command

Command that is executed when a critical charge level is reached. (Default: Shutdown)

Low battery level (percentage)

Percentage of remaining battery charge deemed low. (Default: 10)

Low battery action

Action to be taken in the event of a low charge level
Possible options:

 Do nothing
 Show warning (Default)
 Run command
 Run command in terminal

Low command

Command that is executed when a low charge level is reached. (Default: Shutdown)

Battery Tray Icon

Show battery tray icon on desktop

 The battery icon is shown in the taskbar. The icon is dynamic and represents the state of the battery charge. For 

example when the battery is charging: 

Hover over the icon to see information on the charge. Clicking the icon displays the battery tray app. For more 
information on the battery tray app, see Tray Applications in IGEL OS 12 (see page 367) . (Default)



Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   306 / 691

Display Power Management in IGEL OS 12
This article shows how to configure energy-saving stages for the display in IGEL OS.

Menu path: System > Power Options > Display > Power Management / Brightness Reduction

Power Management

Handle display power management

 The DPMS energy saving functions are enabled. (Default)

On Battery / Plugged In

You can select time frames after which energy-saving modes get activated. The time frames are configured 
separately for On Battery and Plugged In use of the device. When Never is selected, the energy-saving mode is 
disabled.
The following energy-saving modes can be configured:

 Standby Time
After this time frame, the device goes to standby mode.

Changing the default settings may result in higher power consumption and shorter battery runtime.

The display must support Display Power Management Signaling (DPMS).
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 Suspend Time
After this time frame, the device goes to sleep mode.

 Off Time
After this time frame, the device turns off.

Brightness Reduction

These settings are relevant for mobile devices resp. for devices with integrated display.

If a device is switched on but not used for some time, energy can be saved by brightness reduction. The values of 
the reduction are configured separately for On Battery and Plugged In use of the device.

On Battery / Plugged In

On inactivity reduce to

The percent value to which the brightness is reduced after a period of inactivity.

Reduce after

The period of inactivity after which brightness is reduced. You can set the period between 10-120 seconds. Setting 
the value to 9 deactivates the reduction.

Chronologically, Standby mode must occur before or simultaneously with Suspend mode, and Suspend
mode must occur before or simultaneously with Off mode. Therefore, verify that the customized timeout 
values are greater than or equal to the timeout values of earlier modes: Standby Time ≤ Suspend Time ≤ 
Off Time.
Inconsistent values will result in BadValue error.
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Shutdown Settings in IGEL OS 12
This article shows the options to configure the behavior of shutdown menu in IGEL OS. The shutdown menu button 
can be displayed in the start menu and in the Application Launcher. For more information, see Start Menu in IGEL 
OS 12 (see page 121) . You can also configure the shutdown menu as a command session and configure various 
starting methods. For more information, see Commands Session in IGEL OS 12 (see page 125) .

Menu path: System > Power Options > Shutdown

By default, when the user clicks the shutdown button, an information dialog is displayed. The user can select from 
the enabled actions or cancel the procedure by closing the window by clicking X or by pressing [Esc].
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Global Options

Allow system shutdown

 The user can shut down the device. The Shutdown button is shown in the info dialog. (Default)

☐ The user cannot shut down the device. The Shutdown button is not shown in the info dialog. 

Allow system suspend

 The user can suspend the device. The Suspend button is shown in the info dialog. (Default)

☐ The user cannot suspend the device. The Suspend button is not shown in the info dialog.

Allow system reboot

 The user can reboot the device. The Reboot button is shown in the info dialog. (Default)

☐ The user cannot reboot the device. The Reboot button is not shown in the info dialog.

Allow system logoff

 The user can log off the device, if the user is logged in. The Logoff button is shown in the info dialog. (Default)

☐ The user cannot log off the device. The Logoff button is not shown in the info dialog.

Default action

The action that is carried out if the timeout defined under Dialog timeout expires.
Possible options:

 Shutdown
 Suspend (Default)
 Reboot
 Logoff
 Cancel

To configure the option, at least one login method needs to be enabled under Security > Logon. For more 
information, see Logon Settings in IGEL OS 12 (see page 246) .
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Dialog timeout

Time (in seconds) after which the info dialog will close and the action specified under Default action will be carried 
out. If the value is set to 0, the dialog will be shown until the user selects one of the possible actions. (Default: 10)

Additional Parameters When Triggered via UMS

Allow canceling of shutdown process

 The user can cancel the shutdown procedures initiated from the UMS by clicking the Cancel button in the info 
dialog. (Default)

☐ The user cannot cancel the procedures. 

Without dialog

 The info dialog is not shown. The shutdown procedures initiated from the UMS are carried out without 
notification.

☐ The info dialog is shown. (Default)

Known Issue

For OS version 12.2.0, the parameters of the Additional Parameters When Triggered via UMS are not 
effective. The parameters will be reworked in a future release.

For the manual cancellation to work, the following parameters need to be configured:
 Without dialog needs to be disabled.
 Prompt user on UMS actions under System > Remote Management needs to be 

enabled. For details, see Remote Management in IGEL OS 12 (see page 280) .
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System Customization in IGEL OS 12
You can use the following configuration to customize your IGEL OS.

 Custom CronJob/Systemd Timer in IGEL OS 12 (see page 312)
 Custom Partition in IGEL OS 12 (see page 314)
 Custom Commands in IGEL OS 12 (see page 319)
 Custom Application in IGEL OS 12 (see page 334)
 Environment Variables in IGEL OS 12 (see page 336)
 Corporate Design - Configure the User Interface in IGEL OS 12 (see page 342)
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Custom CronJob/Systemd Timer in IGEL OS 12
You can set timers on your IGEL OS 12 device to execute commands or to install/update apps at defined dates and 
times. The dates and times are specified in systemd syntax.

Menu path: System > System Customization > Custom CronJob/Systemd timer

Configuring a Timed Custom Command

1. Click  to add a new timer.
2. Edit the data as follows and then click Confirm.

 Name job: Display name for the timed command. It is recommended to use a name that 
speaks for itself.

 User: User to run the command. The following users are available on IGEL OS 12:
 root
 user: A user with typical user permissions

 Type: Select custom command action.
 Command: Enter the command to execute.
 Date and time for execution of job - using systemd timer syntax: Specify the date and 

time at which the command is to be executed. For examples, see https://
www.freedesktop.org/software/systemd/man/latest/
systemd.time.html#Calendar%20Events

 Delays the timer by a randomly selected value; default of 0: This parameter is useful 
when the command consumes many resources, e.g. network resources, and is executed by 
a great number of devices. Example: If you enter 10, the command will be executed 
somewhere between the specified time +1 seconds and the specified time +10 seconds.

 If hardware supports rtc wake and this option is enabled, the system will boot up to 
initiate the specified job / action: Please note that this feature is still experimental. The 
functionality depends strongly on the specific hardware and BIOS/UEFI.

https://www.freedesktop.org/software/systemd/man/latest/systemd.time.html#Calendar%20Events
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Configuring a Timed Update

You can configure the timer to install or update apps on a given date and time. For this, System > Update > Action 
after app assignment from UMS must be set to Nothing (additional step is needed to download and activate 
new app(s)). For a description, see Update - App Update Settings in IGEL OS 12 (see page 361) .

1. Click  to add a new timer.
2. Edit the data as follows and then click Confirm.

 Name job: Name for the timed command. It is recommended to use a name that speaks for 
itself, e.g. “Update”.

 User: Select root.
 Type: Select update action.
 Date and time for execution of job - using systemd timer syntax: Specify the date and 

time at which the command is to be executed. For examples, see https://
www.freedesktop.org/software/systemd/man/latest/
systemd.time.html#Calendar%20Events

 Delays the timer by a randomly selected value; default of 0: This feature does not work 
with IGEL OS 12.7.0 or earlier.

 If hardware supports rtc wake and this option is enabled, the system will boot up to 
initiate the specified job / action

https://www.freedesktop.org/software/systemd/man/latest/systemd.time.html#Calendar%20Events
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Custom Partition in IGEL OS 12
In IGEL OS, a custom data partition is available for use as required. A download/update function that loads data 
from a server and, where appropriate, updates them can be set up for this custom storage area.

Menu path: System > System Customization > Custom Partition

 Partition - Configuring Custom Partition in IGEL OS 12 (see page 315)
 Download Custom Partition in IGEL OS 12 (see page 317)

The IGEL Support Team offers support for the deployment of Custom Partitions. However, it is not possible 
to offer support for any third-party software that is installed on a Custom Partition.

If the device is reset to the default settings (factory reset), the custom partition and all data stored on it 
will be deleted.
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Partition - Configuring Custom Partition in IGEL OS 12

This article shows how to configure options to use a custom partition of your own in IGEL OS.

Menu path: System > System Customization > Custom Partition > Partition

Enable partition

  The use of custom partitions is enabled.

☐ Custom partitions cannot be used. (Default)

Size
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Size of the partition in bytes. The number can be followed by a multiplicative ending, without a space in between. 
Example: "100K" stands for 100 Kibibytes, that is, 100 * 1024 bytes.
The following multiplicative endings are possible:

 k for Kilobytes
 K for Kibibytes (number * 1024)
 m for Megabytes
 M for Mebibytes (number * 1024 * 1024)
 g for Gigabytes
 G for Gibibytes (number * 1024 * 1024 * 1024)

Mount point

Path on which the partition is to be mounted. (Default:  /custom )

Partitions Parameters

You can enter name value pairs which are passed on to the custom partition for further processing.
To manage the list:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   brings up the Add dialogue, where you can define the following settings:

 Name

Name of the parameter

 Value

Value of the parameter

Sensible values are for example "100K" (for 100 KiB = 100 * 1024 bytes) or "100M" (for 100 MiB = 100 * 1024 
* 1024 bytes). The size of the partition should be set to at least 100 KiB. However, no more than 300 MiB 
should be reserved for the customer-specific partition (based on the 1 GB standard CF used in IGEL Linux 
thin clients). This is because subsequent firmware updates may require more storage space than the 
current version.
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Download Custom Partition in IGEL OS 12

This article shows how to set up data sources for the custom partitions in IGEL OS.

Menu path: System > System Customization > Custom Partition > Download

Partitions Data Sources

In order to load data onto the custom partition, at least one partition data source must be set up here.

To manage the list, proceed as follows:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.
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Clicking   brings up the Add dialogue, where you can define the following settings:

 Automatic update
 The contents from this source will be updated automatically.

☐ The contents from this source will not be updated automatically. (Default)
 URL

URL of the web server

 User name

User name for access to the web server

 Password

Password for access to the web server. Click Set password to save the password. Click Change password to 
change the password.

 Initial action

Action which is performed after mounting the partition (program or script with absolute path). For example, a 
program downloaded to the partition can be launched.

 Final action

Action which is performed before unmounting the partition (program or script with absolute path). For 
example, a program downloaded to the partition can be ended.

The transfer protocols are the same as the ones for updating the firmware, e.g. HTTP and HTTPS. 
An  INF  file which in turn references a tar archive zipped using bzip2 must be referenced as the target.
The structure of the INF file is as follows:

 [INFO], [PART]  - Header information

 file="test.tar.bz2"  - File name of the compressed tar archive

 version="1"  - Version number - a higher version results in an update if Update 
automatically is enabled.

The files to be transferred must therefore be zipped in a tar archive which is then compressed using bzip2. 
This file is referenced in the INF file which is the target of the URL.
The tar archive can be created under Windows, e.g. with the open source program 7-Zip (www.7-zip.de59). 
This program also allows  bzip2  compression. Under Linux, tar and bz2 files can be created using 
onboard resources.
The procedure makes it possible to replace the file(s) on the server with a new version which the thin client 
loads the next time it is booted. The  Version  parameter in the  INF  file must be increased for this 
purpose.

59. http://www.7-zip.de/

http://www.7-zip.de/
http://www.7-zip.de/
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Custom Commands in IGEL OS 12
Custom commands are executed at specific points of the system startup process.

You can use environment variables in your custom commands. For more information on environment variables, 
see Environment Variables (see page 336).

The timeout in seconds for custom commands can be configured in System > Registry > userinterface > rccustom 
> timeout (Registry key: userinterface.rccustom.timeout). The default is 10.

You can define custom commands for the following startup processes:

 Base Custom Commands in IGEL OS 12 (see page 320)
 Desktop (see page 322)
 Network Custom Commands in IGEL OS 12 (see page 324)
 Reconfiguration Custom Commands in IGEL OS 12 (see page 326)
 Post-session Custom Commands in IGEL OS 12 (see page 327)

The content of custom scripts used in the custom command fields cannot be supported by IGEL. 
Therefore, you may be requested to remove custom scripts as part of the troubleshooting/support 
process.

Custom commands are executed as root .
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Base Custom Commands in IGEL OS 12

The commands defined here are executed at the specific execution times during the boot process.

Menu path: System > System Customization > Custom Commands > Base

You can define commands for the following execution times:

Initialization

The command is executed during boot, at the beginning of initialization. At this point:

 Not all drivers are loaded, not all devices are available
 Network scripts are not launched, network is not available
 Partitions are available, except for firefox profile, scim data, ncp data, custom partition
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Before session configuration

The command is executed during boot, before the session configuration. At this point:

 Not all drivers are loaded, not all devices are available
 Network scripts are not launched, network is not available
 Partitions are available, except for firefox profile, scim data, ncp data, custom partition
 Sessions are not configured

After session configuration

The command is executed during boot, after the session configuration. At this point:

 All drivers are loaded, all devices are available
 Network is available
 Partitions are available, except for custom partition
 System daemons are not launched (CUPS, ThinPrint etc.)
 Sessions are configured
 UMS settings are retrieved but not yet effective

Final initialization command

The command is executed during boot, after the initialization. At this point:

 All partitions are available
 All system daemons are launched
 UMS settings are effective
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Desktop

The commands defined here are executed at the specific execution times when the X server is launched.

Menu path: System > System Customization > Custom Commands > Desktop

You can define commands for the following execution times:

Desktop initialization

The command is executed during the boot process, before the X server is started. At this point:

 Desktop environment is configured but not launched
 User is not logged on (Kerberos, smartcard etc.)

Before desktop start
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The command is executed before the windowmanager and the autostart sessions are started. At this point:

 Desktop environment is launched
 Message service is launched
 Session D-Bus is launched
 User is not logged on (Kerberos, smartcard etc.)

Final desktop command

The command is executed after each user logon and desktop restart. At this point:

 User is logged on (Kerberos, smartcard etc.)
 User desktop is launched
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Network Custom Commands in IGEL OS 12

You can define commands for network-related execution times.

Menu path: System > System Customization > Custom Commands > Network

You can define commands for the following execution times:

Network initialization

The command is executed at the beginning of the network configuration.

The commands in the below fields are executed each time the relevant network interface starts. 
The  INTERFACE  environment variable contains the name of the network interface started.
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After network DNS

The command is executed after each change in the IP address or host name / after each DNS configuration. At this 
point:

 IP address / name server settings are used (e.g. via DHCP)

Before network services

The command is executed before network services are started. At this point:

 IP address / name server settings are used
 VPN is connected (if VPN autostart was enabled in the setup)
 No network / host routing settings used

Final network command

The command is executed after network configuration is finished. At this point:

 Network / host routing settings are used
 NFS and SMB drives are available
 System time is synchronized with the time server
 UMS settings are retrieved but not effective yet
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Reconfiguration Custom Commands in IGEL OS 12

The command defined here is executed after settings relating to the local setup or the UMS have been changed. 

Menu path: System > System Customization > Custom Commands > Reconfiguration

After reconfiguration

The command is executed after an effective change in the endpoint device settings (local setup, UMS).
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Post-session Custom Commands in IGEL OS 12

You can define an action to be performed when a process or group of processes has ended. The following will refer 
to this as a global post-session command. You can use the pre-defined actions Logoff or Shutdown or define a 
custom command.

The main purpose of this function is to monitor the processes of the Base System, but it can also be used for apps. 
However, typically, apps bring their own post-session commands. The global post-session command can be given 
priority over the app-specific post-session commands.

You can specify a list of return codes that indicate that the session has ended successfully. Moreover, you can define 
which command parameters should be ignored; herewith, you can prevent a command like wfica -version
from triggering a post-session command.

Menu path: System > System Customization > Custom Commands > Post Session

Activate generic base_system post-session command

The action defined under The post-session command to be executed will be performed when all 
processes set as a trigger have been ended successfully.
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No action will be performed when the process ends. (Default)

The post-session command to be executed

This command will be executed when all monitored processes have finished successfully.

Possible options:

 Logoff
 Shutdown
 Enter custom command here: Enter the command you want to have executed.

This session will have priority in executing the post-session command

This setting is relevant if app-specific post-session commands are enabled.

Example: An IGEL Azure Virtual Desktop (AVD) session that has post-session command priority is running. Now, a 
Citrix Workspace App session that has its own post-session command is started and ended while the AVD session is 
still running. Because the priority is assigned to the AVD session, the post-session command of the Citrix Workspace 
App session is ignored.

The global post-session command has priority over any app-specific post-session command.
The global post-session command has no priority.

How to Assign Post-Session Command to a One or More Processes

1. Click  to add a process.

2. Enter the Process name. This is the name of the binary that is being executed; it also appears 
when you monitor your processes with ps  or top . In our example, the process a local terminal.
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3. Enter the Valid return codes for the session. When the process returns one of these return codes, 
it will be considered as ended successfully. The post-session command will only be executed if the 
process ends successfully.
The return codes must be comma-separated. You can define ranges using “..”; for example, a range 
between 10 and 20 is written as 10..20 .
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4. With Ignore command lines, you can ensure that the post-session command will only be triggered 
if the program runs normally, not with parameters like --version , or --help , for instance.
The command lines must be comma-separated.
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5. Click Confirm, then Save and Close (or Save), and decide whether the change should be sent to 
the device immediately or after the next reboot.



Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   332 / 691



Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   333 / 691



Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   334 / 691

Custom Application in IGEL OS 12
You can add custom applications to call up commands through the defined starting methods. For example, you can 
create a desktop shortcut to run a command.

Menu path: System > System Customization > Custom Application

To manage the list of custom applications:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

→ Click  to add a new custom application session.

The starting methods parameters are described under Starting Methods for Apps (see page 421). 

Under Custom Application > [Custom Application Name] > Settings, you can define the command to be run and 
the icon for the shortcut.

Custom application commands are executed as user .
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Icon large

Select an icon provided. (Default: applications-other)

 

Command

Give the name and path of the application. (Example:  /usr/bin/gpicview )

Only the desktop icon of a session is customizable. The taskbar icon of a session cannot be customized 
and will remain the default icon. Complete customization is not possible.
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Environment Variables in IGEL OS 12
Environment variables allow you to use dynamic parameter values for a number of session types, e.g. so as not to 
have to enter ICA or RDP servers for every session. Predefined variables can also be allocated and distributed via the 
IGEL UMS. Additional variables can only be used locally on the device and may be overwritten by a UMS 
configuration.

Menu path: System > System Customization > Environment Variables

Enable variable substitution in session

 The use of variables in sessions such as ICA and RDP is enabled. If specific parameters contain a  $ , shell 
substitution will be carried out.

☐ The use of variables in sessions is not enabled. (Default)
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You can use environment variables in custom commands. For more information on these, see Custom Commands 
in IGEL OS 12 (see page 319) .

In addition, the following session parameters can be updated through variables:

 Legacy ICA sessions: Citrix Server or published application
 Legacy ICA sessions: User
 RDP session: Server
 RDP session: User

 Predefined Environment Variables (see page 338)
 Additional Environment Variables (see page 340)
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Predefined Environment Variables

This article shows the options to configure predefined environment variables in IGEL OS.

Menu path: System > System Customization > Environment Variables > Predefined

Variable name

Name for the variable

Value

Value for the variable

Using Environment Variables in Sessions

To use environment variables in sessions, proceed as follows:
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1. Enable environment variables under System > System Customization > Environment Variables 
> Enable variable substitution in session.

2. Define the variable name and content, e.g.
 Variable name:  SERVERNAME

 Value:  testServer
3. Enter the variable name in the parameter field of the session with the $ symbol before it. 

Example:  $SERVERNAME

In the case of RDP and ICA sessions, the value is entered in the session file after saving. 
With XenApp, the setting is not implemented until a session starts and is running.
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Additional Environment Variables

This article shows how to define other environment variables in addition to the predefined ones.

Menu path:  System > System Customization > Environment Variables > Additional

To manage the list of Additional variables:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   brings up the Add dialogue, where you can define the following settings:
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 Variable name

Name for the variable

 Value

Value for the variable
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Corporate Design - Configure the User Interface in IGEL OS 12
In this area, you can configure settings allowing you to adapt the user interface to your needs.

Use the settings on the following pages to create your design:

 Custom Bootsplash in IGEL OS 12 (see page 343)
 Background (1st Monitor) for Corporate Design in IGEL OS 12 (see page 346)
 Company Logos in IGEL OS 12 (see page 353)
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Custom Bootsplash in IGEL OS 12

With a bootsplash, you can show your company logo or a specific image during the booting procedure. The 
bootsplash will be shown instead of the console messages. You need to provide an image file for your custom 
bootsplash on a download server.

Menu path: System > System Configuration > Corporate Design > Custom Bootsplash

Custom Bootsplash

Enable custom bootsplash

The file types JPG, JPEG, BMP, PNG, SVG, GIF, and TIFF can be used for a bootsplash. A total storage area of 
25 MB is available for all user-specific images. The image is 800 x 600 pixels in size (aspect ratio remains 
unchanged). It can be positioned vertically and horizontally.
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 A custom bootsplash can be configured.

☐ No custom bootsplash is configured. (Default)

Custom Bootsplash - Server Location

Protocol

Access method for the image
Possible options:

 HTTP: Download from a web server
 HTTPS: Download from a TLS/SSL-secured web server
 FTP: Download from an FTP server. (Default)
 Secure FTP: Download via SSH-secured FTP
 FTPS: Download from a TLS/SSL-secured FTP server
 FILE: The image file lies in the file system of the device, possibly as a shared NFS or Windows 

update. You can enter the location under Local path.

Local path

The path to the background image. The parameter is shown when FILE is selected as protocol.

Server name

Name or IP address of the server

Server path

Path to the directory with the image file on the server

Port

Port of the server on which the service is provided. The field is populated by protocol specific default values.

User name

User name on the server

Password

Password for the user account on the server

Custom Bootsplash - Settings

Custom bootsplash file

Filename of the custom image

Custom bootsplash style

 Original (Default)
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 Stretched
 Scaled
 Zoomed

Background color

The background color of the bootsplash. Click the color preview square to open the color selector.

Horizontal position of the bootsplash image 

The following applies: 0 = left-justified, 50 = centered, 100 = right-justified. (Default: 50)

Vertical position of the bootsplash image 

The following applies: 0 = aligned on top, 50 = centered, 100 = aligned on bottom. (Default: 50)

Size of progress indicator 

Valid range is 72-256. (Default: 72)

Horizontal position of the progress indicator

The following applies: 0 = left-justified, 50 = centered, 100 = right-justified. (Default: 90)

Vertical position of the progress indicator

The following applies: 0 = aligned on top, 50 = centered, 100 = aligned on bottom. (Default: 90)

Bootsplash update

When clicked the user-specific bootsplash is downloaded from the given server.

If you change the image file or even just one of the settings for an existing bootsplash, be sure to 
click Bootsplash update in order to regenerate the system files used.
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Background (1st Monitor) for Corporate Design in IGEL OS 12

This article shows how to configure the desktop background for a corporate design in IGEL OS. You can use 
predefined IGEL backgrounds, a fill color/color gradient, or a background image of your own. You can set up 
different background images for each monitor connected to the device.

Menu path: System > System Customization > Corporate Design > Background (1st Monitor)

Wallpaper

Provides a selection of predefined IGEL backgrounds.
Possible options:

 Neutral
 Off
 IGEL (default)

Wallpaper style
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Provides various design versions.
Possible options:

 Auto
 Centered
 Tiled
 Stretched (Default)
 Scaled
 Zoomed

Color style

Sets a fill color or a color gradient.
Possible options:

 Solid color
 Horizontal gradient (Default)
 Vertical gradient

Desktop color

The desktop color if Wallpaper is set to Off. Click the color preview square to open the color selector.

2nd desktop color

The second desktop color if Wallpaper is set to Off and a gradient Color style is selected. Click the color preview 
square to open the color selector.

Custom wallpaper download

 You can provide a user-specific background image on a download server. Specify the download server under 
System > System Customization > Corporate Design > Background > Custom Wallpaper Server.

☐ Custom wallpaper is not used. (Default)

Custom wallpaper file

The name of the background image file

The user-specific background image will be downloaded from the specified server if the function was enabled and if 
requested manually by clicking Wallpaper update under System > System Customization > Corporate Design > 
Background > Custom Wallpaper Server. The download can also be launched from the IGEL Universal 
Management Suite (UMS) via the Update desktop customization command.

A user-specific image can be provided on a download server. The file types BMP, JPG, GIF, TIF, PNG and 
SVG are supported for an own background image and bootsplash. A total storage area of 25 MB is available 
for all user-specific images. For more information, see Universal Management Suite > UMS Reference 
Manual > Firmware Customizations in the IGEL UMS.
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Background (2nd-8th Monitor)

This article shows how to configure the desktop background of further monitors in multi-monitor environments in 
IGEL OS.

Menu path: System > System Customization > Corporate Design > Background (2nd-8th Monitor)

You can use predefined IGEL backgrounds, a fill color or a color gradient. You can also use a background image of 
your own.

Wallpaper

Provides a selection of predefined IGEL backgrounds.
Possible options:

You can set up a separate background image for each monitor that is connected to the device.
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 Follows configuration for first monitor (Default)
 Neutral
 Off
 IGEL

Wallpaper style

Provides various design versions.
Possible options:

 Follows configuration for first monitor (Default)
 Auto
 Centered
 Tiled
 Stretched
 Scaled
 Zoomed

Color style

Sets a fill color or a color gradient.
Possible options:

 Follows configuration for first monitor (default)
 Solid color
 Horizontal gradient
 Vertical gradient

Desktop color

The desktop color if Wallpaper is set to Off. Click the color preview square to open the color selector.

2nd desktop color

The second desktop color if Wallpaper is set to Off. Click the color preview square to open the color selector.

Custom wallpaper download

 You can provide a user-specific background image on a download server. Specify the download server under 
System > System Customization > Corporate Design > Background > Custom Wallpaper Server.

☐ Custom wallpaper is not used. (Default)

Custom wallpaper file

The name of the background image file

The user-specific background image will be downloaded from the specified server if the function was enabled and if 
requested manually by clicking Wallpaper update under System > System Customization > Corporate Design > 
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Background > Custom Wallpaper Server. The download can also be launched from the IGEL Universal 
Management Suite (UMS) via the Update desktop customization command.

A user-specific image can be provided on a download server. The file types BMP, JPG, GIF, TIF, PNG and 
SVG are supported for an own background image and bootsplash. A total storage area of 25 MB is available 
for all user-specific images. For more information, see Universal Management Suite > UMS Reference 
Manual > Firmware Customizations in the IGEL UMS.
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Custom Wallpaper Server

This article shows how to configure the download server for your own background images in IGEL OS.

Menu path: System > System Customization > Corporate Design > Background (1st Monitor) > Custom 
Wallpaper Server

Protocol

Access method for the image
Possible options:

 HTTP: Download from a web server. (Default)
 HTTPS: Download from a TLS/SSL-secured web server
 FTP: Download from an FTP server
 Secure FTP: Download via SSH-secured FTP
 FTPS: Download from a TLS/SSL-secured FTP server



Configuration of IGEL OS 12 Device Settings

IGEL OS Base System   352 / 691

 FILE: The image file lies in the file system of the device, possibly as a shared NFS or Windows 
update. You can enter the location under Local path.

Local path

The path to the background image. The parameter is shown when FILE is selected as protocol.

Server name

Name or IP address of the server used

Server path

Directory in which you saved the background image

Port

Port of the server on which the service is provided. The field is populated by protocol specific default values.

User name

Name of the user account on the server

Password

Password for this account

Wallpaper update

The button refreshes the background image when clicked.
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Company Logos in IGEL OS 12

You can configure the device to show your company logo in the screensaver and in the start menu.

Menu path: System > Firmware Customization > Corporate Design > Company Logos

Screensaver

Enable image display

 The image defined below will be shown as the screensaver. (Default)

File for screen saver logo

Complete path for an image file or a directory that contains a number of image files.

If you enter a folder instead of a single image file as the source, all images in the folder will be displayed as 
a slide show. The image display time for the images can be configured. If you do not specify a file of your 
own, the IGEL logo will be used.
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One image per monitor

 The image will be shown on each individual monitor rather than one image across all monitors. (Default)

Image duration

Time in seconds until the image changes. (Default: 10)

Image display mode

Defines how the image is displayed
Possible options:

 Small-sized hopping: small image that jumps across the screen. (Default)
 Medium-sized hopping: larger image that jumps across the screen
 Full screen center cut out: Image is displayed across whole screen, edges can be cut off.
 Full screen letterbox: Complete image is shown. A black edge may be visible depending on the 

format.

Start menu

Start button icon

File name with full path to select your logo as the icon for the start menu in the taskbar. Size: 32x32 pixels

Company logo in start menu

File name with full path to show your company logo in the top of the start menu window. Size: 64x64 pixels
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Registry in IGEL OS 12
In the registry, you can change almost any firmware parameter, including parameters not shown in the GUI. You will 
find information on the individual items in the tooltips. 

Menu Path: System > Registry

Registry User Interface
The registry shares most of the GUI elements with the rest of the configuration dialog. For details, see Configuration 
of IGEL OS 12 Device Settings (see page 6).

1 You can use the breadcrumbs to track your navigation within the registry.

2 In the Profile Configurator, you can use the toggle button to only see parameters activated 
by the parameter activator (3) in the registry.

3 In the Profile Configurator, you can use the parameter activator to activate registry 
parameters. When you deactivate the parameter, the value will be automatically set back to 
the default value. For more on profile creation, see (12.05.100-en) How to Create and Assign 
Profiles in the IGEL UMS Web App .

4 Your changes are marked with indicators on the right side of the parameter. For more on 
change indicators, see Configuration of IGEL OS 12 Device Settings (see page 6).

5 Under Used In, you can find the list of configuration pages where the parameter is used. 
Click on the page link to jump to the page.

Add instance

Changes to the registry should only be made by experienced administrators. Incorrect parameter settings 
can easily destroy the configuration and cause the system to crash. In cases like these, the only way to 
restore the functionality is to reset the device to the factory defaults!
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Adds instances to the registry. This is possible with parameters that have a percent sign as their last character, 
e.g.  nfymount% . The new instances are numbered consecutively:  nfymount1 ,  nfymount2  etc.

Delete instance 
Deletes a previously added instance.

Search in the Registry
You can use the advanced search to search for registry parameters.
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To search for parameters in the registry:

1. Enable advanced search using the toggle button.
2. Activate Include Registry.
3. Start typing in the search field.

The search results list automatically refreshes as you type.
4. Click on a search result to display the registry page. The result is highlighted on the page.

When a search result is clicked, the search menu remains displayed in the top right corner with the 
following navigation options:

 arrows to go to the next or the previous search result
 search icon to expand the search tab
 X to close the search
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Notification - User Notifications in IGEL OS 12
To allow seamless operation for your users, you can control the visibility of user notifications on the device.

You can filter notifications according to their severity. Also, you can define an automatic action for those 
notifications that require a user action.

Menu path: System >Notification

Show notification of specified severity and above as floating notification

Specifies which levels of notifications are shown in a message window. Please note that, by default, notifications 
that require a user action are shown independently of this setting. You can change this with Suppress notifications 
with a required user action (see below).

Possible options:

 All: Notifications of the levels “info”, “warning”, and “error” are shown, as with Info. (Default)
 Info: Notifications of the levels “info”, “warning”, and “error” are shown.
 Warning: Notifications of the levels “warning” and “error” are shown.
 Error: Notifications of the level “error” are shown.
 None: No notifications are shown.

Show suppressed notification in notification panel

 The notifications filtered out by the setting Show notification of specified severity and above as floating 
notification can be retrieved by clicking on  in the taskbar. The icon shows the number of unread notifications.

☐ The suppressed notifications cannot be retrieved. (Default)

Suppress notifications with a required user action
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 Notifications are suppressed even when they require a user action. The action is defined by Action in 
suppressed notification with user action.

☐ Notifications that require a user action are not suppressed. (Default)

Action in suppressed notification with user action

Possible options:

 Default: The default action defined for the notification is executed. (Default)
 Cancel: The action is canceled.
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Update - App Update Settings in IGEL OS 12
This article shows how to configure app update settings in IGEL OS.

Menu path: System > Update

Action after app assignment from UMS

Possible options:

 Download and activate (Apps usable after reboot): When an app is assigned to the device, it will 
be downloaded and installed immediately. The app can be used after the next reboot. (Default)

 Download only (additional step is needed to activate new app(s)): When an app is assigned to 
the device, it will be downloaded immediately. It will be installed when the UMS sends an update 
command to the device. The device will then reboot; afterward, the app can be used.

 Nothing (additional step is needed to download and activate new app(s)): When an app is 
assigned to the device, the device does nothing. The app will be downloaded and installed when a 
timer is triggered; see Custom CronJob/Systemd Timer in IGEL OS 12 (see page 312) The device will 
then reboot; afterward, the app can be used.

Action after app activation

Possible options:

Apps can only be installed by the user if Permit local app installation is enabled under Security > 
Update. For more information, see Installing IGEL OS Apps Locally on the Device60.

60. https://kb.igel.com/en/how-to-start-with-igel/current/installing-igel-os-apps-locally-on-the-device

https://kb.igel.com/en/how-to-start-with-igel/current/installing-igel-os-apps-locally-on-the-device
https://kb.igel.com/en/how-to-start-with-igel/current/installing-igel-os-apps-locally-on-the-device
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 Ask User: When the app has been assigned to the device and Download and activate (Apps 
usable after reboot) is selected or the UMS has sent an update command, a dialog with a timeout 
appears. Depending on the user’s action, the device will act as follows:

 The user clicks Restart Now: The device reboots. The app can be used after the reboot.
 The timeout expires: The device reboots. The app can be used after the reboot.
 The user clicks Restart Later: The app can be used after the next reboot.

 Reboot immediately: The device reboots immediately. The app can be used after the reboot.
 Nothing: When the app has been assigned to the device and Download and activate (Apps 

usable after reboot) is selected or the UMS has sent an update command, the device does 
nothing. The app will be installed and ready for use on the next reboot.

Show download progress as notification to the user

 When an app is downloaded, the download progress is shown as a notification.

☐ No download progress is shown.

Timeout for automatical reboot in seconds

Time period between the app installation and the reboot. (Default: 60)

Use a bandwidth limit while updating

 Limits bandwidth usage during the downloading of updates to the value set under Limit bandwidth used for 
updating.

☐ Bandwidth usage is not limited during the downloading of updates. (Default)

Limit bandwidth used for updating

The value to which the bandwidth is limited during the downloading of updates. You can give the value with KB, MB, 
or GB as the quantifier. If no quantifier is given, the value is in megabytes. (Default: 2MB)

Seconds to wait for network connection during a multi stage update

A multi stage update is cancelled if no network connection can be established during this period. (Default: 60)

Check for and download updates for non pinned apps on boot

This option helps keep the apps on the device up-to-date by checking for updates on each boot. This is potentially 
security-relevant

Non-pinned apps are all apps that are not assigned to a device via the UMS, regardless of whether the assignment 
was made via a profile or directly. This applies to apps that are dependencies of other apps, for instance. Example: 
The app Citrix Multimedia Codec is a dependency for the Citrix Workspace App. 

 On each boot, the device checks for updates of non-pinned apps. If updates are found, they are installed on the 
device. (Default)

☐ Updates of non-pinned apps are not checked automatically.
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Check for and download updates for non pinned apps on given calendar time, use the crontab syntax to 
specify the calendar time

This option helps keep the apps on the device up-to-date by checking for updates periodically. To define the period, 
use the crontab syntax.

Non-pinned apps are all apps that are not assigned to a device via the UMS, regardless of whether the assignment 
was made via a profile or directly. This applies to apps that are dependencies of other apps, for instance. Example: 
The app Citrix Multimedia Codec is a dependency for the Citrix Workspace App.

If the defined checking time has been missed because the device has no network or cannot reach the UMS or the 
IGEL App Portal, the update check is queued until the connection is available again. If the defined checking time has 
been missed because the device has been powered off, the update check will not be queued.

Possible values: Crontab syntax; if the field is empty, no update check will be performed. For details on the crontab 
syntax, see https://man7.org/linux/man-pages/man5/crontab.5.html or check out the interactive tool at https://
crontab.guru/.

Repositories

Prioritized list of repositories used for app updates

To manage the list:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   brings up the Add dialogue, where you can define the following settings:

 Certificate

The certificate used for authentication to the repository

 Priority

The number defines the priority of the repository, where a larger number means a higher priority. The priority 
determines the order in which the device tries to connect to download apps. It will try to connect to the 
repository with the highest priority, and if that is not available, it will fall back to the next one.

Numbers are accepted from 0 to 4294967295.

 Repository URL

The URL of the repository

Consider Network Load
It is recommended to take into account the network load that occurs when a large number of devices 
download the updated apps. If required, use the settings Use a bandwidth limit while updating and 
Limit bandwidth used for updating.

https://man7.org/linux/man-pages/man5/crontab.5.html
https://crontab.guru/
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External binary source

You can use the below options to configure a connection to a server used as a distributed app repository. For more 
information, see How to Use Distributed App Repositories in IGEL UMS61.

To manage the list:

 Click   to create a new entry.

 Click   to remove the selected entry.

 Click   to edit the selected entry.

 Click   to copy the selected entry.

Clicking   brings up the Add dialogue, where you can define the following settings:

 Priority: The number defines the priority of the repository, where a larger number means a higher 
priority. The priority determines the order in which the device tries to connect to download apps. 
It will try to connect to the repository with the highest priority, and if that is not available, it will fall 
back to the next one.

 Repository URL: The URL of the repository
 Username: The username with which the device downloads the binaries from the app repository.
 Password: The password associated with the username.
 Certificate: File path to the SSL certificate that is used for an HTTPS connection to the app 

repository.

Use only repositories deployed by the UMS

 The device can only download apps from repositories for which the UMS acts as an update proxy.

☐ The device can download apps from all the configured repositories. (Default)

The parameter requires UMS 12.04.110 or later.

61. https://kb.igel.com/en/universal-management-suite/12.06.120/how-to-use-distributed-app-repositories-in-igel-um

https://kb.igel.com/en/universal-management-suite/12.06.120/how-to-use-distributed-app-repositories-in-igel-um
https://kb.igel.com/en/universal-management-suite/12.06.120/how-to-use-distributed-app-repositories-in-igel-um
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Distributed Peer Update Server Configuration in IGEL OS 12
The IGEL OS 12 device can be configured as a Distributed Peer Update Server (formerly known as Buddy Update 
Server) to distribute app and base system updates through the network to other IGEL OS 12 devices. You can specify 
one or several IGEL OS 12 devices to function as a peer update server for other IGEL OS 12 devices.

Menu path: System > Update > Distributed Peer Update Server

Enable Distributed Peer Update Server

The IGEL OS 12 device serves as a distributed peer update server and can provide app and base 
system updates for other IGEL OS 12 devices in the network over HTTP. The port to serve as an app 
repository server is configured below.
The IGEL OS 12 device does not serve as a peer update server. (Default)

Port of the distributed peer update server

Port on which the distributed peer update server runs. (Default: 22335)

For more information on how to configure the feature, see How to Configure Distributed Peer Update with 
IGEL OS 12 Devices (see page 439) .
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IGEL Discovery Service Configuration in IGEL OS
The IGEL Discovery service allows endpoint devices on the same local network to automatically find and obtain 
updates from one another using a distributed peer update mechanism. Sourcing updates within the subnet when 
possible, reduces dependency on a central server and helps distribute update traffic efficiently within a subnet.

IGEL Discovery uses an UDP-based mechanism to detect available update sources on the local network and 
provides an interface that update components use to determine update availability and select an appropriate 
update source.

Enable IGEL Discovery

The device provides the IGEL Discovery service on the port configured below.
The IGEL Discovery service is not provided. (Default)

Specifies the network port utilized by the igel-discovery daemon for communication

The port utilized by the IGEL Discovery service. It must be different from the server port configured for the server in 
System > Update > Distributed Peer Update Server. (Default: 22336)

For more information on how to configure the feature and how it works, see How to Configure Distributed 
Peer Update with IGEL OS 12 Devices (see page 439) .
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Tray Applications in IGEL OS 12
Tray applications in IGEL OS 12 provide quick access to device settings such as Wi-Fi, display, sound, battery status, 
and UMS connectivity. From the system tray, users can quickly view system status, manage network connections, or 
adjust hardware settings without access to the IGEL Setup. This article provides an overview of tray apps and 
describes their functions in detail.

Tray Apps in This Article

The tray icons change dynamically to represent the current setup or status. If you hover over the icons, tooltips are 
displayed with further information.

Tray Icon Link to Section Purpose

Battery Tray App (see page 390) Set CPU power plan regulation and show 
battery information for the device and 
connected devices.

Bluetooth Tray App (see page 393) Manage Bluetooth devices such as 
headsets, keyboards, and mice.

Display Tray App (see page 379) Configure monitor layout, resolution, and 
other display settings.

Language & Keyboard Layout 
Tray App (see page 399)

Change language settings for the 
keyboard and the user interface.

LAN Tray App (see page 374) Display and monitor the status of the 
wired Ethernet network connection.

Mobile Broadband Tray App (see 
page 375)

Connect to and manage mobile data 
networks using a WWAN modem or SIM 
card.

Mouse & Touchpad Tray App (see 
page 387)

Adjust mouse and touchpad behavior, 
such as speed, scrolling, and pointer 
settings.

OpenConnect VPN Tray App (see 
page 399)

Connect to and monitor the VPN 
connection.

Printer Tray App (see page 395) View and manage configured printers and 
printer status.
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Tray Icon Link to Section Purpose

Sound Tray App (see page 391) Select audio devices and control input/
output volume settings.

UMS Tray App (see page 368) Display the device’s connection status and 
information for the IGEL Universal 
Management Suite (UMS).

Wi-Fi Tray App (see page 369) Connect to and manage wireless 
networks.

UMS Tray App

Access the Tray App
→ Open the UMS tray app by clicking the UMS tray icon. The icon is dynamic and represents the state of the 
connection as described below.

UMS Connection Status Taskbar Icon

Connected

Connecting

Disconnected

Unmanaged

Information for Administrators
 The system tray and most of the tray apps are available to the users by default.
 You can enable and disable the system tray and the tray apps under User Interface > 

Desktop > Taskbar Items. For details, see Taskbar Items in IGEL OS 12 (see page 112).
 The access to tray apps on lockscreen is configured separately under User Interface > 

Desktop > Screenlock / Screensaver > Taskbar. For details, see Taskbar in Locked 
Screen in IGEL OS 12 (see page 59).

 Some configurations available in the tray apps are connected to configurations in the IGEL 
Setup. For example, printer configurations applied through profiles cannot be modified 
through the tray app.
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Get Information on the UMS Connection
→ Check basic information of the connected Universal Management Suite (UMS), like IP address and Hostname in 
the tray app.

Wi-Fi Tray App 

Access the Tray App
→ Open the Wi-Fi tray app by clicking the Wi-Fi tray icon. The icon is dynamic and represents the state of the 
connection.

Automatic Network Scan
When you open the Wi‑Fi tray app, a search for available networks starts automatically. During the search, 
you can see a visual feedback of the ongoing scan and the list of available networks updates continuously. 
The search stops automatically after a few seconds and the list then remains unchanged until a new scan 
is triggered or the tray app is reopened.

 The connected network is shown at the top of the list. All other networks are listed in 
order of signal strength.

 Previously configured networks are marked with a star icon.
 The currently connected network is marked with a tick icon.
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Action Icons
Using the icons at the top of the window, you can:

→ Use the toggle switch of the Wi-Fi tray app to turn Wi-Fi on and off.

→ Add a hidden network.

→ Scan for Wi-Fi networks to refresh the list of available networks.

→ Check the details of the connected network.

→ Switch between the Known Networks list and the Available Networks list.
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Connect to Available Wi-Fi Networks
To connect to a network:

Click for instructions...

1. Reopen the tray app or click the Scan Wi-Fi icon to refresh the list under Available Networks.

2. Click the network to be connected and provide the network key. You can already start typing with 
the search still ongoing.

If the Automatic switch of network connection parameter is enabled under Network > Common 
Settings, the toggle can get disabled. For more information, see Common Settings (see page 180).
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You can enable the Store WiFi key and Auto Connect parameters according to your needs.
For information on saving network credentials for Wi-Fi WPA Enterprise connections, see How to 
Configure the Permanent Storage of User-Provided Network Credentials (Wi-Fi and Ethernet) (see 
page 580).

3. Click Connect.
The Wi-Fi tray icon changes to show the active connection.
The configured network is listed in the Known Networks list.
The configured connections get listed in the IGEL Setup under Network > Wireless > Wi-Fi 
Networks. For more information, see Wi-Fi Networks (see page 153).

4. To disconnect from the connected network, click the network and click Disconnect.

Edit and Delete Known Networks
To edit or delete a network:

Click for instructions...

1. Switch to the Known Networks list.
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2. Click on the network to be edited or deleted.
You can enable the Store WiFi key and Auto Connect parameters according to your needs.

If you need to edit or delete Wi-Fi WPA Enterprise connections, you cannot do this via the above 
dialog. Use the IGEL Setup or the UMS profile, instead.

3. Click Save to save the changed configuration or click Delete to remove the network from the list.

Connect to Hidden Networks
To connect to a hidden network:

Click for instructions...

1. Switch to the Known Networks list.

2. Click the Add Hidden Network icon at the top of the window.
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3. Set the Encryption Type, provide the SSID and the network key.

4. Click Connect.
The Wi-Fi tray icon changes to show the active connection.
The configured network is listed in the Available Networks list and in the Known Networks list.
The configured connections get listed in the IGEL Setup under Network > Wireless > Wi-Fi 
Networks. For more information, see Wi-Fi Networks (see page 153).

5. To disconnect from the connected network, click on the network in the Available Networks list 
and click Disconnect.

LAN Tray App

Access the Tray App

→ Open the LAN tray app by clicking the LAN tray icon.

LAN Status Taskbar Icon

Connected

No connection

Connected, but no internet

Connecting

Disconnected by user

Connection error

The tray icon is dynamic and represents the state of the connection as described below.
The state of the connection is determined by the network manager. The network manager periodically 
requests http://connectivity-check.ubuntu.com/ to check the connectivity.
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Manage LAN Connections
→ Select a network connection to see information on the network.

→ Use the buttons to connect to and disconnect from LAN networks.

The saving network credentials for Ethernet IEEE 802.1X connections requires further administration, see How to 
Configure the Permanent Storage of User-Provided Network Credentials (Wi-Fi and Ethernet) (see page 580).

Mobile Broadband Tray App

Access the Tray App
→ Open the tray app by clicking the mobile broadband tray icon. The tray icon is dynamic and represents the state 
of the connection:

MBB Connection Status Taskbar Icon

Connected
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MBB Connection Status Taskbar Icon

No connection

SIM locked

Switch WWAN On and Off
→ Use the toggle to switch the WWAN connection off and on.

Get Information on Mobile Broadband Connection
The mobile broadband tray app displays details about the WWAN network connection, like the network Provider
and the Signal Strength, and provides an option to easily connect / disconnect and configure networks.

Starting from OS version 12.4.1, on devices supporting mobile broadband physical SIM and eSim as well, 
an automatic switch to the physical SIM slot is performed if eSim has no profile assigned.

If the Automatic switch of network connection parameter is enabled under Network > Common 
Settings, the toggle can be disabled. For more information, see Common Settings (see page 180).
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Configure the WWAN Network
→ Click SIM Details to display the details and to configure the settings that are enabled for the tray app.

Click for details on configuration..

You can set which configurations are available in the tray up under Network > Mobile Broadband. For 
details, see Mobile Broadband in IGEL OS 12 (see page 147).
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You can configure the following:

 Auto Connect
 The mobile internet connection is established automatically. (Default)

 Edit PIN
Change the PIN of the SIM card.

 Request PIN on boot
Set if PIN needs to be provided at startup.

 Roaming
Use the toggle to enable/disable the connection to roaming networks.

Edit the Network Provider
→ Click Change Provider to edit the network provider information.

Click for details on configuration...
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You can configure the following:

 Country or region
Country or region of the service provider.

 Provider
Your mobile network connection provider.

 Access Point
APN (Access Point Name) for your network connection. If you do not know the APN, ask your 
mobile communications operator for it.

Display Tray App

Automatic Display Profile
When the endpoint device is connected to different environments, such as when the user switches 
between different workplaces, it will attempt to store each monitor setup.
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Access the Tray App

→ Open the display tray app by clicking the tray icon: 

The icon is dynamic in multi-monitor environments and represents the configured Multiple Display Mode. 

The basic window opens with different content for single display and multiple display setups.

Manage a Single Display
If you have a single display, you have the following configuration options:

→ Click the info icon to display device information.

→ Set Orientation, Resolution and Refresh rate for the single display.

Change the Multiple Display Mode
→ Change the Multiple Display Mode by clicking the icons. The currently selected mode is shown under the icons.

After clicking Apply, you need to confirm keeping the changes before timeout. After the timeout, settings 
revert to the previous configuration.
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You have the following Multiple Display Mode options:

 Custom (Default)
The configurations made in the display configuration window are applied. Configurations made in 
the display configuration window are persistent, they carry over reboot.

 Mirror
The content is mirrored to all displays.

 Internal only 
The internal display will become the primary display. External displays get deactivated.

 External only
One of the external display will become the primary display. The internal display gets deactivated.

Temporary Effect
The Multiple Display Mode option in the basic window can be used to quickly change the display setting 
temporarily. After reboot or suspend, the Multiple Display Mode will reset to the default Custom.
If you want display configurations to be persistent, select Custom as Multiple Display Mode and click 
Custom Configuration to change the settings in the display configuration window.

To apply the changes you made, click Apply in the bottom right corner. After clicking Apply, you need to 
confirm keeping the changes in a dialog. After the timeout, settings revert to the previous configuration.
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Access the Custom Configuration Window
→ Click the You have X connected displays or the Custom Configuration button to open the display configuration 
window.

Display information is always available in the display configuration window, but configuration is only 
possible if you select Custom as Multiple Display Mode.
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Configure the Displays in the Display Configuration Window

Click for a detailed description of the available actions...

Landing Page
→ Click Reset to restore the last saved configurations.

→ Click the info icon to display information on Hardware Limitations for the device. This information is needed for 
the configuration, because you cannot create display layouts which exceed the given maximum resolution or 
number of connected displays.

Display information is always available in the display configuration window, but configuration is only 
possible if Custom display mode is applied in the basic window. You can see the selected mode in the 
bottom left corner.

To apply the changes you made, click Apply in the bottom right corner. After clicking Apply, you need to 
confirm keeping the changes in a dialog. After the timeout, settings revert to the previous configuration.
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→ Click the question mark icon to display the Keyboard shortcuts that you can use for display configuration.

Left Hand Panel
→ Select a display from the dropdown at the top, or by clicking the display in the Layout Area, to configure the 
display and to see the details of the selected display at the bottom of the panel.

You can also select by typing the display identification number shown in the Layout Area.
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You can use the parameters to configure the following:

 Orientation
 Resolution
 Refresh rate
 Primary toggle

Activate if you would like to make the selected display the primary display. The primary display is 
marked with a house icon. Only one display can be primary; if a display is marked as primary, the 
existing primary becomes non-primary.

 Active toggle
Use the toggle to activate/deactivate the selected display. You cannot deactivate all the displays, 
at least one display must remain active.
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 Drag and Drop Panel

Here you can:

 Select a display by clicking on it. 
 Edit the layout of the displays by drag and drop.
 Deactivate displays by moving them to the Inactive Displays row.
 Activate displays by moving from Inactive Displays to the Layout Area.
 Create mirror groups by moving displays together in the Mirror with row.
 Unmirror displays by moving from Mirror Group row to Layout Area.
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Mouse & Touchpad Tray App

Access the Tray App
→ Open the tray app by clicking the tray icon. 

The icon is dynamic and represents the detected device:

 If a mouse is detected, the following icon is shown: 
 If a touchpad is detected, or both a mouse and a touchpad are detected, the following icon is 

shown: 
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Configure the Mouse in the Mouse & Touchpad Tray App

You can use the mouse & touchpad tray app to configure the following mouse settings for the detected device:

More...

 Primary Button
Sets the primary button both for mouse and touchpad. In IGEL Setup, you can configure this 
through Left-handed mode.

 Pointer Speed
Sets the speed of the pointer both for mouse and touchpad. In IGEL Setup, you can configure this 
through Pointer speed.

 Double-click Speed 
Sets how fast two consecutive mouse clicks need to happen to be recognized as a double-click. 
You can test this with the click to test area. In IGEL Setup, you can configure this through Double 
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click interval. The smaller the interval, the faster the consecutive clicks need to happen to be 
recognized as a double click.

 Scrolling Direction
Sets the direction of the screen movement when scrolling with the mouse. In IGEL Setup, you can 
configure this through Natural scroll.

Configure the Touchpad in the Mouse & Touchpad Tray App

You can use the mouse & touchpad tray app to configure the following touchpad settings for the detected device:

More...

 Primary Button
Sets the primary button both for mouse and touchpad. In IGEL Setup, you can configure this 
through Left-handed mode under User Interface > Input > Mouse.
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 Pointer Speed
Sets the speed of the pointer both for mouse and touchpad. In IGEL Setup, you can configure this 
through Pointer speed under User Interface > Input > Mouse.

 Enabled
The toggle buttons enables/disables the touchpad.

 Touchpad Sensitivity
Sets how sensitive the touchpad is to the touch. In IGEL Setup, you can configure this through Min 
speed, Max speed, and Acceleration. If you have those values custom configured, it is advised not 
to change the slider in the tray app, as it will reset the levels in the IGEL Setup.

 Scrolling Direction 
Sets the direction of the screen movement when scrolling with the touchpad. In IGEL Setup, you 
can configure this through Natural scroll.

 Scrolling Method
Sets the type of finer movement to be detected as scrolling. In IGEL Setup, you can configure this 
through Two finger vertical scroll and Two finger horizontal scroll under User Interface > 
Input > Touchpad > Scrolling.

 Tap to Click
The toggle switch enables/disables clicking with a tap on the touchpad. In IGEL Setup, you can 
configure this through Tapping mode.

 Palm Detection
The toggle switch enables/disables palm detection. When enabled, it avoids triggering a function 
accidentally with the palm of your hand. The function must be supported by the device. In IGEL 
Setup, you can configure this through Palm detect under User Interface > Input > Touchpad > 
Advanced.

Battery Tray App

Accessing the Tray App
→ Open the tray app by clicking the battery tray icon.

The icon is dynamic and represents the state of the battery:

  When the battery is charging, the following icon is shown: 

 When the battery is discharging, the following icon is shown: 

Get Battery Information
The battery tray app shows information for all available batteries, including multiple internal batteries and 
batteries of connected bluetooth devices.

Change the Powerplan
You can set the CPU power plan regulation under Powerplan. 
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Sound Tray App

Access the Tray App

→ Open the sound tray app by clicking the following icons:  

When the devices are muted the icons change accordingly to:  

Manage Audio Devices
→ Use the dropdown menu to select which output/input device is to be used.

The CPU power plan is set for the current mode in use (AC or Battery). The CPU power plan can be set for 
all modes under System > Power Options > System. For the description of the power plans, see System 
Power Options in IGEL OS 12 (see page 301).
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→ Set the volume for the selected output/input device using the slider.

→ Enable/disable overamplification. If the overamplification parameters are set by your administrator under 
Devices > Audio > Options, you cannot change the setting from the tray app.
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→ Use the Mute All button to mute all the output devices.

Bluetooth Tray App

Access the Tray App
→ Open the B

luetooth tray app by clicking the tray icon: 

Switch Bluetooth On and Off
→ Use the toggle button at the top to switch Bluetooth on and off.

Connect a Bluetooth Device
1. Go to the Available Devices view by clicking the button in the top right corner:

2. Select a device from the list of devices that are available to connect and click Connect. If the 
device needs a PIN for the pairing process, it will be displayed above the Connect button during 
the connect process.
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3. Some bluetooth devices have no names assigned to them. If you enable Show Unnamed Devices, 
you can see these devices in the list with their MAC address displayed.

Manage Connected Bluetooth Devices
1. Go to the Paired Devices view by clicking the button in the top right corner:

2. Select a device from the list and click Connect, Disconnect or Unpair.

The tray app is constantly scanning for available devices as long as the dialog is open.
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Printer Tray App

Access the Tray App

→ Open the printer tray app by clicking the tray icon: 

Connect a New Printer
1. Go to the Available Printers view by clicking the button in the top right corner:

2. Here, you have two options to connect a printer.

The status of the devices is marked next to the drop-down arrow. The connected devices are marked with 
a tick. The paired devices are marked with the link icon.
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a. Option 1: You can add a printer by clicking +. Provide the configurations of the printer and 
click Connect.

The configuration options change according to the selected Device Type. You have the 
following options to set as connection type:

 USB
 TCP
 IPP
 Parallel
 Serial

b. Option 2: You can scan the network for printers, by clicking the scan button. Then, select a 
printer and click Connect.
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Manage Connected Printers
1. Go to the Connected Printers view by clicking the button in the top right corner:

2. Select a printer under Connected Printers.
You can use the Search bar, to search in the list

3. Here you can:
 print a test page from the selected printer
 delete the selected printer
 set the selected printer as default printer and save
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Manage Printing Jobs
Under Jobs, you can see the list of printer jobs with status info (like Processing, Pending, Aborted). When an error 
occurs, the error messages are displayed under the job.

→ Use the trash icon to cancel a printer job.

Only one default printer can be set (i.e. setting a printer to default means that an existing one loses this 
property.) If there is a default printer set by the admin, the user cannot set another printer as default.
If a printer is set by your administrator, you cannot delete or modify it. But you can still print a test page.
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OpenConnect VPN Tray App

Access the Tray App
→ Open the OpenConnect VPN tray app by clicking the icon.

Get Information of VPN Connection
You can find the status information of the VPN connection under More Details. The status is also shown in the 

displayed tray icon .

Disconnect from VPN
You can click Disconnect to disconnect from the OpenConnect VPN connection.

For more information on the OpenConnect VPN App, see OpenConnect VPN62.

Language & Keyboard Layout Tray App

Access the Tray App
→ Open the language & keyboard tray app by clicking the tray icon with the keyboard layout abbreviation. The 

abbreviation represents the in-use keyboard layout. For example:  (French keyboard layout with variation CH)

Change System Language
1. Select a language from the dropdown under Display Language and click Change Language.

62. https://kb.igel.com/en/igel-apps/current/openconnect-vpn

https://kb.igel.com/en/igel-apps/current/openconnect-vpn
https://kb.igel.com/en/igel-apps/current/openconnect-vpn
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2. Confirm to apply the changes.

The changing of the language restarts the desktop and the running sessions.

Change Keyboard Layout
→ To change the keyboard layout select one of the available Keyboard Layouts. The available layouts are defined 
centrally by the UMS through the applied profiles.

You can see the keyboard layout abbreviation change in the taskbar accordingly.
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After reboot, the keyboard layout reverts to the default keyboard layout. The default keyboard layout is 
the configured through a profile under User Interface > Input > Keyboard63.
The selectable keyboard layouts can be added through profiles as additional keyboard layouts under User 
Interface > Input > Additional Keyboard Layouts64.

63. https://kb.igel.com/en/igel-os-base-system/current/keyboard-settings-in-igel-os-12
64. https://kb.igel.com/en/igel-os-base-system/current/additional-keyboard-layouts-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/keyboard-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/additional-keyboard-layouts-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/keyboard-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/additional-keyboard-layouts-in-igel-os-12
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Configure the Language & Keyboard Layout Tray App
The following configurations can be applied through profiles:

 enable/disable the tray app with the option Show keyboard layout switcher in taskbar under 
Language Settings in IGEL OS 1265.

 enable/disable the display language change with the option Show language setting together 
with keyboard layout in tray-app under Language Settings in IGEL OS 1266.

If the Language is configured under User Interface > Input > Language67, it cannot be changed using the 
tray app. If you want to enable users to set the system language, make sure to set this back to default. 
Otherwise, they will see the following message.

65. https://kb.igel.com/en/igel-os-base-system/current/language-settings-in-igel-os-12
66. https://kb.igel.com/en/igel-os-base-system/current/language-settings-in-igel-os-12
67. https://kb.igel.com/en/igel-os-base-system/current/language-settings-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/language-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/language-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/language-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/language-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/language-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/language-settings-in-igel-os-12
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How to Create Shortcuts to Tray Applications in IGEL OS 12
You can create shortcuts to run commands with the help of custom applications. For example, you can configure a 
custom application (see page 334) as a desktop shortcut to open a tray application dialog (see page 367). For this, you can 
use the igel-system-tray  CLI commands.

Profile with Tray App Shortcuts Configured as Custom Applications
You can find attached a OS 12 profile with examples of shortcuts for the tray applications available at the time of 
writing. You can import this profile as described in (12.06.100-en) Exporting and Importing Profiles in the IGEL UMS 
Web App .

IGEL OS 12 Tray Applications Shortcuts.ipm

How to Create Shortcuts as Custom Application
To create a custom application and configure shortcuts:

1. In the profile configurator, go to System > System Customization > Custom Application. For 
details, see Custom Application in IGEL OS 12 (see page 334) .

2. Add a new custom application session and give it a name.

3. Set the starting methods of the session according to your needs. For example, you can set a 
shortcut in the desktop context menu. For details, see Starting Methods for Apps (see page 421) .

3. Under Settings > Icon large, set the icon to be displayed for the shortcut.

The profile comes with shortcuts in the start menu, the desktop and the desktop context menu. The 
shortcuts use the suitable icon for each app.

You can browse icons that are available in the system with the /usr/bin/yad-icon-browser
command:
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You can also use the gpicview  command to check the images in a given directory, for example in /

usr/share/icons :

The taskbar icon of a session cannot be customized and will remain the default icon.
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4. Under Settings > Command, enter the command you would like the custom application to 
perform.
For example, set igel-system-tray -d input  for opening the mouse tray app.

CLI of Tray Applications for Reference

igel-system-tray --help
Usage:
  igel-system-tray [OPTION...]
 
Help Options:
  -h, --help                 Show help options
  --help-all                 Show all help options
  --help-gapplication        Show GApplication options
  --help-gtk                 Show GTK+ Options
 
Application Options:
  -v, --version              Print application version and terminate
  -r, --reload               Reload the running system tray
  -e, --enable               Enable the given tray icon. Currently available: [audio, 
mobile_broadband, wifi, lan, battery, rmagent, printer, ums_status]
  -d, --dialog               Show dialog. Currently available: [display, 
display_advanced, audio, mobile_broadband, wifi, lan, battery, input, printer, 
ums_status]
  -m, --monitor-backend      Force a specific monitor backend, possible values are: 
randr (default),file. Backends can be configured by appending parameters with a ":", 
for example file backend needs an input parameter: --monitor-backend=file:input=/tmp/
monitor.json
  -s, --screen               Set screen lock state: locked, unlocked
  -V, --verbose              Start in verbose mode
  --display=DISPLAY          X display to use
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Accessibility Tray Apps in IGEL OS 12
IGEL OS 12 includes two accessibility tray apps. The general accessibility tray app  is enabled by default to 

individually manage and configure accessibility settings. The screen magnifier tray app  appears only when the 
screen magnifier is activated and allows to control the screen magnifier feature.

Information for Administrators
 The system tray and most of the tray apps are available to the users by default.
 You can enable and disable the system tray and the tray apps under User Interface > 

Desktop > Taskbar Items. For details, see Taskbar Items in IGEL OS 1268.
 The access to tray apps on lockscreen is configured separately under User Interface > 

Desktop > Screenlock / Screensaver > Taskbar. For details, see Taskbar in Locked 
Screen in IGEL OS 1269.

 The configurations in the tray app might slightly differ from the configurations available in 
IGEL Setup. IGEL Setup remains the place for administrators to set the framework for their 
end users (e. g. access to tray apps or starting sessions). The tray apps are designed for 
end users to make individual adjustments as needed.

68. https://kb.igel.com/en/igel-os-base-system/current/taskbar-items-in-igel-os-12
69. https://kb.igel.com/en/igel-os-base-system/current/taskbar-1

https://kb.igel.com/en/igel-os-base-system/current/taskbar-items-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/taskbar-1
https://kb.igel.com/en/igel-os-base-system/current/taskbar-items-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/taskbar-1
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Accessibility Tray App

The accessibility tray app provides a central place to adjust IGEL OS 12 for improved readability, visibility, and input 
control. From here, you can configure themes, color filters, screen magnifier and screen reader, as well as mouse 

and keyboard behaviour. Each area includes a reset icon  in the top-right corner to quickly revert to the default 
configuration.
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Themes

Choose a base theme from the dropdown to adjust the user interface theme. By default, Colored IGEL Theme is 
selected. Confirm your choice by clicking Set Theme.

Available themes

 Colored IGEL Theme
 Dark IGEL Theme
 Light IGEL Theme
 High Contrast Theme
 Inverted High Contrast Theme
 Custom Theme

In the field Base Color, it is possible to enter a color code in HTML hex format to set a custom base color, e. g. 
#000000 to display black.

In IGEL Setup, you can use a color picker to design individual base colors. For more information see 
Themes70.

70. https://kb.igel.com/en/igel-os-base-system/current/themes

https://kb.igel.com/en/igel-os-base-system/current/themes
https://kb.igel.com/en/igel-os-base-system/current/themes
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Color Filter

Use the toggle next to Use Color Filter to enable or disable color filters. By default, this option is disabled.

Available color filters

 Protanopia (Red/Green)
 Protanopoa (Red/Green) High Contrast
 Deuteranopia (Red/Green)
 Deuteranopia (Red/Green) High Contrast
 Tritanopia (Blue/Yellow)
 Monochrome
 Monochrome Inverted
 Inverted

Set the Filter Strength either by dragging or clicking in the bar. (Default filter strength: 100)

Screen Magnifier



Tray Applications in IGEL OS 12

IGEL OS Base System   410 / 691

Use the toggle next to Use Screen Magnifier to enable or disable the screen magnifier. By default, the screen 
magnifier is disabled. Enabling the screen magnifier opens a separate window and tray app where you can 
configure the screen reader. For more information, see Using the Screen Magnifier Tray App71.

Screen Reader

Use the toggle next to Use Screen Reader to enable or disable the screen reader. By default, the screen reader is 
disabled.

Mouse

Modify the mouse pointer size from the bar by dragging or by clicking in the bar. The available mouse pointer sizes 
range from 16 to 94 (Default size: 24).

In IGEL Setup, it is possible to configure the starting methods for sessions, for more information see 
Screen Magnifier72.

In IGEL Setup, it is possible to configure the starting methods for sessions, for more information see 
Screen Reader73.

71. https://kb.igel.com/en/igel-os-base-system/current/accessibility-tray-apps-in-igel-os-12#Using-the-Screen-Magnifier-Tray-
App

72. https://kb.igel.com/en/igel-os-base-system/current/screen-magnifier
73. https://kb.igel.com/en/igel-os-base-system/current/screen-reader

https://kb.igel.com/en/igel-os-base-system/current/accessibility-tray-apps-in-igel-os-12#Using-the-Screen-Magnifier-Tray-App
https://kb.igel.com/en/igel-os-base-system/current/screen-magnifier
https://kb.igel.com/en/igel-os-base-system/current/screen-reader
https://kb.igel.com/en/igel-os-base-system/current/accessibility-tray-apps-in-igel-os-12#Using-the-Screen-Magnifier-Tray-App
https://kb.igel.com/en/igel-os-base-system/current/screen-magnifier
https://kb.igel.com/en/igel-os-base-system/current/screen-reader
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Keyboard Mouse

Use the toggle to enable or disable the keyboard mouse. By default, the keyboard mouse is disabled.

Click here to see how to navigate the mouse when the keyboard mouse is enabled:

 Use NumPad 5 for left-clicks.
 Use Shift + NumPad 5 for right-clicks
 Use NumPad 4 and 6 for horizontal movement.
 Use NumPad 2 and 8 for vertical movement.
 Use NumPad 1, 3, 7 and 9 for diagonal movement.



Tray Applications in IGEL OS 12

IGEL OS Base System   412 / 691

Keyboard Sensitivity

Repeat Keys
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Use the toggle next to Use Repeat Keys to enable or disable repeat keys. By default, this option is enabled.

Configuration options for repeat keys:

 Repeat Delay: Determines the delay (in milliseconds) before automatic repetition begins. (Default: 
660)

 Repeat Rate: Determines the number of times a character repeats per second. (Default: 40)

Slow Keys

Use the toggle next to Use Slow Keys to enable or disable slow keys. By default, this option is disabled.

Configuration options for slow keys:

 Input Delay: Set the delay in milliseconds before the key input is accepted.
 Press Beep: Output beep when a key is pressed.
 Acceptance Beep: Output beep when a key was registered.
 Rejection Beep: Output beep when a key was not registered.

Bounce Keys

Use the toggle next to Use Bounce Keys to enable or disable bounce keys. By default, this option is disabled.

Configuration option for bounce keys:

 Rejection Beep: Output beep when a duplicated press happened.

Sticky Keys

Use the toggle next to Use Sticky Keys to enable or disable sticky keys. By default, this option is disabled.

Configuration option for sticky keys:

 Deactivation by two keys: Disable sticky keys by pressing two modifier keys simultaneously.
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Using the Screen Magnifier Tray App

The screen magnifier tray app  only appears when the screen magnifier option is enabled. Clicking on the tray 
app will open and close the screen magnifier window.

Configuration options within the screen magnifier window:

Follow Mouse (M)
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This option is enabled by default. The magnified area follows the mouse.

Fixed Center (F)

The magnified area stays at a fixed position on the screen. Dragging the window to a different spot changes the 
magnified area to be displayed.

Zoom (+/-)

Set the zoom level from 1x to 16x. By default, this value is set to 2x.

Minimap

 Enables a minimap at the bottom of the window. It shows the magnified area on the screen.

☐ Minimap is disabled. (Default)

Stay on top

 The magnifier window always stays on top of other screens. (Default)

☐ The magnifier window behaves like a normal window. It can be covered by other applications.

Smoothing

 Reduces pixelation and jagged edges in the magnified area.

☐ Smoothing is disabled. (Default)
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Boot Process
The following stages of the boot process are important from a configuration perspective:

1. Second stage loader, the loading of the kernel
 You can access the Boot Menu in this stage. For details, see Boot Menu (see page 417).
 You can set up Base Custom Commands with specific execution times. For details, see 

Base (see page 320). 
2. Network Integration

 After the kernel has loaded, network configurations are applied. Depending on the settings 
of the endpoint device, there are three possible ways of integrating the endpoint device into 
the network environment:

 DHCP
 BOOTP
 Manually configured IP address

3. Starting the X server and the local windowmanager
 You can set up Desktop Custom Commands for the stages of the X server launch. For details, 

see Desktop Custom Commands in IGEL OS 12 (see page 322).

The network interface can be stopped and restarted on the Linux Console 
(accessible via [Ctrl]+[Alt]+[F11]) with this command:  /etc/init.d/

network stop   /etc/init.d/network start
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Boot Menu in IGEL OS 12
During the boot process, a boot menu is available on request. Through this menu, you can start boot modes for 
troubleshooting. There are modes to access system parameters, or to reset the device to the factory defaults if the 
device is configured incorrectly or if you experience problems when booting.

→ During the boot process, press the [Esc] key repeatedly in rapid succession in the second stage loader, when the 
loading kernel  message is shown on the screen.

The boot menu is displayed with the available boot modes:

Using the arrow keys, navigate to one of the boot modes and press the [Enter] key to start the process. You can start 
the following boot modes:

 Quiet boot (see page 418): Normal startup. (Default)
 Verbose boot (see page 418): Start with system messages and an interactive root shell
 VESA only boot (see page 418): Basic graphic boot
 Emergency boot (setup only) (see page 418): Only the Setup window is available
 Failsafe boot with CRC check (see page 419): Start with an integrity check of the operating system
 Reset to factory defaults (see page 419): Reset the client to factory defaults
 Custom boot command (see page 419): Boot with configurable command line options



Boot Process

IGEL OS Base System   418 / 691

Quiet Boot
Quiet boot is the default boot mode. It is the normal startup mode. In this mode, all kernel messages are disabled 
and the graphical user interface is started.

Verbose Boot
Unlike in Quiet boot mode, the kernel messages are shown in Verbose boot mode. The boot process also pauses 
before the graphics system and the user session start.

This gives you an opportunity to open a root shell and interactively execute debugging commands (for 
example,  ifconfig ).

To execute debugging commands:

1. Select Verbose boot from the boot menu.
2. Wait until the boot messages stop at  Reached target IGEL Network Online .
3. Open a virtual console with one of the key combinations:

 [Ctrl] + [Alt] + [F11]
 [Ctrl] + [Alt] + [F12]

4. Log in by pressing [Return] and enter the root password if necessary.
5. Go through the desired individual commands.
6. Now enter the following command to continue the normal boot process: systemctl 

default
The graphical user session starts.

VESA Only Boot
Use this boot mode if normal boot has graphic issues, for example, if the device has limited Graphical Processor 
Unit (GPU) support. This mode is not manufacturer specific. In this mode resolution and multimonitor mode and 
performance might be limited.

Emergency Boot (Setup Only)
In the Emergency boot mode, the device is started without network drivers and with a resolution of 640 x 480 - 60 
Hz. After the boot process, the Setup window is opened automatically.

This mode is useful, for example, if you have selected an excessively high screen resolution or a wrong mouse type 
and these settings can no longer be changed in the normal setup. Unlike with a reset, the setup opens with the 
actual settings.

Only use the root shell if you have adequate knowledge of Linux or if you are instructed to do so by the 
IGEL Helpdesk and are given appropriate guidance. Incorrect use can destroy the operating system.
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→ Once you are done with the changes, close the setup window to reboot the device.

Failsafe Boot with CRC Check
During a Failsafe boot, a check of the file system is carried out first. Then, the Verbose boot is started.

This mode is helpful if you no longer have a bootable system after a firmware update. The Failsafe boot checks 
where the problem is. If need be, an old version will be booted and you will need to repeat the firmware update.

Reset to Factory Defaults

Before the reset procedure is carried out:

1. Confirm the displayed warning message.
2. If the device is protected by an administrator password, enter the password. You have three 

attempts.

Custom Boot Command
In the Custom boot command mode, preconfigured options are placed on the kernel command line. This allows 
you, for example, to investigate and rectify problems with specific hardware components.

To configure the options for the Custom boot command, proceed as follows:

1. Open a local terminal and log in as  root .

If you select Reset to factory defaults, all personal settings on the device (including your password and 
the sessions you have configured) will be lost.

You can reset IGEL OS devices to factory defaults through the boot menu, but the best practice is to reset 
devices using the OSC as descried in How to Deploy IGEL OS 12 with IGEL OS Creator (OSC)74.
You can also reset your device to factory defaults through the UMS Web App. In this case, the device will be 
removed from the UMS and you will have to register your device with the UMS again. For details, see How 
to Reset a Device to Factory Defaults via the IGEL UMS Web App75.

The administrator password can be set or changed under Security > Password > Administrator76 using a 
profile or the device configurator in the IGEL UMS Web App.

The Custom boot command is merely a temporary solution – it is not an everyday booting method. It 
must therefore be selected manually in the boot menu.

74. https://kb.igel.com/en/igel-os-base-system/current/how-to-deploy-igel-os-12-with-igel-os-creator-osc
75. https://kb.igel.com/en/universal-management-suite/current/how-to-reset-a-device-to-factory-defaults-via-the-
76. https://kb.igel.com/en/igel-os-base-system/current/password-and-user-types-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/how-to-deploy-igel-os-12-with-igel-os-creator-osc
https://kb.igel.com/en/universal-management-suite/current/how-to-reset-a-device-to-factory-defaults-via-the-
https://kb.igel.com/en/igel-os-base-system/current/password-and-user-types-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/how-to-deploy-igel-os-12-with-igel-os-creator-osc
https://kb.igel.com/en/universal-management-suite/current/how-to-reset-a-device-to-factory-defaults-via-the-
https://kb.igel.com/en/igel-os-base-system/current/password-and-user-types-in-igel-os-12
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2. Enter the following command to bring up the current options:
bootreg get /dev/igfdisk boot_cmd

3. Save your desired options with the following command:
bootreg set /dev/igfdisk boot_cmd "<Your Options>"

4. Check the options that you have entered:
bootreg get /dev/igfdisk boot_cmd

IGEL Tech Video

If you would like to delete options for the Custom boot command, leave an empty string of characters in 
their place:  bootreg set /dev/igfdisk boot_cmd ""

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=bpfWNIR6eUE

In the video, IGEL OS11 is used for demonstration.

https://www.youtube.com/watch?v=bpfWNIR6eUE
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Starting Methods for Apps
For all sessions that can be started by the user, a selection of starting methods is provided.

Session name: Name for the session.

Starting Methods for Session

Start menu

 The session can be launched from the start menu.

Menu folder

If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be 
created for the session. The menu path will be used in the start menu and in the desktop context menu.

Start menu's system tab

 The session can be launched with the start menu's system tab.

Application Launcher

 The session can be launched with the Application Launcher.

Application Launcher folder

If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be 
created for the session. The menu path will be used in the Application Launcher.

Desktop

 The session can be launched with a program launcher on the desktop.

Desktop folder

If you specify a folder name or a path comprising a number of folder names separated by "/", a menu path will be 
created for the session. The menu path will be used for the program launcher on the desktop.

Desktop context menu

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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 The session can be launched with the desktop context menu.

Quick start panel

 The session can be launched with the quick start panel.

Password protection

Specifies which password will be requested when launching the session.

Possible values:

 None: No password is requested when launching the session.
 Administrator: The administrator password is requested when launching the session.
 User: The user password is requested when launching the session.
 Setup user: The setup user password is requested when launching the session.

Hotkey Configuration
Hotkey

 The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers

A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/combination or 
your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

 (No modifier) =  None

  =  Shift
 [Ctrl] =  Ctrl

  =  Mod4

Password protection only works if the selected password is configured under Security > Password. 
Without the password configuration, the session will launch without requesting a password. For more 
information, see Password and User Types in IGEL OS 12 (see page 241).

Do not use [AltGr] as a modifier (represented as  Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".
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 [Alt] =  Alt

Key combinations are formed as follows with  | :

 Ctrl +  =  Ctrl|Super_L

Key

Key for the hotkey

Autostart Configuration
Autostart

 The session will be launched automatically when the device boots.

Restart

 The session will be relaunched automatically after the termination.

Autostart delay

Waiting time in seconds between the complete startup of the desktop and the automatic session launch.

Autostart notification

This parameter is available if Autostart is activated and Autostart delay is set to a value greater than zero.

 For the duration defined by Autostart delay, a dialog is shown which allows the user to start the session 
immediately or cancel the automatic session start.

☐ No dialog is shown; the session is started automatically after the timespan specified with Autostart delay.

When this keyboard key is used as a modifier, it is represented as  Mod4 ; when it is used as a key, it is 

represented as  Super_L .

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on 
as  user  and enter  xev -event keyboard . Press the key to be used for the hotkey. The text in 

brackets that begins with  keysym  contains the key symbol for the Key field. 

Example:  Tab  in  (keysym 0xff09, Tab)
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Autostart requires network

 If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Articles on Deploying and Updating IGEL OS 12
 How to Deploy and Use IGEL OS Dual Boot (IGEL Business Continuity & Disaster Recovery) (see page 

426)
 How to Configure Distributed Peer Update with IGEL OS 12 Devices (see page 439)
 Downgrade Limit on IGEL OS 12.7.1 or Higher (see page 449)
 How to Deploy IGEL OS 12 with IGEL OS Creator (OSC) (see page 450)
 How to Deploy IGEL OS 12 with IGEL OS 12 SCCM Add-on (see page 481)
 How to Deploy IGEL OS 12 with IGEL OS Creator for Windows (OSCW) (see page 505)
 How to Deploy IGEL OS 12 with PXE (see page 545)
 How to Use IGEL OS 12 with UD Pocket (see page 556)
 Troubleshooting: SCEP Certificate Renewal Failure due to Hostname Change (see page 563)
 Upgrading from IGEL OS 11 to IGEL OS 12 (see page 565)
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How to Deploy and Use IGEL OS Dual Boot (IGEL Business Continuity & 
Disaster Recovery)
If Windows becomes unavailable, whether due to a security breach, malware infection, or a system failure, you can 
quickly boot into IGEL OS and maintain business continuity. IGEL OS Dual Boot also enables testing or evaluation of 
IGEL OS alongside Windows, without replacing the existing environment.

How IGEL Dual Boot Works
IGEL provides a Windows installer that installs IGEL OS in parallel with Microsoft Windows. The installer reduces the 
size of the Windows system partition and creates a new partition for IGEL OS. Then it retrieves the initial IGEL OS 
image from the device’s storage, validates it, writes it to this partition, and installs an IGEL bootloader. After 
installation, the user can choose the system to boot using hotkeys at boot time, or permanently set the default boot 
entry within Windows through a system tray app.

Requirements

 You have local administrator rights on the device.
 Windows 11 with EFI Boot is running on the device.
 Minimum of 36 GB of free storage space in the Windows system partition ( C: ). This value is 

composed of 20 GB as reserve storage space for Windows + 16 GB for IGEL OS. Please note that you 
can set a size between 16 GB and 64 GB in the IGEL OS Dual Boot installer. 128 GB storage space is 
recommended.

 You have acquired the following software:
 IGEL OS Dual Boot 1.1 or higher. Please contact your IGEL representative to get access and 

guidance.
 The Dual Boot variant of IGEL OS 12.7.4 or higher from https://igel.com/software-downloads 

> OS 12 Base System Image for Dual Boot or from https://app.igel.com/software > IGEL 
OS 12 Base System Image for Dual Boot.

IGEL OS should be booted, updated, and tested periodically as part of your BC&DR plan. We recommend 
working with your assigned TRM to coordinate the process.

Device Backup Strongly Recommended
Installing IGEL OS Dual Boot will perform critical system modifications. Therefore, it is strongly 
recommended to back up all important data on your device. Installing IGEL OS Dual Boot without having a 
backup may result in data loss.

https://igel.com/software-downloads
https://app.igel.com/software
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Installing IGEL OS Dual Boot

Installation via GUI

1. Save the installer and the IGEL OS package ZIP file on your Windows device.

2. Double-click the installer icon, confirm the dialog Do you want to allow this app to make 
changes to your devices? and accept the license agreement.
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3. Read the warning carefully, confirm that you understand the risks, and click Next.
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4. Accept the license agreement and click Next.

5. Provide the following data (some of the files are optional as they can be provided by the UMS after 
device registration):

 Base…: (Required) The ZIP file that contains the Dual Boot variant of IGEL OS, e.g., 
IGEL_OS_12.7.4_dualboot.zip .

 Certificates…: (Optional) One or more certificate files (multiple files can be selected in the 
file browser). Possible formats: *.crt , *.cer , *.pem

 Licenses…: (Optional) The license file that contains the license for this device, as a plain file 
or in an archive. Possible formats: *.lic , *.lic.gz

 Settings…: (Optional) The settings file for your device, as a plain file or in an archive. 
Possible formats: *.ini , *.ini.gz , *.ini.bz

 Partition size: The size of the partition that will be created for IGEL OS. Minimum: 16 GB; 
maximum: 64 GB; default: 16 GB

 Show IGEL Boot menu: If enabled, the IGEL Boot menu is shown at the next system start. 
(Default: enabled)

 Enable boot-entry check at each startup: If enabled, the correct installation of the IGEL 
bootloader will be checked on each startup of MS Windows. If necessary, it will be repaired. 
(Default: enabled)
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The IGEL OS Dual Boot installer verifies the system requirements.

4. Once the system requirements have been verified successfully, click Install.

IGEL OS Dual Boot is installed on your device.
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4. Click OK to complete the installation. The device restarts and boots into IGEL OS.
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5. Connect your device to the UMS to integrate it with your environment. For in-depth introductory 
information, see How to Start with IGEL77

Installation via Command-Line Interface (CLI)
You can install IGEL OS Dual Boot via CLI. The exact syntax depends on whether you are using the EXE file or the MSI 
installer; see the examples below.

Files to Be Integrated

The files to be installed are specified with the following parameters:

 /base  - path to the ZIP file that contains the IGEL OS Base System. Prefills the corresponding 
field in the installer GUI

 /certs  - one or more certificate file paths (semicolon-separated). Populates the Certificates list 
in the GUI

 /licenses  - one or more license file paths (semicolon-separated). Populates the Licenses list 
in the GUI

 /settings  - one or more settings file paths (semicolon-separated). Populates the Settings list 
in the GUI

Partition Size

The partition size is specified with the following parameter:

 /partitionsize  - the size of the partition in GB that will be created for IGEL OS. Minimum: 16; 

maximum: 64; default: 16. Example: /partitionsize=64

Switching off the Boot Menu

To switch off the boot menu, use the following parameter:

 /nobootmenu  - prevents the boot menu from being shown at system startup.

Disabling the Bootloader Check

 /nobootentrycheck  - disables checking the correct installation of the IGEL bootloader on 
each startup of MS Windows; the check includes a repair if necessary.

Enable boot-entry check at each startup: If enabled, the correct installation of the IGEL bootloader will be 
checked on each startup of MS Windows. If necessary, it will be repaired.

77. https://kb.igel.com/en/how-to-start-with-igel/current/

https://kb.igel.com/en/how-to-start-with-igel/current/
https://kb.igel.com/en/how-to-start-with-igel/current/
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Silent Installation

To perform a silent installation, which is the preferred option for scripting, add /accepteula  (mandatory) and 

/silent  or /verysilent . For details, see the explanations below.

 /accepteula  - by adding this parameter, you confirm that you accept the EULA.

 /silent  - a dialog is shown, but the installation is performed without user intervention

 /verysilent  - the installation is performed without user intervention, no dialog is shown

Log File Path

 /LOG  - file path under which the IGEL Dual Boot installer will store its logfile. This logfile can be 
used for analyzing problems during installation. Examples:

 /LOG=”setup.log”  - the logfile setup.log  is stored in the location of the installer 
file

 /LOG="C:\ProgramData\IGEL\logs\setup.log"  - the logfile setup.log  is 
stored in the same path as the other logfiles of IGEL Dual Boot

Example Using the EXE file

setup-igel-dual-boot_1.0.0.exe /base="C:\temp\base.zip" /certs="C:

\certs\a.crt;C:\certs\b.crt" /licenses="C:\licenses\l1.lic;C:

\licenses\l2.lic.gz" /settings="C:\config\s1.ini;C:\config\s2.ini.gz" /

verysilent /accepteula

Example Using the MSI installer

setup-igel-dual-boot_1.0.0.msi WRAPPED_ARGUMENTS="/base=""C:\temp\base.zip"" /

certs=""C:\certs\a.crt;C:\certs\b.crt"" /licenses=""C:\licenses\l1.lic;C:

\licenses\l2.lic.gz"" /settings=""C:\config\s1.ini;C:\config\s2.ini.gz"" /

verysilent /accepteula"

Logging
IGEL Dual Boot creates logs during its operation. The log files are stored in C:\ProgramData\IGEL\logs ; 

please note that C:\ProgramData\ is a hidden folder.

Licensing with the Universal Management Suite (UMS)
If you have not included the license files during installation, the licenses must be deployed via the UMS.
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If Your IGEL OS Dual Boot Devices Are Connected to a Separate UMS
In this case, you can deploy the licenses you have received with your Business Continuity purchase to all devices of 
your UMS.

If Your IGEL OS Dual Boot Devices Are Connected to a Productive UMS
In this case, you must define distribution conditions in your UMS to differentiate between the devices already 
registered in the UMS and those devices that are to receive the licenses from your Business Continuity purchase.

To define the appropriate distribution conditions:

1. Create a view that collects devices whose device name starts with “BC”. For details on creating a 
view, see https://kb.igel.com/en/universal-management-suite/current/how-to-create-a-new-view-
in-the-igel-ums.

2. Define the distribution conditions for your BC&DR licenses based on the view you have created. 
For details on defining distribution conditions, see Distributing Licenses to Devices in a Specified 
View78.

Switching IGEL OS at Boot Time

Using the IGEL Boot Menu
When IGEL OS Dual Boot is installed, you can start IGEL OS at boot time using the IGEL Boot Menu. It is available for 
a short time during device startup. This also applies in the case of an emergency, i.e., if the MS Windows installation 
has been compromised.

→ Choose the desired operating system from the menu:

 Windows (default): Please note that the system to be booted next can be defined by the tray app 
under MS Windows. Also note that the selection made here overrides the setting of the tray app.

 OS 12 IGEL OS Dual Boot: The IGEL OS system that has been installed with the Dual Boot facility is 
started

 IGEL OS USB Boot: If an IGEL OS USB Boot stick is inserted into the device, the system located on 
it is started

 Advanced Options:
 IGEL OS Verbose boot: See Boot Menu in IGEL OS 1279, section Verbose Boot80

 IGEL OS VESA only boot: See Boot Menu in IGEL OS 1281, section VESA Only Boot82

78. https://kb.igel.com/en/igel-subscription-and-more/current/configuring-the-distribution-
conditions#HowtoConfiguretheDistributionConditionsofLicensesinIGEL-
DistributingLicensestoDevicesinaSpecifiedViewDistributing-Licenses-to-Devices-in-a-Specified-View

79. https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12
80. https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12#id-(12.7.1-en)BootMenuinIGELOS12-

VerboseBootVerboseBoot
81. https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12
82. https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12#id-(12.7.1-en)BootMenuinIGELOS12-

VESAOnlyBootVESABoot

https://kb.igel.com/en/universal-management-suite/current/how-to-create-a-new-view-in-the-igel-ums
https://kb.igel.com/en/igel-subscription-and-more/current/configuring-the-distribution-conditions#HowtoConfiguretheDistributionConditionsofLicensesinIGEL-DistributingLicensestoDevicesinaSpecifiedViewDistributing-Licenses-to-Devices-in-a-Specified-View
https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12#id-(12.7.1-en)BootMenuinIGELOS12-VerboseBootVerboseBoot
https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12#id-(12.7.1-en)BootMenuinIGELOS12-VESAOnlyBootVESABoot
https://kb.igel.com/en/igel-subscription-and-more/current/configuring-the-distribution-conditions#HowtoConfiguretheDistributionConditionsofLicensesinIGEL-DistributingLicensestoDevicesinaSpecifiedViewDistributing-Licenses-to-Devices-in-a-Specified-View
https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12#id-(12.7.1-en)BootMenuinIGELOS12-VerboseBootVerboseBoot
https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12#id-(12.7.1-en)BootMenuinIGELOS12-VESAOnlyBootVESABoot
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 IGEL OS Emergency boot (setup only): See Boot Menu in IGEL OS 1283, section Emergency 
Boot (Setup Only)84

Using a Hotkey (with IGEL Boot Menu Disabled)
If the IGEL Boot Menu is disabled, you can use a hotkey to boot directly into IGEL OS or to open the IGEL Boot Menu.

→ To boot directly into IGEL OS, press one of the following hotkeys during bootup:

 [+] on the keypad
 [R]
 [F5]

→ To open the IGEL Boot Menu, press [F4] during bootup.

83. https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12
84. https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12#id-(12.7.1-en)BootMenuinIGELOS12-

EmergencyBoot(SetupOnly)EmergencyBoot

https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12#id-(12.7.1-en)BootMenuinIGELOS12-EmergencyBoot(SetupOnly)EmergencyBoot
https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/boot-menu-in-igel-os-12#id-(12.7.1-en)BootMenuinIGELOS12-EmergencyBoot(SetupOnly)EmergencyBoot
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Changing the Default Operating System via the System Tray App

1. Open the tray app menu and right-click the IGEL OS icon .

2. Click Configuration Menu.

3. Select the desired behaviour on next boot and click Ok.
 Windows: The device will boot into Windows.
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 IGEL OS: The device will boot into IGEL OS.
 Show IGEL Boot Menu: The device will show the IGEL Boot Menu.

Uninstalling IGEL OS Dual Boot
→ Uninstall IGEL OS Dual Boot like any other program on your device.

When IGEL OS Dual Boot is uninstalled, the device reverts to booting into Windows only, as before. The IGEL OS 
partition will be deleted, and the 16 GB storage space will be added to the Windows partition again.
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How to Configure Distributed Peer Update with IGEL OS 12 Devices
The Distributed Peer Update feature in IGEL OS 12 (formerly known as Buddy Update in IGEL OS 11) allows IGEL OS 
12 devices to act as local update servers. Instead of each device downloading applications and firmware updates 
from a central repository (for example, UMS app proxy, Distributed App Repository, IGEL App Portal), devices in the 
same local network can share the download load between them.

Using the Distributed Peer Update mechanism reduces:

 bandwidth usage across WAN links
 load on central repositories
 time until all devices in a subnet receive the assigned updates

Starting from IGEL OS 12.7.4, the IGEL Discovery service allows endpoint devices on the same local network to 
automatically find and obtain updates from one another. For details, see the section How IGEL Discovery Works (see 
page 443).

Limitations and Known Issues

Community Applications Not Supported Yet
Currently, community applications are not supported by Distributed Peer Update. Including a community 
application in an update can break the entire update process. Fixes are planned to be added with a future IGEL OS 
12 release.

HTTPS Not Supported Yet
Currently, the communication for the Distributed Peer Update is done through HTTP by default. HTTPS support is 
planned to be added with a future IGEL OS 12 release.

Components
Peer-to-peer distribution relies on two components that run on IGEL OS devices:

 IGEL Discovery
 Distributed Peer Update Server (“Buddy”)

Together, these components allow peer-to-peer distribution of applications and updates within the same subnet.

Do not use Distributed Peer Update for updates that include community applications until fixes are 
available.
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Component Description Network Traffic Types Configuration

IGEL Discovery Zero-configuration peer 
discovery service that 
automatically discovers 
peers that already have 
applications available. It 
also decides if a device that 
should download from a 
repository if no peer has the 
application.

IGEL Discovery works only 
within the same broadcast 
domain. The Discovery uses:

 UDP broadcast requests 
within the local subnet

 UDP unicast for 
responses between 
devices

System > Update 
> IGEL Discovery85

Distributed Peer 
Update Server 
(“Buddy”)

HTTP server running on the 
device that provides 
applications and updates to 
other IGEL OS devices.

HTTP peer transfers System > Update 
> Distributed 
Peer Update 
Server86

Requirements

IGEL OS Version
IGEL OS 12 devices need to run IGEL OS Base System version 12.7.4 or higher.

Port Requirements
The IGEL Discovery service and the Distributed Peer Update Server use separate ports, as described in the table 
below:

Service Protocol Default Port Configuration

IGEL Discovery UDP 22336 System > Update > IGEL 
Discovery > Port

Distributed Peer Update 
Server

HTTP 22335 System > Update > 
Distributed Peer Update 
Server > Port of the 
distributed peer update 
server

When configuring the ports, consider the following:

 The Distributed Peer Update Server and the IGEL Discovery service must run on different ports.
 The same Discovery port must be configured on all devices that should discover each other.

85. https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
86. https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig

https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
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 The same Distributed Peer Update Server port must be configured on all devices that should act as 
peers for each other.

 The configured ports must be open and allowed by any host firewall on the endpoint and by any 
network firewalls between devices.

Network Requirements
Some network configurations may prevent discovery from working correctly. In these environments, devices may 
not be able to discover peers automatically.

For example:

 Wi-Fi networks with client isolation
 Networks that block broadcast traffic

Fallback Behavior with Repositories
Peer-to-peer distribution relies on IGEL Discovery to locate a device that already has the requested application. If 
no device in the subnet can provide the application, Discovery elects one device to download the application from a 
configured repository. This device becomes the fallback candidate. Once the application is downloaded and 
installed, the device can serve it to other devices as the Distributed Peer Update Server.

The fallback device downloads the application from the repository with the highest priority that contains the 
application. Supported repository types include:

 UMS App Proxy
 WebDAV repositories
 IGEL App Portal
 Other repositories configured under System > Update > Repositories87

Can Fallback Be Disabled?
There is no direct setting to disable the fallback, because at least one device (the first device of the subnet) must 
obtain the application from a repository. However, repository usage is limited to the first download within a subnet.

Once a device has downloaded the application:

1. The device can serve the app to other peers if it is configured as Distributed Peer Update Server.
2. IGEL Discovery detects the available peer.
3. Other devices download the application directly from the peer instead of the repository.

No reboot is required for the Distributed Peer Update Server to start distributing newly received 
applications. As soon as an application is installed, it can be served to peers.

87. https://kb.igel.com/en/igel-os-base-system/current/update-app-update-settings-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/update-app-update-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/update-app-update-settings-in-igel-os-12
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Recommended Configuration - Intended Use Case
The intended use case is to operate Distributed Peer Update as a peer‑to‑peer network, where all devices both 
discover and serve updates.

To do this, you can configure devices through profiles:

1. Create a profile.
2. In the profile configurator, configure IGEL Discovery and Distributed Peer Update Server on all 

devices according to the table:

Configuration Page Parameter Value

System > Update > IGEL 
Discovery88

Enable IGEL Discovery Enabled

System > Update > IGEL 
Discovery89

Discovery Port Same on all devices (default 
22336)

System > Update > Distributed 
Peer Update Server90

Enable Distributed Peer 
Update Server

Enabled

System > Update > Distributed 
Peer Update Server91

Port of the distributed peer 
update server

Same on all devices (default 
22335)

3. Save and assign the profile to the devices.

With this configuration:

 You can assign applications to devices without considering server roles.
 Discovery ensures that only one device at a time in a subnet uses the fallback to fetch the 

application from a repository.
 Once a device that is configured as a Distributed Peer Update Server has the application, it 

becomes a peer server for other devices.
 The distribution speed ramps up quickly due to exponential growth:

 1 Distributed Peer Update Server with the application → 1 device can download and 
become Peer Update Server

 2 Distributed Peer Update Servers → 2 devices can download and become Peer Update 
Server

 4 Distributed Peer Update Servers → 4 devices can download and become Peer Update 
Server

 8 Distributed Peer Update Servers … and so on …

88. https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
89. https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
90. https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
91. https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig

https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
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Rollout Considerations for Large Environment
In very large environments or networks with limited bandwidth, application deployments can be performed in 
waves as a best practice.

Example rollout:

 First wave: 100 devices
 Second wave: next 100 devices
 Third wave: remaining devices

This prevents excessive simultaneous downloads and reduces network congestion.

How IGEL Discovery Works
Once IGEL Discovery and Distributed Peer Update are enabled, application distribution is automated.

Distribution Process

1. A management system (for example UMS) assigns an application to a device.
2. The device’s update daemon checks whether Discovery is enabled.
3. If Discovery is enabled, the update daemon asks Discovery to find a peer with the requested 

application.
4. IGEL Discovery broadcasts a UDP request within the subnet asking for the application.
5. Devices respond depending on their state.

Discovery Responses

Response Meaning

SERVER_READY  via 
UDP unicast

A peer has the application and is ready to serve it

SERVER_BUSY  via 
UDP broadcast

A peer has the application but is currently serving another download

FALLBACK No peer has the application; a device must download from a repository

Update Daemon Behavior
The update daemon reacts to Discovery responses as follows.

To view IGEL Discovery responses, run:
journalctl -u igel-discovery-daemon -f
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Discovery Response Behavior of the Update Daemon

SERVER_READY Downloads the application from the peer’s Distributed Peer Update 
Server over HTTP.

SERVER_BUSY The update daemon waits and retries in an infinite loop, with a wait 
time (for example 100 seconds) between search rounds.

FALLBACK The device elected as fallback downloads the application from the 
repository (UMS app proxy, WebDAV, IGEL App Portal, and so on). Once 
downloaded and installed, this device can serve the application to 
others via its Distributed Peer Update Server.

Update Progress Indicator Behavior
During peer discovery and fallback selection, the update progress indicator may temporarily remain at 0%.

This can occur while:

 Discovery searches for a peer server
 A fallback device downloads the application
 A peer disappears (for example powered off, network loss) and the update daemon has to request 

another server.

Once a peer becomes available, the download proceeds normally.

Proxy Considerations
IGEL Discovery and the update daemon behave differently when a proxy is configured.

Component Proxy Behavior

IGEL Discovery Bypasses HTTP proxy configuration because it uses UDP broadcast and 
unicast.

Update daemonHonors the configured HTTP proxy when downloading applications.

This difference can lead to connectivity issues. For example:

1. Discovery identifies a peer that has the required application.
2. The update daemon attempts to download the application.
3. The request is routed through the configured proxy.
4. The proxy cannot route the request back to the local network.

Result: the peer update fails.

Workaround
To prevent peer-to-peer traffic from being routed through the proxy, add the local subnet(s) to the No Proxy for
configuration:

1. Go to Network > Proxy > Manual proxy configuration92.

https://kb.igel.com/en/igel-os-base-system/current/proxy-configuration-in-igel-os-12
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2. Find the No Proxy for parameter.
3. Add the CIDR of the subnet, for example:

192.168.1.0/24
10.0.0.0/16

This ensures that peer-to-peer HTTP traffic is sent directly to local devices.

Alternative Configurations

Using Only a Subset of Devices as Peer Servers
You can configure a subset of devices as servers and the rest as clients.

Efficiency drawbacks of this configuration:

 The UMS assigns applications without considering which devices are servers.
 It is more likely that a client‑only device is elected first to use fallback.
 Due to the election protocol:

 only one device at a time downloads from the fallback repository
 if the elected device is client‑only, it cannot share the application with others
 this significantly slows down distribution

To configure this model:

1. Create a profile for the servers.

 

2. Apply the following configurations:

Configuration Page Parameter Value

System > Update > IGEL 
Discovery93

Enable IGEL Discovery Enabled

System > Update > IGEL 
Discovery94

Discovery Port Same on all devices (default 
22336)

System > Update > Distributed 
Peer Update Server95

Enable Distributed Peer 
Update Server

Enabled

System > Update > Distributed 
Peer Update Server96

Port of the distributed peer 
update server

Same on all devices (default 
22335)

92. https://kb.igel.com/en/igel-os-base-system/current/proxy-configuration-in-igel-os-12
93. https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
94. https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
95. https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
96. https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig

https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
https://kb.igel.com/en/igel-os-base-system/current/proxy-configuration-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
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3. Create a profile for the clients.

 

4. Apply the following configurations:

Configuration Page Parameter Value

System > Update > IGEL 
Discovery97

Enable IGEL Discovery Enabled

System > Update > IGEL 
Discovery98

Discovery Port Same on all devices (default 
22336)

System > Update > Distributed 
Peer Update Server99

Enable Distributed Peer 
Update Server

Disabled

5. Save and assign the profiles to the selected devices.

Using Distributed Peer Update Servers Without Discovery
You can also disable Discovery entirely and configure Distributed Peer Update Servers as static repositories on the 
clients.

In this model:

 no auto‑discovery or election protocol is used
 no limitation of one client at a time coming from the election
 clients download applications directly from configured servers

This can be useful in tightly controlled environments where you want deterministic server selection and do not 
need the discovery behavior.

To configure this model:

1. Create a profile for the servers.

 

2. Apply the following configurations:

Recommendations
If you want to use this model, ensure that:

 servers are prioritized to receive the applications first
 a sufficient number of servers is available in each network segment
 for large environments, consider increasing the maximum number of parallel connections 

on server devices when such an option is available

97. https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
98. https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
99. https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig

https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
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Configuration Page Parameter Value

System > Update > IGEL 
Discovery100

Enable IGEL Discovery Disabled

System > Update > Distributed 
Peer Update Server101

Enable Distributed Peer 
Update Server

Enabled

System > Update > Distributed 
Peer Update Server102

Port of the distributed peer 
update server

Same on all devices (default 
22335)

3. Create a profile for the clients.

 

4. Apply the following configurations and configure each Distributed Update Server as repository:

Configuration Page Parameter Value

System > Update > IGEL 
Discovery103

Enable IGEL Discovery Disabled

System > Update > Distributed 
Peer Update Server104

Enable Distributed Peer 
Update Server

Disabled

Setup > System > Update105 Repositories > Repository 
URL

For each Distributed Update 
Server - IP address of the OS 12 
device that will serve as the 
server:
http://<IP address of 

server>:<server port>/

api/

Setup > System > Update106 Repositories > Priority For each Distributed Update 
Server - The client will try to get 
the updates from the repository 
with the highest priority.

5. Save and assign the profiles to the selected devices.

100. https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
101. https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
102. https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
103. https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
104. https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
105. https://kb.igel.com/en/igel-os-base-system/current/update-app-update-settings-in-igel-os-12
106. https://kb.igel.com/en/igel-os-base-system/current/update-app-update-settings-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
https://kb.igel.com/en/igel-os-base-system/current/update-app-update-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/update-app-update-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
https://kb.igel.com/en/igel-os-base-system/current/igel-discovery-service-configuration-in-igel-os
https://kb.igel.com/en/igel-os-base-system/current/distributed-peer-update-server-configuration-in-ig
https://kb.igel.com/en/igel-os-base-system/current/update-app-update-settings-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/update-app-update-settings-in-igel-os-12
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Further Information
You might also find the following IGEL Community article useful: FAQ - Distributed Peer Update (Buddy Update)107.

The content of this external guide is not covered by official support channels, and the IGEL Knowledge 
Base Team cannot guarantee its accuracy or completeness.

107. https://igel-community.github.io/IGEL-Docs-v02/Docs/HOWTO-COSMOS/#faq-distributed-peer-update-buddy-update

https://igel-community.github.io/IGEL-Docs-v02/Docs/HOWTO-COSMOS/#faq-distributed-peer-update-buddy-update
https://igel-community.github.io/IGEL-Docs-v02/Docs/HOWTO-COSMOS/#faq-distributed-peer-update-buddy-update
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Downgrade Limit on IGEL OS 12.7.1 or Higher
As of IGEL OS 12.7.1, there is a downgrade limit for the IGEL OS Base System app in certain situations. IGEL OS Base 
System can no longer be downgraded to versions older than 12.7.0. This restriction applies to IGEL UD 
Pocket108 devices and endpoints with Secure Boot enabled (see Verifying that Secure Boot is Enabled109). In such 
cases, downgrade attempts to versions prior to 12.7.0 will be refused to maintain system integrity and boot 
security.

Known Issues for IGEL OS 12.7.1
 Downgrades to versions prior to 12.7.0 are possible - despite the implemented downgrade limit - 

via the Local App Portal or using igelpkgctl through local terminal. In UMS-managed 
environments, disabling the Local App Portal is recommended to enforce the downgrade limit. For 
how to disable the local app installation, see Installing IGEL OS Apps Locally on the Device110.

If the older shim bootloader signature (in 12.6.1 PR1 or earlier) is revoked and Secure Boot is enabled, the 
device may become unbootable. Verify boot compatibility before downgrading.

108. https://kb.igel.com/hardware/current/ud-pocket-powered-by-igel-ud-pocket-products
109. https://kb.igel.com/security-safety/current/verifying-that-secure-boot-is-enabled
110. https://kb.igel.com/en/how-to-start-with-igel/current/installing-igel-os-apps-locally-on-the-device

https://kb.igel.com/hardware/current/ud-pocket-powered-by-igel-ud-pocket-products
https://kb.igel.com/security-safety/current/verifying-that-secure-boot-is-enabled
https://kb.igel.com/en/how-to-start-with-igel/current/installing-igel-os-apps-locally-on-the-device
https://kb.igel.com/hardware/current/ud-pocket-powered-by-igel-ud-pocket-products
https://kb.igel.com/security-safety/current/verifying-that-secure-boot-is-enabled
https://kb.igel.com/en/how-to-start-with-igel/current/installing-igel-os-apps-locally-on-the-device
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How to Deploy IGEL OS 12 with IGEL OS Creator (OSC)
With the IGEL OS Creator (OSC), you can install IGEL OS 12 on any supporting device. Moreover, you can use the 
IGEL OS Creator to recover a broken installation of IGEL OS that cannot boot anymore. 

Devices Supported by IGEL OS 12
For a detailed list, see Devices Supported by IGEL OS 12.

Licensing
For information on licensing, see Essential IGEL Licensing FAQ .

Create USB Installation Medium

Windows

1. Download the ZIP archive for OS Creator from the IGEL Download Server111.
2. Unzip the contents into a local directory.
3. Connect a USB memory stick with at least 4 GB capacity to the computer.

All existing data on the USB memory stick will be destroyed.
4. Double-click the  preparestick.exe     file from the unzipped directory.

If you are in the "administrators" group, the program will start after you have confirmed a dialog. If 
you are not in the "administrators" group, you must enter the administrator password to start the 
program.
The dropdown menu Isofile shows the ISO file contained in the unzipped directory, 
e.g.  osc12.01.110.iso .

Installing the IGEL OS operating system via OSC destroys all data on the target device’s mass storage 
device (hard disk, flash memory, SSD).

111. https://www.igel.com/software-downloads/igel-os-12-secure-endpoint/

https://www.igel.com/software-downloads/igel-os-12-secure-endpoint/
https://www.igel.com/software-downloads/igel-os-12-secure-endpoint/
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5. Under Destination USB stick, select the USB storage medium on which you would like to save the 
installation data.
It is recommended that you only have one USB storage medium connected during this procedure. 
If you accidentally select the wrong medium, all data on it will be lost.
Generally speaking, the list of available USB storage media is refreshed automatically. If, however, 
you would like to refresh it manually, click on View > Refresh USB Device List.
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6. Click Start writing process.
7. Confirm the following dialog:

In the program window, the progress of the process is shown.



Articles on Deploying and Updating IGEL OS 12

IGEL OS Base System   453 / 691

When the process is finished, a message window is displayed.

8. Close the message window and the program.
9. After about 3 seconds, remove the USB memory stick.

The USB memory stick for OSC installation is ready for use.

Linux

1. Download the ZIP archive for OS Creator from https://www.igel.com/software-downloads/.

2. Unzip the contents into a local directory.
3. You will need the ISO file (e.g., osc12.4.1.iso) from this directory to create a bootable medium.
4. Connect a USB memory stick with at least 4 GB capacity to the computer.

If you remove the USB memory stick too early, the writing process may still need to be completed. In this 
case, the data on the memory stick gets corrupted.

https://www.igel.com/software-downloads/
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5. Open a terminal emulator and enter the command  dmesg  to determine the device name of the 
USB memory stick.
Example output: 
[...]

[19514.742229] scsi 3:0:0:0: Direct-Access JetFlash Transcend 8GB 

1100 PQ: 0 ANSI: 6

[19514.742805] sd 3:0:0:0: Attached scsi generic sg1 type 0

[19514.744688] sd 3:0:0:0: [sdb] 15425536 512-byte logical blocks: 

(7.89 GB/7.35 GiB)

[19514.745370] sd 3:0:0:0: [sdb] Write Protect is off

[19514.745376] sd 3:0:0:0: [sdb] Mode Sense: 43 (0) 00 00 00

[19514.746040] sd 3:0:0:0: [sdb] Write cache: enabled, read cache: 

enabled, doesn't support DPO or FUA

[19514.752438] sdb: sdb1

In this example, the device name searched for is  /dev/sdb .

6. The following command writes the installation data to the USB memory stick (example):
dd if=osc12.4.1.iso of=/dev/sdX bs=1M oflag=direct

Replace  sdX  with the device name of the USB memory stick that you have determined. 

When the dd  command has terminated, you can see the terminal emulator input prompt again.

7. Wait for about 3 seconds after the  dd  command has terminated, and remove the USB memory 
stick.

The USB memory stick for OSC installation is ready for use.

All existing data on the USB memory stick will be destroyed.

Ensure that you have determined the correct device name. If you use the wrong device name, the dd
command in the next step can destroy your operating system.

If you remove the USB memory stick too early, the writing process may still need to be completed. In this 
case, the data on the memory stick gets corrupted.
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Create DVD Installation Medium 
The ISO file in the installation directory for OSC is a so-called hybrid image. It can not only be copied onto USB 
storage devices but can also be used to create a bootable DVD.

Burn ISO Image (Windows)

1. In Explorer, open the directory that contains the ISO file.
2. Right-click on the ISO file.
3. Select Burn disc image.

Burn ISO Image (Linux)
Under Linux, various burning programs with a graphical user interface or for the command line are available.

The Ubuntu Wiki112 explains how to burn an ISO image onto a DVD using several programs.

Boot Settings
OSC works on systems with BIOS and UEFI.

Your system must support booting from USB storage media or from a DVD. This may already be enabled, or you may 
have to enable it yourself.

IGEL OS 12 supports UEFI Secure Boot. Refer to the manual of your device's manufacturer to learn whether 
your device supports Secure Boot and how to enable it. Enabling Secure Boot often consists of two steps. 
First, the boot mode has to be changed to UEFI Boot in the BIOS; after that, Secure Boot can be activated, 
also in the BIOS. For instructions on how to check whether Secure Boot has been properly enabled, see(en) 
Verifying that Secure Boot is Enabled .
For UEFI Secure Boot on devices manufactured by IGEL, see (en) UEFI Secure Boot Enabling Guides.

If IGEL OS fails to boot in UEFI mode, try switching to Force Legacy (non UEFI) boot. IGEL OS will then be 
installed in legacy/BIOS mode.

112. https://help.ubuntu.com/community/BurningIsoHowto#Burning_from_Ubuntu

https://help.ubuntu.com/community/BurningIsoHowto#Burning_from_Ubuntu
https://help.ubuntu.com/community/BurningIsoHowto#Burning_from_Ubuntu


Articles on Deploying and Updating IGEL OS 12

IGEL OS Base System   456 / 691

General Hints on Changing the Boot Settings
The required key presses for this may vary from vendor to vendor. However, here are some hints:

 → While the device is booting, try pressing [F12] (in general), [F10] (Intel devices), or [F9] (Hewlett-Packard devices) 
to access a list of boot devices and select your USB installation medium.

→ If the above does not work, access the BIOS settings via pressing [Del], [F1], or [F2] during boot, activate booting 
from USB storage media and/or change the boot order.

→ See the BIOS/UEFI documentation for your system for details of how to boot from USB storage media.

Changing the Boot Settings of Devices Manufactured by IGEL

UD7 (H860C)

1. Power up the device while pressing the [Del] button repeatedly in rapid succession.
2. If a password prompt is shown, enter the BIOS password.
3. Select  Setup Utility.
4. Select the Boot tab.

If the USB installation medium is not found, though the USB boot is enabled, try the following:
 Reconnect the USB  installation medium and reboot the endpoint device.
 Use another USB port.
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5. Set USB Boot to <ENABLED>.
6. Save the settings and exit.
7. Connect the USB stick to the device.
8. Reboot the device while pressing the [Del] button repeatedly in rapid succession.
9. Select Boot Manager.

10. Select the USB stick as the boot medium and press Enter.
11. You can continue with the installation procedure.

UD3 (M350C)

1. Power up the device while pressing the [Del] button repeatedly in rapid succession.
2. If a password prompt is shown, enter the BIOS password.
3. Select  Setup Utility.
4. Select the Boot tab.
5. Set USB Boot to <ENABLED>.
6. Save the settings and exit.
7. Connect the USB stick to the device.
8. Reboot the device while pressing the [Del] button repeatedly in rapid succession.
9. Select Boot Manager.

10. Select the USB stick as the boot medium and press Enter.
11. You can continue with the installation procedure.

Installation Procedure

1. Connect the prepared USB memory stick to the target device and switch the target device on.
2. Select one of the following options from the boot menu:

The installation will overwrite all existing data on the target drive.
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 Standard Installation + Recovery: Boots the system with just a few messages from the USB 
memory stick and launches the installation program. (Default)

 Verbose Installation + Recovery: Boots the system from the USB memory stick and shows 
the Linux boot messages. You can use a USB serial adapter for debugging purposes. For this 
purpose, the Registry key system.kernel.bootparams.serial_console_debug
must be enabled (path: System > Registry > system > kernel > bootparams > 
serial_console_debug > Enable debug console). The serial port parameters are as follows: 
115200 baud, 8 bits, 1 stop bit, no parity, no flow control.

 Failsafe Installation + Recovery: Fallback mode; to be used if the graphical boot screen 
cannot be displayed.

 Memory Test: Memory test, only available in legacy/BIOS mode. This option does not carry 
out an installation.

3. Select the language for the installation process.
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4. If IGEL OS 12 has been running on the device before and you want to preserve the device's settings, 
ensure that Migrate old settings is enabled.

5. If one of the following is the case, make sure that Migrate licenses is enabled:
- Your device has been operating with IGEL OS 11 before and you want to preserve the device's 
IGEL OS 11 licenses because you want to test IGEL OS 12 and downgrade to IGEL OS 11 afterward
- Your device has been operating with IGEL OS 12 before and you want to keep the licenses on the 
device
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6. Check the Target drive to ensure that the system is installed on the desired drive.

7. Click Install IGEL OS.
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8. Accept the EULA by clicking I agree.
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9. To view the details for the target drive, click More Info.

10. Click Install IGEL OS.
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The installation program will install IGEL OS 12 on the target drive. If you see the success message, 
the installation is complete.
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11. Click Reboot.

12. Remove the USB memory stick.
13. Close the message window.

The system will shut down and then boot IGEL OS 12.
The device is ready for onboarding; for details, see Onboarding IGEL OS 12 Devices113.

113. https://kb.igel.com/en/how-to-start-with-igel/current/onboarding-igel-os-12-devices

https://kb.igel.com/en/how-to-start-with-igel/current/onboarding-igel-os-12-devices
https://kb.igel.com/en/how-to-start-with-igel/current/onboarding-igel-os-12-devices
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Installation Procedure for Factory Images 

Preparing the Image

1. Connect the prepared USB memory stick to the target device and switch on the target device.
2. Select Standard Installation + Recovery or Verbose Installation + Recovery.

3. Select the language for the installation process.

The installation will overwrite all existing data on the target drive.
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The installation program  IGEL OS Creator opens. Here, you can configure settings for the 
installation process and start it. 

4. Activate Factory Image and enter your factory ID.
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5. Check the  Target drive  to ensure that the system is installed on the desired drive.

6. If you want to change the initial settings for the devices you are about to deploy, click  Edit. 
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The IGEL Setup opens, enabling you to change the settings in the same way as with a regular IGEL 
OS installation. The changes are stored on the USB memory stick from which the IGEL OS Creator 
(OSC) is executed. For details about the settings, see Configuration of IGEL OS 12 Device 
Settings (see page 6).

7. If you want to undo your changes and restore the original settings, click Reset.
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8. If you want to perform manual tests with visual feedback on each device, enable Enable Reset 
after first boot. The test procedure is described under Unit Testing (see page 477).

If Reset after first boot is activated, the first boot of your devices MUST take place BEFORE shipment to 
end customers!
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9. If you want to perform automatic tests (unattended), enable both Reset after first boot and 
Enable Reset after first boot. The test procedure is described under Automatic Unit Testing (see 
page 478).

If Reset after first boot is activated, the first boot of your devices MUST take place BEFORE shipment to 
end customers!
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9. To start the installation, click  Install IGEL OS.  
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10. Confirm the warning dialog.
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The installation of IGEL OS 12 starts.
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The installation program will set up IGEL OS 11 on the target drive. If you see the success message, 
the installation is complete.
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11. Click Shutdown.
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12. Read out the image from your device to deploy it on the units.

13. To ensure the integrity of the image, you should create checksums of the original image and the 
deployed images and then compare them. For details, see IGEL Endpoint Partners: Ensuring Image 
Integrity with a Checksum114.

14. Proceed as appropriate:

DO NOT BOOT THE EXACT FACTORY IMAGE THAT IS INTENDED FOR DEPLOYMENT ON YOUR DEVICES! ALL 
DEVICES TO WHICH THIS IMAGE HAS BEEN DEPLOYED WOULD SHARE ONE AND THE SAME UNIT ID. AS A 
RESULT, YOUR DEVICES WOULD BE PRACTICALLY UNUSABLE.
If you want to test the factory image before its deployment, transfer it to your target medium first and then 
boot the image on the machine on which you created it, or any other test machine. The important thing is 
that the factory image that will be mass-deployed to your units has not been booted before.

The maximum size of the image created by the IGEL OS Creator (OSC) is 64 GiB. Therefore, only the first 64 
GiB of your storage medium is needed. If your devices have larger storage, this will allow for faster 
deployment.

114. https://kb.igel.com/en/igel-os/11.10.250/igel-endpoint-partners-ensuring-image-integrity-wi

https://kb.igel.com/en/igel-os/11.10.250/igel-endpoint-partners-ensuring-image-integrity-wi
https://kb.igel.com/en/igel-os/11.10.250/igel-endpoint-partners-ensuring-image-integrity-wi
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 If Reset after first boot is inactive, you can deploy the images on the units and roll them 
out straight away. The deployment should include a comparison of the checksums.

 If Reset after first boot has been activated, deploy the images on the units and continue 
with Unit Testing (see page 477).

 If Automatically shutdown at first boot has been activated, deploy the images on the units 
and continue with Automatic Unit Testing (see page 478).

Unit Testing
Perform the following procedure on the original device and every unit on which the image has been deployed. 

1. Start the device and review the green test screen.

2. Click OK.
You can access IGEL OS in a regular way and perform your tests.

3. Shut the device down.
The device is ready for roll-out.

The first boot test MUST take place with each unit BEFORE it is rolled out. (Otherwise, the device would 
present the green test screen on the first boot instead of the IGEL Setup Assistant.)
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Automatic Unit Testing
When Reset after first boot and Automatically shutdown at first boot has been enabled, the device writes a log 
file on its first boot and then shuts down automatically. 

Your test routine must perform the following procedure:

1. Start the device.
The device will perform a check and write the results to a file on the first VFAT partition of the 
device's storage medium. The file format is JSON, and the file name is  check.log . After a few 
seconds, the machine shuts down automatically. During the uptime, the green test screen is 
shown.

2. Get the file check.log  from the first VFAT partition of the storage medium and analyze it. The 
contents of the file are described below.

Example Content of check.log

{
  "product": "Standard PC",
  "serial": "12345678",
  "product_id": "UC1-LX",
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  "version": "12.4.1",
  "bootmode": "UEFI Secure Boot",
  "flashsize": "7688 MB",
  "date": "2024-09-26, 08:08 AM",
  "status": "SUCCESS",
  "log": ""
}

Explanation of the JSON Fields

Field Explanation

product Product id from DMI

serial Serial number from DMI

product_

id

The IGEL product ID. This value is also shown in the About window:

version The version of the IGEL OS Base System. This value is also shown in 
the About window:
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Field Explanation

bootmode The boot mode:  Legacy ,  UEFI , or  UEFI Secure Boot . This value is also 
shown in the About window:

flashsiz

e

The size of the IGEL partition (not the complete available disk space). This value is 
also shown in the About window:

date Time and date of the check

status SUCCESS  if the check was successful

log Empty if no error has occurred; otherwise, an error description is provided
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How to Deploy IGEL OS 12 with IGEL OS 12 SCCM Add-on
IGEL OS 12 SCCM Add-on facilitates deploying IGEL OS via Microsoft SCCM. The package contains IGEL OS Base 
System as a dd image that will be booted using a Windows PE boot file customized for this purpose.

Optionally, you can use a different version of IGEL OS Base System, add certificates, license files, and rules for 
computing the unit ID, and compress the image file; for details, see Alternative Deployment (see page 499). Moreover, 
you can choose whether to deploy the IGEL OS dd image together with the Windows PE boot image as a single file 
or separately via a network share.

With the installation of IGEL OS SCCM Add-on, a customized Windows PE image and a task sequence for deploying 
IGEL OS are created, and the IGEL OS Image Manager is installed.

This article is based on version 2.2.2 of IGEL OS 12 SCCM Add-on.

Prerequisites
 Microsoft Endpoint Configuration Manager (see https://docs.microsoft.com/en-us/mem/

configmgr/)

 Configured PXE environment for OS deployment; all target devices must be in a network where 
they are available either from the main site server or a distribution point. (For further information, 
see https://docs.microsoft.com/en-us/mem/configmgr/osd/plan-design/infrastructure-
requirements-for-operating-system-deployment)

 All target devices have a minimum of 4 GB RAM. For further requirements, see Devices Supported 
by IGEL OS 12115.

 On the host on which Microsoft Endpoint Configuration Manager is running, Microsoft Power Shell 
Script execution must be allowed, at least for signed scripts (the Powershell scripts that come with 
IGEL OS SCCM Add-on are signed by IGEL).

Installing IGEL OS SCCM Add-On
1. Go to https://www.igel.com/software-downloads/igel-os-12-secure-endpoint/ > OS 12 Base 

System Deployment Tool for SCCM and download the executable file to the host on which 
Microsoft Endpoint Configuration Manager is running.

2. Start the executable file.

The solution presented here has been developed and tested with the current version of Microsoft Endpoint 
Configuration Manager (status 01/2024). For details on the versioning of Microsoft Endpoint Configuration 
Manager, see https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/changes/whats-new-
incremental-versions .

115. https://kb.igel.com/en/hardware/current/devices-supported-by-igel-os-12-1

https://docs.microsoft.com/en-us/mem/configmgr/
https://docs.microsoft.com/en-us/mem/configmgr/osd/plan-design/infrastructure-requirements-for-operating-system-deployment
https://kb.igel.com/en/hardware/current/devices-supported-by-igel-os-12-1
https://www.igel.com/software-downloads/igel-os-12-secure-endpoint/
https://docs.microsoft.com/en-us/mem/configmgr/core/plan-design/changes/whats-new-incremental-versions
https://kb.igel.com/en/hardware/current/devices-supported-by-igel-os-12-1
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3. Accept the EULA and click Next.

4. On the Site Server configuration page, review the field Site Server Name (FQDN), which should 
be prefilled, and enter the Site Code of this Endpoint Configuration Manager site. Then, click Next.
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5. If you plan to deploy the IGEL OS image separately via a network share, i.e., not embedded in the 
boot file, enter the shared Network folder containing the IGEL OS image and the corresponding 
Username. Then, click Next.



Articles on Deploying and Updating IGEL OS 12

IGEL OS Base System   484 / 691

The installation of IGEL OS SCCM Add-on starts.
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Verifying the Installation
1. Under Software Library, select Operating Systems > Boot Images and check if the IGEL Boot 

Image (WIM) is available.
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2. Go to Task Sequences and check if IGEL Create , IGEL Create over Net, and IGEL Inplace 
Upgrade are available. These task sequences will drive and control the deployment process.
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Provisioning IGEL OS via a PXE Boot Environment
The task sequences provided by IGEL OS SCCM Add-on will deploy IGEL OS to a device collection via a PXE boot 
environment. The task sequence will be executed after the device has booted into the IGEL Boot Image 
( igel.wim ).

You can choose between the following task sequences:

 IGEL Create: The IGEL OS image ( minimal.bin ) is built into the IGEL Boot Image 

( igel.wim )

 IGEL Create over Net: IGEL OS image ( minimal.bin ) is provided separately via a network 
share

To deploy the PXE boot environment:

1. Check if you need to define your own custom device collection to allocate your target devices or if 
you can use one of the preconfigured collections. #

2. Under Software Library, select Operating Systems > Boot Images. Open the context menu for 
IGEL Boot Image and select Distribute content.
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3. Open the Distribute Content Wizard and check if IGEL Boot Image is shown in the Content area. 
Afterward, continue with the wizard.

4. If your device requires a specific network driver: Select Operating Systems > Boot Images, Open 
the context menu for IGEL Boot Image, and select Properties. Then, select the Drivers tab and 
add the driver. 



Articles on Deploying and Updating IGEL OS 12

IGEL OS Base System   489 / 691

5. Select Operating Systems > Boot Images, open the context menu for IGEL Boot Image and 
select Update distribution points.
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6. If you want to deploy the IGEL OS image separately via a network share: Select Operating 
Systems > Task Sequences, open the context menu for IGEL Create over Net, and then select 
Edit. Otherwise, continue with step 8.
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7. If you want to deploy the IGEL OS image separately via a network share (continued): Edit the 
settings for the task Connect to Network Folder as follows:

 Path: Enter the path to the network share you want to use for distributing the IGEL OS 
image.

 Account: Click Set to open the account data dialog and enter the required data:
 User name: The username for accessing the network share, in the format 

DOMAIN\user
 Password / Confirm password: The password for accessing the network share
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8. Select Operating Systems > Task Sequences, open the context menu for IGEL Create or IGEL Create over Net, 
and then select Deploy.



Articles on Deploying and Updating IGEL OS 12

IGEL OS Base System   494 / 691

The Deploy Software Wizard opens.

9. Click the Browse button next to Collection:
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The Select Collection dialog opens.

10. From the list of collections, select the collection that contains your target devices and click OK.
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In our example, a user-created collection named IGEL OS Collection is selected.

11. Click Next to continue with the wizard.
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All target devices receive the PXE boot request that triggers them to boot the IGEL Boot Image.
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The target devices load the IGEL Boot Image (WIM).
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Alternative Deployment
You can deploy a different IGEL OS image as an alternative to the image that comes with IGEL OS SCCM Add-on. The 
current main version is available from igel.com116. Optionally, you can add pre-configured settings, certificates, 
license files, and rules for computing the unit ID to the image. In addition, you can compress the image to reduce 
the network load during distribution; please note that this increases the processing effort on the endpoint's side 
because the image needs to be decompressed.

1. Open a web browser, go to https://www.igel.com/software-downloads/igel-os-12-secure-
endpoint/ > OS 12 Base System Deployment Tool for SCCM, download the current IGEL OS file, 
and unzip it.
The IGEL OS image is ready for deployment.

116. http://igel.com

http://igel.com
https://www.igel.com/software-downloads/igel-os-12-secure-endpoint/
http://igel.com
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2. Start the IGEL OS Image Manager by clicking on the desktop icon.

3. Click Select next to Select IGEL OS bin file and choose your image file.

4. If you want to add settings, certificates, license files, or unit ID rules, click Add next to the relevant 
item and choose the relevant files.

 Add IGEL OS settings: The settings for IGEL OS. These settings can also be configured via 
the local Setup, the UMS device configurator, or a UMS profile.

 Add certificate: Certificate files
 Add IGEL licenses: License files
 Add IGEL unit ID rules: A file with alternative rules to compute a unit ID for a device. Please 

note that this can only be used for IGEL OS 12.8.0 or higher. For details, see How to 
Customize the Unit ID Computation for IGEL OS Creator (OSC)117. Please note that this article 

https://kb.igel.com/en/igel-os-base-system/current/how-to-customize-the-unit-id-computation-for-igel-
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focuses on deploying the rules file via OSC, but the rules and their format can be used 
equivalently for this use case.

5. Set Update SCCM IGEL Boot Image according to your deployment method:
 NO: Select this option if you want to modify only the IGEL OS image, but not the IGEL OS 

boot image (Windows PE).
 COPY: Select this option if you want to deploy the IGEL OS image together with the basic 

Windows PE boot image. The Windows PE boot image and the IGEL OS image will be baked 
into one file which is distributed by the Microsoft Endpoint Configuration Manager.

 DELETE: Select this option if you want to deploy the IGEL OS image separately via a network 
share. Only the basic Windows PE boot image will be distributed by the Microsoft Endpoint 
Configuration Manager; at a later stage, the devices will fetch the IGEL OS image from the 
network share.

117. https://kb.igel.com/en/igel-os-base-system/current/how-to-customize-the-unit-id-computation-for-igel-

https://kb.igel.com/en/igel-os-base-system/current/how-to-customize-the-unit-id-computation-for-igel-
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6. If you want to compress the IGEL OS image, enable Compress IGEL OS bin file.
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7. When all settings are made, click Apply.
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The files are added to the image.
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How to Deploy IGEL OS 12 with IGEL OS Creator for Windows (OSCW)
The IGEL OS Creator for Windows (OSCW) is able to convert Windows machines to IGEL OS 12, provided that they 
fulfill the hardware requirements.

Choose the instructions according to your needs:

 IGEL OS Creator for Windows (OSCW) for IGEL OS 12 on Windows 11/10 Workstations (see page 506)

On modern computers such as secured-core PCs (see e.g. https://www.microsoft.com/en-us/windows/
business/devices?col=secured-core-pcs ), there may be a BIOS setting related to Secure Boot that allows 
the use of Microsoft’s 3rd party UEFI Secure Boot Certificate. The usual description of such a BIOS setting is 
"Allow Microsoft 3rd Party UEFI CA". This setting must be set to enabled, as IGEL uses the 3rd party 
certificate to support UEFI Secure Boot. If UEFI Secure Boot is enabled, but "Allow Microsoft 3rd Party UEFI 
CA" is not enabled, you may be unable to boot IGEL OS Creator or UD Pocket. Similarly, if the setting 
"Allow Microsoft 3rd Party UEFI CA" is disabled after a previous installation of IGEL OS, IGEL OS will fail to 
boot. For how to enable the setting, see (en) Secured-Core PCs: Microsoft 3rd-Party UEFI Certificate for 
Secure Boot.

https://www.microsoft.com/en-us/windows/business/devices?col=secured-core-pcs
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IGEL OS Creator for Windows (OSCW) for IGEL OS 12 on Windows 11/10 
Workstations

Introduction
The IGEL OS Creator (OSC) for Windows is able to convert any Windows 11 or Windows 10 machine to IGEL OS 12, 
provided that it fulfills the hardware requirements, see IGEL OS 12 Hardware Support.

Read all the following chapters and follow the instructions in the order given.

Prerequisites

Hardware

 For supported hardware, see IGEL OS 12 Hardware Support.

Software

The following software and configuration must be present on the target machines:

 Windows 11 or Windows 10 (32 Bit or 64 Bit)
 Microsoft Bitlocker is disabled

Network

 All machines are in a network that can be reached by the UMS.
 For buddy mode: All machines must be joined to a Microsoft Active Directory (AD) and be 

accessible by the same AD user with reading permissions.

Getting the Required Software
The following software must be downloaded resp. installed:

IGEL Universal Management Suite (UMS) 12.01.100 or Higher

1. Download UMS 12.01.120 or higher from https://www.igel.com/software-downloads/igel-os-12-
secure-endpoint/  > Universal Management Suite 12.

2. Update your UMS to version 12.01.120 or later resp. install UMS 12.01.120. For update instructions, 
see IGEL UMS Update; for installation instructions, see IGEL UMS Installation.

OSCW Files

1. Download OSC for Windows 1.01.100 or higher (EXE or MSI installer)
 EXE file: https://www.igel.com/software-downloads/igel-os-12-secure-endpoint/ > OS 

Creator for Windows >  setup-igel-osc-for-windows_<VERSION>.exe

https://www.igel.com/software-downloads/igel-os-12-secure-endpoint/
https://www.igel.com/software-downloads/igel-os-12-secure-endpoint/
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 MSI file: https://www.igel.com/software-downloads/igel-os-12-secure-endpoint/ > OS 
Creator for Windows >  setup-igel-osc-for-windows_<VERSION>.msi

2. Download IGEL OS 12.4.1 or higher (ISO): https://www.igel.com/software-downloads/igel-os-12-
secure-endpoint/  > OS Creator (Deployment Tool (USB) for IGEL OS 12) >  osc-

<VERSION>.zip

Check List
 The UMS is updated to version 12.01.120 or higher.

 OSC for Windows 2.1.0 or higher is available.

 IGEL OS 12.4.1 or higher (ISO file) is available.

Transferring the IGEL OSC File to the UMS
In this step, we will transfer the IGEL OS firmware file (ISO) to the UMS so that the UMS can deploy it to the target 
machines.

1. Get access to the file system of the machine on which your UMS Server is running.
2. Copy osc-<version>.iso  to <UMS Installation 

directory>\rmguiserver\webapps\ums_filetransfer

Deploying the OSCW Installer on the Target Machines
In this step, we will deploy the OSCW installer on the target machines.

Deploy the installer on all devices that are to be converted. The following methods are available for deployment:

 SCCM (System Center Configuration Manager):
→ Use the MSI installer ( e. g. setup-igel-osc-for-windows_<VERSION>.msi ) and 
deploy it just like any software. The OSCW installer is installed silently.

 Group policy:
→ Use the MSI installer (e. g. setup-igel-osc-for-windows_<VERSION>.msi ) and 
deploy it just like any software. The OSCW installer is installed silently.

 File-based methods:
→ Transfer the EXE file (e. g. setup-igel-osc-for-windows_<VERSION>.exe ) to your 
target machines and install it on each machine; see Installing the OSCW Installer from a FIle (see 
page 508).
You can use file sources such as:

 USB memory stick

Do not register the file as a file object. This might lead to various issues, particularly in ICG and HA 
environments.

https://www.igel.com/software-downloads/igel-os-12-secure-endpoint/
https://www.igel.com/software-downloads/igel-os-12-secure-endpoint/
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 Network drive
 DVD

Installing the OSCW Installer from a File

1. On the target machine, double-click  setup-igel-osc-for-

windows_<VERSION>.exe  and confirm the Windows UAC (user account control). The OSCW 
installer is digitally signed by "IGEL Technology GmbH".
The setup wizard opens.

2. Read the licence agreement, accept it and click Next.

3. Click Next to install IGEL OS Creator for Windows on your device.
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Check List
 The OSCW installer is installed on each target machine.

Registering the Target Machines to the UMS
In this step, we will register all target machines to the UMS. This is necessary because the conversion to IGEL OS will 
be triggered by the UMS.

Two registration methods are available: a scan by the UMS and automatic registration.

 Registering by a UMS Scan (see page 509)
 Registering by Automatic Registration (see page 511)

Registering by a UMS Scan

1. Open the UMS Console and click   to scan for devices. 

2. Select the scope in which the devices are located; for details, see (12.04.120) How to Scan the 
Network for Devices and Register Devices on the IGEL UMS.

3. Click Scan.
The dialog Found devices opens.

4. In the Filter field, enter "IGEL Unified Management Agent OSCW".



Articles on Deploying and Updating IGEL OS 12

IGEL OS Base System   510 / 691

5. Select all target machines and click Ok.

The target machines are registered with the UMS.

6. In the Result dialog, click Ok.
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Registering by Automatic Registration

For this method, a DNS entry or DHCP option must be set.

→ Follow the instructions in (12.04.120) Registering Devices Automatically on the IGEL UMS.

Check List
 All target machines are registered with the UMS.

Configuring the OSCW Installer
In this step, we will provide the OSCW installer with the download source for the ISO file that contains the IGEL OS 
Creator.

Two methods are available:

 Configuring the OSCW Installer in Normal Mode (see page 512): Each target machine individually 
downloads the ISO file from the server (UMS). This increases the amount of outgoing traffic from 
the UMS.
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 Configuring the OSCW Installer in Buddy Mode: This method is recommended if the connection 
bandwidth of the download source is limited; it ensures a more balanced use of network 
bandwidth during the distribution of the ISO file to the target machines. First, a group of target 
machines downloads the ISO file. Then, these machines serve as the download source ("update 
buddies") for the remaining target machines. As a requirement, all devices must be joined to a 
Microsoft Active Directory (AD) and be accessible by the same AD user with reading permissions.

Configuring the OSCW Installer in Normal Mode

To provide the OSCW installer with the download source for the IGEL OS Creator file (ISO), we will create a profile 
that provides the path to that file. To assign the profile to the target machines, we will use a view that recognizes 
the target machines by their product ID.

The configuration comprises the following steps:

 Creating a Profile (see page 512)
 Creating a View to Select All Target Machines (see page 514)
 Assigning the Profile to the Target Machines (see page 519)
 Monitoring the Process (see page 521)

Creating a Profile

1. In the structure tree of the UMS Console, go to Profiles and open New Profile in the context menu.

2. In the New Profile dialog, change the settings as follows and confirm with Ok.
 Profile Name: A name for the profile, e. g. "IGEL OS Creator for Windows - configuration"
 Based on: Select "IGEL Unified Management Agent <VERSION>".
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The configuration dialog opens.

3. Click Converter.

You are taken to System > OSC > Converter where you can set all relevant parameters.

4. Change the settings as follows (click the   icon to enable the configuration; the icon will change 

to  ):
 Download URL of IGEL OS Creator: Enter  https://[IP address of your UMS 

Server]:8443/ums_filetransfer / or  http://[IP address of your UMS 
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Server]:9080/ums_filetransfer /

Example:   https://192.168.178.100:8443/ums_filetransfer/  or  http://

192.168.178.100:9080/ums_filetransfer/
 Username: Enter the username for the UMS.
 Password: Enter the password for the UMS user.

5. Click Save.

Creating a View to Select All Target Machines

The target machines must be selected to assign the profile to them. For the selection, a view will be used.

1. In the structure tree of the UMS Console, go to Views and select New View in the context menu.
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2. Enter a name for the view, e.g. "IGEL OS Creator for Windows - target machines" and click Next.
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3. On the Select criterion page, select Product ID and click Next.

4. On the Text search page, enter "OSCW" and click Next.
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5. On the Create new view page, click Finish.
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The number of matches is shown.

6. Click Load devices to view the target machines.

7. The target machines are shown.
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Assigning the Profile to the Target Machines

1. Select the view you have created beforehand and select Assign objects to the devices of the 
view .....

2. In the Assign objects dialog, select the profile you have created beforehand, click   to assign it 
and then click Ok.
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3. In the Update time dialog, select Now and click Ok.

4. Confirm the Information dialog.
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The target machines download the ISO file. This may take a few minutes.

Monitoring the Process

1. In the structure tree of the UMS, open the context menu of one of the target machines and select 
Other commands > Refresh system information. 

2. In the dialog, click Refresh system information and then   from time to time.
In the Attribute area, under Firmware Description, the current status of the OSC installation is 
shown.
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When a device is ready, the value of Firmware Description changes to "IGEL OSC Ready for 
Conversion".
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3. When Firmware Description reads "IGEL OSC Ready for Conversion", continue with Starting the 
Conversion in IGEL OS Creator (see page 543).

Check List
 The conversion profile is assigned to all target machines.

 All target machines have downloaded the IGEL OS Creator (ISO), which is indicated by the Firmware Description
"IGEL OS Ready for Conversion".

Next Step
>>  Starting the Conversion in IGEL OS Creator (see page 543)
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Configuring the OSCW Installer in Buddy Mode

The target machines designated as update buddies download the ISO file containing the IGEL OS firmware from the 
UMS. When they have downloaded the file, the remaining target machines download it from the update buddies. 

First, we create a profile for the update buddies that provides the OSCW installer with the download source for the 
ISO file. Then, we will assign this profile to the update buddies; the assignment of the profile triggers the update 
buddies to download the file. After that, we create a profile for the remaining target machines which configures 
them to use the update buddies. When the update buddies have downloaded the file, we can assign the profile to 
the remaining target machines. On assignment, each target machine selects an update buddy automatically and 
starts downloading the file from it.

The configuration comprises the following steps:

 Creating a Profile for the Update Buddies (see page 524)
 Assigning the Profile to the Update Buddies (see page 527)
 Checking if the Update Buddies are ready (see page 529)
 Creating a Profile for the Remaining Target Machines (see page 529)
 Creating a View to Select the Target Machines (see page 532)
 Assigning the Profile to the Target Machines (see page 538)
 Monitoring the Process (see page 540)

Creating a Profile for the Update Buddies

1. In the structure tree of the UMS Console, go to Profiles and open New Profile in the context menu.

Make sure that all devices are joined to a Microsoft Active Directory (AD) and are accessible by the same AD 
user with reading permissions.
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2. In the New Profile dialog, change the settings as follows and click Ok:
 Profile Name: A name for the profile, e. g. "IGEL OS Creator for Windows - update buddies"
 Based on: Select "IGEL Unified Management Agent <VERSION>".

The configuration dialog opens.
3. Click Converter.
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You are taken to System > OSC > Converter where you can set all relevant parameters.

5. Change the settings as follows (click the   icon to enable the configuration; the icon will change 

to  ):
 Download URL of IGEL OS Creator: Enter  https://[IP address of your UMS 

Server]:8443/ums_filetransfer/  or  http://[IP address of your UMS 

Server]:9080/ums_filetransfer/

Example:  https://192.168.178.100:8443/ums_filetransfer/  or  http://

192.168.178.100:9080/ums_filetransfer/
 Username: Enter the username for the UMS.
 Password: Enter the password for the UMS user.
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6. Click Save.

Assigning the Profile to the Update Buddies

1. In the structure tree of the UMS console, select the machines that will serve as update buddies and 

click   in the Assigned objects area.

2. Select the update buddies profile, click   and then Ok.
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3. In the Update time dialog, select Now and click Ok.
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Checking If the Update Buddies Are Ready
Perform the following check for each update buddy:

1. In the structure tree of the UMS, open the context menu of the update buddy and select Other 
commands > Refresh system information. 

2. In the dialog, click Refresh system information and then   every few seconds.
In the Attribute area, under Firmware Description, the current status of the download is shown. 
When it reads "IGEL OSC Ready for Conversion", the update buddy is ready for use.

Creating a Profile for the Remaining Target Machines

1. In the structure tree of the UMS Console, go to Profiles and open New Profile in the context menu.
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2. In the New Profile dialog, change the settings as follows:
 Profile Name: A name for the profile, e. g. "IGEL OS Creator for Windows - target machines"
 Based on: Select "IGEL Unified Management Agent <VERSION>".

3. Click Ok.

The configuration dialog opens.
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4. Click Converter.

You are taken to System > OSC > Converter where you can set all relevant parameters.

5. Change the settings as follows (click the   icon to enable the configuration; the icon will change 

to ):
 Select Buddy Mode.
 Username: Common username in Microsoft Active Directory for all target machines, 

including the update buddies.
 Password: Common password associated with the Username. 
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6. Click Save.

Creating a View to Select the Target Machines
The target machines must be selected in order to assign the profile to them. For the selection, a view will be used.

1. In the structure tree of the UMS Console, go to Views and select New View in the context menu.
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2. Enter a name for the view, e. g. "IGEL OS Creator for Windows - target machines" and click Next.
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3. On the Select criterion page, select Product ID and click Next.
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4. On the Text search page, enter "OSCW" and click Next.
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5. On the Create new view page, click Finish.
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The number of matches is shown.

6. Click Load devices to view the target machines.

7. The target machines are shown.
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Assigning the Profile to the Target Machines

1. Select the view you have created beforehand and select Assign objects to the devices of the 
view .....

2. In the Assign objects dialog, select the profile for the target machines, click   to assign it and then 
click Ok.
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3. In the Update time dialog, select Now and click Ok.
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4. Confirm the Information dialog.

The target machines download the ISO file.

Monitoring the Process

1. In the structure tree of the UMS, open the context menu of one of the target machines and select 
Other commands > Refresh system information. 

2. In the dialog, click Refresh system information and then   every few seconds.
In the Attribute area, under Firmware Description, the current status of the download is shown.



Articles on Deploying and Updating IGEL OS 12

IGEL OS Base System   541 / 691

When a device is ready, the value of Firmware Description changes to "IGEL OSC Ready for 
Conversion".
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3. When Firmware Description reads "IGEL OSC Ready for Conversion", continue with Starting the 
Conversion in IGEL OS Creator (see page 543).

Check List
 The conversion profile is assigned to all target machines.

 All target machines have downloaded the OSCW ISO file, which is indicated by the Firmware Description "IGEL 
OS Ready for Conversion".

Next Step
>> Starting the Conversion in IGEL OS Creator (see page 543)
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Starting the Conversion in IGEL OS Creator

1. In the UMS structure tree, select the view you have created for selecting the target machines, and 
click Load devices.

2. Select all machines and in the context menu, select Specific Device Command.

3. In the Specific Device Command dialog, select Convert to IGEL OS and click Execute.
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On the devices, a dialog is displayed. When the dialog is confirmed, the conversion starts 
immediately. If the dialog is not confirmed, the conversion starts after 20 seconds.
When the conversion is complete, the Product information in the UMS is changed to "IGEL OS 12".
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How to Deploy IGEL OS 12 with PXE

Prerequisites
 Your devices meet the requirements for IGEL OS 12. For further information, see Hardware > 

Supported Devices > IGEL OS 12 Hardware Support > Devices Supported by IGEL OS 12
 Your devices are able to boot via the network
 Your devices are in a network with Internet access
 A DHCP Server is available in your network

Retrieving the Required Files from the OSC ZIP File
1. Open a web browser, go to https://www.igel.com/software-downloads/cosmos/, and select the 

folder OS 12 BASE SYSTEM IMAGE FOR PXE.
2. Download the ZIP file (e.g. osc_12.2.1_pxe.zip ) and extract it.

We will distribute the required files to their appropriate locations later on.

Setting up the DHCP Server
When the devices are powered on, they need to be directed to the TFTP server that provides the low-level files 
required for booting. This is done by the DHCP server. In our example, we use a Microsoft Windows DHCP server; 
other DHCP can be used as well.

In the following, we will create three vendor classes, two for UEFI and one for BIOS. 

1. On your Windows server, go to DHCP and right-click on IPv4.
2. Define each vendor class as follows:

a. In the DHCP Vendor Classes dialog, click Add.
b. Enter the data according to the vendor class you are creating:

i. Vendor class for UEFI on an x86 architecture:
 Display name: PXEClient (UEFI x86)

 Description: PXEClient:Arch:00006
ii. Vendor class for UEFI on an x64 architecture:

 Display name: PXEClient (UEFI x64)

 Description: PXEClient:Arch:00007
iii. Vendor class for BIOS on x86 and x64 architectures:

Internet Access Required
In contrast to a typical PXE environment, the installation of IGEL OS 12 requires Internet access because 
the endpoint devices must be able to reach the IGEL App Portal.

https://www.igel.com/software-downloads/cosmos/
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 Display name: PXEClient (BIOS x86 & x64)

 Description: PXEClient:Arch:00000

3. Perform the following steps for each vendor class you have created:
a. Right-click Scope ([IP address]) DHCP range > Policies and select New Policy from the 

context menu.
b. At Policy Name, enter the name exactly as you did for the vendor classes, i.e, once 

PXEClient (UEFI x86) , once, PXEClient (UEFI x64) , and once PXEClient 

(x86 & x64) .
c. Click Next.
d. In the Configure Conditions for the policy screen, click Add.
e. In the Add/Edit Condition dialog, click the drop-down menu Value:.
f. Select the appropriate vendor class.

g. Activate Append wildcard. click Add and then OK.
h. Click Next,
i. Answer the question Do you want to configure an IP address range for the policy? with 

No and click Next.
j. Activate option 060 and edit it, according to the policy you are at:

 For PXEClient (UEFI x86) , enter PXEClient .

 For PXEClient (UEFI x64) , enter PXEClient .

 For PXEClient (BIOS x86 & x64) , leave the option empty.
k. Activate option 066 and enter the Fully Qualified Domain Name (FQDN) or the IP address of 

your TFTP server.
l. Activate option 067 and enter the path to the appropriate .efi file on your TFTP server. For 

example, this might be grub/bootx64.efi  for the PXEClient (UEFI x64)
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vendor class if you are using GRUB as the bootloader.
 

4. Review your Scope Options; they should be similar to this:

5. Go to Server Options, add option 066, and enter the Fully Qualified Domain Name (FQDN) or the 
IP address of your TFTP server.
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Deploying the TFTP Server
In this step, we deploy that TFTP server that provides the bootloader and a minimal OS that will load the higher-
level components of IGEL OS.

1. Install a TFTP server, e.g. SolarWinds. see https://www.solarwinds.com/de/free-tools/free-tftp-
server

2. Specify the directory in which the PXE boot files will be stored, typically C:\TFTP-Root

https://www.solarwinds.com/de/free-tools/free-tftp-server
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3. Copy the directories and files from the tftp/  directory of your OSC ZIP file to the TFTP root 

directory, in our example C:\TFTP-Root . The directory structure must be preserved.
The most important contents are:

 GRUB Bootloader for 64-bit EFI systems
 GRUB Bootloader for i386/BIOS systems
 Configuration file for GRUB Bootloader
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Providing the PXE Configuration File (pxe-config.json)
The file pxe-config  is used at an early stage of the boot process and will be provided by the TFTP server. It 
specifies the download paths for specific necessary files, an authentication token for connecting with the IGEL App 
Portal, and the version of the Base System that is to be installed. 

First, we retrieve the file from the UMS, then we edit it to adapt it to our environment. Afterward, we put it into the 
appropriate directory on the TFTP server.

Retrieving the File from the UMS

1. Open the UMS Web App, go to Apps and click the  icon.

2. In the area PXE Configuration, select the version of the IGEL OS Base System you want to install 
and the validity period for the authentication token that enables access to the App Portal.
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3. Click Generate.
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The file pxe-config.json  is downloaded by your browser.

Editing the "pxe-config.json" FIle

1. In the OSC ZIP file (example: osc_12.2.1_pxe.zip ), check out the contents of the 

webserver/  directory. We will create a reference for each file in step 2.
Example:
osc.bspl

osc.nvgfx

osc.sys

2. Edit pxe-config.json  as follows:

 "osc"/"partitions" : Enter a list of the URLs of the files to be downloaded from your 

web server. The format is http://<WEB SERVER ADDRESS>/<PATH>/<FILENAME>

 "apps"/"version" : Ensure that the desired version of IGEL OS is specified.
Example:

{
    "osc": {
        "partitions": [
            "http://igel-pxe-weberver/osc.bspl",
            "http://igel-pxe-weberver/osc.nvgfx",
            "http://igel-pxe-weberver/osc.sys"   
        ]
    },
    "appdata": {
        "app_portal": "https://app.igel.com/api/",
        "auth_token": 
"eyJ0eXAiOiJKV1QiLCJhbGciOiJSUzUxMiJ9.eyJmaW5nZXJwcmludCI6IjQ2Njc
E4NkMyMTk4Njg3MUIzMEUwMzU3NUQ5Q0NFRTQzNUJGRkU3M0IxQjYxRkMiLCJib2R5Ijp7InVt
c0lkIjoiVU1TL
UNMVVNURVItLTQ0MDMxLTE2ODgxMzQzNTY4NDEtMi0wIn0sInR5cGUiOiJ1bXMiLCJleHAiOjE
3MDA0ODAxMDgs
ImlhdCI6MTY5NzgwMTcwOH0.p-03tX5Zoesud95cpZBJuBCJU77fGzd17J3i1cbCIvhdIAB8D6
CmAdN6kFQ-9Qn
q35SmhyN8f8Jyn63AZEhmiAKPYVGNu1OgVxN-oIU3SBTE74JlU0W26kQuYNEa-WqyAh4BGm-
dJ2qnyqH7_5L08F
DFalJChN8v7DlZ5MVA_G9IWNQ6d87cM13dNFbuH4gK9z6lvKKI2s9Mfr2WQcu5qxBi3HhR-
f3M45zCMyUfm95Tu
eON48tAyfLPbxlqBUjm2FREJN89dqoZpo-obfcLQ85od6bFyotnK-MDm27-
BQvSlOpRujki2wMMYHz1vBeEJJfN
l78aGha5wRDpvrffrOgd_vY4Taicd8hwETcAmI9ihksOHO4gj6GIYZ1dBTbSGBMdooBkB4T5nK
trSX3IOkKCm79-
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x_c9gfRNKS-5ox8fvYPIVTK42gHBkQvpgJ5c0G2PqpFCiA8wSBU1bx6bgJdNpQQA1WhadKjOjM
ICp49pf5PPrfA
zvDzRpXxzQ43HpA86r2Jd59KSOi7QuW7Jb0D2WvjaoCSUFvXhaB-
UTsey61DKJJH73xqXbOoA5bdon123m8eTVK
wUJRTL6By41wG6nHnQ0dCYg8noucCg_rOCPBxVfvAhgxzwxllWNgQbGBWtG9Iw1qZIpEuvJa3u
x3YxJE5flMsXm
qDtpsyRURBQ0E2RTc3Qzg4RDI5Mjfzzhbs",
        "apps": [
            {
                "name": "base_system",
                "version": "12.2.1"
            }
        ]
    }
}

Proving the PXE Configuration File (pxe-config.json) via the TFTP Server 

→ Copy pxe-config.json  to <TFTP ROOT>/images/ . Example file path: C:\TFTP-

Root\images\pxe-config.json

Configuring the Web Server (IIS)
For installing the components of IGEL OS 12, we need a web server. In our example, we will use the Microsoft 
Internet Information Server (IIS).

1. If IIS is not already available on your Windows server, install it.
2. Add the file name extensions and the corresponding MIME types for all file types that are present in 

the webserver/  directory of the OSC ZIP file. In our example:

 File name extension .bspl ; MIME type application/octet stream

 File name extension: .sys ; MIME type application/octet stream

 File name extension: .nvgfx ; MIME type application/octet stream



Articles on Deploying and Updating IGEL OS 12

IGEL OS Base System   555 / 691

3. Specify a directory in which the required files will be stored, in our example C:\HTTP-Root

4. Copy all files from the webserver/  directory of the OSC ZIP file into the directory on the web 

server that has been defined in the section "osc"/"partitions"  of your pxe-

config.json  (see Editing the "pxe-config.json" File (see page 553)). In our example, the directory 

is C:\HTTP-Root  and the files are osc.bspl , osc.nvgfx , and osc.sys . The files may 
vary depending on the version of your OSC ZIP file.

Installing IGEL OS via PXE
→ Start the devices in your PXE environment. 
If everything has been set up correctly, your devices boot into IGEL OS 12.

Web Server Check

We recommend checking the URLs for these files in a web browser to ensure the download is 
functional.
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How to Use IGEL OS 12 with UD Pocket
UD Pocket boots IGEL OS on your computer. However, it does not make any changes to the operating system 
already installed on the device's storage – UD Pocket runs entirely from the USB stick.

To facilitate booting your UD Pocket, you can use the IGEL UD Pocket Starter. The IGEL UD Pocket Starter creates a 
boot option for the UD Pocket so that there is no need to change the boot settings manually. You can install the 
IGEL UD Pocket Starter easily on an endpoint device running Microsoft Windows 10 or 11 - provided Microsoft 
BitLocker is not active on the device. When you uninstall the IGEL UD Pocket Starter, it is removed without any trace 
on the device.

UD Pocket, like all IGEL operating systems, can be managed centrally using the IGEL Universal Management Suite 
(UMS). UD Pocket uses IGEL OS, which is described in detail under Configuration of IGEL OS 12 Device Settings (see 
page 6).

UD Pocket has a partition that contains this manual and is readable under Windows. The manual describes setting 
up and starting UD Pocket on your computer. 

Requirements
To use UD Pocket, your computer must meet the following requirements:

 USB 3.0 or 2.0 port from which the computer can boot
 Capability of booting from USB storage media
 Ethernet or wireless adapter. For a detailed list of supported graphics and network chips, see 

the IGEL Linux 3rd Party Hardware Database119.
 The device is supported by IGEL OS; for details, see Devices Supported by IGEL OS 12 .

If you want to use the IGEL UD Pocket Starter, the following requirements apply:

 Microsoft Windows 10 or 11 is installed on the endpoint device.
 The device has EFI BIOS
 Microsoft BitLocker is deactivated

These instructions apply to IGEL UD Pocket 2118.

If you use the IGEL UD Pocket, note that there is a downgrade limit, see Downgrade Limit on 
IGEL OS 12.7.1 or Higher (see page 449).

118. https://kb.igel.com/en/hardware/current/ud-pocket-2
119. https://www.igel.com/linux-3rd-party-hardware-database/

https://www.igel.com/linux-3rd-party-hardware-database/
https://kb.igel.com/en/hardware/current/ud-pocket-2
https://kb.igel.com/en/hardware/current/ud-pocket-2
https://www.igel.com/linux-3rd-party-hardware-database/
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Installing the IGEL UD Pocket Starter

1. Download setup-igel-udp_starter_<VERSION_NUMBER>.exe  from https://
www.igel.com/software-downloads/

2. Copy the file to your endpoint device, double-click it, and follow the instructions of the IGEL UD 
Pocket Starter Setup Wizard.

https://www.igel.com/software-downloads/
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Configuring the Boot Order
You can define which operating system is booted by default, i.e. if the user does not make a selection in the boot 
menu.

1. In the system tray, click on the IGEL OS icon.
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2. Choose the desired default operating system and click Save.
 Windows: Windows is booted by default, even if a UD Pocket is plugged into the device.
 UD Pocket: IGEL OS is booted from the UD Pocket, provided it is plugged in.

Starting Your IGEL UD Pocket (With IGEL UD Pocket Starter Installed)
1. Plug the UD Pocket into a free USB slot of your device.

2. Turn o your device; if the device is already switched on, restart it.
Your device boots into IGEL OS, provided you have chosen this option when configuring the boot 
order.
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Starting Your IGEL UD Pocket (Without IGEL UD Pocket Starter)

Booting from Your UD Pocket

1. Plug the UD Pocket into a free USB slot of your device.

2. Turn on your device; if the device is already switched on, restart it.

3. If a boot menu is presented that contains IGEL UD Pocket as an option, select this option. If not, 
proceed with the next step Customizing the Boot Settings.

Customizing the Boot Settings
Booting from USB storage media may already be enabled on your device, or you may have to enable it yourself. The 
required key presses for this may vary from vendor to vendor. However, here are some hints:

→ While the device is booting, try pressing [F12] (in general), [F10] (Intel devices), or [F9] (Hewlett-Packard devices) 
to access a list of boot devices and select IGEL UD Pocket.

→ If the above does not work, access the BIOS settings via pressing [Del], [F1], or [F2] during boot, activate booting 
from USB storage media, and/or change the boot order.

→ See the BIOS/UEFI documentation for your system for details on how to boot from USB storage media.

IGEL OS supports UEFI Secure Boot. Refer to the manual of your device's manufacturer to learn whether 
your device supports Secure Boot and how to enable it. Enabling Secure Boot often consists of two steps. 
First, the boot mode has to be changed to UEFI Boot in the BIOS; after that, Secure Boot can be activated, 
also in the BIOS. How to check whether Secure Boot has been properly enabled, you can learn 
under https://igel-jira.atlassian.net/wiki/pages/createpage.action?
spaceKey=ENLITESECURITYP&title=%28en%29%20Verifying%20that%20Secure%20Boot%20is%20Enable
d .

If UD Pocket fails to boot in UEFI mode, try it in legacy/BIOS mode. If this does not help, try another 
endpoint device to verify that the UD Pocket is functional and/or check for BIOS updates for your endpoint 
device and the latest IGEL OS updates. 

Do not remove the UD Pocket from the computer until you have shut down the IGEL OS contained on it. 
Otherwise, you can damage the operating system on UD Pocket and lose your settings as well as data on 
other removable media.
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After the First Boot-Up
To get started with your IGEL OS 12 device, see (en) How to Start with IGEL .

IGEL Tech Video

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=iURhgESsn6k

https://www.youtube.com/watch?v=iURhgESsn6k


Articles on Deploying and Updating IGEL OS 12

IGEL OS Base System   563 / 691

Troubleshooting: SCEP Certificate Renewal Failure due to Hostname 
Change
When SCEP certificate is linked to the DNS name of the device, the renaming of the device can lead to certificate 
renewal failure. This is indicated by the notification: " Renewal of client certificate failed - 

subject has changed OLDNAME > NEWNAME ".

Problem
If DNS name (auto) is selected under Network > SCEP Client (NDES) > Certificate (see page 185) > Type of 
CommonName/SubjectAltName, the hostname (also known as computer name or terminal name) is used for the 
SCEP certificate.

When the device gets renamed, the change is ignored for the network authentication and the certificate with the old 
hostname remains in use by default. This way the network authentication continues to function despite of the 
mismatch between the certificate with the old hostname and the one with new hostname.

However, when the certificate needs to get renewed, it usually fails because the SCEP server does not hand out a 
certificate for the new hostname based on the legitimacy of the old certificate.

Solution
To change the configuration:

1. In the profile configurator, go to System > Registry > 
network.scepclient.cert0.hostname_change_handling

You can also use the Search to find the registry key by enabling Include Registry.
If you only see the network.scepclient.cert%.hostname_change_handling, you need to add a new 
instance under cert% first.



Articles on Deploying and Updating IGEL OS 12

IGEL OS Base System   564 / 691

The default value of the Hostname change handling is Ignore, this is why hostname changes are ignored in 
network authentication. 

2. Set the the parameter to Reset.
As a result, when the hostname changes, any existing certificate gets discarded and the whole 
SCEP process starts over.

The Reset option is helpful when starting over the whole SCEP process is desired. It will not work when 
e.g. a fixed challenge password is configured and not valid anymore. So when the hostname is changed 
carelessly, the Ignore option’s consequences are less severe.
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Upgrading from IGEL OS 11 to IGEL OS 12
For instructions on upgrading endpoint devices from IGEL OS 11.09 to IGEL OS 12 via the Universal Management 
Suite (UMS), see Upgrading (Migration) from IGEL OS 11 to IGEL OS 12120.

120. https://kb.igel.com/en/igel-os/current/upgrading-migration-from-igel-os-11-to-igel-os-12

https://kb.igel.com/en/igel-os/current/upgrading-migration-from-igel-os-11-to-igel-os-12
https://kb.igel.com/en/igel-os/current/upgrading-migration-from-igel-os-11-to-igel-os-12
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Articles on Integrating IGEL OS 12 Devices Into Your 
Infrastructure

 How to Customize the Unit ID Computation for IGEL OS Creator (OSC) (see page 567)
 Troubleshooting: UMS Tray App Reports Connection failure: read failed (see page 571)
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How to Customize the Unit ID Computation for IGEL OS Creator (OSC)

In Which Cases Should I Change the Computation of the Unit ID?
Every IGEL OS device has a unit ID which must be unique and persistent. This is crucial for the administration and 
licensing of the device. For devices with a permanently installed IGEL OS (not UD Pocket), the unit ID is derived from 
the MAC address of a network interface. 

The unit ID is computed on the first boot after IGEL OS has been successfully installed by IGEL OS Creator (OSC). In 
almost all cases, the default algorithm for computing the unit ID will choose the appropriate MAC address. However, 
in the rare case that the MAC address chosen by the default algorithm is not the ideal one for your requirements, 
e.g. if the chosen network device is not used later on, you can define custom rules. To apply your custom rules, you 
must write them to a file within the IGEL OS Creator (OSC).

Requirements
 Bootable USB memory stick with IGEL OS Creator (OSC) 12.2.2 or higher. If you haven't got this 

software already, download it from https://www.igel.com/software-downloads/igel-os-12-secure-
endpoint/. 

 A Linux machine; the examples in this article are based on IGEL OS. 

What Is the Default for Computing the Unit ID?
The default algorithm for choosing the MAC address for unit ID computation is as follows:

1. If a network interface exists that matches a license already installed on the device, discard all 
other network interfaces.

2. Discard network interfaces that do not have the highest subsystem priority. The subsystem 
priorities are (from highest to lowest): PCI, SDIO, USB, others.

3. Discard wireless network interfaces if a wired interface exists.
4. From the remaining network interfaces, use the one that is first in lexicographical order.

Which Computation Rules Are Available?
The following list contains all available rules for unit ID computation. Please note that if several network interfaces 
meet the criteria, the first one in the lexicographic order is selected unless the rule reverse_order  is applied.

 prefer_pci : If a network interface connected via the PCI subsystem exists, discard all 
interfaces connected via other subsystems.

Changing the Unit ID of a Registered Device
When the unit ID of a device that is registered with the UMS is changed, the registration is broken. In this 
case, you must re-register the device, e.g. by scanning.

https://www.igel.com/software-downloads/igel-os-12-secure-endpoint/
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 prefer_sdio : If a network interface connected via the SDIO subsystem exists, discard all 
interfaces connected via other subsystems.

 prefer_usb : If a network interface connected via USB subsystem exists, discard all interfaces 
connected via other subsystems.

 prefer_wired : If a wired network interface exists, discard all wireless interfaces.

 prefer_wireless : If a wireless network interface exists, discard all wired interfaces.

 ignore_licensed : Do not take into account whether an interface is licensed or not. (In 
contrast to the default behavior where network interfaces that match the device's license are 
given preference.)

 reverse_order :  If more than one equivalent network interface is found, use the last one in 
the lexicographical order instead of the first one,

Creating a Custom Set of Rules
To achieve a specific computation of the unit ID, you can combine several rules.  

Example

The set of rules prefer_wireless, ignore_licensed, reverse_order  leads to the following 
behavior:

1. prefer_wireless : If a wireless network card is connected, all wired network cards are 
discarded.

2. ignore_licensed : If there are several wireless network cards and one of them matches the 
device's license, this does not count as a reason to use it for unit ID computation.

3. reverse_order : As the licensing criterion does not count, the position of a network device's 
name in the lexicographic order is the next criterion. By default, the first device in lexicographic 
order would be selected, but reverse_order  defines that the last device is selected.

Applying the Set of Rules to Your OSC (IGEL OS)
In the following description, we use IGEL OS. On other Linux variants, the procedure may differ; in particular, 
mounting the memory stick may require sudo .

1. Plug the USB memory stick with IGEL OSC on it into your device.
2. Open a terminal on the device and log in as root. For details on configuring a terminal on IGEL OS, 

see Terminals (see page 13).
3. Create a directory to which the memory stick will be mounted, e.g. stick/ 

mkdir stick
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4. Determine the device name of the memory stick with lsblk

lsblk

The output should look something like this:

5. When you have determined which of the listed devices is your memory stick, mount the second 
partition to the stick/  directory. In our example, this is sdb2 .

mount /dev/sdb2 stick/
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6.  Use your favorite text editor, e.g. vi , to create your unit_id_rules.ini  file.

vi stick/igel/unit_id_rules.ini

 

7. Unmount the partition.

umount stick

Now you can use the modified OSC on your memory stick to install IGEL OS on your devices.
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Troubleshooting: UMS Tray App Reports Connection failure: read failed
IGEL OS 12 devices are disconnected form the IGEL Universal Management Suite (UMS) and you can see the 
following error message in the UMS tray app: Connection failure: read failed  or in device logs. This 
error occurs because the TLS handshake is aborted during the establishment of a TLS connection to the UMS. This 
can happen when the IGEL OS 12 device has an expired client certificate.

Environment
 IGEL OS registered in UMS more than 1 year ago
 IGEL OS version 12.4.1 or lower

Problem
For devices with older IGEL OS 12 version, that is, running IGEL OS version 12.4.1 or lower, the client certificates are 
never renewed. These certificates expire 1 year after device registration in the UMS. As a result, devices cannot 
connect to the UMS and you can see the following error message in the UMS tray app: ERROR: Connection 

failure: read failed

You can also see the same error message in the device log files when the device is trying to connect to the UMS.

Solution
The mitigation of the issue is done by allowing expired certificates to be temporarily accepted for device connection 
to the IGEL UMS. This way, the devices can be updated without manual intervention.

For details, see Troubleshooting: IGEL OS 12 Devices Failing to Connect to UMS Due to Expired Client Certificates121.

For details on how to enable the custom TrustManager  for the IGEL Cloud Gateway, see Troubleshooting: IGEL 
OS 12 Devices Failing to Connect to the ICG Due to Expired Client Certificates122.

121. https://kb.igel.com/en/universal-management-suite/current/troubleshooting-igel-os-12-devices-failing-to-conn
122. https://kb.igel.com/en/igel-cloud-gateway/current/troubleshooting-igel-os-12-devices-failing-to-conn

https://kb.igel.com/en/universal-management-suite/current/troubleshooting-igel-os-12-devices-failing-to-conn
https://kb.igel.com/en/igel-cloud-gateway/current/troubleshooting-igel-os-12-devices-failing-to-conn
https://kb.igel.com/en/universal-management-suite/current/troubleshooting-igel-os-12-devices-failing-to-conn
https://kb.igel.com/en/igel-cloud-gateway/current/troubleshooting-igel-os-12-devices-failing-to-conn
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Articles on Network Configuration in IGEL OS 12
 How to Configure Wi-Fi Network Roaming in IGEL OS 12 (see page 573)
 How to Configure Server Certificate Verification during 802.1x Authentication in IGEL OS 12 (see page 

576)
 How to Configure the Permanent Storage of User-Provided Network Credentials (Wi-Fi and 

Ethernet) (see page 580)
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How to Configure Wi-Fi Network Roaming in IGEL OS 12
This article describes the parameters for configuring/optimizing Wi-Fi roaming for devices with IGEL OS 12. With this 
configuration, a device moving around will automatically select the strongest Wi-Fi access point available at the 
current position.

To find the settings described in this article, go to System > Registry.

Requirements
 Devices with IGEL OS 12.7.0 or higher
 All Wi-Fi networks within the device may roam are configured on the device

Roaming with Access Points that Share the Same SSID

Preventing Roaming
→ To make a device stick to the access point it is connected to, even if candidates with better signal quality are 
present, enable network.interfaces.wirelesslan.device0.lock_initial and set 
network.interfaces.wirelesslan.device0.bgscan.module to none. This should be regarded as a last resort for 
problems caused by too much roaming.

Configuring Background Scanning for a Stronger Signal
When background scanning is enabled, the Wi-Fi module continuously scans the environment for a potentially 
better signal. Background scanning is done by the simple module of wpa_supplicant . The parameters for 
background scanning are configurable.

Background Scanning

→ To configure backup scanning, set network.interfaces.wirelesslan.device0.bgscan.module according to your 
needs:

 none: No background scanning is done.
 default: Background scanning is performed by the “simple” module with typical settings. (Default)
 simple: Background scanning is performed by the “simple” module. The settings can be adjusted; 

see Background Scanning Behaviour According to the Signal Strength (see page 574).

The settings changes described here should only be made by experts.
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Background Scanning Behaviour According to the Signal Strength

These settings are available when network.interfaces.wirelesslan.device0.bgscan.module is set to simple.

When the signal strength falls below the defined threshold, background scanning is performed in a short interval. 
When the signal strength is higher than the threshold, background scanning is performed in a long interval.

→ To adjust the signal strength threshold, change the dBm value in 
network.interfaces.wirelesslan.device0.bgscan.simple.signal_strength. (Default: -45)

→ To adjust the short interval that is used when the signal strength falls below the defined threshold, change the 
interval in seconds in network.interfaces.wirelesslan.device0.bgscan.simple.short_interval. (Default: 30)

→ To adjust the long interval that is used when the signal strength is higher than the defined threshold, change the 
interval in seconds in network.interfaces.wirelesslan.device0.bgscan.simple.long_interval. (Default: 300)

Roaming Between Wi-Fi Networks with Different SSIDs

Interval for Triggering Automatic Roaming
→ To adjust the interval within which the device will check if automatic roaming might be necessary, edit the value 
network.interfaces.wirelesslan.device0.mssid_check_interval (default: 10s). This includes detecting that a 
connection has been lost and that a new one must be established.

Quality Threshold for Triggering a Scan
If the current quality is below the quality threshold, the device will start scanning for a better network.

→ To adjust the quality threshold, edit the percentage value of 
network.interfaces.wirelesslan.device0.mssid_quality_threshold (default: 20).

Quality Difference Threshold for Switching Over to a New Network
If the quality of a network is higher than that of the current network by a defined percentage, the new network is 
considered a candidate.

→ To adjust the quality difference threshold, edit the percentage value in 
network.interfaces.wirelesslan.device0.mssid_quality_difference_threshold (default: 40).

Quality Threshold for Re-Using a Network after Reboot
The network used before the reboot is preferred if its quality percentage is higher than a defined value.

→ To adjust the quality difference threshold, edit the percentage value in 
network.interfaces.wirelesslan.device0.mssid_previously_used_threshold (default: 55).
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User-Initiated Roaming
→ To enable roaming via the Wi-Fi tray icon's context menu (see https://kb.igel.com/en/igel-os-base-system/
12.6.1/tray-applications-in-igel-os-12#wifi), activate 
network.interfaces.wirelesslan.device0.mssid_user_selection (default: disabled).

→ To prevent automatic roaming from interfering with user-initiated roaming, make the following settings:

 network.interfaces.wirelesslan.device0.mssid_quality_threshold: 0
 network.interfaces.wirelesslan.device0.mssid_quality_difference_threshold: 101
 network.interfaces.wirelesslan.device0.mssid_previously_used_threshold: 0

Faster Roaming
Faster Wi-Fi roaming can be achieved by preventing the ARP cache from being purged and/or by limiting the 
frequencies to be scanned.

→ To prevent the ARP cache from being purged, which saves about 1 sec, set 
network.interfaces.wirelesslan.device0.arp_ndisc_evict_nocarrier to 0.

→ To limit the frequencies to be scanned, make the following settings:

 network.interfaces.wirelesslan.device0.freq_list: <LIST OF FREQUENCIES IN MHZ>. Example: 
2412 2437 2462

 network.interfaces.wirelesslan.device0.freq_list: <LIST OF FREQUENCIES IN MHZ>. Example: 
2412 2437 2462

When the ARP cache is not purged during roaming, packet loss may occur.

https://kb.igel.com/en/igel-os-base-system/12.6.1/tray-applications-in-igel-os-12#wifi
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How to Configure Server Certificate Verification during 802.1x 
Authentication in IGEL OS 12
You can use registry key configurations for verifying server certificate during 802.1x authentication in wireless and 
LAN connections in IGEL OS 12.

Example Configuration
If you would like to configure a substring to be matched against the subject of the certificate presented by the 
authentication server, you can do that through a dedicated registry key:

1. Configure the network connection under Network > Wireless > Wi-Fi Network or Network > LAN 
Interfaces for IGEL OS 12 devices. This can be done through a profile, or through local 
configurations. For details, see Wi-Fi Networks Configuration in IGEL OS 12123 and LAN Interfaces in 
IGEL OS 12124 .

2. In the profile configurator, go to the Search and enable Include Registry.

3. Start typing the name of the registry key and open the search result under Results in Registry to 
navigate there in the registry.
For example search for:

 network.interfaces.wirelesslan.device1.alt_ssid  for authentication 
through WLAN

123. https://kb.igel.com/en/igel-os-base-system/current/wi-fi-networks-configuration-in-igel-os-12
124. https://kb.igel.com/en/igel-os-base-system/current/lan-interfaces-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/wi-fi-networks-configuration-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/lan-interfaces-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/wi-fi-networks-configuration-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/lan-interfaces-in-igel-os-12
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 network.interfaces.ethernet.device  for authentication through Ethernet

4. Find the right instance of the registry key to update. Instances are present for each configured 
connection. Instances are marked by the numbers in the registry keys, like 
device0.alt_ssid1 .

5. Fill out the registry key field with the substring.

Useful Registry Keys
You can use the following registry parameters to further configure the 802.1x authentication. You can find them by 
searching for the registry key as described above.

Subject alternative matches

List of strings separated by ";" to be matched against altSubjectName of the certificate presented by the 
authentication server, for example DNS:server.example.com

Registry key for WiFi: 
network.interfaces.wirelesslan.device0.alt_ssid0.wpa.altsubject_matches

Registry key for LAN: network.interfaces.ethernet.device0.ieee8021x.altsubject_matches

Domain match

List of FQDNs separated by ";" to be matched against the certificate presented by the authentication server.

Registry key for WiFi: 
network.interfaces.wirelesslan.device0.alt_ssid0.wpa.domain_match

Registry key for LAN: network.interfaces.ethernet.device0.ieee8021x.domain_match

Domain suffix match

List of FQDN suffixes separated by ";" to be matched against dNSName elements of the certificate presented by the 
authentication server.

Registry key for WiFi: 
network.interfaces.wirelesslan.device0.alt_ssid0.wpa.domain_suffix_match

You can also use the Registry navigation tree to get to the registry keys. Each dot in the registry key marks 
a level deeper in the tree. For example, for network.interfaces.ethernet.device1 , you need 
to click through network > interfaces > ethernet > device1.

For WLAN, the instance you are looking for is the one where 
network.interfaces.wirelesslan.device0.alt_ssidX.network_name  contains the 

right name (SSID).
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Registry key for LAN: 
network.interfaces.ethernet.device0.ieee8021x.domain_suffix_match

Subject match

Substring to be matched against the subject of the certificate presented by the authentication server.

Registry key for 
WiFi: network.interfaces.wirelesslan.device0.alt_ssid0.wpa.subject_match

Registry key for LAN: nnetwork.interfaces.ethernet.device0.ieee8021x.subject_match

Phase 2 alternative subject matches

List of strings separated by ";" to be matched against altSubjectName of the certificate presented by the 
authentication server.

Registry key for WiFi: 
network.interfaces.wirelesslan.device0.alt_ssid0.wpa.phase2_altsubject_matches

Registry key for LAN: 
network.interfaces.ethernet.device0.ieee8021x.phase2_altsubject_matches

Phase 2 Domain match

List of FQDNs separated by ";" to be matched against the certificate presented by the authentication server during 
the inner "phase 2" authentication.

Registry key for WiFi: 
network.interfaces.wirelesslan.device0.alt_ssid0.wpa.phase2_domain_match

Registry key for LAN: 
nnetwork.interfaces.ethernet.device0.ieee8021x.phase2_domain_match

Phase 2 Domain suffix match

List of FQDN suffixes separated by ";" to be matched against dNSName elements of the certificate presented by the 
authentication server during the inner "phase 2" authentication.

Registry key for WiFi: 
network.interfaces.wirelesslan.device0.alt_ssid0.wpa.phase2_domain_suffix_match

Registry key for LAN: 
network.interfaces.ethernet.device0.ieee8021x.phase2_domain_suffix_match

Phase 2 Subject match

Substring to be matched against the subject of the certificate presented by the authentication server during the 
inner "phase 2" authentication.



Articles on Network Configuration in IGEL OS 12

IGEL OS Base System   579 / 691

Registry key for WiFi: 
network.interfaces.wirelesslan.device0.alt_ssid0.wpa.phase2_subject_match

Registry key for LAN: 
network.interfaces.ethernet.device0.ieee8021x.phase2_subject_match
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How to Configure the Permanent Storage of User-Provided Network 
Credentials (Wi-Fi and Ethernet)
In the following article, you will learn how you can configure the permanent storage of the username (identity) and 
password in IGEL OS that are provided by an end user via an entry mask when connecting to the enterprise 
network.

Problem
Username and password are required for IEEE 802.1x authentication for wireless and Ethernet connections with 
certain authentication methods like e.g. EAP-PEAP-MSCHAPv2 or EAP-TTLS-PAP, see Wi-Fi Networks Configuration 
in IGEL OS 12125 and Authentication in IGEL OS 12126. If you do not preconfigure the username (identity) and 
password via a UMS profile or the device’s local Setup, these credentials can be entered by an end user via an entry 
mask. However, they are not saved, so the end user has to re-enter the credentials each time the endpoint device 
reboots or resumes from suspend (sleep) mode.

Solution
You can enable the permanent storage of the credentials entered by an end user for enterprise network 
connections using the following registry keys. If enabled, the credentials are stored securely on the device.

The credentials for the following networks can be stored:

 Wi-Fi (WPA Enterprise)
 Ethernet (IEEE 802.1X)

This applies to those use cases where the network credentials are not preconfigured via a UMS Profile or the 
device’s local Setup.

Wi-Fi
For the relevant Wi-Fi network, edit the configuration as follows:

→ Go to System > Registry > network > interfaces > wirelesslan > device0 > alt_ssid[number of the relevant Wi-
Fi network] > wpa > allow_saving_credentials and set Allow saving credentials to permanent.

125. https://kb.igel.com/en/igel-os-base-system/current/wi-fi-networks-configuration-in-igel-os-12
126. https://kb.igel.com/en/igel-os-base-system/current/authentication-in-igel-os-12

https://kb.igel.com/en/igel-os-base-system/current/wi-fi-networks-configuration-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/authentication-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/wi-fi-networks-configuration-in-igel-os-12
https://kb.igel.com/en/igel-os-base-system/current/authentication-in-igel-os-12
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If you have activated the above registry key, the entry mask will include the option for saving the network 
credentials:

Ethernet (IEEE 802.1X)
For the relevant network device, edit the configuration as follows:

→ Go to System > Registry > network > interfaces > ethernet > device[number of the relevant network device] > 
ieee8021x > allow_saving_credentials and set Allow saving credentials to permanent.
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If you have activated the above registry key, the entry mask will include the option for saving the network 
credentials:
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Articles on Single-Sign On (SSO) with IGEL OS 12
 Facilitated Switching between IdPs for Single-Sign On (SSO) In IGEL OS 12.2 (see page 584)
 How to Configure Single Sign-On (SSO) on IGEL OS 12 (see page 588)
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Facilitated Switching between IdPs for Single-Sign On (SSO) In IGEL OS 
12.2

Overview
Switching between Okta and Microsoft Entra ID has been facilitated with IGEL OS 12.2.

With IGEL OS 12.01, the behavior of the SSO configuration was as follows: When you wanted to switch the IdP 
between Okta and Microsoft Entra ID, you had to delete and re-enter the public client identifier and the secret every 
time. This goes back to the fact that these values were not stored as separate parameters on the device.

With IGEL OS 12.2 or higher, the SSO configuration has been optimized. The public client identifiers and the secrets 
are now handled separately for Okta and Microsoft Entra ID. To benefit from this improvement, the profile must be 
based on IGEL OS 12.2. 

Setting Up a New Profile for Easy IdP Switching
1. In the UMS Web App, create a new profile for the IGEL OS Base System based on version 12.2. This 

can be done by setting the profile's App Selector to version 12.2.0 explicitly or by setting the base 
system's default version to 12.2 and the profile's App Selector to Default version.

2. For your Okta configuration, go to Security >  Logon > Single Sign-On and edit the settings as 
follows:

Automatic Update Results in Broken SSO
If your devices have been updated because Auto-update Default Version to newest version is active (see 
Universal Management Suite > IGEL UMS Web App > Apps - Import and Configure Apps for IGEL OS 12 Devices 
via the IGEL UMS Web App > Updating IGEL OS Apps > How to Configure Update Settings for Apps in the IGEL 
UMS Web App), and the SSO settings are still defined by a profile for IGEL Base System 12.01, SSO will not 
function anymore. In this case, you must immediately create an appropriate profile for IGEL OS Base 
System 12.2, as described in this article. 

Important Measures for Devices that Retain Base System 12.01
If some of your devices are to keep IGEL OS Base System 12.01, ensure the following:

 The current SSO profile is set to version 12.01.x of the IGEL OS Base System, not to the 
default version. This is done by setting the App Selector to version 12.01.x explicitly. If the 
base system version remains set to the default version, and the default version is then set 
to 12.2 or higher, the settings will be lost when the profile is saved.

 The current SSO profile (based on IGEL OS Base System 12.01) remains assigned to those 
devices.
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 Enable Single Sign-On with Identity Provider.
 Set Identity Provider to Okta.
 Provide the Okta URL for your user. This is the Okta organization URL. Example: "https://

mycompany.okta.com"
 Provide the Client ID. This is the client ID that was created in Okta.
 Provide the Client secret.

3. For your Microsoft Entra configuration, go to Security >  Logon > Single Sign-On and edit the 
settings as follows:

 Enable Single Sign-On with Identity Provider.
 Set Identity Provider to Azure ID.
 Enter the Azure AD Tenant Name/ID. This is the value you have obtained as Directory 

(tenant) ID in the Microsoft Entra Portal.
 Set the appropriate Application (client) ID. This is the value you have obtained 

as Application (client) ID in your Microsoft Entra ID Portal.
 Enter the Client secret.

The secret for Microsoft Entra ID can only be viewed once. If you have not stored it, you need 
to generate a new one. 
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4. Assign this profile to all relevant devices.
5. If you want to switch between Okta and Microsoft Entra ID, simply select the appropriate Identity 

Provider:
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How to Configure Single Sign-On (SSO) on IGEL OS 12
With IGEL OS 12, you can use Single Sign-On (SSO) via a cloud-based identity provider (IdP) to access the local 
device and apps. 

The following identity providers are supported:

 Okta
 Microsoft Entra ID (formerly known as Microsoft Azure AD)
 Ping Identity | PingOne
 Omnissa Workspace ONE Access

Generally, IGEL OS 12 supports OpenID Connect authentication. For IdPs that adhere closely to this standard, there 
is a good chance that they can be used with IGEL OS 12.

Apps and Utilities for IGEL OS 12 That Support SSO with Microsoft Entra ID
 IGEL Azure Virtual Desktop Client (AVD)
 Zoom client (SSO via Chromium)
 Web apps, e. g. Office 365 (SSO via Chromium) 
 Device login
 Screenlock

Apps and Utilities for IGEL OS 12 That Support SSO with Okta
 Web apps, e. g. Okta portal (SSO via Chromium) 
 Device login
 Screenlock

Generally, you can edit the IGEL OS 12 device configuration as follows:
 via the IGEL UMS Web App:

 Configuration > Create new profile 
(You select one or several apps that will be configured by the profile. If the IGEL OS 
base system app is selected, all other apps are shown under the tab "Apps"; if not, 
each app is displayed as a separate tab)

 Apps > [name of the app] > Create new profile (used to quickly configure a profile 
for the selected app. It is also possible to add other apps that will be configured by 
this profile)

 Devices > [name of the device] > Edit Configuration (shows all installed apps. 
Apps are displayed under the tab "Apps"

 via IGEL Setup locally on the device (shows all installed apps. Apps are displayed under 
the tab "Apps")

The best practice to configure your devices is via profiles. For details on how to create profiles, see (en) 
IGEL UMS 12: Basic Configuration .
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Apps and Utilities for IGEL OS 12 That Support SSO with Ping Identity / PingOne
 Web apps (SSO via Chromium) 
 Device login
 Screenlock

Apps and Utilities for IGEL OS 12 That Support SSO with Omnissa Workspace ONE 
Access

 Omnissa Horizon (if Chromium is used for authentication)
 Web apps (SSO via Chromium) 
 Device login
 Screenlock

Apps and Utilities for IGEL OS 12 That Support SSO with Other IdPs
 Web apps (SSO via Chromium) 
 Device login
 Screenlock

Setting Up SSO with Microsoft Entra ID
To enable SSO with Entra ID on IGEL OS 12 devices, an Entra application must be registered first. Then, you can 
configure IGEL OS 12 to use this application for authentication; the Entra application is referenced via its Public 
Client Identifier.

Registering an Entra Application

1. In your Entra AD Portal, go to App registrations > New registration.

2. Edit the data as follows and then click Register.
 Add a proper name for the application. Note that this name will be visible to the user once 

during the consent process for granting permissions. In our example, "IGEL OS Single sign-
on" is used as the name.

 Select the option Accounts in this organizational directory only ([name of your 
organization's AD Portal] only - Single tenant).

 Under Redirect URI (optional), select the option Public client/native (mobile & 
desktop), and enter the redirect URI you will define on your device later. It is recommended 
to use http://127.0.0.1/callback  rather than http://localhost/

callback .
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3. Check if the User.Read permission is granted.
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4. Click Add a permission.
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5. Select Microsoft Graph.
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6. Select Delegated permissions.
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7. Enable the following permissions and then click Add permissions: 
 email
 openid
 profile
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8. Check if the permissions are correct.
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9. Go to Certificates & secrets and click New client secret.
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10. Enter a Description, define when the secret Expires, and then click Add.
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11. Copy the Value of the client secret.
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12. Go to Overview and copy the Application (client) ID and the Directory (tenant) ID. In the IGEL 
OS configuration, these values will be used as the Public client identifier (client/application 
ID) and the Azure ID Tenant Name/ID.
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Configuring IGEL OS for SSO with Microsoft Entra ID

1. Go to Security > Logon > Single Sign-On and edit the settings as follows:
 Enable Single Sign-On with Identity Provider.
 Set Identity Provider to Microsoft Entra ID.
 Enter the Microsoft Entra ID Tenant Name/ID. This is the value you have obtained 

as Directory (tenant) ID in Azure AD Portal.
 Set the appropriate Application (client) ID. You have obtained this value as Application 

(client) ID in your Azure AD Portal.
 Enter the Client secret.
 Under Redirect URI, enter the URI you have entered in the Microsoft Entra ID portal 

under Redirect URI (optional), Public client/native (mobile & desktop).
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2. If you want to use an automatic desktop login with predefined credentials that are stored securely 
on your endpoint device:

 Enable Automatically perform login.
 Under Username for autologin, enter a user's name known to your IdP.
 Under Password for autologin, enter the enter the corresponding password.

3. Click Save or Save and close.
The desktop of the device is terminated. The login screen is displayed.
You can now use the apps and utilities for IGEL OS 12 that support SSO with Entra ID (see page 588).
For details on importing apps from the IGEL App Portal and installing them on IGEL OS devices, 
see (en) IGEL UMS 12: Basic Configuration.
All methods of multi-factor authentication are available except the hardware token.

Configuring SSO with Okta

Registering an Application in Okta

1. Log in to Okta with your admin account, and from the Applications menu, select Applications > 
Create App Integration.

Please be aware that after the automatic desktop login, a fully unlocked desktop session will run on your 
endpoint device. This feature should only be used for use cases where no interactive login is possible. It is 
good practice to restrict this user's access to only the relevant components and data that are necessary for 
the specific use case.
Please also note that Multi-Factor Authentication (MFA) is not possible when automatic login is enabled.
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2. Edit the settings as follows and then click Next. 
 Set Sign-in method to OIDC - OpenID Connect.
 Set Application type to Native Application
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3. Edit the settings as follows and then click Save.
 Under App integration name, enter a name for your application, e.g. "IGEL OS Single sign-

on".
 Make sure that as the Grant type, the option Authorization Code is selected.
 Under Sign-in redirect URIs, enter the redirect UR you will define on your device later. It is 

recommended to use http://127.0.0.1/callback  rather than http://

localhost/callback .
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The app integration is created.

4. Select the General tab and then click Edit.
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5. Under Client authentication, select Client secret and make sure that under Proof Key for Code 
Exchange (PKCE), Require PKCE as additional verification is enabled. Afterward, click Save.
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The client secret will be created.

6. Copy the Client ID and the Secret (client secret).
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Configuring IGEL OS for SSO with Okta

1. Go to Security > Logon > Single Sign-On and edit the settings as follows:
 Enable Single Sign-On with Identity Provider.
 Set Identity Provider to Okta.
 Provide the Okta URL for your user. This is the Okta organization URL. Example: "https://

mycompany.okta.com/"
 Provide the Client ID. This is the client ID that was created in Okta.
 Provide the Client secret.
 Under Redirect URI, enter the URI you have entered in the Okta portal under Sign-in 

redirect URIs.
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2. If you want to use an automatic desktop login with predefined credentials that are stored securely 
on your endpoint device:

 Enable Automatically perform login.
 Under Username for autologin, enter a user's name known to your IdP.
 Under Password for autologin, enter the enter the corresponding password.

Please be aware that after the automatic desktop login, a fully unlocked desktop session will run on your 
endpoint device. This feature should only be used for use cases where no interactive login is possible. It is 
good practice to restrict this user's access to only the relevant components and data that are necessary for 
the specific use case.
Please also note that Multi-Factor Authentication (MFA) is not possible when automatic login is enabled.
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3. Click Save or Save and close.
The desktop of the device is terminated after the profile is applied. The login screen is displayed.
You can now use the apps and utilities for IGEL OS 12 that support SSO with Okta (see page 588).
If you want to use multi-factor authentication, you can configure this in the Okta console. The 
available methods are Google Authenticator, E-Mail, and Okta Verify.

Setting up SSO with Ping Identity / PingOne

Setting up Your Application

1. Log in to your PingIdentity account, go to Applications, and click the add symbol to create a new 
application.

2. Provide an Application Name, select Native as the Application Type, and click Save.
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3. Select the Configuration tab and click the edit button.



Articles on Single-Sign On (SSO) with IGEL OS 12

IGEL OS Base System   611 / 691

4. Edit the configuration as described below and click Save.
 Response Type: Select Code.
 Grant Type: Select Authorization Code and set PKCE Enforcement to S256_REQUIRED.
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 Redirect URIs: Enter the redirect URI you will define on your device later. It is 
recommended to use http://127.0.0.1/callback  rather than http://

localhost/callback .
 Token Endpoint Authentication Methods: Select Client Secret Post.
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5. Select the Resources tab and click the edit button.

6. Ensure that the following resource scopes are activated and click Save.
 email
 openid
 profile
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7. Review the list of ALLOWED SCOPES.
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8. Select the Configuration tab and copy the following data for later use:
 Client ID
 Client Secret
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9. Expand the list of URLs and copy the Issuer URL for later use.
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10. Activate your application.
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Configuring IGEL OS for SSO with Ping Identity / PingOne

1. Go to Security > Logon > Single Sign-On and edit the settings as follows:
 Enable Single Sign-On with Identity Provider.
 Set Identity Provider to Ping Identity | PingOne.
 Provide the PingOne issuer URL for your user. This is the Issuer URL provided in the Ping 

Identity configuration portal. Example:  https://auth.pingone.eu/0815abc-

xyz123456/as
 Provide the Client ID. This is the client ID that was created in Ping Identity.
 Provide the Client secret.
 Under Redirect URI, enter the URI you have entered in the PingIdentity portal 

under Redirect URIs.
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2. If you want to use an automatic desktop login with predefined credentials that are stored securely 
on your endpoint device:

 Enable Automatically perform login.
 Under Username for autologin, enter a user's name known to your IdP.
 Under Password for autologin, enter the enter the corresponding password.

3. Click Save or Save and close.
The desktop of the device is terminated after the profile is applied. The login screen is displayed.
You can now use the apps and utilities for IGEL OS 12 that support SSO with Ping Identity / 
PingOne (see page 589).
If you want to use multi-factor authentication, you can configure this in the Ping Identity console.

Please be aware that after the automatic desktop login, a fully unlocked desktop session will run on your 
endpoint device. This feature should only be used for use cases where no interactive login is possible. It is 
good practice to restrict this user's access to only the relevant components and data that are necessary for 
the specific use case.
Please also note that Multi-Factor Authentication (MFA) is not possible when automatic login is enabled.
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Setting Up SSO with Omnissa Workspace ONE Access

Registering an Application in Omnissa Workspace ONE Access

1. In the Omnissa Workspace ONE Access console, go to Settings > OAuth 2.0 Management and 
click Add client.

2. Set up the client as follows and finally click Save.
 Access type: Select User Access Token.
 Client type: Select Confidential.
 Client ID: Enter a client ID that suits your needs; respect the allowed characters. 

Example:  IGEL_OS_SSO
 Grant type: Enable Authorization Code Grant. 
 Redirect URI: Enter the redirect URI you will define on your device later. It is recommended 

to use http://127.0.0.1/callback  rather than http://localhost/

callback .
 User grant: Disable Prompt users for scope acceptance.
 Scope: Edit the settings as follows:

 Email: Enabled
 Profile: Enabled
 User: Disabled
 NAPPS: Disabled
 OpenID: Enabled
 Group: Disabled
 Admin: Disabled

 PKCE support: This option is enabled because Authorization Code Grant is selected as 
the Grant type.

 Issue refresh token: Enable or disable this option according to your needs.
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 Access token TTL: Adjust the time to live for the authorization token according to your 
needs.

 Idle token TTL: Adjust the time to live for the idle token according to your needs.
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3. Review the settings and copy the following data for later use:
 Client ID
 Shared Secret

Configuring IGEL OS for SSO with Omnissa Workspace ONE Access

1. Go to Security > Logon > Single Sign-On and edit the settings as follows:
 Enable Single Sign-On with Identity Provider.
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 Set Identity Provider to Omnissa Workspace ONE Access (formerly VMware Workspace 
ONE Access).

 Provide the Workspace ONE Access issuer URL for your user. Pattern:  https://<YOUR 

WORKSPACE ONE ACCESS URL>/SAAS/auth
 Provide the Client ID. This is the client ID that was created in Omnissa Workspace ONE 

Access.
 Provide the Client secret.
 Under Redirect URI, enter the URI you have entered in the Omnissa Workspace ONE Access 

console under Redirect URI.
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2. If you want to use an automatic desktop login with predefined credentials that are stored securely 
on your endpoint device:

 Enable Automatically perform login.
 Under Username for autologin, enter a user's name known to your IdP.
 Under Password for autologin, enter the enter the corresponding password.

3. Click Save or Save and close.
The desktop of the device is terminated after the profile is applied. The login screen is displayed.
You can now use the apps and utilities for IGEL OS 12 that Support SSO with Omnissa Workspace 
ONE Access (see page 589).
If you want to use multi-factor authentication, you can configure this in the Omnissa Workspace 
ONE Access portal.

Configuring SSO with Other IdPs That Use OpenID Connect
For setting up your application or client, the exact procedure depends on the OpenID Connect solution you are 
using. Therefore, the settings in the IdP console can only be described generically.

Please be aware that after the automatic desktop login, a fully unlocked desktop session will run on your 
endpoint device. This feature should only be used for use cases where no interactive login is possible. It is 
good practice to restrict this user's access to only the relevant components and data that are necessary for 
the specific use case.
Please also note that Multi-Factor Authentication (MFA) is not possible when automatic login is enabled.
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Setting up Your Application / Client
In your IdP console, edit the parameters as follows (the exact parameter names will probably deviate):

Parameter Values

Response type code

Scopes openid, profile, email

Redirect URI The redirect URI you will define on your endpoint device 
later. It is recommended to use http://127.0.0.1/

callback , rather than http://localhost/

callback .

Code challenge method S256

Response mode fragment

Client authentication client_secret_post

Configuring IGEL OS for SSO with Generic OpenID Connect

1. Go to Security > Logon > Single Sign-On and edit the settings as follows:
 Enable Single Sign-On with Identity Provider.
 Set Identity Provider to OpenID Connect.
 Provide the Issuer URL for your user. This is the Issuer URL provided in the IdP console. 

Example for Keycloak:  https://keycloak.yourcompany.com/realms/

yourrealm
 Provide the Client ID. This is the client ID that was created in the IdP console.
 Provide the Client secret.
 Under Redirect URI, enter the redirect URI you have entered in your IdP’s portal.

Please note that automatic login is not possible with generic OpenID connect.
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2. Click Save or Save and close.
The desktop of the device is terminated. The login screen is displayed.
You can now use the apps and utilities for IGEL OS 12 that support SSO with OpenID Connect 
(generic) (see page 589).
For details on importing apps from the IGEL App Portal and installing them on IGEL OS devices, 
see (en) IGEL UMS 12: Basic Configuration .
For supported multi-factor authentication methods, check the documentation of your IdP.

Enabling Local Login (Optional)
To have a fallback option if something goes wrong with SSO, e.g. a network failure, it is recommended to configure 
local login in addition. 

1. Open the profile configurator and go to Security > Logon > Local user.

2. Activate Login with local user password and enter a password.



Articles on Integrating IGEL Apps With Your Base System

IGEL OS Base System   631 / 691

Articles on Integrating IGEL Apps With Your Base System
 How to Set the Default Browser in IGEL OS 12 (see page 632)
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How to Set the Default Browser in IGEL OS 12
If a browser app is installed, it is automatically set as the default browser. If several browsers are installed on your 
system, you should define a default browser. The default browser will be used for Single Sign-On (SSO).

In the following example, we will set the Chromium browser as the default browser.

1. In the Web UMS, open the profile for your desired default browser.

2. Go to System > Registry > app > [your browser] > mimetype > default_browser and enable 
Default browser, and save your settings.

Importance of Setting a Default Browser Correctly
Please note the following:

 If several browsers are installed and no browser is set as default, the browser whose name 
is last in alphabetical order is the default. Example: If Chromium, Edge, Firefox, and Island 
are installed and no default browser is set, Island will be the default browser.

 If several browsers are erroneously set as default, the browser from this selection whose 
name is last in alphabetical order will be the actual default.
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Articles about Securing IGEL OS 12
 How to Use Smart Card and Smart Key Authentication in IGEL OS 12 (see page 635)
 How to Mitigate Terrapin Vulnerability through Registry Parameter in IGEL OS (see page 640)
 How to Keep Your IGEL OS 12 System up to Date (see page 641)
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How to Use Smart Card and Smart Key Authentication in IGEL OS 12
In IGEL OS 12 you can enable smart card authentication to Microsoft Azure Virtual Desktops (AVD) by leveraging 
Microsoft Entra Certificate-Based Authentication (CBA). This article guides you through the necessary 
configurations. You can also see the blog post for an overview: https://www.igel.com/blog/authentication-to-
windows-365-with-igel-smart-card/.

Prerequisites
 IGEL OS Base System version 12.6.0 or higher
 IGEL AVD App verison 1.3.0 or higher

Process Overview
1. If you are a US Military / Government customer, contact the regional IGEL representative for 

configuration support.
2. Configure Microsoft Entra ID Certificate Based Authentication as described in https://

learn.microsoft.com/en-us/entra/identity/authentication/concept-certificate-based-
authentication .

3. Configure Smart Card Middleware in IGEL OS.
4. Configure AVD in IGEL UMS Web App.
5. Test the authentication on the IGEL OS endpoint device.

Configure Smart Card Middleware
IGEL has a built-in OpenSC that you can use as middleware, or you can choose a middleware from the IGEL App 
Portal.

Built-in OpenSC as Middleware
If no Smart Card middleware from the IGEL App Portal is installed, the built-in OpenSC middleware is enabled by 
default.

For more information on the Common Access Card (CAC) / Personal Identity Verification (PIV) 
smart cards and Yubikey PIV supported by IGEL, see https://www.igel.com/blog/cac-piv-smart-
cards-yubikey-and-more-insider-tips-on-how-igel-os-use-both/ .

US Military / Government customers need to contact their regional IGEL representative for the complete 
configuration.

https://www.igel.com/blog/authentication-to-windows-365-with-igel-smart-card/
https://learn.microsoft.com/en-us/entra/identity/authentication/concept-certificate-based-authentication
https://www.igel.com/blog/cac-piv-smart-cards-yubikey-and-more-insider-tips-on-how-igel-os-use-both/
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It is possible to use the OpenSC middleware in parallel with a Smart Card middleware from the IGEL App Portal, but 
this is not recommended. If you still want to use both middlewares in parallel, edit the configuration as follows:

1. In the profile configurator, go to System > Registry > scard > pkcs11 > use_opensc

2. Enable the parameter.

Smart Card Middleware from the IGEL App Portal

1. Go to the IGEL App Portal127.

2. Open the Smartcard category.

3. Choose an app and import to the IGEL UMS.

127. https://app.igel.com/

https://app.igel.com/
https://app.igel.com/
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4. Install the app on the IGEL OS endpoints according to your app distribution process.

5. Reboot the endpoint devices.
The middleware will become active automatically.

Configure the AVD Session in IGEL UMS Web App
1. Import the AVD app from the IGEL App Portal to your UMS.

2. Create a new profile. For details, see How to Create and Assign Profiles in the IGEL UMS Web App128.

3. Select OS 12 (shown only if there are OS 11 devices registered in the UMS) and enter the name of 
the profile.

4. Click Select Apps and select IGEL Azure Virtual Desktop.

5. Click Save.

6. Go to Apps > AVD > AVD Sessions.

7. Click + to create a new session and add a Session Name.

8. Go to the Advanced Options of the session.

Use version 1.3.0 or higher.

128. https://kb.igel.com/en/universal-management-suite/current/how-to-create-and-assign-profiles-in-the-igel-ums-

https://kb.igel.com/en/universal-management-suite/current/how-to-create-and-assign-profiles-in-the-igel-ums-
https://kb.igel.com/en/universal-management-suite/current/how-to-create-and-assign-profiles-in-the-igel-ums-
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9. Enable Microsoft Authentication Library (MSAL)

10. Go to System > Registry.

11. Go to the registry key scard.scwatchd.enable and enable Smart Card Insert and Removal 
Actions.
This will allow executing commands when a hardware event is triggered by inserting or removing 
the smart card from the reader.

12. Go to scard.scwatchd.insert_action and set the following command as the value:

export avduser=$(pkcs11getloginname | grep "^Login:" | sed -e "s/^Login://"); su -c 
"appwrap avd0 avd" user

This will read out the User Principal Name (UPN) on smart card insert and start the session.

13. Go to scard.scwatchd.removal_action and set the following command as the value:

export avduser=""; killall -9 igelrdp3-avd; killall -9 igelrdp3-msal-auth

This will reset the ‘avduser’ variable and hard kill the running processes to disconnect from the Windows 365 
session.
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14. Go to app.avd.sessions.avd0.options.cmd_ext and set the following command as the value:

--username $avduser

This will tell the IGEL AVD App to set the username to the previously retrieved UPN during the card insert.

Test Authentication
Once the configurations are applied, you should test the authentication process on the endpoint device.

You should get a similar experience as in the below demo video:

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=R3068gY17TQ

https://www.youtube.com/watch?v=R3068gY17TQ
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How to Mitigate Terrapin Vulnerability through Registry Parameter in 
IGEL OS
To mitigate Terrapin Vulnerability, you can enable a registry parameter that will disable weak MACs and Chipers to 
prevent terrapin attacks. For more information on terrapin attacks and the related CVE-2023-48795, see Security & 
Safety > IGEL Product Security Information > ISN 2023-39: SSH Terrapin Vulnerability and https://terrapin-
attack.com/ and https://cve.mitre.org/cgi-bin/cvename.cgi?name=2023-48795.

To enable Terrapin mitigation through the registry parameter:

1. In configuration, go to System > Registry > network > ssh_server > 
enable_terrapin_mitigation.

2. Enable the parameter.
3. Click Save or Save and Close to save the change.

The following options vulnerable to Terrapin attack are disabled:

 the ChaCha20-Poly1305 cipher
 all -cbc ciphers
 all -ctr ciphers
 all -etm@openssh.com macs

If you use OpenSSH 9.6p1 both on the client and server there is no need to use this registry parameter. 
IGEL OS versions 12.3.1 or higher use the latest OpenSSH 9.6p1. When you use this version or newer on the 
peer, they will automatically use the new "strict KEX" protocol extension.

https://terrapin-attack.com/
https://cve.mitre.org/cgi-bin/cvename.cgi?name=2023-48795
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How to Keep Your IGEL OS 12 System up to Date

Rationale
Software updates fix newly discovered vulnerabilities in the IGEL OS Base System and the apps installed. This 
means that keeping up with updates is one of the most important measures in securing IGEL OS systems.

Prerequisites
 Your devices are managed by the Universal Management Suite (UMS) 12
 Your Universal Management Suite (UMS) has access to the IGEL App Portal. It must be registered 

for this; see (en) Registering the UMS.
 Your devices have valid licenses

Receiving regular safety information
→ To get new ISNs and ISN updates delivered to your inbox, subscribe to the Security Announcements Mailing 
List. Go to http://igel.com  and find the "Subscribe for Updates" form at the bottom of the page. This will initially 
subscribe you to all mailings from IGEL, but by using the unsubscribe link at the bottom of a mail, you can select 
which communications you wish to receive and which not.

Before You Begin
As the steps for the Base System differ from those for the other apps, the procedure is as follows:

 Setting the UMS to Update Regularly (see page 641)
 House Keeping: Delete Older, Unused Versions Regularly (see page 644)
 Setting up a Test Directory (see page 645)
 Keeping the Base System up to Date (see page 648)

 Testing the Base System Updates on One or a Few Devices (see page 648)
 Rolling out the Base System Update on All Devices (see page 666)

 Keeping Other Apps up to Date (see page 670)
 Testing the App Updates on One or a Few Devices (see page 670)
 Rolling out the App Update on All Devices (see page 674)

Setting the UMS to Update Regularly
To ensure you have every version of your apps available in the UMS, we will set the UMS to import new versions 
automatically.

Follow these steps for each app installed on your devices. We will use the Base System as an example.

1. In your UMS Web App, go to APPS and then open the Update Settings.

http://igel.com
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2. Enable Check for updates and auto-import into UMS and Update Default Version manually.
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The UMS is now kept always up-to-date. The latest software versions are imported automatically. As Update 
Default Version manually is selected, the updates are not automatically rolled out to the devices.

The default interval for update checks is 120 minutes. You can configure the interval via Settings > 
Automatic Updates:
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House Keeping: Delete Older, Unused Versions Regularly
If you have configured your UMS to import every new version of your imported apps, as described above, you 
should dispose of older, unused versions. It is recommended to do this regularly.

→ In your UMS Web App, go to the app version in question and click to remove it.
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Setting up a Test Directory
It is highly recommended that test devices be put into a separate directory.

1. In your UMS Web App, go to DEVICES and create a directory for your test devices, e.g., "Update 
test”.
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3. Find your test devices and put them into the new test directory using drag & drop.
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Keeping the Base System up to Date

Testing the Base System Updates on One or a Few Devices
To prepare for testing the Base System update, we will proceed in two steps:

1. Create a test profile to be able to activate or configure new features, e.g. security features of the 
new Base System version

2. Assign the new Base System version explicitly to the test devices

Creating the Test Profile

To create a test profile, we will duplicate the productive profile by exporting and re-importing it.

1. In your UMS Web App, go to the Configuration Objects and then find the relevant profile.

As of IGEL OS 12.7.1, there is a downgrade limit. See Downgrade Limit on IGEL OS 12.7.1 or 
Higher (see page 449) .
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2. Click Export Profile and save the file on your machine.
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4. Click  and import the file.
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The imported profile is displayed underneath the original profile. The imported profile can be distinguished from 
the original one by its ID, which is higher.

4. Select the imported profile, and click  to change the name appropriately.



Articles about Securing IGEL OS 12

IGEL OS Base System   653 / 691

5. Set the app version of the test profile to the target version.
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Assigning the Profiles to the Test Devices

1. Find your test devices and detach the relevant productive profiles from each test device.
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2. Assign the test profile to your test directory.
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Assigning the New Base System Version to the Devices

1. Go to each of your test devices and check under Assigned Objects if a version of the IGEL OS Base 
System is assigned to the device.
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2. Move your mouse to the right side of the IGEL OS Base System entry; if a Detach object button (

) appears, click it and confirm your change.
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3. Go to the test directory and click Assign Object.
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2. In the dialog Assign Object to Directory, choose the desired version of the IGEL OS Base System 
and assign it to the directory.
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After a dialog timeout, the devices update to the new version of the IGEL OS Base System. You can perform your 
tests as appropriate.

Rolling out the Base System Update on All Devices

1. Go to your productive profile and ensure it is set to use the default version of the app.
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2. In the apps section, select the app to be updated, and click Set Default Version.
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2. Set the default version to the version you have tested successfully.

3. Choose whether the update should take place immediately or on the next reboot.

On reboot, the devices update their Base System to the default version.
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Keeping the Other Apps up to Date

Testing the App Updates on One or a Few Devices

1. Go to each of your test devices and check under Assigned Objects if a version of the app is 
assigned to the device.

2. Move your mouse to the right side of the app’s entry; if a Detach object button ( ) appears, click 
it and confirm your change.
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3. Go to the test directory and click Assign Object.
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2. In the dialog Assign Object to Directory, choose the desired version of the app and assign it to the 
directory.
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After a dialog timeout, the device reboots to install the new version of the app. You can perform your tests as 
appropriate.

Rolling out the App Update on All Devices

1. In the apps section, select the app to be updated, and click Set Default Version.
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2. Set the default version to the version you have tested successfully.

3. Choose whether the update should take place immediately or on the next reboot.
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4. Go to the directory that contains your productive devices and click Assign Object.
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On reboot, the devices update their app to the new version.
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Articles about Hardware-Related Topics
 How to Handle More Than One Touchscreen in IGEL OS 12 (see page 680)
 How to Use Multiple GPUs in IGEL OS 12 (see page 682)
 Troubleshooting - USB Fiber Network Adapter Does Not Work on IGEL OS (see page 684)
 Special Key Actions in IGEL OS 12 (see page 686)
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How to Handle More Than One Touchscreen in IGEL OS 12
If you connect multiple touchscreens to your IGEL OS device, you can configure them either using the configuration 
options or through script.

Prerequisites
You need OS Base System version 12.2.2 or higher.

Using the Configuration Options
To configure multiple touchscreens:

1. Connect only one touchscreen and configure it using the options under User Interface > Input > 
Touchscreen, section Multimonitor. For details, see Touchscreen Configuration in IGEL OS 12 (see 
page 89).

2. If the first touchscreen works, connect the next touchscreen.
It will get assigned to the next monitor in the monitor order. The order is the numbering shown by 
screenid or in the display tray app.

3. If you have more than 2 monitors, continue connecting them this way.
The touch screen to monitor assignment can be done through the monitor order.

Using a Script
To configure touchscreens using a script:

1. Connect the touchscreens.

2. Check which touchscreens are available with fix_touchscreen_matrix show . It should 
show you something like this:

Found Touchscreen: Name: UNITEC USB Touch (Windows 8)
               XID: 19
               USB: Bus 1 Port 2 -> HUB Port 2 -> HUB Port 3 (conf entry: 
usb1-2.2-port3)
               Configured for screen: dp1 (DisplayPort)
 
Available connected monitors setup name: dp1 screenid name: DisplayPort X11 
name: DP-1
Available connected monitors setup name: dp2 screenid name: DisplayPort(II) X11 
name: DP-2
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Starting screenid to identify connected monitors.
 
Script will exit if screenid is closed

2. For configuration (that is, assigning the touchscreens to the monitors), create a /wfs/user/

touchconf.ini  file with the information from above. The file should look like this:

# Format usb<bus num>[-[portnum]]-port<portnum>-><conn setup name>
# Use fix_touchscreen_matrix show to get the needed data (conf entry: ... contains 
the usb... Part
# Setup name: ... is the setup connector name you should use
# a entry could look like this: usb1-2.3.1-port3->dp2
usb1-2.2-port3->dp1
usb1-2.3.1-port3->dp2

The screenid will make it easier to identify the correct monitor.
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How to Use Multiple GPUs in IGEL OS 12
If you run IGEL OS 12 on a device with multiple physical GPUs and multiple monitors, you need to check GPU 
configurations and you may need to modify them to successfully operate all connected screens. This article 
provides general explanation and the necessary configurations for a multi-4K monitor setup.

Primary and Secondary GPU in Linux
To find the right configuration, we need to understand how Linux uses multiple GPUs for an extended desktop 
across multiple monitors. When several screens are in use, the Linux driver merges multiple physical GPUs into one 
logical X screen by having one GPU (the primary GPU) doing all the rendering for all the screens. The secondary GPU 
only receives a copy of the frame buffers that it needs to display.

The internal GPUs of the devices are usually slower, thus the GPU on the add-in card (from now called the external 
GPU) would be better as primary GPU, because the primary GPU does all the rendering. However, if the external 
GPU doesn’t have sufficient memory (e.g. minimum 2GB VRAM) it may run out of memory when asked to render for 
all connected screens (especially if 4K screens are involved). In this case, it is better to configure the internal GPU to 
have more memory and use it as the primary GPU despite the performance loss - otherwise, some screens may 
remain blank.

Example Configuration for the Use Case of Six 4K Monitors with HP Elite t755
When you are connecting six 4K monitors to a HP Elite t755, you need to consider GPU settings to successfully 
operate all screens. Go through the decision tree and perform the necessary configurations described below.
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1. Enable GPUs from different manufacturers under System > Registry using 
x.drivers.<hw>.use_modesetting, <hw>. amdgpu|ati|intel|nouveaux|nvidia|...

2. Check the VRAM of the external GPU. If the external GPU has less than 2 GB VRAM, it should be 
operated as a secondary GPU. This way, it only needs to maintain the frame buffer for the two 
displays attached to it.
To configure the external GPU as the secondary GPU:

a. In the configuration dialog go to System > Registry > x > drivers > 
swap_card0_with_card1.

b. Enable Make the secondary graphic card to the primary one.

3. If the internal GPU is used as primary GPU, you need to assign 2GB VRAM to the internal GPU to 
guarantee that it has enough VRAM to render all screen content. This needs to be done by forcing 
the corresponding setting in the BIOS:

a. Start the HP BIOS (Setup Utility) by pressing F10 during boot.
b. Navigate to Advanced > Device Options > Auto.
c. Then press the key “cursor left” and the word Auto will change to Force.
d. Now navigate one line down to UMA Frame Buffer Size and change the 512MB to 2048MB.
e. Leave the Device Options by pressing [F10] for Accepting the change.
f. Then navigate to File > Save Changes and Exit.

g. Press [Enter] to save this change.

If the GPUs use different drivers (usually different vendors, e.g. Intel and Nvidia), you need to turn on 
modesetting_driver  on all involved GPU drivers.

For more information on registry parameters, see Registry in IGEL OS 12 (see page 356).

Configuring this in the BIOS does not yield the expected result because the BIOS only defines which GPU to 
use for boot messages.

If the internal GPU doesn’t have enough VRAM, the driver will allocate system memory to alleviate the 
situation. This helps at first but fails during a suspend/resume cycle when the driver tries to re-allocate the 
system memory. As a result, the two monitors connected to the external GPU remain dark.
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Troubleshooting - USB Fiber Network Adapter Does Not Work on IGEL 
OS
You use fibre-to-USB adaptors with your IGEL OS 12 devices. IGEL OS can see the adaptor, but no network trafic is 
transmitted.

Problem
Some USB ethernet fiber adaptors work with 4.4.x kernel but not with newer ones.

Solution
As of IGEL OS 12.7.1, you can activate the asix_thirdparty driver to get some fibre USB ethernet adapters to work.

1. In the Profile Configurator, create a profile for IGEL OS Base System. For more information on 
profile creation, see How to Create and Assign Profiles in the IGEL UMS Web App129.

2. Go to System > Registry and enbale the following registry key:

Parameter Use thirdparty asix kernel module.

Registry network.drivers.asix.prefer_thirdpart

Range [Auto] [Yes] [No]

Value Auto

129. https://kb.igel.com/en/universal-management-suite/current/how-to-create-and-assign-profiles-in-the-igel-ums-

https://kb.igel.com/en/universal-management-suite/current/how-to-create-and-assign-profiles-in-the-igel-ums-
https://kb.igel.com/en/universal-management-suite/current/how-to-create-and-assign-profiles-in-the-igel-ums-
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Special Key Actions in IGEL OS 12
In IGEL OS 12 you can trigger special key actions, like decreasing the volume, by pressing special keys of the 
keyboard.

Basic Special Keys
The following common special keys are supported in IGEL OS 12.

Accessing Special Keys - Combinations with Fn and Ctrl Key

When to use [Fn] key?

In many keyboards the special keys share the same physical key as function keys. For example, 
the [Volume down] and [F2] share the same keyboard key on many Lenovo keyboards. To 
differentiate between the action triggered by pressing the key, you might need to keep the [Fn]
key pressed down to switch to the special key and trigger the special key action instead of the 
function key action. This depends on the keyboard and the local configurations, and can also be 
the other way around, so that you need to use the [Fn] key to access the function key actions.

To test whether you need to use the [Fn] key, try to decrease the volume just by pressing the 
dedicated special key. If nothing happens, try keeping the [Fn] key pressed down while pressing 
the dedicated special key.

When to use key combinations with [Ctrl] key?

When VDI sessions are used, some special keys and key combinations are also forwarded to the 
VDI session. If you want the special key or key combination to be handled by the IGEL OS itself, 
you need to press [Ctrl] in addition to the other keys. For example, if you want to switch between 
IGEL OS windows, press [Ctrl]+[Alt]+[Tab]. However, the special keys that are not relevant for the 
OS running in the VDI session, for example volume or brightness control, are always handled by 
the IGEL OS without the need to press [Ctrl].
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Special key Action triggered

Mute speaker Mute loudspeaker

Volume down Decrease audio volume

Volume up Increase audio volume

Mute microphone Mute microphone

Brightness down Decrease display brightness

Brightness up Increase display brightness

Lenovo Specific Special Keys
If you are using IGEL OS 12 on specific Lenovo devices, you can use special keys to trigger additional actions 
described in the table below. In some cases, the special key triggers the action when pressed in combination with 
the Ctrl key. For example, to maximize the window, you need to press [Ctrl]+[Maximize Window].

Special key Action triggered 
on L14 Gen5 Intel/
AMD and L16 Gen1 
Intel/AMD

Action 
triggered on 
L13 Gen5 Intel

Further Information

Display Mirror 
Special Key

(located at F7)

Launch IGEL display tray app For details on the display tray app, see 
(12.4.2-en) Tray Applications in IGEL OS 12.

In many cases these special keys are located on the function keys [F1]-[F6]. However, depending on the 
hardware, they can be located differently and still trigger the same action.

Special key actions are supported starting from IGEL OS version 12.5.1 and with the following Lenovo 
models:

 ThinkPad L13 Gen5 Intel
 ThinkPad L14 Gen5 AMD/Intel
 ThinkPad L16 Gen1 AMD/Intel
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Special key Action triggered 
on L14 Gen5 Intel/
AMD and L16 Gen1 
Intel/AMD

Action 
triggered on 
L13 Gen5 Intel

Further Information

Power Mode / 
Flight Mode 
Special Key

(located at F8)

Access power mode

The following 
power modes are 
available:

 low-power - 
limits max 
power and 
keeps fan 
running 
quieter

 balanced - 
normal 
operation

 performance - 
peak 
performance 
and higher 
temperatures 
allowed

Turn on flight 
mode

Ctrl + Print 
Screen Special 
Key

(located at F9)

Take screenshot of 
the whole screen

Not mapped to 
any action

Ctrl + Snipping 
Tool Special Key

(located at F10)

Launch Snipping 
Tool

Not mapped to 
any action

Ctrl + Maximize 
Window Special 
Key

(located at F11)

Maximise window 
(double press to 
restore)

Not mapped to 
any action

Performance mode is not available 
when you move the laptop around. 
This is because the g-sensor 
detects movement and assumes 
the device is used in lapmode, 
placed on your lap. In lapmode the 
system maintains lower 
temperatures. You can check the 
sensor status with: cat /sys/

devices/platform/

thinkpad_acpi/

dytc_lapmode 
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Special key Action triggered 
on L14 Gen5 Intel/
AMD and L16 Gen1 
Intel/AMD

Action 
triggered on 
L13 Gen5 Intel

Further Information

Star key

(located on F12)

Jump to the web browsers URL bar 
if web browser is installed.

 If a web browser is running, Ctrl+L is 
sent to focus the URL bar.

 If no web browser is running, the 
default browser is launched and the 
focus is automatically set in the URL 
bar.

 If no web browser is installed: the key 
has no effect.

If multiple web browsers are 
installed, the action is only 
triggered for the default browser.
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Articles on Miscellaneous Topics
 Troubleshooting: Error Message "Problem with libva for Chromium 2.16.0 BUILD 3.0 RC1" after 

Reboot (see page 691)
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Troubleshooting: Error Message "Problem with libva for Chromium 
2.16.0 BUILD 3.0 RC1" after Reboot

Environment
 A version of IGEL OS between 12.3.0 and 12.4.1 is installed on the device
 The Chromium app is installed on the device
 The app "libva for Chromium" is not assigned to the device
 Automatic update on boot is enabled on the device (System > Update > Check for and download 

updates for non pinned apps on boot or System > Update Check for and download updates for 
non pinned apps on given calendar time, use the crontab syntax to specify the calendar time)

Problem
On bootup, the device shows the error message "Problem with libva for Chromium 2.16.0 BUILD 3.0 RC1".

Background: Because the library app "libva for Chromium" is installed as a dependency app for Chromium, it has 
been updated to the version that Chromium requires, which is 2.19.0+0.1.rc.1. This version is supported by IGEL OS 
12.5.0 or higher; it can not be installed with IGEL OS 12.4.1 and earlier.

However, apart from the error message, there should be no issue; video playback should work as usual.

Solution
There are three possible solutions:

 Update IGEL OS Baye System to 12.4.2 or higher (release planned for the 18th of July, 2024).
IGEL OS Base System 12.4.2 recognizes if the reason why the latest version of "libva for Chromium" 
can not be installed lies in other dependencies, like the Base System, and avoids needless error 
messages.

 Assign the app "libva for Chromium" explicitly in the appropriate version
 Disable automatic update on boot (System > Update > Check for and download updates for non 

pinned apps on boot or System > Update Check for and download updates for non pinned 
apps on given calendar time, use the crontab syntax to specify the calendar time)
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